‘;'. Yeastar
Yeastar Contact Center Guide

Yeastar P-Series Appliance Edition

Version: v1
Date: 2025-12-03

Q3 +86-592-5503309 0 sales@yeastar.com @ www.yeastar.com



Contents

Contact Center GUIde OVEIVIEW........ccciiiiiiiiiimmuuuniiiiiciiinnniieteceeeteeaaeeessssesssseseeeseessssnes 1
Inbound Call Center GUIdE..........ccoourrmueeeiiiiiiiiiiiniiiereeeeeieerreeeeeeeeeeeeeeeeeeennnasnssssssnnnes 4
INbound Call Center OVEIVIEW........cc.oouiiieieeiieee ettt 4
AdMINISTrator GUIAE. ... ..ottt ettt et aeeeeens 5
OVEIVIBW....c ettt et ettt ettt et e et e et e et e e bt e ebeeeneeeas 5
Fundamental Call QUEUE SETUP.........ooeiiiiiieeeeeeeeeeee et 9
Enhanced Call QUEUE SETUP........coveeiiiieieeeeeee e 19

Call CaNTEr SELUP.....iieiieiieeieeee ettt be e b e e re e e aseeennee e 47

Call CNTEI REPOIM. ...ttt et eae e et eereeen 51

QUEUE PrefereNCES. ..ottt ettt e ne e nseenas 77

Manage Call QUEUES..........oouiiieeieeeeeee ettt ettt enseenreennes 83
SUPEIVISON GUIAE.......eeiiieieeeeeeeee ettt et e e et e e e eaae e e eaaeeeenns 84
OVEIVIBW ...ttt ettt ettt e st e e et e e s st e e snbeeeabeessbeesneeeanseesneeeenneenee 84
WaIIDOAIM. ...ttt ettt et 85

QUEUE PANEL..... .ottt sttt e aeesneenneenneens 103

Manage QUEUE Call LOGS.......coouiieeieeeeeee et 125

AGENT GUIE. ...ttt ettt e et e e e tb e e e beeesbeeesbeeeeseassseeenseaeaseeenns 133
OVEIVIBW.....c.t ettt et ettt et e e et e et e et e ebeeenee e 133

Agent Operations on Web Client / Desktop Client...........ccooieiiiiieiieiieieee 134

Agent Operations on Mobile Client...........c..oooiiiiiiiiiieieceee e, 164
Omnichannel Messaging GUIde...........ccoeueiiiiiiieiiiiiiiiireerereeneeceeeeeeneneeeeeeennssssssseennes 191
Omnichannel Messaging OVEIVIEW..........couieiieiiieiieieeieete ettt ens 191
AdMINISTrator GUIAE. ..o 192
Omnichannel Messaging Administrator GUide...........c.coccievieiieiieiieeeeee e 192
Message Channel SEIUP........c.oooiiieiieeeeeee e 194
MeSSage QUEUE SETUP.....oouiiiiieeiie ettt ettt e et e et e et esabeeenneeas 349
MeSSage CamIPAIgN.......uiiiiieiiiieee et e e e e e e e e e e e e e anaeeas 352

External Chat Log Management...........cc.oooiiiiiiiiiieciieeeeeeeee et 366

AGENT GUIE. ... .ottt e e e e e et e et eete e e aeeeteeereeeneeenns 371

Omnichannel Messaging Agent GUIde...........ccooeiiieiiieciiceeeee e 371



Agent Operations on Web Client / Desktop Client
Agent Operations on Mobile Client........................

Contents | iii



Contact Center Guide Overview

Yeastar P-Series PBX System provides an all-in-one Contact Center solution that unifies
voice and digital messaging channels into a single platform. This guide provides detailed in-
sights into the contact center solution, covering its key features and functionalities, and of-
fers role-based guides to help you set up, manage, utilize, and optimize your contact center
operations effectively.

Introduction

In today's fast-paced business environment, customer-focused businesses face challenges
such as managing high volumes of customer inquiries, providing consistent support across
multiple channels, and maintaining high levels of customer satisfaction.

To address these challenges, Yeastar P-Series PBX System offers a one-stop solution that
integrates unified communications and contact center functionality, including Inbound Call
Center and Omnichannel Messaging, into a single platform. This enables businesses to es-
tablish a contact center that provides seamless communication between customers and
agents across voice and digital messaging channels. Customers can engage with the busi-
ness through multiple communication touchpoints, while business agents can handle cus-
tomer inquiries from all channels in a unified agent portal, improving both customer satis-
faction and agent productivity.

Key features
Yeastar Contact Center solution provides the following features to help businesses deliver
exceptional customer service and achieve operational excellence.

Seamless communication

Customers can reach business through their preferred channels, while busi-
ness agents have unified access to data across all channels, ensuring smooth
transitions of the customer interactions between channels.

Quick and efficient routing

Customer inquiries, whether via voice calls or messages, are automatically
routed to the appropriate agent based on pre-defined rules, ensuring rapid re-
sponse and reducing wait times.

Constant monitoring and analytics

The system provides rich performance metrics, generates call reports, and
records comprehensive messaging histories. This enables administrators to
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track and evaluate agent and queue performance for better workforce man-
agement and strategy optimization.

Unified agent portal

Intuitive and easy-to-use agent portals are built into Linkus UC Clients, allow-
ing agents to handle calls and manage inquiries efficiently, enhancing produc-
tivity and customer service quality.

Powerful integrations

The system implements integrations with various software platforms, such as
CRM, Helpdesk and Microsoft 365, ensuring seamless information exchange.
This boost efficiency and enables agents to deliver exceptional service by
streamlining workflows and focusing on meaningful customer interactions.

Inbound Call Center

Yeastar P-Series PBX System offers an Inbound Call Center solution that is designed to effi-
ciently manage high-volume inbound calls. It specializes in handling customer inquiries and
offering information or assistance through voice calls. By utilizing a range of inbound call
center features provided by the PBX system, including advanced call routing and manage-
ment capabilities, businesses can effectively improve caller satisfaction.

To set up and effectively use the inbound call center, refer to the guides tailored to your spe-
cific role.

« Call Center Administrator Guide
« Call Center Supervisor Guide
« Call Center Agent Guide

Omnichannel Messaging

In addition to voice calls, modern contact center also needs to support digital communica-
tion methods to allow customers to reach out to businesses and seek assistance via their
preferred channel. Yeastar P-Series PBX System provides an omnichannel messaging fea-
ture to help business integrate various digital communication channels into the phone sys-
tem, including text messages, social media, and more. By leveraging the omnichannel mes-
saging functionality, businesses can enhance customer engagement and deliver a seam-
less communication experience through unified messaging across multiple channels.

To set up and utilize the omnichannel messaging, refer to the guides tailored to your specif-
ic role.

* Omnichannel Messaging Administrator Guide
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» Omnichannel Messaging Agent Guide

Additional resources

Yeastar P-Series PBX System also offers a series of features and integrations to optimize
your contact center operations. These features helps to streamline workflows, automate
processes, and provide agents with the tools they need to improve productivity, ultimately
delivering superior customer service.

* Interactive Voice Response

* CRM Integration

 Helpdesk Integration

» WebRTC Click-to-call

« Linkus Web Client CTI / Linkus Desktop Client CTI

» Open API



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/interactive-voice-response-overview.html
https://help.yeastar.com/en/p-series-appliance-edition/integrations/integrations.html#topic_integrations__integrations-crm-system
https://help.yeastar.com/en/p-series-appliance-edition/integrations/integrations.html#topic_integrations__integrations-helpdesk
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/webrtc-trunk-overview.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/web-client-user-guide/linkus-web-client-cti-overview.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/desktop-client-user-guide/linkus-desktop-client-cti-overview.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/about-this-guide.html

Inbound Call Center Guide

Inbound Call Center Overview

Yeastar P-Series PBX System provides an Inbound Call Center for businesses to provide
customer supports via voice calls. With the call center functionalities, business agents can
promptly and efficiently handle and manage incoming calls from customers, significantly
improving agent productivity and responsiveness, ultimately ensuring a higher level of cus-
tomer satisfaction.

Highlights
Yeastar Inbound Call Center service provides the following highlights:

Automatic call distribution

Efficiently routes incoming calls to the most appropriate agents based on pre-
defined rules and criteria, ensuring that customer inquiries are handled quickly
and by the most qualified personnel.

Enhanced caller waiting experience

Proactively serve customers in the queue with valuable information such as
their queue position, estimated waiting time, queue callback instructions, hol-
iday greetings, and other customized prompts, ensuring a seamless and en-
gaging experience.

Unified supervisor and agent workspace

Provide unified supervisor and agent web-based workspace - Wallboard and
Queue Panel, to allow users to monitor and optimize performance with met-
rics, and offer a comprehensive view on activity of call for users to handle
queue calls.

SLA for quality assurance
Ensure that your call center consistently delivers high-quality service by meet-
ing or exceeding the targets defined in your Service Level Agreement (SLA).
Intuitive reports and analytics

Run targeted analysis of your call center data by customizing timeframe,
agent, or queue selection. Share the real-time or historical reports with your
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team in graphical, downloadable formats, and schedule reports to be run peri-
odically in the future.

Roles in Yeastar Call Center

Users can access the call center and perform different tasks based on their assigned roles,
as the following table lists.

Role Description

System The PBX system administrator is responsible for queue management, including

Administrator creating call queues, configuring options (such as call distribution, announcements
and MoH, overflow and timeout handling, and queue preferences), assigning
managers and agents to queues, setting up the call center, and managing call center
reports.

For more information, see Call Center Administrator Guide.

Supervisor Users with the Queue Manager role assigned by the system administrator to be a
supervisor for a queue. The supervisors are responsible for monitoring call queue
performance, managing queue calls, and supervising agents.

For more information, see Call Center Supervisor Guide.

Agents Users with Agent role assigned by the system administrator. The agents are
responsible for handling incoming call interactions in the call queues.

For more information, see Call Center Agent Guide.

Administrator Guide

Call Center Administrator Guide

This guide describes the call center composition, and provides step-to-step instructions on
how to set up and configure an inbound call center.

Audience

This guide is intended for system administrators responsible for establishing, configuring,
and maintaining an inbound call center.

Inbound Call Center components

Yeastar Inbound Call Center consists of two main components: the basic call queue estab-
lished by an administrator in the PBX web portal, and the Call Center Console integrated into
the Linkus Web Client and Linkus Desktop Client.
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Call queue

A call queue is the point of entry for inbound interactions. It functions as a vir-
tual waiting room where callers remain in line until an available agent can at-
tend to them. When a customer calls into the system and enters the queue,

he / she can hear the hold music and announcement while the queue distribut-
ing the call to the available agents.

Review the essential elements of a call queue listed below to grasp its func-
tionality and features:

Terminology Description

Caller Customers who place calls to the queue.
Agents Members who answer the queue calls (extensions or users who log in
as agents).

« Static agent: The agent is always a member of the queue and
cannot log out.

» Dynamic agent: The agent can log in to or log out of a queue
at any time.

Announceme Announcements played to callers and agents, including agent ID

nt announcement, position announcement, and periodic announcement.
Music on Music or advertisements played to callers while waiting in the queue.
Hold (MoH)

Ring strategy A strategy for how to distribute calls to agents.

Failover A destination to which calls will be routed in the following scenarios.
destination
» The number of callers that wait in a queue reaches the
Maximum Callers In Queue.
* The time that callers wait reaches the Maximum Waiting
Time.
» No agents in queue and the caller is pulled out of a queue.

For more detailed information about call queue settings, see Queue Prefer-
ences.

Call Center Console

Yeastar Call Center provides a unified workspace, Call Center Console, for
queue managers (supervisors) and agents to handle queue calls. The Call
Center Console is an embedded utility integrated into Linkus Web Client and
Linkus Desktop Client for more convenient call management, including a cus-
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tomizable Wallboard for proactive tracking of 16 key performance metrics,
and a switchboard-type Queue Panel for real-time monitoring & control of
gueue activities.

Note:
The Call Center Console service requires a subscription to Enterprise
Plan and Ultimate Plan.

For more information of monitoring queue performance and managing queue
calls on Call Center Console, see Yeastar Call Center Supervisor Guide and
Yeastar Call Center Agent Guide.

Steps to establish an Inbound Call Center

1. Create a call queue

Define the basic call queue structure, create the call queue and decide how to
distribute inbound calls to the queue of agents.

« To create a queue with Workload-based call routing, see Create a Call

Queue.
« To set up a queue with Skill-based call routing, see Set up Skill-based
Routing for a Queue.

2. Improve call queue management

According to your needs, set up the call queue with advanced features to opti-
mize caller experience, and implement configurations on agent management
to increase productivity.

» Queue Callback

To save callers' time while keeping their positions in the queue, you can
enable callback feature for the queue, and decide whether callers can
press a digit or wait till timeout to request a callback.

For more information, see Allow Users to Request a Callback in a Queue.
* Queue Priority

To reduce time on holding callers, you can set a queue initial weight and
an acceleration weight to determine which queue has higher priority
and automatically moves the calls in a higher-priority queue up in line.
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When agents are logged in to multiple queues, calls from the queue with
a greater weight will be prioritized and assigned to agents first.

For more information, see Set a Priority for a Call Queue.
* Queue Agent Management

To optimize agent work efficiency and service quality, you can perform
specific configurations that simplify the way agents and queue man-
agers (supervisors) handle operational statuses and activities.

Item Description

Agent Pause Set specific reasons for pause status of call queue
Reason agents, enabling agents to select specific reasons when
pausing their service.

By monitoring and tracking these reasons, you and
supervisors can better manage agent availability and
assess disruptions in service, ensuring more accurate
workforce planning and operational efficiency.

For more information, see the following topics:
o Set Pause Reasons for Queue Agents
o Monitor Specific Pause Status of an Agent by

Function Key

Queue Call Log Give specific or all agents access to queue call log,
Access enabling them to effectively handle and follow up on
customer communications.

For more information, see Allow Agents to View Queue
Call Logs on Linkus Clients.

Agent Status Equip agents with the ability to adjust their status in
Management real-time via feature code or IP phone, enabling a more
flexible and efficient operation.
For more information, see the following topics:
o Allow Agents to Manage Their Status by Dialing a
Feature Code
o Allow Agents to Manage Their Status via IP
Phones

3. Set up the Call Center

Set up workspaces to provide all the tools your agents and supervisors need in
a unified interface.

« Set up queue managers (supervisors)
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Assign one or more extension users as queue managers for the call
queue. The queue managers are able to access the Call Center Console
dashboards for queue monitoring and management, and receive queue
notifications by email.

For more information, see Set up Queue Managers.
« Customize queue notifications

Configure the notification options for the call queue. The system will au-
tomatically send email notifications to queue managers when the corre-
sponding issue occurs, such as a queue call is missed or abandoned, or
the service level agreement reaches the alarm threshold, etc.

For more information, see Customize Queue Notification.
- Set up Service Level Agreement (SLA)

Set a target service level and SLA threshold for the queue to enable
gueue managers to evaluate whether agents are handling customer
calls promptly for quality assurance purpose.

For more information, see Set up Service Level Agreement (SLA).
« Grant Call Center Console permissions

Grant the access permission to the Call Center Console dashboards
(Wallboard & Queue Panel) for queue managers and agents respectively,
and decide what they can on the Queue Panel.

For more information, see Grant Call Center Console Permissions.

4. Manage Call Center reports

Get access to advanced Call Center reports based on queue or agent, and run
targeted analysis of your call center.

For more information, see Call Center Reports Overview.

Fundamental Call Queue Setup

Create a Queue

You can create and design queues to allow callers to talk with agents according to your
business. This topic describes how to create a queue.
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Prerequisites

Before you begin, prepare the following voice prompts and music as needed, and upload
them to the system.

* Prepare and upload the following voice prompts for the queue to provide different in-
formation:

> Join Announcement: The prompt played to callers when they join the queue.

- Periodic Announcement: The prompt played periodically to callers after they
reach the queue and before agents answer the calls. Following the prompt,
callers can press the key to respond.

« Prepare and upload Music on Hold for the queue, which is played to callers when their
calls are put on hold by agents.

Procedure

1. Log in to PBX web portal, go to Call Features > Queue, click Add.
2. In the Basic page, configure the basic settings for the queue.
a. In the Basic section, configure the following settings.

Setting Description

Number Enter a virtual number for callers to access the queue.

The default queue number range is from 6400 to 6499.

Name Specify a name to help you identify this queue.
Skill-based Decide whether to route incoming calls in the queue based on
Routing agents' skill level.

If this option is enabled, you can specify skill levels for agents, and
queue calls will be routed in descending order of agent skill level.
For more information, see Set up Skill-based Routing for a Queue.

Ring Strategy Select a ring method to distribute calls to agents.
* Ring All: Ring all available agents simultaneously until
someone answers.
» Least Recent: Ring the available agent that was least
recently called.
» Fewest Calls: Ring the available agent with the fewest
completed calls.
» Random: Ring the agents randomly.
* Rrmemory: Round robin with memory.
> Queue with static agents only: The system
remembers the last agent it tried and rings the next
agent specified in the static agents list.



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/upload-a-custom-prompt.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/set-up-a-custom-moh-playlist.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/system-preferences.html#system-preferences__table_yjw_wzk_nlb
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Setting Description

> Queue with dynamic agents only: The system
remembers the last agent it tried and rings the next
agent in the order that dynamic agents have logged
in.

> Queue with both static agents and dynamic agents:
The system remembers the last agent it tried and
rings the next agent specified in the static agents list.
If none of the static agents are available, the system
rings the dynamic agent in the order that dynamic
agents have logged in.

« Linear: Ring the available agent in specific order based on
the type of agents in the queue.

> Queue with static agents only: The system rings
available agents in the order specified in the agents
list.

> Queue with dynamic agents only: The system rings
available agents in the order that agents have logged
in.

> Queue with both static agents and dynamic agents:
The system rings available agents in the order that
agents have logged in.

Maximum Waiting Set a number of seconds that the caller can wait for an available

Time(s) agent.
Failover Select a destination to route the call when the call is not answered
Destination by any agent.

* Hang up: End the current call.

« Extension: Route the call to the specified extension.

« Extension Voicemail: Route the call to voicemail box of
the specified extension.

+ Group Voicemail: Route the call to voicemail box of a
queue, a ring group, or a custom group.

* IVR: Route the call to the specified IVR.

« Call Flow: Route the call to the specified call flow.

« Ring Group: Route the call to another ring group.

» Queue: Route the call to the specified queue.

 External Number: Route the call to an external number.

« Play Prompt and Exit: Play a custom prompt, then hang
up the call.

b. To only receive calls during business hours and route calls received outside
business hours to designated destinations, configure the following settings:

| Note:
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To achieve this, make sure the following requirements are met:
« The firmware of Yeastar P-Series PBX System is 37.18.0.59 or lat-
er.
* You have set up business hours and holidays in the desired time
zone.

Setting Description

Time Condition Select the checkbox to allow the PBX to route queue calls to
different destination based on time.

Time Zone Select a desired time zone.

The business hours and holidays settings in the selected time zone
will be applied to the queue.

," Note:
The time displayed in the gueue notification emails will also
follow the time of the selected time zone.

Outside Business Select the destination for calls received during the time periods that
Hours Destination are not defined as business hours or holidays in the selected time

zone.
Holidays Select the destination for calls received during holidays defined in
Destination the selected time zone.

Ignore the Optional. To prevent incoming calls from being distributed to the
Holiday holiday destination, select the checkbox of Ignore the Holiday
Destination Destination.

If enabled, incoming calls during holiday will be distributed to other
destinations according to your office hour setting.

Play Holiday Optional. To play a prompt to callers before routing the inbound
Prompt During calls to the holiday destination, select the checkbox of Play
Holidays Holiday Prompt During Holidays.

Note:
Make sure that you have set a prompt for the holiday
(Path: Call Control > Business Hours and Holidays >
Holidays > Type > Prompt). Otherwise, the inbound calls
will be directly routed to the holiday destination without
playing a prompt.

c. In the Agent Options section, configure the following agent settings.


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/overview-of-business-hours-and-holidays.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/overview-of-business-hours-and-holidays.html
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Setting Description

Agent Timeout(s) Set a number of seconds that the system rings an agent's phone.

Retry Interval(s)  Set a number of seconds to wait before ringing the next available
agent when the last available agent has been ringed and timed out.

Wrap-up Time(s) Set a number of seconds for agents to complete post-call
processing after finishing a call.

The next call will come after this period following the ring strategy.

Agent Select a prompt to be played to agents when they answer a queue
Announcement call.

Ring In Use Set whether to ring an in-call agent when there are incoming calls
in the queue.
Agent Auto Pause .
Note:
If the Ring Strategy is set to Ring All, this feature will NOT
take effect.

Decide whether to automatically pause agents when their
consecutive missed calls in the queue reach a threshold.

To use this feature, select Agent Auto Pause and specify the
threshold in the Max Threshold for Missed Calls drop-down list.

Note:

« Agents will receive a notification email when they
are paused.
» The missed calls count for an agent will be cleared
when any of the following events occurs:
o The agent makes or answers a queue call.
> The agent is paused or logged out.
o The PBX is rebooted.

Display Missed Decide whether to display missed queue call records on agents' IP
Call Records in phones.

Agent IP Phone
Note:

« This option will be applied to all agents in the
queue.

« If an agent belongs to multiple queues, the agent's
IP phone will only display the missed call records
for those queues in which this option is enabled.

d. In the Prompt section, complete the following prompt settings.
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Queue-related Announcement

Join Announcement Set the announcement to be played to callers when they
join the queue.

« Play full Join Announcement to the caller
before ringing extensions: Set whether to play
full join announcement to callers before ringing
agents.

Ringback Tone Select a prompt to be played continuously in a loop to
callers before agents answer the calls.

Note:

» The existing prompts are synchronized
from the Music on Hold playlists and
custom prompts uploaded on PBX
settings > Voice Prompt.

» The Ringback Tone will be played after
the Join Announcement.

Music On Hold Set the music to be played to callers when their calls are
put on hold by agents after being answered.

Periodic Announcement Set the announcement to be played to callers
periodically after they reach the queue and before
agents answer the calls.

Frequency (s) Set the time interval to play the periodic
announcements.

Caller Position Announcement

Announce Position Set whether to announce the position of the caller in the
queue.

Announce Hold Time Set whether to announce the estimated waiting time to
the caller.

Play "Thank You for Your Set whether to play the prompt "Thank You for Your
Patience" Prompt Patience" to callers periodically while the callers are
waiting in the queue.

Frequency (s) Set the time interval to play the caller position
announcement.

Agent-related Announcement
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Agent ID Announcement Set whether to play an announcement to both the caller
and the agent to prompt the agent ID when an agent
answers the call.

Announcement Language

Custom Prompt Language Set the language of system default announcements
heard by callers when they join the queue.

," Note:
The available languages are synchronized from
System Prompt (Path: PBX Settings > Voice
Prompt > System Prompt).

3. Click the Members tab, set agents for the queue.

- Dynamic Agents: Select the dynamic agents that can log in to or log out of a
queue at any time.

Note:
The queue distributes calls to the dynamic agents only when they log in
to the queue and unpause the queue calls.

- Static Agents: Select the static agents that always stay in the queue.

Note:
Static agents do not need to “log in” to the queue, and cannot “log out”
of the queue.

4. Click Preferences tab to customize the queue according to your needs.

For more information of the preference settings, see Queue Preferences.
5. Click Save and Apply.

What to do next
Set up an inbound route, and specify the destination of the inbound route to the queue.

Set up Skill-based Routing for a Queue

Skill-based routing supports specifying skill level for agents in a queue, and route calls to
the designated agents in descending order of their skill levels. Prioritizing queue calls to the


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/set-up-an-inbound-route.html
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most skilled agents ensures properly handling of customer inquiries and enhanced work ef-
ficiency.

Requirements

» Firmware: Version 37.14.0.24 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

Scenario
Depending on whether there are agents with equal skill level within the same queue, the
skill-based routing process varies.

Agents with unique skill levels

In this scenario, each agent in the queue is specified with a unique skill level.
When a caller calls into the queue, the call will be directly routed to the agent
with highest skill level (1). If the agent is not available, the call will be routed to
the next agent in descending order of skill level.

bbbl g Skill Level 1 (Highest)

R

Q) e B e a

Customer

Agent 2

Skill Level 99 (Lowest)

R

Agent 99

Agents with equal skill level

In this scenario, several agents are specified with equal skill level. When a
caller calls into the queue, the call will be directly routed to agents with the
highest skill level (1) in the queue, and ring the agent according to the ring
strategy of equal skill level. If all the agents with the highest skill level are not
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available, the call will be routed to the next agents in descending order of skill
level.

r——— Skill Level 1 (Highest)

e — Omm———n

o 2 2 B

Agent 1 Agent 2 Agent 3 Agent4

Skill Level 99 (Lowest)

Customer

R 1 =K

Agent 100 Agent 101 Agent 102

Procedure

1. Log in to PBX web portal, go to Call Features > Queue.

2. Click Z. beside the desired queue.
3. In the Basic tab, enable skill-based routing and select ring strategy.

Basic Members Preferences Queue Panel Permissions

Basic

Support

Skill-based Routing
Ring All 1800

Hang Up

a. Select the checkbox of Skill-based Routing.
b. In the Ring Strategy of Equal Skill Level drop-down list, select the ring strate-
gy for agents of equal skill level.

| Note:
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If each agent in the queue is assigned with a unique skill level, the sys-
A tem will strictly ring the agents in descending order of skill level, disre-
garding the ring strategy settings.

Ring Strategy | Description

Ring All Ring all agents of equal skill level simultaneously until someone
answers.

Least Recent Among agents of equal skill level, ring the agent that was least
recently called.

Fewest Calls Among agents of equal skill level, ring the agent with the fewest
completed calls.

Random Ring the agents of equal skill level randomly.

Rrmemory Round robin with memory.

» Queue with static agents only: Among agents of equal skill
level, the system remembers the last agent it tried and rings the
next agent specified in the static agents list.

* Queue with dynamic agents only: Among agents of equal skill
level, the system remembers the last agent it tried and rings the
next agent in the order that dynamic agents have logged in.

* Queue with both static agents and dynamic agents: Among
agents of equal skill level, the system remembers the last
agent it tried and rings the next agent specified in the static
agents list. If none of the static agents are available, the system
rings the dynamic agent in the order that dynamic agents have
logged in.

Linear Ring the agents of equal skill level in specific order based on the type
of agents in the queue.

* Queue with static agents only: The system rings agents of
equal skill level in the order specified in the agents list.

* Queue with dynamic agents only: The system rings agents of
equal skill level in the order that agents have logged in.

» Queue with both static agents and dynamic agents: The system
rings agents of equal skill level in the order that agents have
logged in.

4. In the Members tab, set the skill level for agents.

Note:

By default, all agents are assigned with the skill level 1 (the highest level).
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Basic Members Preferences Queue Panel Permissions

Dynamic Agents

5items Available 4 items Selected

Extension Number Caller ID Name Extension Caller IDN. Skill Level Operations

2005 Kristin Hale 2000 Leo Ball 1 2

2006 Naomi Nichols 2001 Phillip Huff 1

2007 Ashley Gardner 2003 DelEs 9

2010 ming10 xing10
Edit - (Leo Ball)
2222 Import Model

a. Click Z beside a selected agent.
b. In the pop-up window, specify a skill level for the agent.

Note:
 The permitted value is 1 to 99. The smaller the number, the higher
the skill level, and consequently the higher the priority for ringing.
« The agent skill level specified here ONLY takes effect in this
queue.

c. Click Confirm.
d. Repeat step a - ¢ for all the desired agents.
5. Click Save and Apply.

Result

When a caller calls into the queue, the system will route the call to agent(s) according to
agent skill level, starting from the highest and descending to the lowest.

Enhanced Call Queue Setup

Allow Users to Request a Callback in a Queue

A queue callback allows callers waiting in a queue to opt out of the queue and be called

back when an agent becomes available. With callback feature, customers can save time
while keeping their positions in the queue, and you can reduce the number of abandoned
calls and ensure queue performance.
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Allow users to request a callback by pressing a digit

Prerequisites
You have subscribed Enterprise Plan (EP) or Ultimate Plan (UP).

Procedure

1. Log in to PBX web portal, go to Call Features > Queue.

2. Click Z beside a desired queue.

3. Click Preferences tab, then scroll down to the Callback section to en-
able and set up queue callback.

@ callback

Triggered by caller input 1

@ Please make sure all agents in this queue have permission to use this outbound
route

Enable Queue's Maximum Waiting Time

a. Turn on Callback.

b. In the Request Callback Method drop-down list, select Trig-
gered by caller input.

c. In the Digit to press drop-down list, select a value.

Note:
The value can NOT conflict with the Key Press Event val-
ue of the queue.

Customers can press the digit to request a callback while in queue
waiting for being answered.

d. Optional: In the Callback Outbound Prefix field, enter the prefix
of an outbound route, which will be used to make the callback.

Note:
Make sure all agents in this queue have permission to use
the outbound route, or the callback would fail.

e. In the Callback Timeout drop-down list, set how long a callback
request can be reserved in the queue. If there are no available
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agents in the queue within the timeout period, the callback request
will be cancelled.

Note:

The default timeout period is the queue's Maximum Wait-
ing Time (Path: Queue > Basic > Maximum Waiting
Time(s)). You can also select Custom to customize a
timeout period.

4. Click Basic tab, then scroll down to the Prompt section to select a
prompt, instructing customers to press the specified digit to request a
callback.

Prompt
[None] default

Testwav 60

a. In the Periodic Announcement drop-down list, select a prompt.

Note:

The available prompts are the ones that you have record-
ed or uploaded to the system. For more information, see
Record a Custom Prompt and Upload a Custom Prompt.

b. Optional: In the Frequency (s) field, select or enter a value to set
the time interval to play the prompt.
5. Click Save and Apply.

Result

Customers can press the specified digit to request a callback while waiting in
the queue.

What to do next

« Read the provided example to know the callback flow.

For more information, see Queue Callback Example.
« Enable email notifications to queue managers when a callback request
is made or a callback failed.

For more information, see Customize Queue Notification.



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/record-a-custom-prompt.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/upload-a-custom-prompt.html
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« Query callback statistics of the queue as needed.

For more information, see Queue Callback Summary Report and Queue
Callback Activity Report.

Allow users to request a callback after timeout

Prerequisites
You have subscribed Enterprise Plan (EP) or Ultimate Plan (UP).

Procedure

1. Log in to PBX web portal, go to Call Features > Queue.

2. Click Z beside a desired queue.

3. Click Preferences tab, then scroll down to the Callback section to en-
able and set up queue callback.

@ Ccallback

Auto triggered after the timeout 60

@ Please make sure all agents in this queue have permission to use this outbound
route

Enable Queue's Maximum Waiting Time

a. Turn on Callback.

b. In the Request Callback Method drop-down list, select Auto
triggered after the timeout.

c. In the Timeout (s) field, select or enter a value.

Note:
» The value can NOT be greater than Maximum
Waiting Time (s) of the queue.
» The Timeout is calculated as soon as customers
call to the queue.

After waiting the specified duration of time in a queue, the system
plays the callback option to the caller automatically.

d. Optional: In the Callback Outbound Prefix field, enter the prefix
of an outbound route, which will be used to make the callback.
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Note:

Make sure all agents in this queue have permission to use
the outbound route, or the callback would fail.

e. In the Callback Timeout drop-down list, set how long a callback
request can be reserved in the queue. If there are no available
agents in the queue within the timeout period, the callback request
will be cancelled.

Note:

The default timeout period is the queue's Maximum Wait-
ing Time (Path: Queue > Basic > Maximum Waiting
Time(s)). You can also select Custom to customize a
timeout period.

4. Click Save and Apply.

Result

After waiting the specified duration of time in a queue, the system plays the
callback option to the caller automatically. Customers can press a specific

digit to request a callback.

What to do next

« Read the provided example to know the callback flow.

For more information, see Queue Callback Example.
« Enable email notifications to queue managers when a callback request

is made or a callback failed.

For more information, see Customize Queue Notification.

« Query callback statistics of the queue as needed.

For more information, see Queue Callback Summary Report and Queue
Callback Activity Report.

Queue callback example

We provide an example to help you understand the callback flow:
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Customer Queue Callback Registration Available Agenis
Caller input
. “(E )
b L %
T After timeout

Callback

1. A customer makes a call to a queue, but there are no agents available to answer the
call.
2. The customer requests a callback in either of the following methods:
« After the periodic announcement, the customer presses the specified digit.
« After waiting a specified duration of time, the customer presses the specified
digit.
3. The customer registers a callback number, then hangs up the call.

Note:

« By default, the callback number is the phone number from which the
customer is calling the queue.

 The customer can register another phone number as needed. The call-
back number must be at least 5 digits.

The customer's position in the queue is reserved.

4. Upon an agent is available, the system makes a call to the agent and the customer
successively.
If the agent and the customer both answer the call, the queue call is established.

Note:
If there are no available agents in the queue within Callback Timeout, the
callback request will be cancelled.

Set a Priority for a Call Queue

The Priority Queue feature allows you to assign a weight to each call queue. The system
factors in both the initial weight assigned to a queue as well as the amount of time that a
call has been waiting in the queue to determine the importance of calls in different queues.
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When agents are logged into multiple call queues, the system calculates the weight of
queues and automatically moves the calls in a higher-priority queue up in line, reducing wait-
ing time for VIP callers while maintaining customer satisfaction for other callers.

Scenario

An agent simultaneously services for two queues (e.g. Support-VIP and Support), both of
them have been assigned a weight. If there are incoming calls in both queues, the agent will
first be connected to the calls coming from the higher-priority queue Support-VIP, ensuring
that VIP callers receive a faster response.

Queue: Support - VIP

Weight: 2
[« TEEREEN .
Qo0 & o
Customer call-4 call-1 O ©
e 3 N B N ) poA © S o'
Queue: Support Yoo %
Weight: 1 H call-3 call-2 call-4 call-1 Agent
..
Qo0 &
Customer call-3 call-2

Procedure

1. Log in to PBX web portal, go to Call Features > Queue.

2. Click Z beside the desired queue, and go to the Preferences tab.
3. Turn on the switch of Priority Queue.
4. In the Weight field, specify the initial weight of the queue.

You can enter a number between 1 and 999. The larger the number, the greater the
weight.

The system will compare the weight of multiple queues, and assign incoming calls
from the queue with a greater weight to agents first. For example, calls in a queue
with a weight of 2 will be answered more quickly than that in a queue with a weight of
1.
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5. Optional: To avoid the calls in a low-priority queue being waited for too long, you can
set up acceleration weight for a low-priority queue.

a. Select the checkbox of Enable Acceleration Weight.
b. In the Acceleration (s) field, specify the amount of time a call has been waiting
in the queue before the weight is increased by 1.

You can enter a number between 10 and 1800, and the total queue weight will
be calculated based on the initial queue weight and the waiting time of a call.

Queue Weight = Wight + (Waiting Tine / Acceleration) * 1

Note:

If there are decimals in the result, the value will be rounded.

6. Click Save.

Result

When an agent is logged in to multiple queues and there are calls waiting in more than one
queue, the system automatically calculates and compares the queue weight for each call
queue and routes the call in the higher-priority queue to the agent first.

Example

We provide an example to help you understand how call distribution works based on queue
weight:

Agent Leo Ball has logged in to two support queues, Support - VIP and Support, and the
queue weight settings for these queues are as follows:

Setting Queue (Support - VIP) Queue (Support)
Initial Weight 2 1
Acceleration Disabled 60s
Weight

When agent Leo Ball is available and both queues have calls waiting in the queue, the fol-
lowings will occur.
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® Call-2 (£)

Call-1(9) Call-3

® Callsinqueue Support

Calls in queue Support-VIP

« Call-1 enters the Support - VIP queue, and Call-2 enters the Support queue simultane-
ously.

In this case, the queue weight of Support - VIP (2) is greater than that of Support (1).
Therefore, Call-1 will be answered first, while Call-2 keeps waiting in the queue.

« Call-3 enters the Support - VIP queue when Call-2 in the Support queue has been wait-
ing for 120 seconds.

In this case, the queue weight of Support - VIP remains 2, while the queue weight of
the Support queue is calculatedas 1 + (120 / 60) * 1 = 3.

Since the queue weight of the Support (3) is now greater than that of Support - VIP
(2), Call-2 will be answered first after the agent completes the ongoing call.
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Agent Management

Set Pause Reasons for Queue Agents

Yeastar P-Series PBX System allows you to set specific reasons for pause status of queue
agents. Agents can pause with reasons by feature code, or by dedicated button on their
Linkus Clients. Queue managers can track the pause reasons and duration of agents in call
reports.

Prerequisites

Subscribe to Enterprise Plan or Ultimate Plan.

Limitation

Yeastar P-Series PBX System supports up to 20 pause reasons.

Procedure

1. Log in to PBX web portal, go to Call Features > Queue.
2. On the top of the page, click Pause Reason.

o

Ri
Number Name Queue Managers Static Agents Dynamic Agents i)

Operations
Strategy

6400 6400 1001-Joe ... .. 1004-Dave...  1005-Troy. . 1002-docs...  1000-1000 Ring All Z

3. In the pop-up window, complete the following settings:

Note:
Yeastar P-Series PBX System provides the following default pause reasons
and the corresponding feature codes. You can modify them or add new ones.
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Pause Reason X

Feature Code Pause Reason Operations

*01 Lunch T
02 Break |

*03 Wrap up |

+ Add

X Cancel

a. Specify pause reasons and the corresponding feature codes.
« Feature Code: Assign a feature code to the pause reason.

- Pause Reason: Specify the reason why an agent pauses receiving calls.
b. Click Save.

Result

« The pause reasons are available for all queues in the PBX.
* Queue agents can pause with reasons in the following ways:
- By feature code

Queue agents can dial Pause Feat ure Code + Queue Nunber + Pause Reason
Feat ure Code to pause from a queue for corresponding reason.

6 Tip:
You can obtain the Pause feature code on Call Features > Feature
Code > Queue > Pause/Unpause.

For example, an agent dials "*076400*03" to pause from queue 6400 for Wrap
up reason.

> By dedicated button on Linkus Clients
Queue agents can click Pause button and select a specific pause reason on
their Linkus Clients, as shown in the following table.
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Linkus Web Client

On web page

y Lunch % Pause
Break & Log Out 'I
e
Wrap up
Abangdhed Call
b inyoﬁ alls
So s

On 'Yeastar Linkus
for Google' Chrome
extension

Linkus Desktop Client

Lunch

Break

Wrap up

¢ Yeastar Linkus for Google ~ — o X
B e NumberorName Q @ .';-@@

Switch Status To

My Queue
% 6400 [6400]
Time : 00:06:31
1 Z 3
ABC DEF
4 S 6
H JKL MNO
7 8 9
Tl VX
@ 0 #

7% Yeastar Linkus for Google ~ —

orName Q @ .'#e

B e Numbt
Switch Status To

& Pause

& Unpause

& Logout

ABC

o X

>
5

7+ Yeastar Linkus for Google

B e N

Pause Reason

Lunch
Break
Wrap up
4 S
GH
7 8
PQF
*

Linkus Mobile Client

Presence <

© Away

@ Do Not Disturb

Lunch Break

@ Business Trip

® off Work

Ring Timeout (s)

Set Temporary Presence

Ring Mobile Number Simultane...

Accept Push Notifications

Presence Information

{j Internal Calls

External Calls

Ring sequence of extension termi...

Agent Status Auto Swit...Do Nothing

73 Note:
To use the feature,
the App version
should be updated.
= Linkus
Android
Client:
4.10.6 or
later
= Linkus
iOS Client:
4.10.3 or
later

« Queue managers can switch agents to pause on a specific reason from the queue

panel.
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& Agent (2/7)

Alex Dumphy

& Loggedin11/16/202...

|

Lunch & Pause

Break & Log Out

Wrap up
VS

Related information
Agent Pause Activity Report
Monitor Specific Pause Status of an Agent by Function Key

Monitor Specific Pause Status of an Agent by Function Key

This topic provides an example on how to monitor specific pause status of an agent by
function key on Linkus Web Client, Linkus Desktop Client, or on an IP phone.

Prerequisites

« Obtain the following feature codes:
o Pause feature code (Path: Call Features > Feature Code > Queue > Pause/
Unpause)
o Pause Reason feature code (Path: Call Features > Feature Code > Pause
Reason)
« To monitor specific agent pause status on an IP phone, make sure that the IP phone
is connected to Yeastar P-Series PBX System via auto provisioning, and has been as-
signed with an extension.

Note:

For detailed instructions about auto provisioning the IP phone, see IP Phone
Configuration Guide.



https://help.yeastar.com/en/p-series-appliance-edition/ip-phone-configuration-guide/ip-phone-configuration-guide-overview.html#overview__section_f3g_5dz_syb
https://help.yeastar.com/en/p-series-appliance-edition/ip-phone-configuration-guide/ip-phone-configuration-guide-overview.html#overview__section_f3g_5dz_syb
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Procedure

Assume that you want to monitor the three default pause status of agents 1001, 1002 and
1003 in queue 6400, do as follows to configure function keys for your extension.

1. Set up function keys for monitoring specific pause status.

a. Log in to PBX web portal, go to Extension and Trunk > Extension, edit your
extension.

b. Click the Function Keys tab.
c. Configure the following function keys.

Presence Voicemail Features Advanced Security Linkus Clients Phone Function Keys

Function Key Type Value Label Operations Sort

Key 1 BLF *071001%6400%01 Agent1001_Lunch o) =

Key 2 BLF *071002*6400*02 Agent1002_Break D)

Key 3 BLF 071003*6400%03 Agent1003_Wrapup o =

» Type: Select BLF key.
« Value: Enter the feature codes.

The format should be Pause feature code + ext ensi on nunmber
+* + queue number + pause reason feature code. For example,
*071001*6400*01.
« Label: Optional. Enter a display label for the function key.
d. Click Save.
2. If you want to monitor specific agent pause status on IP phone, apply the function key
configuration to the IP phone.

a. Go to Auto Provisioning > Phones, click C beside the desired phone.
b. In the pop-up window, click OK.

Result
You can monitor specific pause status of the agents via the followings:

Function key on Linkus Web Client, Linkus Chrome extension, and Linkus Desk-
top Client

. 1‘0: The monitored agent is NOT in the specified pause status.

[ : _ g
« 4D: The monitored agent is in the specified pause status.
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- & The function key configuration failed.

'Yeastar Linkus for
Google' Chrome extension

Linkus Web Client Linkus Desktop Client

4+ Yeastar Linkus for Google
@ [ L[ v AgentStatusv @ Available
/] B e Number or Name Q F & )
' . Function Keys
Function Keys x I
|‘ i & Agent1001_Lunch
Agent1001_Lunch
\\ & Agen _Lunc \\ & Agent1002_Break
& Agent1002_Break ~ & Agent1003_Wrapup
uff
& Agent1003_Wrapup
; 1 2 3
(1] ABC DEF
Hale 4 5 6
GHI JKL MNO
PQRS TUV WXYZ
. 0 #
Total: 5 10 / Row +
Total: 5 10/ Row

BLF LED on IP phone

« BLF LED Solid Green: The monitored agent is NOT in the specified pause
status.

« BLF LED Flashing Red: The agent is in the specified pause status.

* BLF LED off: The BLF key configuration failed.

Related information
Allow Agents to Manage Their Status by Dialing a Feature Code
Allow Agents to Manage Their Status via IP Phones

Enable Shared Wrap-up Time Among Multiple Queues

With shared wrap-up time feature, agents who belong to multiple queues will have sufficient
time to complete post-call processing after finishing a call, avoiding receiving new calls
from other queues during wrap-up time period. This topic describes how to enable shared
wrap-up time among multiple queues.
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Requirements

The firmware version of PBX server is 37.19.0.110 or later.
Procedure

1. Log in to PBX web portal, go to Call Features > Queue.

2. On the top of the page, click Options.

3. In the Shared Wrap-up Time Across Multiple Queues drop-down list, select En-
able

E] Options |

Options

* Default Status of Dynamic Agents

Log Out

% Shared Wrap-up Time Across Multiple Queues

i ‘ Disabled

Enabled

Disabl

X Cancel

4. Click Save and Apply.

Result

When an agent who belongs to multiple queues finishes a call in one queue, the wrap-up
time configured in that queue will be applied across all queues associated with this agent,
the agent will not receive new calls from other queues during this wrap-up period.

Example
We provide an example to demonstrate the effect if the shared wrap-up time is enabled.

In this example, we have an agent A belongs to Queue-1 and Queue-2, and Call-1 from
Queue-1, Call-2 from Queue-2.
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Call-1 from Queue-1
v
pveamary | o — | | |
A A
AgentA Call-l end AgentA
answers Call-1 answers Call-2

1. A call (call-1) comes into Queue-1, and agent A answers call-1.

2. After finishing call-1, agent A enters a wrap-up period in Queue-1.

3. A second call (call-2) comes into Queue-2 during agent A's wrap-up time.

4. If call-2 is routed to agent A, it will wait until the shared wrap-up time ends (which is
configured in Queue-1 and shared across Queue-2 for agent A). Then call-2 will ring to
alert agent A to answer it.

Set Default Status for Dynamic Agents

By default, the initial status of dynamic agents is logout after being added to a queue. You
can set the default login status for newly added dynamic agents as needed. This pre-set
status will be applied globally to all dynamic agents newly added to queues, thus minimizing
manual errors and improving management efficiency.

Requirements

The firmware version of PBX serveris 37.19.0.110 or later.

Procedure

1. Log in to PBX web portal, go to Call Features > Queue.
2. On the top of the page, click Options.
3. In the Default Status of Dynamic Agents drop-down list, select the desired status.
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E] Options |

Options

* Default Status of Dynamic Agents

Log Out

Log In

Log Out

* Auto-sync call disposition results for repeat callers in the same queue

Disabled

X Cancel

4. Click Save.

Result

The selected default status will be automatically applied to all dynamic agents when they
are added to queues.

Note:

Dynamic agents who are already in queues will NOT be affected by this setting.

Automatically synchronize Processing Results for Repeat Calls

The auto-sync for processing results of repeat calls allows the system to automatically ap-
ply an updated processing result to all missed or abandoned calls from the same caller to
the same queue within a specified time range, which helps maintain consistent call records
and prevents multiple agents from making duplicate callbacks to the same caller. This topic
describes how to enable the auto-sync for processing results.

Requirements

The firmware version of PBX server is 37.19.0.110 or later.

Procedure

1. Log in to PBX web portal, go to Call Features > Queue.
2. On the top of the page, click Options.
3. In the pop-up window, do as follows:
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Options

Log Out
Enabled

Enabled

X Cancel

a. In the Auto-sync call disposition results for repeat callers in the same
queue drop-down list, select Enabled.

b. In the Time Range (X hours ago) drop-down list, specify the time range for
syncing call processing results.

This setting determines that, starting from the time when an agent manual-
ly updates the processing result for a missed or abandoned queue call log, all
missed or abandoned call logs from the same number to the same queue re-
ceived in the preceding { X} hours will be synchronized.

For example, if you set the time range to 2 hours, and update the processing re-
sult of a missed call log at 3:00 PM, then call logs of all missed calls from the
same number between 1:00 PM and 3:00 PM will be synchronized.

c. Click Save.

Result

When the processing result of a missed / abandoned queue call is updated, other missed
calls from the same number to the same queue within the specified time range will be syn-
chronized with the updated status.

Note:

« Synchronization is only triggered when the processing status moves forward
(e.g. from Not Dealt to Dealing).
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* The operation details of the synchronized missed call logs will show "Auto
4 Sync" to indicate that the results was updated automatically.

Operator: Leo Ball(5000)| Auto Sync ;

dperations
Time of Operation: 2025/06/24 13:08:26

Name Status Source Time Duration Call Notes

Kristin Hale Customer
Missed call :08: 00:00:00 i Dealt &
KQ 5001 (Extension; G =z Support (6400) T @% LB
Kristin Hale Customer
Missed call :20: 00:00:00 i Dealt =2
K° 5001 (Extension) - Missed ca Support (6400) 11:20:40 e LB

Allow Agents to View Queue Call Logs on Linkus Clients

This topic describes how to allow agents to view queue call logs on their Linkus UC Clients.
Procedure

1. Log in to PBX web portal, go to Call Features > Queue.

2. Click Z beside the desired queue, and enter the Queue Panel Permissions tab.
3. Scroll down to the Agents section, and complete the following settings.
a. Select the checkbox of Queue Call Logs.

Queue Call Logs

Member

@ Al

Specified Agent

View Range
Al

Incoming call

Missed call

b. Set up the viewing permission.

Description

Member Specify the agents that can view call logs of the queue on their Linkus
clients.
« All: All the queue agents can view the queue call logs.
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Item Description

- Specified Agent: Only the specified agents can view the queue
call logs.

Member

All
(®) Specified Agent

2006-Naomi Nichols % 2007-Ashley Gardner x

View Specify the type of queue call logs that the authorized agents can view.
Range « All: Agents can view all call logs, including incoming calls and
missed calls.

+ Incoming call: Agents can view the call logs of the queue calls that
they answered.

« Missed call: Agents can view the call logs of missed queue calls,
as well as the missed call processing status.

4. Click Save.

Result

The authorized agents are able to view queue call logs on their Linkus Web Client and Desk-
top Client (Path: Call Logs > Queue Call Logs).
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Linkus Web Client Linkus Desktop Client
.'v. Yeastar = 52 @ [@) Linkus Desktop Client = o X
Qs J 0 = oo E |
A Bdensions Personal Call Logs Queue Call Logs -,. Yeastar = 8¢ [ O v AgentStatusv @ - ° e
[ Contacts
5 chat & A | 2: Extensions
Personal Call Logs Queue Call Logs
B Video Conty Name Status Source
ideo Conferencing
[ Contacts
6 CallCenter Consale . _Ie wu%t i . Missedcall  Tech Support - USA = Alv a
B CallLogs [ Chat
1 WUZt . . Missedcall  Tech Support-EU (
oo Voleemalls @ B Video Conferencing Thursday 03:53:02
o -00-
@ Recording 1 1,00"‘ . . Incomin gcall  Tech Support- USA N SA(64 6 00:00:00
= | 6 Call Center Console v ort - USA(6401) f8
s Prefe Ices
£ Chrome Extension ° 10 1?02“ . - ncoming il Tech Support-EU{ | [ gy Logs Thursday 03:31:16
00:00:00
1001 yport - EU(6400)
1 . . Incomin gcall  TechSupport-USA  @o Voicemails
1001 Wednesday 03:30:31
@ Recordings R 1001 (Extension) 00:00:03
Queue:Tech Support - USA(6401)
Ze Preferences 1002

Wednesday 03:30:29

) 1002 (Extension) 00:00:11
QueueTech Support - EU(6400)

Related information
Agent Guide - Check and Manage Queue Call Logs on Web Client / Desktop Client

Allow Agents to Manage Their Status by Dialing a Feature Code

The PBX defines feature codes that allow the agents to switch their status. This topic de-
scribes how to allow agents to manage their agent status by dialing a feature code.

Procedure

1. Log in to PBX web portal, go to Call Features > Feature Code.
2. Scroll down to the Queue section.
3. To allow agents to log in to or log out of a queue via feature code, do as follows:
a. Select the checkbox of Log in/Log out.
b. Optional: Change the feature code according to your needs.
4. To allow agents to pause or unpause service via feature code, do as follows:
a. Select the checkbox of Pause/Unpause.
b. Optional: Change the feature code according to your needs.
c. Optional: Scroll down to the Pause Reason section, and configure reasons for
the agent pause and the corresponding feature codes.
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Pause Reason
Feature Code Pause Reason Operations

01 Lunch 11
02 Break o)

*03 Wrap up o}

+ Add

Agents can pause with specific reason by dialing the pause reason feature
codes.

5. Click Save and Apply.

Result

Agents can manage their status by dialing the corresponding feature codes either on their
Linkus clients or IP phone.

Scenario Instruction

Log in to a queue Only dynamic agents can log in to a queue; static agents are always in the
queue.

For example, a dynamic agent dials * 76400 to log in to queue 6400.

Log out of a queue  Only dynamic agents can log out of a queue; static agents are always in the
queue.
For example, a dynamic agent 1000 dials * 76400 to log out of queue 6400.
Pause receiving Both static agents and dynamic agents can pause queue calls when they are

queue calls away from desk. The system will not distribute queue calls to the agents in
"Paused" status.

Pause without reason

For example, an agent 1000 dials * 076400 to directly pause calls
from queue 6400.

Pause with specific reason
For example, an agent 1000 dials *076400* 03 to pause calls from
queue 6400 for after-call processing.

Unpause receiving Both static agents and dynamic agents can unpause queue calls when they are
queue calls ready to take calls.

For example, an agent 1000 dials * 076400 to unpause calls from queue 6400.
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Related information
Allow Agents to Manage Their Status via IP Phones
Monitor Specific Pause Status of an Agent by Function Key

Allow Agents to Manage Their Status via IP Phones

This topic describes how to set up agents' IP phones to enable them to monitor and switch
their agent status in specific queue using the BLF keys and indicators on IP phones.

Prerequisites

Ensure that the IP phones are connected to Yeastar P-Series PBX System via auto provision-
ing, and have been assigned to the agents' extensions.

For detailed instructions about auto provisioning the IP phone, see IP Phone Configuration
Guide.

Step 1. Set up function keys for agents’ extensions

1. Access the configuration page for extensions' function keys.
a. Log in to PBX web portal, go to Extension and Trunk > Extension.
b. Select the agents' extensions and click Edit.

c. Click the Function Keys tab.
2. Configure function keys for the extensions.

a. Select the checkbox of Bulk Edit.
b. Select a key and configure the followings:

Function Key Type Value Label

Key 1 ‘ ‘ Tech-Support Switch agent status

Agent Login/Logout

Agent Pause/Unpause

« Type: Select a key type from the following two options:

- Agent Login/Logout: Allow agents to log in to or log out of a
queue.

- Agent Pause/Unpause: Allow agents to pause or unpause receiv-
ing queue calls.

« Value: Select a queue that the agent sits in.

« Label: Optional. Enter a label, which will be displayed on the phone
screen.


https://help.yeastar.com/en/p-series-appliance-edition/ip-phone-configuration-guide/ip-phone-configuration-guide-overview.html#overview__section_f3g_5dz_syb
https://help.yeastar.com/en/p-series-appliance-edition/ip-phone-configuration-guide/ip-phone-configuration-guide-overview.html#overview__section_f3g_5dz_syb
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3. Click Save.
Step 2. Apply the configuration to agents’ IP phones

1. Go to Auto Provisioning > Phones.
2. Select the phones assigned to the agents and click Reprovision.

[ Status Extension Name Vendor Model

,c-{', 2000 Leo Ball Grandstream GRP2602
9, 2001 Jimmy Gordon Snom snomD713
9; 2003 Joe Lewis Snom snomD735

3. In the pop-up window, click OK.

Result

Agents can monitor and switch their status in the specified queue using the BLF keys and
indicators on the IP phones.

Note:

The BLF key indicator status may vary by phone models.

BLF key LED status Description
Log in/Log out Solid Green The agent has logged in to the queue.

The agent can press the Log in/Log out BLF key to log out of the
queue.

Solid Red  The agent has logged out of the queue.

The agent can press the Log in/Log out BLF key to log in to the
queue.

Off The BLF key does not subscribe the agent's status. Check if your
configurations are correct or if the agent's extension is registered.

Pause/unpaus Solid Green The agent can receive queue calls.

© The agent can press the Pause/Unpause BLF key to pause receiving

queue calls.
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BLF key LED status Description

Flashing The agent has paused receiving queue calls.

Red The agent can press the Pause/Unpause BLF key to resume
receiving queue calls.
Off The BLF key does not subscribe the agent's status. Check if your

configurations are correct or if the agent's extension is registered.

Related information
Monitor Specific Pause Status of an Agent by Function Key
Supervisor Guide - Manage Agent Status on Call Center Console

Allow Agents to Identify Callers from Company Contacts in
Queue Panel

Yeastar P-Series PBX System allows both queue manager and queue agents to view contact
names in Queue Panel when receiving queue calls from company contacts. This topic de-
scribes how to enable contact name display for queue agents.

Introduction

To allow queue agents to view contact names in Queue Panel when receiving queue calls
from company contacts, you need to assign the relevant Queue Panel permission to agents
in specific queues, and configure the matching rule for company contacts.

In doing so, when a call from a company contact reaches a specified queue, the PBX will ig-
nore the contact visibility rule and display the contact name in Queue Panel of all agents as-
signed to the queue.

Requirements

The firmware version of PBX server is 37.20.0.128 or later.
Step 1. Grant permission to agents in specific queue

1. Access the configuration page of call queue.
a. Log in to PBX web portal, go to Call Features > Queue.

b. On the right of the desired queue, click Z.
2. Grant permission to queue agents.

a. Click Queue Panel Permissions tab.
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b. Scroll down to Agents section, then select the checkbox of Show Company
Contacts Matching Results.

Agents

Wallboard

Queue Panel
Queue Panel Permission

Call distribution management (Redirect, Transfer, Drag and Drop operation)
Allow for picking up or hanging up other agents' calls
Call parking operation

Show Company Contacts Matching Results

c. Click Save and Apply.

Step 2. Configure company contacts matching

1. Access the configuration page of company contacts matching.
a. Go to Contacts > Company Contacts.
b. On the Company Contacts page, click Options.

Contact Name Company Email Business Mobile Home Operations Y
2 W
2 W
Z W

Q Total: 3 20/ page

2. In the pop-up window, configure Caller ID match.
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Number Match X

Do Not Match
Exact Match

(® Match the last 7 digits

Ignore Symbols and Letters

a. Choose how to match incoming Caller ID.

Option Description

Exact Match Display contact name when an incoming Caller ID
exactly matches existing number.

Match the last { nunber} digits  Display contact name based on the digits of incoming
Caller ID.

« If the digit length of an incoming Caller ID is
shorter than or equal to the specified value,
contact name will be displayed only when the
incoming Caller ID exactly matches existing
number.

« If the digit length of an incoming Caller ID is
longer than the specified value, contact name
will be displayed when the last { nunber}
digits of the incoming Caller ID matches that
of existing number.

73 Note:
The default value is 7. You can enter a value
between 4 and 31.

b. Optional: To ignore symbols and letters in numbers during contacts matching,
select the checkbox of Ignore Symbols and Letters.
c. Click Save.
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Result

When company contacts call the queue, agents can see contact name in Queue Panel if a
match is found, as shown below.

6402 [6402] v

0 5 0 00:00:00

SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time

L. Waiting Calls (1)

Caller Callee Status Time Details

Gary:6402 [15880123456] 6402 [6402] 00:00:34 External,Waiting in Queue

t3 Active Calls (0)

Caller Callee Status Time Details

Call Center Setup

Set up Queue Managers

With call center service activated, you can set any extension as queue manager. A queue
manager does not need to be a queue agent. This topic describes how to set queue man-
agers.

Procedure

1. Log in to PBX web portal, go to Call Features > Queue, edit the desired queue.
2. Click the Members tab.
3. Inthe Queue Managers section, manage the queue managers:
» To add queue managers, select the desired extensions from the Available box
to the Selected box.
« To delete queue managers, select the desired extensions from the Selected
box to the Available box.
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4. Click Save and Apply.

Related information
Customize Queue Notification

Customize Queue Notification

With call center service activated, the system sends email notifications to queue managers
when a queue call is missed or abandoned, when the service level agreement reaches the
alarm threshold, when a callback request is made or a callback failed. This topic describes
how to customize these notifications.

Prerequisites

« Make sure there is a valid email address assigned to queue manager's extension.
» Make sure system email works.

Procedure
1. Log in to PBX web portal, go to Call Features > Queue, edit the desired queue.

2. Click the Members tab.
3. Select the checkbox of notification option according your needs.

Option Description

Notify Manager when a If enabled, the system will send an email to queue manager
queue call is missed when a queue call is missed.

Notify Manager when a If enabled, the system will send an email to queue manager
queue call is abandoned when a queue call is abandoned.

Notify Manager when the If enabled, the system will send an email to queue manager
SLA is lower than its alarm when the SLA alarm threshold is reached.

threshold

Notify Manager when a If enabled, the system will send an email to queue manager
callback request is made when a callback request is made.

Notify Manager when a If enabled, the system will send an email to queue manager
callback failed when a callback is failed.

4. Click Save and Apply.


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/email-server-overview.html
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Set up Service Level Agreement (SLA)

With call center service activated, you can set up service level agreement for a queue. This
topic describes what is service level agreement and how to set up service level agreement.

What is Service Level Agreement (SLA)

Service Level Agreement is a call center performance statistic. It is the goal for how quickly
the agent should answer a portion of the customers, and makes sure everyone is working to
the same objective.

SLA is expressed as the percentage of conversations answered within a pre-defined amount
of time. Let us suppose that the goal is to answer 80% of calls within 20 seconds. If the
measurement is less than 80%, the manager knows they are below their target Service Lev-
el.

The calculated formula of SLA is shown as below:

Note:

The Total cal | s parameter is the total number of calls that the queue received, in-
cluding calls answered by agents, calls abandoned by callers and missed calls in
the queue.

SLA = (Nunber of calls answered within SLAtime / Total calls) * 100%

How to set up Service Level Agreement

You can set a target service level and SLA threshold for each queue, and evaluate the ser-
vice level periodically.

1. Log in to PBX web portal, go to Call Features > Queue, edit the desired queue.
2. Click the Preferences tab.
3. In the Service Level Agreement section, edit the SLA according to your needs.
+ SLA Time (s): Enter the maximum amount of time (in seconds) that an agent
needs to answer an incoming call.

If a caller waits for a duration of time shorter than the SLA Time, the SLA is met.
« Evaluation Interval (min): Enter the time interval to compare the queue's SLA
performance against the alarm threshold so that the system can send a notifi-
cation email timely.
« Alarm Threshold (%): Enter the service level threshold for the queue.
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4. Click Save and Apply.

Grant Call Center Console Permissions

With call center service activated, you can grant the access permission to the Call Center
Console dashboards (Wallboard & Queue Panel) and decide what the queue managers and
agents can do on Queue Panel, and grant the Queue Panel permissions for queue manager
and agents respectively. This topic describes how to grant permissions for queue manager
and agents.

Call Center Console permissions

The following table outlines the supported permissions on the Call Center Console for
gueue managers and agents respectively.

Permission Manager Agent
Access Wallboard
Access Queue Panel

Switch agents' status

2. 2 2 =2

Call distribution management (Redirect,
Transfer, Drag and Drop operation)

Allow for picking up or hanging up agents' \/ \
calls

Call monitoring operations (Listen, Whisper, x
Barge In)

Call parking operation \
Switch agent's recording status \/
Show Company Contacts Matching Results \
Queue Missed Call Logs \
Delete Queue Missed Call Logs \

Queue Call Logs (including calls answered by = x \
agents and missed calls within the queue)

Grant permissions for queue managers

1. Log in to PBX web portal, go to Call Features > Queue, edit the desired queue.
2. Click the Queue Panel Permissions tab.
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3. Inthe Manager section, select the checkboxes of permissions according to your
needs.

4. Click Save and Apply.
Grant permissions for agents

1. Log in to PBX web portal, go to Call Features > Queue, edit the desired queue.

2. Click the Queue Panel Permissions tab.

3. In the Agents section, select the checkboxes of permissions according to your needs.
4. Click Save and Apply.

Call Center Report

Call Center Reports Overview

Yeastar P-Series PBX System provides a set of predefined reports concerning detailed infor-
mation about call center performance. This topic describes what you can do with call center
report, and the report types.

What you can do with call center reports

The system automatically generates reports in the format of graphs or charts, and helps you
to simplify analysis and extract invaluable data with ease. These reports can be historical
and real-time. You can view and schedule reports on demand to evaluate past activities and
plan future actions.

Reports types
We divide reports into two categories: queue performance and agent performance.

* Queue performance reports: The queue performance reports give you insight into the
work efficiency of one or more queues over a period of time, and help you evaluate the
performance of each queue.

> Queue AVG Waiting & Talking Time
> Queue Performance

> Queue Performance Activity

> Queue Callback Summary

> Queue Callback Activity

o Satisfaction Survey

o Satisfaction Survey Details
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« Agent performance reports: The agent performance reports give you insight into the
performance of one or more agents, and help you evaluate if every agent meets the
expectations of your call center over a period of time.

o Agent Login Activity

o Agent Pause Activity

> Agent Missed Call Activity
> Agent Performance

> Agent Call Summary

Queue Performance Reports

Queue AVG Waiting & Talking Time Report

Queue AVG Waiting & Talking Time report provides granular insights into the hourly, dai-
ly, and monthly breakdown of the average amount of time that callers wait in a queue, and
the average amount of time that queue agents spend in talking with callers. This topic intro-
duces how to access the report and explains the key metrics in detail.

Access Queue AVG Waiting & Talking Time report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Queue AVG Waiting & Talking Time.

Call Reports Scheduled Reports

R ]

DID/Outbound Caller ID Activity

IVR Report

Queue AVG Waiting & Talking Time
Queue Performance

Queue Performance Activity

Queue Callback Summary

Queue Callback Activity

3. Filter data by system time and queue(s).
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Call Reports Scheduled Reports Download Scheduled Reports Rate

* *

Queue AVG Waiting & Talking Time By Day 12/2023 6401-Support X

A report that meets the filter criteria is displayed on the page, as shown below.

Queue AVG Waiting & Talking Time

—— AVG Waiting Time (All Calls —— AVG Waiting Time (Answered Calls Average Talking Time

s /AN

Date AVG Waiting Time (All Calls) AVG Waiting Time (Answered Calls) Average Talking Time

Dec. 21 00:00:06 00:00:06 00:00:09

Dec. 22 00:00:06 00:00:05 00:00:08

Dec. 27 00:00:07 00:00:08 00:00:58

Total 00:00:06 00:00:06 00:00:20
Report details

The key metrics for Queue AVG Waiting & Talking Time report is shown below.

Metric Description

AVG Waiting Time  The average amount of time that all inbound calls had been waiting in the
(All Calls) queue, regardless of whether they were answered or not.

Formula: (Total Ring Duration + Retry Interval) / Total Calls

AVG Waiting Time  The average amount of time that the answered calls had been waiting in the
(Answered Calls) queue before being answered by agents.

Formula: (Total Ring Duration of Answered Calls + Retry Interval) / Total
Answered Calls

Average Talking The average amount of time that agents spent talking to callers.

Time Formula: Total Talking Time / Total Answered Calls
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Queue Performance Report

Queue Performance report provides a quick overview of call queue performance and
granular insights into queue calls. This topic introduces how to access the report and ex-
plains the key metrics in detail.

Access Queue Performance report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Queue Performance.

Call Reports Scheduled Reports

PBX Call Activity

DID/Outbound Caller ID Activity
IVR Report

Queue AVG Waiting & Talking Time
Queue Performance

Queue Performance Activity

Queue Callback Summary

3. Filter data by system time, queue(s), call abandonment time, or talk duration.

Note:

» To filter out abandoned short calls, specify the ring duration in the Ex-
clude Calls Abandoned within Xs field. Calls abandoned within this
time frame will NOT be included in the report.

« To filter out answered short calls, specify the talk duration in the Ex-
clude Calls within Xs field. Calls ended within this time frame will
NOT be included in the report.

Queue Performance 12/27/2023 00:00:00 ~ 12/28/2023 23:50:50 6400-Pre-Sales > 6401-Support X

A report that meets the filter criteria is displayed on the page, as shown below.
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Queue Total Calls Answered Missed Abandoned AVG Handle Time AVG Waiting Time (Answered Calls) ~ AVG Waiting Time (All Calls) Max Waiting Time (All Calls) Average Talking Time ~ AVG Hold Time ~ Answered Details

Pre-Sales 13 5 4 4 00:00:57 00:00:11 00:00:23 00:01:42 00:00:45 00:00:00 38.46% @
Support 6 4 0 2 00:01:06 00:00:08 00:00:07 00:00:15 00:00:58 00:00:00 66.67% @
Total 19 9 4 6

Report details

We take the above report as an example to introduce the key metrics for Queue Perfor-
mance report.

Metrics for queue

Queve  TotalCalls Answered Missed Abandoned AVG Handle Time AVG Waiting Time (Answered Calls) ~AVG Waiting Time (AllCalls) ~Max Waiting Time (AllCalls)  Average Talking Time ~ AVG Hold Time ~ Answered Rate Missed Rate  Abando Details
Pre-Sales 13 5 4 4 000057 00:00:11 00:00:23 00:01:42 00:00:45 00:00:00 38.46% 30.77% 3077% @
support 6 4 0 2 0001:06 000008 00:00:07 0000115 0000:58 00:00:00 66.67% 0% 3333% @

Total 19 9 4 6

Metric Description

Total Calls The total number of calls that the queue received.
Answered The total number of calls that the queue answered.
Missed The total number of calls that the queue missed.

Note:
A missed queue call includes, but is not limited to, the
following scenarios:

* A call exits the queue when the number of
Maximum Callers is reached.

+ A call exits the queue when the Maximum
Waiting Time is reached.

« A call is assigned to another queue or extension
by queue manager.

« A caller presses a key to exit the queue and be
routed to another destination.

Abandoned The total number of calls that the callers abandoned.
AVG Handle The average amount of time that agents spent handling
Time customers' calls.

Formula: (Total Ring Duration of Answered Calls + Total Talk
Duration of Answered Calls) / Total Answered Calls

AVG Waiting The average amount of time that the answered calls had been
Time (Answered  waiting in the queue before being answered by agents.
Calls)
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Metric Description

Formula: (Total Ring Duration of Answered Calls + Retry
Interval) / Total Answered Calls

AVG Waiting The average amount of time that all inbound calls had been
Time (All Calls) waiting in the queue, regardless of whether they were answered
or not.

Formula: (Total Ring Duration + Retry Interval) / Total Calls

Max Waiting Time The maximum amount of time that callers waited in the queue,
(All Calls) regardless of whether the calls were answered or not.

Average Talking The average amount of time that agents spent talking to callers.

Time Formula: Total Talking Time / Total Answered Calls

AVG Hold Time  The average amount of time that calls were held.
Formula: Total Hold Duration / Total Answered Calls

Answered Rate The percentage of answered calls in relation to the total received
calls.

Formula: (Total Answered Calls / Total Calls) * 100%

Missed Rate The percentage of missed calls in relation to the total received
calls.

Formula: (Total Missed Calls / Total Calls) * 100%

Abandon Rate The percentage of abandoned calls in relation to the total
received calls.

Formula: (Total Abandoned Calls / Total Calls) * 100%

SLA The Service Level Agreement (SLA) for the queue. SLA is the
percentage of conversations answered within a predefined
amount of time.

Formula: (The Number of Calls Answered within SLA Time) /
Total Calls) * 100%

Metrics for queue call
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Pre-Sales Details

[} Time. Call From Agent

Statu Reason

20231228112341130C1  12/28/2023 11:23:40 Terrell Smith<15880123..  NONE Mis Queue Pre-Sales<6400> connected

20231228112143CFABO  12/28/2023 11:21:42 Terrell Smith<15880123..  NONE Mis Redirected to Naomi Nichols<2006>

202312281119374A622  12/28/2023 11:19:36 Terrell Smith<15880123..  NONE Mis Queue Pre-Sales<6400> timed out,

20231228111843CAB2A  12/28/2023 11:18:42 Terrell Smith<15880123..  NONE Mis Queue Pre-Sales<6400> hung up

2023122811183646847  12/28/2023 111835 Terrell Smith<15880123..  NONE Aba Terrell Smith<15880123456> hung.

20231228111831004CD  12/28/2023 11:18:30 Terrell Smith<15880123..  NONE Aba Terrell Smith<15880123456> hung.

20231228111500BE662  12/28/2023 11:14:50 Terrell Smith<15880123..  NONE Aba Terrell Smith<15880123456> hung.

202312281113224A9C2  12/28/2023 1111321 Terrell Smith<15880123..  Carmen Gordon'test<..  Ans Queue Pre-Sales<6400> connected

20231228111207D8D88  12/28/2023 11:12:06 Terrell Smith<15880123..  Naomi connected

Ans Queue

20231228111051211AA  12/28/2023 11:10:50 Terrell Smith<15880123..  Ashley 7> Ans Queue

connected

Total 12 E 2 > 10/page | Goto

Metric Description

ID A unique ID for the call.

Time
Call From

Agent

Status

Ring Duration

Talk Duration
Hold Duration

Reason

When the call was received.
The number and the name of the caller.

The agent who answered the call.

Note:
If the call was not answered, None is displayed.

Call status.

« Answered

« Abandoned

« Missed

» For answered calls, this indicates the time between the call
started and the call was answered.

» For abandoned or missed calls, this indicates the time
between the call started and the call disconnected.

The time between the call answered and the call ended.
The total amount of time that the call was held.

The reason why the call was not answered by the agent or why the
call ended.
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Queue Performance Activity Report

Queue Performance Activity report provides granular insights into the hourly, daily, and
monthly breakdown of call queue performance and queue calls. This topic introduces how
to access the report and explains the key metrics in detail.

Access Queue Performance Activity report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Queue Performance Activity.

Call Reports Scheduled Reports

Queue AVG Waiting & Talking Time
Queue Performance

Queue Performance Activity
Queue Callback Summary

Queue Callback Activity
Satisfaction Survey

Satisfaction Survey Details

3. Filter data by system time, queue(s), or call abandonment time.

Note:

To filter out abandoned short calls, specify the ring duration in the Exclude
Calls Abandoned within Xs field. Calls abandoned within this time frame
will NOT be included in the report.

Queue Performance Activity By Day 12/2023 6401-Support

A report that meets the filter criteria is displayed on the page, as shown below.
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Date TotalCalls Answered Missed Abandoned AVG Handle Time AVG Waiting Time (Answered Calls) AVG Waiting Time (All Calls) Max Waiting Time (Al Calls)  Average Talking Time AVG Hold Time  Answered Rate  Mi: Details

Dec.21 8 5 1 2 00:00:15 00:00:06 00:00:06 00:00:11 00:00:09 00:00:00 62.5% 12 @
Dec.22 9 7 0 2 00:00:13 00:00:05 00:00:06 00:00:12 00:00:08 00:00:00 77.78% 0% B
Dec.27 6 a 0 2 00:01:06 00:00:08 00:00:07 00:00:15 00:00:58 00:00:00 66.67% 0% &
Total 23 16 1 6 00:00:27 00:00:06 00:00:06 00:00:15 00:00:20 00:00:00 69.57% 43

Report details

We take the above report as an example to introduce the key metrics for Queue Perfor-
mance Activity report.

Metrics for queue
Date TotalCalls Answered Missed Abandoned AVG Handle Time AVG Waiting Time (Answered Calls) AVG Waiting Time (All Calls) Max Waiting Time (All Calls) Average Talking Time  AVG Hold Time ~Answered Rate Mi: Details
Dec.21 8 5 1 2 00:00:15 00:00:06 00:00:06 00:00:11 00:00:09 00:00:00 62.5% 12 @
Dec.22 9 7 0 2 00:00:13 00:00:05 00:00:06 00:00:12 00:00:08 00:00:00 77.78% 0% @
Dec.27 6 4 0 2 00:01:06 00:00:08 00:00:07 00:00:15 00:00:58 00:00:00 66.67% 0% @
Total 23 16 1 6 00:00:27 00:00:06 00:00:06 00:00:15 00:00:20 00:00:00 69.57% 4z
Metric Description

Total Calls The total number of calls that the queue received.

Answered The total number of calls that the queue answered.

Missed The total number of calls that the queue missed.

724 Note:

A missed queue call includes, but is not limited to, the
following scenarios:

« A call exits the queue when the number of
Maximum Callers is reached.

« A call exits the queue when the Maximum
Waiting Time is reached.

« A call is assigned to another queue or extension
by queue manager.

« A caller presses a key to exit the queue and be
routed to another destination.

Abandoned The total number of calls that the callers abandoned.

AVG Handle Time The average amount of time that agents spent handling
customers' calls.

Formula: (Total Ring Duration of Answered Calls + Total Talk
Duration of Answered Calls) / Total Answered Calls
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Metric Description

AVG Waiting The average amount of time that the answered calls had been
Time (Answered  waiting in the queue before being answered by agents.
Calls)

Formula: (Total Ring Duration of Answered Calls + Retry
Interval) / Total Answered Calls

AVG Waiting The average amount of time that all inbound calls had been
Time (All Calls) waiting in the queue, regardless of whether they were answered
or not.

Formula: (Total Ring Duration + Retry Interval) / Total Calls

Max Waiting Time The maximum amount of time that callers waited in the queue,
(All Calls) regardless of whether the calls were answered or not.

Average Talking  The average amount of time that agents spent talking to callers.

Time Formula: Total Talking Time / Total Answered Calls

AVG Hold Time  The average amount of time that calls were held.
Formula: Total Hold Duration / Total Answered Calls

Answered Rate The percentage of answered calls in relation to the total received
calls.

Formula: (Total Answered Calls / Total Calls) * 100%

Missed Rate The percentage of missed calls in relation to the total received
calls.

Formula: (Total Missed Calls / Total Calls) * 100%

Abandon Rate The percentage of abandoned calls in relation to the total
received calls.

Formula: (Total Abandoned Calls / Total Calls) * 100%

SLA The Service Level Agreement (SLA) for the queue. SLA is the
percentage of conversations answered within a predefined
amount of time.

Formula: (The Number of Calls Answered within SLA Time) /
Total Calls) * 100%

Metrics for queue call
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Time Call From Queue A( Reason

2023122713114407444  12/27/202313:11:44 Terrell Smith<15880123..  Support Te Queue Support<6401> connected

20231227131015FD39B  12/27/2023 13:10:14 Terrell Smith<15880123..  Support Tr Queue Support<6401> connected

20231227130830F4B31  12/27/2023 13:08:38 Terrell Smith<15880123..  Support Pl Queue Support<6401> connected

20231227130828018BD  12/27/2023 13:08:27 Terrell Smith<15880123..  Support N Terrell Smith=<15880123456> hung.

20231227130745FCEID  12/27/2023 13:07:44 Terrell Smith<15880123..  Support NI Terrell Smith<15880123456> hung.

20231227130553D15DE  12/27/2023 13:05:52 Terrell Smith<15880123..  Support Pl Queue Support<6401> connected

Total :6 10/ page

Metric Description

ID

Time

Call From
Queue

Agent

Status

Ring Duration

Talk Duration
Hold Duration

Reason

A unique ID for the call.

When the call was received.

The number and the name of the caller.
The queue that received the call.

The agent who answered the call.

Note:
If the call was not answered, None is displayed.

Call status.

« Answered
« Abandoned
* Missed

» For answered calls, this indicates the time between the call
started and the call was answered.

» For abandoned or missed calls, this indicates the time
between the call started and the call disconnected.

The time between the call answered and the call ended.
The total amount of time that the call was held.

The reason why the call was not answered by the agent or why the
call ended.

Queue Callback Summary Report

Queue Callback Summary report provides a quick overview of queue callback statistics.
This topic introduces how to access the report and explains the key metrics in detail.
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Prerequisites

You have subscribed to Enterprise Plan or Ultimate Plan.

Access Queue Callback Summary report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Queue Callback Summary.

Call Reports Scheduled Reports Download Schedule:

Report Type

Queue Callback Summary A\

-

Queue AVG Waiting & Talking Time

Queue Performance

b Jr—

Queue Performance Activity

~

U4
I Queue Callback Summary I’

Queue Callback Activity
Satisfaction Survey

Satisfaction Survey Details

3. Filter data by system time and queue(s).

Report Type Time * Queue

Queue Callback Summary I 12/30/2023 00:00:00 ~ 12/30/2023 23:59:59 I I 6401-Support X

A report that meets the filter criteria is displayed on the page, as shown below.

Queue Callback Summary

Failed Callbacks

Suecessful Callbacks
154

oo

Queue Failed Callbacks Successful Callbacks Total Callbacks Total Calls

6400 13 2 15 43

Total 13 2 15 43
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Report details

The key metrics for Queue Callback Summary report is shown below.

Metric Description

Failed Callbacks The number of failed callbacks.
Successful Callbacks The number of successful callbacks.
Total Callbacks The total number of callbacks for which callers requested successfully.

Total Calls The total number of calls that the queue received.

Queue Callback Activity Report

Queue Callback Activity report provides granular insights into queue callback statistics.
This topic introduces how to access the report and explains the key metrics in detail.

Prerequisites

You have subscribed to Enterprise Plan or Ultimate Plan.

Access Queue Callback Activity report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Queue Callback Activity.

Call Reports Scheduled Reports

Queue Performance

Queue Performance Activity
Queue Callback Summary
Queue Callback Activity
Satisfaction Survey
Satisfaction Survey Details

Agent Login Activity
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3. Filter data by system time, queue, or callback result.
Queue Callback Activity 01/07/2022 00:00:00 -~ 01/07/2022 23:59:59 6400-Support_Local All

A report that meets the filter criteria is displayed on the page, as shown below.

Time Call From Callback Time Callback Number Waiting Time Callback Result Failed Reason
01/07/2022 16:43:15 6400-test:2000<2000= 01/07/2022 16:44:25 666665 00:01:10 Succeeded

01/07/2022 16:37:55 6400-test:2000<2000> 01/07/2022 16:39:00 99999 00:01:05 Failed Customer no answer
01/07/2022 16:34:28 6400-test:2000<2000> 01/07/2022 16:35:37 333333 00:01:00 Failed Customer no answer
01/07/2022 16:08:00 6400-test:2000<2000> 01/07/202216:09:48 785469 00:01:48 Failed Customer no answer
01/07/2022 15:38:08 6400-test:2000<2000> 01/07/2022 15:41:08 000999 00:03:00 Failed No available agents
01/07/202215:19:45 6400:2000<2000= 01/07/202215:21:.09 569875 00:01:24 Failed Hang up by the agent
01/07/2022 15:09:32 6400:2000<2000> 01/07/2022 15:10:53 00999 00:01:21 Succeeded

01/07/2022 14:16:54 6400:2000<2000> 01/07/202214:21:54 66666 00:05:00 Failed No available agents
01/07/2022 14:13:35 6400:2000<2000> 01/07/2022 141405 563942 00:00:30 Failed No available agents
01/07/2022 14:10:31 6400:2000<2000> 01/07/2022 14:11:01 064583 00:00:30 Failed No available agents
01/07/2022 14:05:58 6400:2000<2000= 01/07/2022 14:06:28 85643 00:00:30 Failed No available agents
01/07/2022 14:02:11 6400:2000<2000> 01/07/2022 14:02:41 605423 00:00:30 Failed No available agents
01/07/2022 13:59:38 6400:2000<2000= 01/07/2022 14:00:19 85689 00:00:41 Failed No available agents
01/07/2022 13:56:23 6400:2000<2000> 01/07/2022 13:56:57 965482 00:00:34 Failed No available agents
01/07/2022 13:55:27 6400:2000<2000> 01/07/2022 13:55:55 00:00:28 Failed Invalid callback number
Total 15 00:19:40

Report details

The key metrics for Queue Callback Activity report is shown below.

Metric Description

Time The time that the caller called to the queue.

Call From The caller's caller ID.

Callback Time The time that the system performed the callback.

Callback Number The callback number that the caller registered.

Waiting Time The time between the call started and the callback answered.
Callback Result Whether the callback is successful or not.

Failed Reason The reason that failed to make the callback.
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Satisfaction Survey Report

Satisfaction Survey report provides a quick overview of the key pressed collected from
callers for a queue and its agents. This topic introduces how to access the report and ex-
plains the key metrics in detail.

Access Satisfaction Survey report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Satisfaction Survey.

Call Reports Scheduled Reports Download

Queue Performance Activity

Queue Callback Summary
Queue Callback Activity
Satisfaction Survey
Satisfaction Survey Details
Agent Login Activity
Agent Pause Activity

Agent Missed Call Activity

3. Filter data by system time and queue.

Satisfaction Survey 11/01/2022 00:00:00 11/01/2022 23:59:59 6400-6400

A report that meets the filter criteria is displayed on the page, as shown below.

Queue KEY:2 (-1 Points) KEY:4 (1 Points) KEY:6 (3 Points) KEY:8 (5 Points) Total KEY Total Points Average Points

6400-6400 1 1 1 1 I3

2000-Leo Ball 0 0 1 1 5 5

2006-Naomi Nichols 0 1 0 2 4
1 0 0

2007-Ashley Gardner

Report details

The key metrics for Satisfaction Survey report is shown below.
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I T -

KEY: { key_pressed} ({ nuneri c} The key pressed by caller and corresponding score for the

Points) key.

Total KEY The total number of keys that were collected for the queue or
an agent.

Total Points The total satisfaction survey scores for the queue or an
agent.

Average Points The average satisfaction survey scores for the queue or an
agent.

Formula: Total Points / Total KEY, where the calculated
average points will be truncated to two decimal places
without rounding up.

Satisfaction Survey Details Report

Satisfaction Survey Details report provides granular insights into customers' feedbacks
on each queue call handled by an agent. This topic introduces how to access the report and
explains the key metrics in detail.

Access Satisfaction Survey Details report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Satisfaction Survey Details.

Call Reports Scheduled Reports

Queue Callback Summary
Queue Callback Activity
Satisfaction Survey
Satisfaction Survey Details
Agent Login Activity

Agent Pause Activity

Agent Missed Call Activity
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3. Filter data by system time, queue, or agent(s).

Satisfaction Survey Details 11/01/2022 00:00:00 ~ 11/01/2022 23:59:59 6400-6400

A report that meets the filter criteria is displayed on the page, as shown below.

Agent Time Call From Key Points

2006-Naomi Nicholas 11/01/2022 10:57:00 9729144899 6 3

2007-Ashley Gardner 11/01/2022 10:55:47 9727257999 2 -1

2000-Leo Ball 11/01/2022 10:53:35 505525301 8 5

2006-Naomi Nicholas 11/01/2022 10:51:05 505525301 4 1
Report details

The key metrics for Satisfaction Survey Details report is shown below.

e i

Time The time that the caller called to the queue.

Call From The caller's caller ID.

Key The key that the caller pressed to rate the agent's service.
Points The score for the key pressed.

Agent Performance Reports

Agent Login Activity Report

Agent Login Activity report provides a quick overview of the login and logout activities of
queue agents. This topic introduces how to access the report and explains the key metrics
in detail.

Access Agent Login Activity report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Agent Login Activity.
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Call Reports Scheduled Reports Down

Queue Callback Activity
Satisfaction Survey
Satisfaction Survey Details
Agent Login Activity
Agent Pause Activity
Agent Missed Call Activity

Agent Performance

3. Filter data by system time, queue, or agent(s).

Call Reports Scheduled Reports Download Scheduled Reports Rate

Agent Login Activity 12/30/2023 00:00:00 ~ 12/30/2023 23:59:59 6401-Support

A report that meets the filter criteria is displayed on the page, as shown below.

Agent Logged In Logged Out Total Login Time
2000-Leo Ball 12/30/2023 10:18:39 12/30/2023 10:18:51 00:00:12
12/30/2023 10:22:10 12/30/2023 10:26:49 00:04:39
Total 00:04:51
2001-Phillip Huff 12/30/2023 10:19:16 12/30/2023 10:26:43 00:07:27
Total 00:07:27
Report details

The key metrics for Agent Login Activity report is shown below.

Description
Logged In The date and time that the agent logged in to the queue.
Logged Out The date and time that the agent logged out of the queue.

Total Login Time The elapsed time between the login time and the logout time.
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Agent Pause Activity Report

Agent Pause Activity report provides a quick overview of the pause and unpause activities
of queue agents. This topic introduces how to access the report and explains the key met-
rics in detail.

Access Agent Pause Activity report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Agent Pause Activity.

Call Reports Scheduled Reports

Sdusiduuun survey

Satisfaction Survey Details
Agent Login Activity
Agent Pause Activity
Agent Missed Call Activity
Agent Performance

Agent Call Summary

Ring Group Statistics
3. Filter data by system time, queue, agent(s), or pause reason(s).

Agent Pause Activity 12/27/2023 00:00:00 ~ 12/27/2023 23:50:50 6400-Pre-Sales

A report that meets the filter criteria is displayed on the page, as shown below.

Agent Pause Pause Reason Unpause Total Pause Time Total Pauses

2005-Kristin Hale 12/27/2023 17:14:11 - 12/27/2023 17:14:15 00:00:04 1
12/27/2023 17:14:19 Break 12/27/2023 17:14:41 00:00:22 1
12/27/2023 17:17:04 Lunch Change Pause Reason 00:00:07
12/27/2023 17:17:11 Break 12/27/202317:17:21 00:00:10 1
Total 00:00:43 3
Report details

The key metrics for Agent Pause Activity report is shown below.
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Metric Description

Pause The date and time that the agent switched status to Pause.
Pause Reason  The reason why the agent switched status to Pause.

Unpause Indicate that the pause reason was changed; or display the date and time that the
agent switched status to Unpause.

Total Pause The elapsed time between switching to the current pause status and changing to
Time another status (unpause or other pause reason).

Total Pauses The number of times that the agent paused service, excluding changing pause
reason.

Agent Missed Call Activity Report

Agent Missed Call Activity report provides a quick overview of missed calls associated
with individual agents. This topic introduces how to access the report and explains the key
metrics in detail.

Access Agent Missed Call Activity report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Agent Missed Call Activity.

Call Reports Scheduled Reports

Satsiacuon survey

Satisfaction Survey Details
Agent Login Activity

Agent Pause Activity
Agent Missed Call Activity
Agent Performance

Agent Call Summary

Ring Group Statistics

3. Filter data by system time, queue, or agent(s).
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Call Reports scheduled Reports Download Scheduled Reports Rate

Agent Missed Call Activity 12/27/2023 00:00:00 12/27/2023 23:59:59 6401-Support

A report that meets the filter criteria is displayed on the page, as shown below.

Agent Time Waiting Time Call From Polling Attempts Queue Status calls

2000-Leo Ball 12/27/2023 13:111:44 00:00:02 15880123456 1 Answered 1
12/27/2023 13:10:14 00:00:07 13512345678 1 Answered 1
12/27/2023 13:08:38 00:00:09 18500876554 1 Answered 1
12/27/2023 13:05:52 00:00:15 15898705642 1 Answered 1
Total 00:00:33 4 4
2001-Phillip Huff 12/27/2023 13:111:44 00:00:02 15880123456 1 Answered 1
12/27/2023 13:10:14 00:00:07 15880123456 1 Answered 1
Total 00:00:09 2 2
Report details

We take the above report as an example to introduce the key metrics for Agent Missed Call
Activity report.

Metric Description

Time The date and time that the caller called to the queue.

Waiting Time  The amount of time that the caller waited before being answered or timeout.

Call From The caller's caller ID.
Polling The number of polling attempts to call the agent.
Attempts

Queue Status  Whether the missed call was answered by other agents in the queue.

« Answered
+ No Answered

Count Indicate that this is a missed call, and the value is fixed at 1.

Agent Performance Report

Agent Performance report provides a quick overview of the performance of individual
agents and the associated call queue, as well as granular insights into agent calls. This top-
ic introduces how to access the report and explains the key metrics in detail.
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Access Agent Performance report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
2. In the Report Type drop-down list, select Agent Performance.

Call Reports Scheduled Reports

Agent Pause Activity
Agent Missed Call Activity
Agent Performance
Agent Call Summary

Ring Group Statistics
Extension Call Accounting

Extension Call Accounting Details

3. Filter data by system time, queue, agent(s), or call abandonment time.

Note:
To filter out abandoned short calls, specify the ring duration in the Exclude

Calls Abandoned within Xs field. Calls abandoned within this time frame
will NOT be included in the report.

Call Reports Scheduled Reports Download Scheduled Reports Rate

Agent Performance 12/27/2023 00:00:00 ~ 12/27/2023 23:59:59 6401-Support 5

A report that meets the filter criteria is displayed on the page, as shown below.

Queue Total Calls Answered Missed Abandoned AVG Waiting Time (Answered Calls) AVG Waiting Time (all Calls) Max Waiting Time Average Talking Time Missed Rate
v support 5 4 0 1 00:00:08 00:00:08 00:00:15 00:00:58
Agent Total Rings Answered Missed Average Waiting Time Max Waiting Time Average Talking Time Total Talking Time Missed Rate
R 2000-LeoBall 4 0 4 00:00:00 00:00:00 00:00:00 00:00:00 100%
®R 2001-Phillip Huff 4 2 2 00:00:12 00:00:16 00:00:57 00:01:54 50%
@ 2002-Terrell Smith 0 00:00:02 00:00:02 00:01:03 00:01:03 0%

[ 2004-Troy Daniel 0 00:00:07 00:00:07 00:00:54 00:00:54 0%
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Report details

We take the above report as an example to introduce the key metrics for Agent Perfor-
mance report.

Metrics for queue

Queue Total Calls Answere d Missed Abandoned AVG Waiting Time (Answered Calls) AVG Waiting Time (All Calls) Max Waiting Time Average Talking Time Missed Rate

> Support 5 4 0 1 00:00:08 00:00:08 00:00:15 00:00:58

Metric Description

Total Calls The total number of calls that the queue received.
Answered The total number of calls that the queue answered.
Missed The total number of calls that the queue missed.

Note:
A missed queue call includes, but is not limited to, the
following scenarios:

« A call exits the queue when the number of
Maximum Callers is reached.

« A call exits the queue when the Maximum
Waiting Time is reached.

* A call is assigned to another queue or extension
by queue manager.

* A caller presses a key to exit the queue and be
routed to another destination.

Abandoned The total number of calls that the callers abandoned.

AVG Waiting The average amount of time that the answered calls had been
Time (Answered | waiting in the queue before being answered by agents.

Calls)

Formula: (Total Ring Duration of Answered Calls + Retry
Interval) / Total Answered Calls

AVG Waiting The average amount of time that all inbound calls had been
Time (All Calls) waiting in the queue, regardless of whether they were answered
or not.

Formula: (Total Ring Duration + Retry Interval) / Total Calls
Max Waiting The longest time a caller waited in the queue.
Time
Average Talking The average amount of time that agents spent talking to callers.

Time Formula: Total Talking Time / Total Answered Calls
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Description

Missed Rate The percentage of missed calls in relation to the total received
calls.
.
Formula: (Total Missed Calls / Total Calls) * 100%
.
Metrics for agents
Queue Total Calls Answered Missed Abandoned AVG Waiting Time (Answered Calls) AVG Waiting Time (All Calls) Max Waiting Time Average Talking Time Missed Rate
v | Support 5 4 0 1 00:00:08 00:00:08 00:00:15 00:00:58 0%
Agent Total Rings. Answered Missed Average Waiting Time ~ Max Waiting Time Average Talking Time ~ Total Talking Time Missed Rate

@ 2000-Leo Ball 4 0 4 00:00:00 00:00:00 00:00:00 00:00:00 100%

® 2001-Phillip Huff 4 2 2 00:00:12 00:00:16 00:00:57 00:01:54 50%

& 2002-Terrell Smith 1 0 00:00:02 00:00:02 00:01:03 00:01:03 0%

E 2004-Troy Daniel 1

0 00:00:07 00:00:07 00:00:54 00:00:54 0%

Metric Description

Total Rings

Answered

Missed

Average Waiting
Time

Max Waiting Time

Average Talking
Time

Total Talking Time
Missed Rate

The total number of calls that the agent received.
Formula: Answered + Missed
The total number of calls that the agent answered.

The total number of calls that the agent missed.

73 Note:
If a call is distributed to an agent multiple times, the
number of missed calls will be cumulated instead of
counting only one missed call.

The average amount of time that the answered calls had been
waiting in the queue before being answered by the agent.
Formula: Total Ring Duration of Answered Calls / Answered
The longest waiting time of the answered calls.

The average amount of time that the agent spent talking to
callers.

Formula: Total Talk Duration / Answered
The total amount of time that the agent spent talking to callers.

The percentage of missed calls in relation to the total received
calls.

Formula: (Missed / Total Rings) * 100%

Metrics for agent call logs




2001-Phillip Huff Details

D

2023122713114407444

20231227131015FD39B

20231227130839F4B31

20231227130745FCE1D

20231227130553D15DE

Metric Description

ID
Time
Call From

Status

Ring Duration

Talk Duration
Polling Attempts

Reason

Time

12/27/202313:11:44

12/27/202313:10:14

12/27/2023 13:08:38

12/27/2023 13:07:44

12/27/2023 13:05:52

Call From

Terrell Smith=<15880123.

Terrell Smith=<15880123.

Terrell Smith=<15880123.

Terrell Smith=<15880123.

Terrell Smith=<15880123.

Status

Missed

Missed

Answered

Missed

Answered
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Ring Duration ~ Reason

00:00:02

00:00:07

00:00:09

00:00:09

00:00:16

Agent Missed/Queue Answered
Agent Missed/Queue Answered
Terrell Smith<15880123456> hung
Agent Missed/Queue No Answered

Terrell Smith<15880123456> hung

Total 5 10/ page

A unique ID for the call.

When the call was received.

The number and the name of the caller.

Call status for the agent.

« Answered
« Missed

» For answered calls, this indicates the time between the
call started and the call answered.

» For missed or abandoned calls, this indicates the time
between the call started and the call disconnected.

The time between the call answered and the call ended.
The number of polling attempts to call the agent.

The reason why the call was not answered by the agent or
why the call ended.

Agent Call Summary Report

Agent Call Summary report provides a quick overview of the internal calls and inbound
calls received by queue agents, as well as the outbound calls that were made by queue
agents. This topic introduces how to access the report and explains the key metrics in de-

tail.

Access Agent Call Summary report

1. Log in to PBX web portal, go to Reports and Recordings > Call Reports.
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2. In the Report Type drop-down list, select Agent Call Summary.

Call Reports Scheduled Reports

Report Type

Agent Login Activity \\\
Agent Pause Activity \I
Agent Missed Call Activity Il
Agent Performance , /

Agent Call Summary o

Ring Group Statistics
Extension Call Accounting

|
3. Filter data by system time, queue, or agent(s).

Call Reports Scheduled Reports Download Scheduled Reports Rate
Report Type Time Queue Agent
Agent Call Summary | 12/27/2023 00:00:00 ~ 12/27/2023 23:59:59 | | 6401-Support | | |

A report that meets the filter criteria is displayed on the page, as shown below.

Agent Call Summary

Inbound Outbound
24
154
1
05
o 3
LR R
. Total Talk AVG Handl A Talkil . A Waiti
Agent Inbound Talk Duration Outbound Talk Duration Total Calls otal fa Ve Handie verage TaKNg - AvG Hold Time SN
Duration Time Time Time
2001-Phillip Huff 2 00:01:54 0 00:00:00 2 00:01:54 00:01:09 00:00:57 00:00:00 00:00:12
2002-Terrell Smith 1 00:01:03 0 00:00:00 1 00:01:03 00:.01:05 00:01:03 00:00:00 00:00:02
2004-Troy Daniel 1 00:00:54 0 00:00:00 1 00:00:54 00:01:01 00:00:54 00:00:00 00:00:07
Total 4 00:03:51 0 00:00:00 4 00:03:51 00:01:06 00:00:57 00:00:00 00:00:08

Report details

The key metrics for Agent Call Summary report is shown below.



Contact Center Guide | 2 - Inbound Call Center Guide | 77

Metric Description

Inbound The number of internal calls and inbound calls that the agent received.

Talk Duration The amount of time that the agent spent in internal calls and inbound calls.

Outbound The number of outbound calls that the agent made.

Talk Duration The amount of time that the agent spent in outbound calls.

Total calls The total number of internal calls, inbound calls, and outbound calls handled by
the agent.

Total Talk The total amount of time that the agent spent in internal calls, inbound calls, and

Duration outbound calls.

AVG Handle Time The average amount of time that the agent spent in handling the answered calls.

Formula: (Total Ring Duration of Answered Calls + Total Talk Duration of
Answered Calls) / Total Answered Calls

Average Talking The average amount of time that the agent spent in internal calls, inbound calls,
Time and outbound calls.

Formula: Total Talk Duration / Total Answered Calls
AVG Hold Time The average amount of time that calls were held.
Formula: Total Hold Duration / Total Answered Calls

Average Waiting | The average amount of time that the answered calls had been waiting in the
Time queue before being answered by the agent.

Formula: Total Ring Duration of Answered Calls / Total Answered Calls

Queue Preferences

This topic describes the queue preference settings, including distinctive ring tone, queue ca-
pacity, queue callback, service level agreement, announcement, and satisfaction survey.

Distinctive ring tone

Setting Description

Queue Alert Info Set an "alert info text" to add to Alert-info header in INVITE
request for queue calls.

When receiving a queue call, the phone will inspect
"Alert-Info" header to determine which ring tone it should
use for ringing.

Linkus Client Distinctive Ringtone Select or upload a ringtone for agent's Linkus clients.
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Setting Description

When an agent receives a call from the queue, the
designated ringtone will be played on the agent's Linkus
client.

Note:

* You can manage the uploaded custom
ringtones on PBX Settings > Voice
Prompt > Custom Ringtone.

« If you select an uploaded custom ringtone
(rather than a built-in ringtone), it will only
apply to agent's Linkus Web Client and
Desktop Client for queue calls. Instead, the
Linkus Mobile Client will play the ringtone
configured in the app.

« If the call is from a contact with a distinctive
ringtone set in the agent's Linkus client,
the contact’s distinctive ringtone will take
priority over the queue ringtone.

Queue capacity

Setting Description

Maximum Callers in Queue The maximum number of callers that can wait in the
queue.

The default value is 0 (unlimited).

73 Note:
When the number of callers waiting in queue
reaches the Maximum Callers In Queue, the
system routes the additional calls to Failover
Destination.

Leave Empty If enabled, callers already on hold will be forced out of a
queue when no agents are available.

You can define the scenario(s) in which it will be
considered that there are no agents available.

I Note:




Setting
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Description

Disallow to Join When Empty

S When all agents are logged out, the queue is
considered Empty by default.

Leave Empty
* Queue is defined as “Empty” when all agents in the queue are

Unavailable (Off Line) X ~ Paused X  Busy X

If enabled, callers can NOT join a queue where no agents
are available.

You can define the scenario(s) in which it will be
considered that there are no agents available.

," Note:
When all agents are logged out, the queue is
considered Empty by default.

Disallow to Join When Empty

* Queue is defined as “Empty" when all agents in the queue are

Unavailable (Off Line) X ~ Paused X  Busy X

Callback

Setting Description

Request Callback Method

Digit to press

Timeout (s)

Define how a caller can request a callback when the queue
is busy.

Define what digit a caller can press to request a callback
when the queue is busy.

Note:

The option is available only when Request
Callback Method is set to Triggered by caller
input.

Define the amount of time (in seconds) that a caller can
wait in the queue. After the timeout, the system will play
the callback option to the caller automatically.
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Setting Description

Callback Outbound Prefix

Callback Timeout

Note:

The option is available only when Request
Callback Method is set to Auto triggered after
the timeout.

Define the prefix of outbound route, which will be used to
call the callback number.

73 Note:
All agents in this queue must have permission to
use this outbound route, or the callback would fail.

Define how long a callback request can be reserved in the
queue. If there are no available agents in the queue within
the timeout period, the callback request will be cancelled.

« Enable Queue's Maximum Waiting Time: Use
the timeout period configured in Queue > Basic >
Maximum Waiting Time (s).

Basic Members Preferences Queue Panel Permissions

Basic

Ring All

60

» Custom: Set a custom timeout period in the
Timeout (s) field.

," Note:
The value should be less than the queue's
Maximum Waiting Time (s).
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Priority queue

Setting Description

Weight Specify the initial weight of a queue.

You can enter a number between 1 and 999. The larger
the number, the greater the weight.

The system will compare the weight of multiple queues,
and assign incoming calls from the queue with a greater
weight to agents first. For example, calls in a queue with
a weight of 2 will be answered more quickly than that in a
queue with a weight of 1.

Enable Acceleration Weight Enable acceleration weight to dynamically adjust queue
weight according to the waiting time of an incoming call in
the queue, so as to avoid the calls in a low-priority queue
being waited for too long,

Acceleration (s) Specify the amount of time a call has been waiting in the
queue before the weight is increased by 1. This ensures
that calls with longer waiting time can be prioritized
through accelerated weighting, enabling them to be
answered more quickly.

You can enter a number between 10 and 1800.

The system will calculate the total queue weight based
on the initial queue weight and the waiting time of a call
according to the following formula:

Queue Weight = Weight + (Waiting Time /
Acceleration) * 1

73 Note:
If there are decimals in the result, the value will
be rounded.

Service level agreement

T

SLA Time(s) The maximum amount of time (in seconds) that an agent
needs to answer an incoming call.

The default SLA time is 60 seconds.

Evaluation Interval(min) The time interval to compare the queue's SLA performance
against the alarm threshold, so the system can send a
notification email accordingly.
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- R - R

Alarm Threshold(%) The service level threshold for the queue.

The default alarm threshold is 80%.

Satisfaction survey

T R

Satisfaction Survey Prompt The prompt played to caller to ask the caller to rate their
satisfaction scale after the agent hangs up.

The default prompt is "Please rate your satisfaction with
our service, press 1 for satisfied, press 2 for dissatisfied.
Thank you.". "Thanks for your calling, goodbye." is
prompted after the caller presses a key.

End Prompt The prompt played to callers after they press the key to
rate agent's service.

) Note:
This option is only available when the
Satisfaction Survey Prompt has been specified.

Satisfaction Survey Points The scores for the keys that the caller can press to rate an
agent's service.

73 Note:
This allows you to collect customer feedback and
gain valuable insight into agent performance.
You can check satisfaction survey score in
Satisfaction Survey report and Satisfaction
Survey Details report. For more information,
see Satisfaction Survey Report and Satisfaction
Survey Details Report.

Key Press Event

Setting Description

Key The caller can press the key to enter the specific destination
when waiting in queue.

Generally, set a Periodic Announcements to guide the
callers to press the key.
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Setting Description

Key Destination The destination to route the call when the caller presses a
key.

* Hang up: End the current call.

« Extension: Route the call to the specified extension.

« Extension Voicemail: Route the call to voicemail
box of the specified extension.

» Group Voicemail: Route the call to group voicemail
box of a queue, a ring group, or a custom group.

« IVR: Route the call to the specified IVR.

- Call Flow: Route the call to the specified call flow.

« Ring Group: Route the call to another ring group.

» Queue: Route the call to the specified queue.

 External Number: Route the call to an external
number.

« Play Prompt and Exit: Play a custom prompt, and
then hang up the call.

Manage Call Queues

You can not change the queue number after setting up a queue. This topic describes how to
edit a queue, and delete queues.

Edit a queue

You can manage the agents, change the ring strategy, or other queue settings.

1. Log in to PBX web portal, go to Call Features > Queue.

2. Click Z beside the queue that you want to edit.
3. Change the queue settings according to your needs.
4. Click Save and Apply.

Delete queues

1. Log in to PBX web portal, go to Call Features > Queue.
2. To delete a queue, do the followings:

a. Click [T beside the queue that you want to delete.

b. Click OK and Apply.
3. To delete queues in bulk, do the followings:
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a. Select the checkboxes of the queues that you want to delete, click Delete.
b. Click OK and Apply.

Supervisor Guide

Call Center Supervisor Guide

This guide provides step-by-step procedures on how you can manage queues and monitor
agents on the Call Center Console dashboards - Wallboard and Queue Panel, and describes
how to manage queue call logs on your Linkus UC Clients.

Audience

This guide is intended for call center managers (supervisors) and authorized agents with
responsibilities that include managing and monitoring the performance of call queue and
agents, as well as ensuring that the call center meets established service level and goals.

Note:

For guidance on introducing operations to agents that responsible for handling
queue calls only, see Call Center Agent Guide.

Call Center management tools

Yeastar P-Series PBX System supports tools such as Wallboard, Queue Panel, and Queue
Call Logs, providing call metrics, real-time performance data, and detailed call records to
help you monitor and optimize Call Center operations.

« Wallboard: Displays call center metrics and KPIs to allow you to monitor and opti-
mize performance.

For more information, see Wallboard Overview.

» Queue Panel: Shows the call metrics and agents' performance in real time, and offer
a comprehensive view on activity of call. It is available for you to manage queue calls.

For more information, see Queue Panel Overview.

* Queue Call logs: Shows the call records in a queue in real-time, allowing you to check
and manage queue call logs on Linkus UC Clients.

For more information, see Manage Queue Call Logs.
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Wallboard

Wallboard Overview

The Wallboard allows you to easily view real-time information related to queues. This topic
describes what you can do on Wallboard and the views displayed on the Wallboard.

Note:
Wallboard is only available for call center managers (supervisors), and specific
agents who have been granted permission by system administrator.

Requirements
To access and use the Wallboard, make sure that your Linkus Web Client and Linkus Desk-
top Client meet the following requirements.

Clients Requirement

Linkus Web Client Web Browser Version
Google Chrome (recommended) Chrome 87 or later
Microsoft Edge Edge 87 or later
Opera Opera 72 or later
Linkus Desktop Client Version 1.10.2 or later

What you can do on Wallboard

As a queue manager, you can quickly access all the important information about your
queues in real time on Wallboard. Yeastar Wallboard drills down into your queue's daily,
weekly, or monthly performance, providing an insight into call volumes, response rates, ser-
vice level, and more.

You can display wallboard for each queue independently as needed. With a Wallboard dis-
played on a TV or a dedicated "wallboard", queue agents should be able to understand their
performance at a glance. In this way, agents are continuously up to date with service level
agreements and daily targets, which increases efficiency and workload output.

Types of Wallboard views

Wallboard view for queue call metrics
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Provide a comprehensive display of aggregated data of all queues as well as
individual queue metrics, offering a quick overview of key performance met-
rics.

Allv L] This Month 2 Edit

00:00:07

AVERAGE WAITING TIME

00:01:18
AVERAGE TALKING TIME
WAITING CALLS 6
00:00:07 oL cas
MAX WAITING TIME
'\ \
0 16.7% 16.7% 66.7% \)
ACTIVE CALLS ANSWERED RATE MISSED RATE ABANDON RATE
15:06 0 0
2024/10/16 Wed . TOTAL CALLBACKS FAILED CALLBACKS PENDING CALLBAC...

List view for queue performance metrics

Present key performance metrics in a list format, making it easy to compare
and analyze the performance of multiple queues.

Allv o This Month

Queue Agents Logged In Available Agents Active Calls Waiting Calls Average Waiting Time SLA Missed Calls Abandoned Calls Y
Al - - 0 0 00:00:07 - 1 a
Support [6401] 3/5 3 0 0 00:00:00 0% 0 2

test [6402] n 1 0 0 00:00:07 254 1 2

Total :3 20/ page

List view for queue agent status

Track agents' presence status, logged in/out status, call statistics, and more in
a clear, organized list view.
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Allv o This Month

Max Talking Time for
Queue Agent Status Time Active Calls Answered Calls Missed Calls Total Talking Time vy
Current Active Calls

Phillip Huff
Logged in - 0 00:00:00 0 0 00:00:00

Terrell Smith
Logged in - 0 00:00:00 0 0 00:00:00

Dave Harris
Support [6401] ° Logged in - 0 00:00:00 0 0 00:00:00

Joe Lewis
) Logged in - 0 00:00:00 0 1 00:00:00

Naomi Nichols
) Logged in - 0 00:00:00 0 1 00:00:00

Naomi Nichols
test [6402] ° Logged in - 0 00:00:00 1 000118

View Queue Statistics on Wallboard
As a manager of a queue or multiple queues, you can view the queue related statistics to
measure the queue performance. This topic describes how to view queue related statistics.

Requirements

« PBX server: 37.19.0.70 or later
« Linkus Desktop Client: 1.13.3 or later

Prerequisites

* You are a queue manager, or an agent with wallboard access permission assigned.

* You have the permission to access Linkus Web Client or Linkus Desktop Client.

* You have get username and password as well as the server's network information (do-
main name or IP addresses and ports) from your system administrator.

Step 1. Access Wallboard from Linkus UC Clients

You can access Wallboard from Linkus Web Client or Desktop Client.

1. Log in to Linkus UC Clients.
Log in to Linkus Web Client
e Tip:

If you have received a Linkus welcome email, you can click the
login link for Linkus Web Client to quickly log in.
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a. Launch your web browser, enter thelP address of Linkus Web
Client, press Enter.
b. Enter your username and password, then click LOG IN.
- Username: Email address.
« Password: Extension User Password.

Log in to Linkus Desktop Client

e Tip:

If you have received a Linkus welcome email, you can use the
login link to quickly log in to Linkus Desktop Client.

a. Open Linkus Desktop Client.

b. Enter the login information, then click LOG IN.
- Username: Email address.
« Password: Extension User Password.

« Domain: Enter the domain name or click @ to enter the IP
addresses and ports.
2. Go to Call Center Console > Wallboard.

Step 2. Filter queue statistics

Click on the links below to check how to filter queue statistics in each view:

» Wallboard view for queue call metrics
« List view for queue performance metrics
« List view for queue agent status

Wallboard view for queue call metrics

Wallboard view for queue call metrics provides a comprehensive display of
aggregated data of all queues as well as individual queue metrics. You can
choose to view the statistics of all queues or a single queue.

1. At the top-left corner of Wallboard, select the desired queue.
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Allv L4 This Month 2 Edit
Al
Support [6401] 00:00:07
AVERAGE WAITING TIME 1
test [6402]
MISSED CALLS
00:01:18
AVERAGE TALKING TIME
WAITING CALLS 6
00:00:07 ToTAL CALLS
MAX WAITING TIME

2. At the top-right corner of Wallboard, select the time range of statistics to
display.

Allv L] This Month £ Edit

Today

This Week

00:00:07

AVERAGE WAITING TIME This Month

MISSED CA

00:01:18
WAITING CALLS 6
00:00:07 TOTAL CALLS

MAX WAITING TIME

The call statistics for all queues or a single queue within the specified
time range are displayed.

Allv L] This Month 2 Edit

00:00:07

AVERAGE WAITING TIME 1

MISSED CALLS

00:01:18

AVERAGE TALKING TIME

WAITING CALLS 6
00:00:07 TOTAL CALLS

MAX WAITING TIME

0 167% °  167% °  66.7% J

ACTIVE CALLS ANSWERED RATE MISSED RATE ABANDON RATE

15:06
2024/10/16 wed .

TOTAL CALLBACKS ~ FAILED CALLBACKS PENDING CALLBAC..

To understand each metric, you can refer to the table below.
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Widget Description

DATE & TIME

AVERAGE
WAITING TIME

AVERAGE
TALKING TIME

MAX WAITING
TIME

WAITING CALLS

ACTIVE CALLS

ANSWERED
CALLS

TOTAL CALLS

MISSED CALLS

ABANDONED
CALLS

ANSWERED
RATE

MISSED RATE

ABANDON
RATE

Display the date and time of the PBX.

Display the average call waiting time for queue calls
answered over a period of time.

Display the average amount of time that an agent spends
talking to a customer.

Display the maximum call waiting time for all calls
answered over a period of time.

Display the number of waiting calls in the queue.
Display the number of current active calls in the queue.

Display the total calls that queue answered over a period
of time.

Display the total calls that queue received over a period of
time.

Display the total calls that queue missed over a period of
time.

Tip:

e You can click on the widget to view the related
queue call logs and manage processing status
of these call logs. Any other agents who are
authorized to view the queue's call logs can see

the changes you make on their Linkus clients.

Display the total calls that has been abandoned over a
period of time.

Tip:

0 You can click on the widget to view the related
queue call logs and manage processing status
of these call logs. Any other agents who are
authorized to view the queue's call logs can see
the changes you make on their Linkus clients.

Display the answered rate over a period of time for all calls
to the queue.

Display the missed rate over a period of time for all calls to
the queue.

Display the abandon rate over a period of time for all calls
to the queue.
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Widget Description

CALL BACKS Display the following data of queue callback over a period
of time:

« TOTAL CALLBACKS: Display the total callback
requests that are successfully made by callers over
a period of time.

« FAILED CALLBACKS: Display the total failed
callback attempts over a period of time.

« PENDING CALLBACKS: Display the total callbacks
to be performed.

List view for queue performance metrics

List view for queue performance metrics present key performance metrics of
all queues in a list format, making it easy to compare and analyze the perfor-
mance of multiple queues.

1. At the top-left corner of Wallboard, select All.

Allv (] This Month 2 Edit

All

Support [6401] 00:00:07

AVERAGE WAITING TIME 1

MISSED CALLS
0 00:01:18
AVERAGE TALKING TIME

WAITING CALLS

test [6402]

00:00:07

MAX WAITING TIME

2. At the top-right corner of Wallboard, select the time range of statistics to

display.
Today

00:00:07 This Week
AVERAGE WAITING TIME This Month

0 00:01:18
AVERAGE TALKING TIME

WAITING CALLS 6

00:00:07 TOTAL CALLS

MAX WAITING TIME

3. On the top of Wallboard, click the toggle button to switch to the list view.
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Allv This Month

Queve Agents Logged In Available Agents Active Calls Waiting Calls Average Waiting Time SLA Missed Calls Abandoned Calls Y
All - - 0 0 00:00:07
Support [5401] a5 3 0 0 000000 o 0 2

test[6402] n 1 0 0 00:00:07

Total 3 1 20/ page

The queue metrics for all queues within the specified time range are dis-
played.

To understand each metric, you can refer to the table below.

Widget Description

Agents Logged Display the number of agents logged in to the queue, and

In the total number of agents.

Available Display the number of agents logged in the queue that are
Agents ready to take a call.

Active Calls Display the number of current active calls in the queue.
Waiting Calls Display the number of waiting calls in the queue.

Average Talking Display the average amount of time that an agent spends
Time talking to a customer.

Average Waiting Display the average call waiting time for queue calls

Time answered over a period of time.

Max Waiting Display the maximum call waiting time for all calls answered

Time over a period of time.

SLA Display the Service Level Agreement (SLA) for the queue.

Missed Calls Display the total calls that queue missed over a period of
time.

Abandoned Display the total calls that has been abandoned over a

Calls period of time.

Answered Calls Display the total calls that queue answered over a period of

time.

Total Calls Display the total calls that queue received over a period of
time.

Missed Rate Display the missed rate over a period of time for all calls to
the queue.

Abandon Rate  Display the abandon rate over a period of time for all calls
to the queue.

Answered Rate Display the answered rate over a period of time for all calls
to the queue.
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Widget Description

Callbacks Display the following data of queue callback over a period
of time:

« Total Callbacks: Display the total callback requests
that are successfully made by callers over a period
of time.

« Failed Callbacks: Display the total failed callback
attempts over a period of time.

- Pending Callbacks: Display the total callbacks to
be performed.

List view for queue agent status

List view for queue agent status allows you to track agents' presence status,
logged in/out status, call statistics, and more in a clear, organized list view.

1. At the top-left corner of Wallboard, select the desired queue.

Allv ® This Month 2 Edit

All

Support [6401] 00:00:07

AVERAGE WAITING TIME 1

MISSED CALLS
00:01:18
AVERAGE TALKING TIME

WAITING CALLS

test [6402]

00:00:07

MAX WAITING TIME

2. At the top-right corner of Wallboard, select the time range of statistics to
display.

Allv L] This Month £ Edit

Today

00:00:07

AVERAGE WAITING TIME

This Week

This Month

0 00:01:18

WAITING CALLS
00:00:07

MAX WAITING TIME

3. On the top of Wallboard, click the toggle button to switch to the list view.
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Allv

Queve P
g Pl Huf
g TereliSmith

Support [6401] @ DaveHaris

Joe Lewis
°

Naomi Nichols

©

test [6402]

The agent status for all queues or a single queue within the specified

Naomi Nichols
°

Status. Time

Loggedin

Logged in

Loggedin

Loggedin

Logged in

Loggedin

time range are displayed.

Max Talking Time for
Current Active Calls

00:00:00

00:00:00

00:00:00

00:00:00

00:00:00

00:00:00

Answered Calls

This Month

Missed Calls

0 00:00:00

0 00:00:00

0 00:00:00

1 00:00:00

1 00:00:00

1 00:01:18

Total 16 1 20/ page

To understand each metric, you can refer to the table below.

Widget Description

Queue

Agent

Type
Status

Display the queues you manage.

Display the name, extension number, and extension
presence of agents.

You can filter the desired agents from the list by the online
status of the extensions.

Queue

Sales-us [6400]

Agent

Type

m Online (21)

Available (21)

Away (0)
Business Trip (0)
Do Not Disturb (0)
Lunch Break (0)

Off Work (0)

Offline (5)

Reset

Display the type of agents.

Display the status of agents.

gents

gents

s

s

Status

Logged in

Logged in

Logged in

You can filter the desired agents from the list by agent

status.

Total Talking Time

v
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Widget Description

Queue Agent Type Status

Jack Wilson
Dynamic Agents Log In (16)

(] Emily Parker Dynamic Agents oo
v 9 Pause (0)

David Miller Pause-Lunch (0)

Static Agents
4 Pause-Break (0
Sales-us [6400] 8 ©

® Tom Mitchell Pause-Wrap up (0)

Static Agents
o

Time Display the time for each status.
- If Status is Logged in, Time shows the last time
the dynamic agent logged in to the queue.

Note:
For static agent, Time shows - .

« If Status is Log Out, Time shows the last time the
dynamic agent logged out of the queue.

Note:
For static agent, Time shows - .

« If Status is Paused, Time shows how long the
agent paused service.

Active Calls Display the total number of calls in the queue that the agent
is answering.

0 Tip:

Click on the number, then you will be redirected
to Queue Panel to view the calls the agent is
answering.

Max Talking Display the maximum amount of time that the agent spends
Time for Current talking to a customer among all calls in the queue.
Active Calls

Answered Calls Display the total number of calls that the agent answered
over a period of time.

Missed Calls Display the total number of calls that the agent missed over
a period of time.

Total Talking Display the total talking time that the agent answered queue
Time calls over a period of time.
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(Optional) Step 3. Display Wallboard independently

Set the Wallboard to display independently in a separate browser window.

1. At the top-right corner of Wallboard, click ** .

This Month £ Edit E'E

L

MISSED CALLS

6

TOTAL CALLS

2. Optional: Set the Wallboard to automatically toggle between wallboard view and list
view with a scrolling display.
a. At the top-right corner of Wallboard, click Settings to set the time to toggle,
then save the setting.
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b. On the top of Wallboard, click Play.

00:00:07
MISSED CALLS 'ABANDONED CALLS
00:01:18
WAITING CALLS 1 6
0 0 : 0 0 : 07 ANSWERED CALLS TOTAL CALLS

MAX WAITING TIME

The Wallboard automatically toggles between wallboard view and list view with
a scrolling display at the specified time interval.

Manage Wallboard Widgets

Widgets displayed on Wallboard are customizable. You can place a widget in a way that is
easy to see. This topic describes how to add, resize, lock, delete, reset, and add a note to a

widget.
Add a widget

1. At the top-left corner of the Wallboard, select All or select a specific queue.
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Al L4 This Month 2 Edit

Al

6400 [6400] 00:00:16
AVERAGE WAITING TIME 2

6401 [6401]

MISSED CALLS

00:03:00

AVERAGE TALKING TIME

WAITING CALLS 00:00:16 TOTAL CALLS

Note:
« If you select All, the changes you make to Wallboard widgets will be ap-
plied to the current view only.
« If you select a specific queue, the changes you make to Wallboard wid-
gets will be applied to the view for all the single queue.

2. At the top-right corner of the Wallboard, click Edit.

Today £ Edit | ¥4

‘ )

P — e ...--"

3. Click Add Widget.

4. In the Type drop-down list, select a statistic type.

5. In the Note field, enter the short description according to your needs.
6. Click Save.

Resize a widget

1. At the top-left corner of the Wallboard, select All or select a specific queue.
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Al L4 This Month 2 Edit
Al

6400 [6400] 00:00:16

AVERAGE WAITING TIME
6401 [6401] 2
MISSED CALLS
00:03:00
WAITING CALLS 00:00:16 TOTAL CALLS

MAX WAITING TIME

Note:
« If you select All, the changes you make to Wallboard widgets will be ap-
plied to the current view only.

« If you select a specific queue, the changes you make to Wallboard wid-
gets will be applied to the view for all the single queue.

2. At the top right corner of the Wallboard, click Edit.
3. Hover your mouse over the lower right corner of the widget.

4. Hold the widget and then drag the border frame around it up/down and left/right to re-
size it.

MISSED CALLS

5. Click Save.
Move and lock a widget on a fixed position

1. At the top-left corner of the Wallboard, select All or select a specific queue.
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Allv
Al
6400 [6400]

6401 [6401]

WAITING CALLS

Note:

2. At the top right corner of the Wallboard, click Edit.

00:00:16

AVERAGE WAITING TIME

00:03:00

AVERAGE TALKING TIME

00:00:16

MAX WAITING TIME

3. Move the widget to a desired position.

4. Click &l on the desired widget.

m £ X

MISSED CALLS

5. Click Save.

Delete a widget

This Month 2 Edit

p.

MISSED CALLS

5

TOTAL CALLS

« If you select All, the changes you make to Wallboard widgets will be ap-

plied to the current view only.
« If you select a specific queue, the changes you make to Wallboard wid-

gets will be applied to the view for all the single queue.

1. At the top-left corner of the Wallboard, select All or select a specific queue.
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Al L4 This Month 2 Edit

Al

6400 [6400] 00:00:16
AVERAGE WAITING TIME 2
6401 [0401] MISSED CALLS
00:03:00
WAITING CALLS 00:00:16 TOTAL CALLS

MAX WAITING TIME

Note:

« If you select All, the changes you make to Wallboard widgets will be ap-

plied to the current view only.
« If you select a specific queue, the changes you make to Wallboard wid-

gets will be applied to the view for all the single queue.

2. At the top right corner of the Wallboard, click Edit.
3. Click X on the desired widget.

MISSED CALLS

4. Click Save.
Add a note to the bottom of the widget

1. At the top-left corner of the Wallboard, select All or select a specific queue.
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Al L4 This Month 2 Edit

Al

6400 [6400] 00:00:16
AVERAGE WAITING TIME 2
6401 [0401] MISSED CALLS
00:03:00
WAITING CALLS 00:00:16 TOTAL CALLS

MAX WAITING TIME

Note:
« If you select All, the changes you make to Wallboard widgets will be ap-

plied to the current view only.
« If you select a specific queue, the changes you make to Wallboard wid-

gets will be applied to the view for all the single queue.

2. At the top right corner of the Wallboard, click Edit.
3. Click @ on the desired widget.

@ & X

"

MISSED CALLS

4. In the Note field, enter the short description according to your needs.
5. Click Save.

Reset widgets
Reset widgets to the default settings and discard changes you have made.

1. At the top-left corner of the Wallboard, select All or select a specific queue.
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Al L4 This Month 2 Edit 3%

Al

6400 [6400] 00:00:16
AVERAGE WAITING TIME 2

6401 [6401]

MISSED CALLS

00:03:00

AVERAGE TALKING TIME

WAITING CALLS 00:00:16 TOTAL CALLS

Note:
« If you select All, the changes you make to Wallboard widgets will be ap-
plied to the current view only.
« If you select a specific queue, the changes you make to Wallboard wid-
gets will be applied to the view for all the single queue.

2. At the top right corner of the Wallboard, click Edit.
3. Click Reset and Save.

The custom position, note, and size of the widgets will be reset to back to the default
settings.

NS o

Queue Panel

Queue Panel Overview

This topic describes what you can do on Queue Panel, and the permissions of queue man-
ager and agents.

Requirements

To access and use the Queue Panel, make sure that your Linkus Web Client and Linkus
Desktop Client meet the following requirements.



Contact Center Guide | 2 - Inbound Call Center Guide | 104

Clients Requirement

Linkus Web Client

Web Browser
Google Chrome (recommended)
Microsoft Edge
Opera

Version
Chrome 87 or later
Edge 87 or later

Opera 72 or later

Linkus Desktop Client Version 1.10.2 or later

What you can do on Queue Panel

6400 [6400] v Today b
85.16% 24 2 1 00:01:20 00:00:26 00:04:25
SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Average Waiting Time Average Talking Time
&S Waiting Calls (0) & Agent (1/7) Q =
Caller Callee Status Time Details Carlos Mendez
!i._ "l\ 1007
9347302234 Customer Service[6400]  Ringing 00:00:16 External, Ringing Agent A=p
<50 @ Static Agents
3829002482 Customer Service [6400] ~ Redirect External, Waiting in Que...
3 0 24:19
~ Hang Up Answered  Missed  Total Talks
&, Pick Up )
Maria Douglas
1008
i @ Static Agents
5 1 26:30
Answered Missed  Total Talks
S Active Calls (0) Rafael Reid
Caller Callee Status Time Details ;2"/ .
= a. @ Logged in 08/31/2020
4609027806 Carlos Mendez [1007] Talking 00:02:49 External
) % o 3 0 14:54
5302119744 Maria Douglas [1008] Talking S, External Answered Missed  Total Talks
2249901278 Rafael Reid [1001] Talking External
9492023450 Sarah Blaese [1002] Talking ~ HangUp External Anna Simmons
7928343909 Ashley Miller [1003] Talking @ Recording External ﬁ o
Q 2 Logged out
P Parked >
0 0 00:00
~ Bargeln Answered Missed Total Talks
¢y Listen
¥  Whisper >

With an easy-to-use interface on Yeastar Queue Panel, you can view call statistics, change
agent status, manage queue calls quickly and efficiently, and manage processing status of
missed or abandoned queue calls.

« View call statistics of each queue and each agent.
» Change agent status in the queue, including login, logout, pause, and unpause.
» Manage queue calls:
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o Call distribution: Redirect incoming calls, and transfer calls.
o Call connection: Pick up ringing calls, and hang up calls.
o Call parking: Park calls.
> Call recording: Monitor and switch recording status.
> Call monitoring: Barge in a call, listen to a call, and whisper to a call.
« Manage processing status of missed or abandoned queue calls, including not deal,
dealing, and dealt.

Queue Panel permissions
What you can do on Queue Panel depends on the following permission. The permission is
assigned by your system administrator.

« Switch agents' status

« Call distribution management (Redirect, Transfer, Drag and Drop operation)
« Allow for picking up or hanging up agents' calls

- Call monitoring operations (Listen, Whisper, Barge In)

« Call parking operation

« Switch agent's recording status

» Show Company Contacts Matching Results

Note:
Once enabled, the user's visibility permission rules for company contacts will
be ignored to display the matching results.

Access and Use Queue Panel
This topic describes how a queue manager can access the queue panel to check the queue
related statistics and manage the calls of one or more queues.

Requirements

* The firmware of PBX server is 37.19.0.70 or later.
« To access and use the Queue Panel, make sure that your Linkus Web Client and
Linkus Desktop Client meet the following requirements.

Clients Requirement

Linkus Web Client Web Browser Version

Google Chrome (recommended) Chrome 87 or later
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Requirement

Microsoft Edge Edge 87 or later
Opera Opera 72 or later
Linkus Desktop Client Version 1.13.3 or later

Procedure

1. Log in to Linkus Web Client or Desktop Client, go to Call Center Console > Queue
Panel.

2. If you manage more than one queue, set the desired queue range to view the corre-
sponding statistics.

Queue Range Instruction

A specific queue ealos-eu [6401] v/

salejius [6400]

sales-eu [6401]

Custom

a. At the top-left corner of the queue panel, click the current
queue.
b. In the drop-down queue list, select the desired queue.

A group of queues o

All

sales-us [6400]
Queue Group Management X

sales-eu [6401]

157 Delete

* SLA Al
* Group Name * Queue Thresholad"(r“’/a) Operations Sort

80

sales-us [6400] X

0 Sales sales-eu [6401] X 80 L2}

e + Add

0

a. At the top-left corner of the queue panel, click the current
queue.

b. In the drop-down queue list, select Custom.
c. In the pop-up window, click Add to add a queue group.
d. Configure a queue group.
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Queue Range Instruction

- Group Name: Enter a name to help you identify the
queue group.
* Queue: In the drop-down list, select the desired queues.
+» SLA Alarm Threshold (%): Specify the SLA rate before
an alert is triggered.
- Sort: Optional. Adjust the display order of the queue
group in the queue list.
e. Click Save.
f. In the drop-down queue list, select the queue group.

/] sales-eu [6401] Vv

All

“af  Sales
sales{g [6400]

sales-eu [6401]

Custom

All queues

A sales-eu [6401] V|

All

-

s

Sales
sales-us [6400]

sales-eu [6401]

Custom

a. At the top-left corner of the queue panel, click the current
queue.
b. In the drop-down queue list, select All.

Note:

If you want to change the threshold of SLA for this
queue range, select Custom, then edit the rate in the
pop-up window.
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Queue Range

sales-eu [6401] v/

All
sales-us [6400]

sales-eu [6401]

Instruction

Queue Group Management

E[ Delete

*SLA Al
* Group Name * Queue arm Operations Sort
Threshold (%)

T C—

~+ Add

<) B

3. Select a time range.
 Today: View statistics of today.
» This Week: View statistics of this week.

 This Month: View statistics of this month.

Today

Today
This Week

This Month

4. Optional: Click ** to display queue panel in a separate browser window.

For example, display the queue panel of Service in a browser window; display the
queue panel of Sales in another browser window.
5. Check and manage calls and queue statistics in the corresponding panels.
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6400 [6400]v Today
100% 1 0 0 00:00:19 00:00:19 00:00:00
SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Auwerage Waiting Time Awerage Talking Time

&, Agent (6/10) o =
RS Waiting Calls (1)
Keira Knightley
Caller Callee Status Time Details
® B Logged in 2024/06/26 142427
6400:Becky Lai [1001] 1024 1024 [1024] Ringing 00:00:03 Internal,Ringing Agent o . 0.0
o Becky Lai [1001] 6400 [6400] Waiting 00:00:03 Internal Waiting in Queue fnawered Hiased Tetal Tk

Audrey Hepburn

A
-- © @ statcagents
Waiting call panel u | UDUU

Answered Missed Total Talks

L3 Active Calls (1) 1003
Caller Callee Status Time Details R Y—
65400:1025 1025 [1025] 3333 3333 [3333] Talking 00:01:34 Internal 0 0 00:00

Answered Missed Total Talks

1006

Active call panel Agent panel

« Check queue data on the call statistics panel
 Check and manage calls on the waiting call panel

» Check and manage calls on the active call panel

» Check and manage agent status on the agent panel

Check queue data on the call statistics panel

You can check the call statistics of the specified range of queue(s).

[

sales-eu [6401] v Today PR
75% 3 1 0 00:00:13 00:00:10 00:00:42
SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Average Waiting Ti... Average Talking Ti...

To understand each metric, you can refer to the table below.

Call statistics Description

SLA Display the percentage of calls answered within the target response time
(SLA) for the queue(s).
Answered calls Display the total calls that queue agents answered over a period of time.
Abandoned Calls Display the total calls that have been abandoned over a period of time.
Tip:

You can click on the widget to view detailed information about related
call logs and manage the processing status.

Missed Calls Display the total calls that queue missed over a period of time.
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Call statistics Description

Tip:
You can click on the widget to view detailed information about related
call logs and manage the processing status.

Max Waiting Time Display the maximum call waiting time for all calls answered over a period of

time.
Average Waiting Display the average waiting time over a period of time for all queue calls.
Time
Average Talking Display the average talking time over a period of time for all queue calls.
Time

Check and manage calls on the waiting call panel

You can check the details of incoming call that is in ringing or waiting state in real time,
including caller, callee, queue, status, time, and details. You can also manage the calls as
needed.

Note:

The QCB indicates that the caller has requested a callback.

.". Yeastar = 8 ® B Ev AgentSttusv @ Availablev ¢ rotou system . (@) Q JoeLevisw
Rz Extensions
Support [6401] v Today
[ Contacts
25% 2 6 0 00:00:12 00:00:09 00:00:38
[= Chat SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Average Waiting Time Average Talking Time
=) Operator Panel Caller Callee Status Time Waiting ﬁ Leo Ball
00 Ringing \&,
€ Call Center Console N Terrell Smith [1002] Ringing 00:00:13 S \\{)O 2 Loggedont
Dave Harris [1003] Ringing 00:00:13 External Ringing Agent
Wallboard 0 0 00:00
Support [6401] Waiting 00:00:14 External Waiting in Queue Answered Missed Total Talks

Queue Panel

B callLogs @
1 Active Calls (0)

“CA® & Logged in 2024/09/12 16:06:45

Terrell Smith

Check and manage calls on the active call panel
You can check the details of answered calls in real time, including caller, callee, queue, sta-
tus, time, and details. You can also manage the calls as needed.

Note:

The QCB indicates that this is a callback.
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-'.. Yeastar = 82 @ B B AgentStatusv @ Availablev  Follow System v ° ? Joe Lewisv
R= Extensions

Support [6401] \/ Today
[ Contacts

35.7% 5 9 0 00:00:12 00:00:05 00:00:19
[= Chat SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Average Waiting Time Average Talking Time
& Video Conferencing R Waiting Calls (0) & Agent (3/5) Q =
& Operator Panel Caller Callee Status Time Details Leo Ball

o)

63 Call Center Console A pg
i & Logged out
Wallboard 0 0 00:00
Answered Missed Total Talks
Queue Panel
Terrell Smith

5 Call Logs
< Active Calls (2) |:/ - L 4/09, 4
[¢ A® & Logged in 2024/09/12 16:06:45

ao Voicemails
Caller Callee Status Time Leo Ball[1000] 2 2

00:18
9 Recordings Joe Lewis [1005] Talking 00:00:09 Terrell Smith [1002] Answered Missed Total Talks
Dave Harris [1003]
_ Terrell Smith [1002] Talking 00:01:26 Dave Harris
Za Preferences Joe Lewis [1005] @
Phillip Huff [1001] I

& static Agents
) Access Management Portal

Check and manage agent status on the agent panel

You can check the agent details in the queue(s), including the agent's presence, queue sta-
tus, and the agent's queue call statistics.

Agent's presence

To see an agent's presence status, hover your mouse over the presence icon.

&, Agent(2/3) Q

1025 1025
Busy

% @ Logged out

Queue Status

Icon Presence

:é The agent has logged in to the queue, and is available to receive a call.
1.6 The agent logged out of the queue.
‘0&. The agent has paused receiving the queue calls.

View Switch
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By default, Standard View is displayed. You can click the View Switch button
to switch to the Compact View, which allows you to view and manage queue
agents more efficiently.

Standard View Compact View

Today @ || Today [CHRIT
00:00:00 00:00:00 00:00:00 MO:OO:OD
Average Waiting Time Average Talking Time r -------- A-u e;g-e VVaErE‘F veTag-E T-a\zn;‘;m: - -=
D | |
&, Agent Q A, Agent Q
Sales-us [6400] (1/4) ~ Sales-us [6400] (1/4) ~
Sales-eu [6401] (4/5) Sales-eu [6401] (4/5) Expand/Collapse Group
JdekWilson™ — T T el ™ ~ ™ 12k wilson-1000
100 . 0 0 00:00

(] Iﬁ Logged in 2025/04/25 u9:27.52|
Emily Parker-1001

0 0 00:00 & 2[00 o000
Answered Missed Total Talks
[ —————— Call Statistics ¥ S —
Sarah Bennett 1002

. 1
Emily Parker £ 0 0 00:00
1 1
asiatchgemsl I David Miller-1003
& 0 0 00:00
0 0 00:00
Answered Missed Total Talks Kevin Thompson-3001

Sarah Bennett

1002
TR === mmmmm e --

1
1
1
& & 0 0 00:00
:
1
1

0 0 00:00
Answered Missed Total Talks
David Miller
o

Search and Filter

You can search and filter from the list using the following options to find the
desired agents quickly and efficiently.
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Option Description

Search the specific agent.

:) Filter and display only online agents that meet with both of the
)Y
following conditions:

» The extension status is online, meaning it is logged in to a
Linkus client, or registered on an endpoint.

» The agent status is set to Log In, Unpause, or Pause.

Manage Agent Status

Manage an Agent's Status in a Queue

As a queue manager, you can change an agent's status remotely. This topic describes how
to log an agent in to a queue, log an agent out of a queue, pause agents' service, and un-
pause agents' service.

Requirements

« Only a queue manager can change agents' status.
» To change agents' status, make sure that you have been granted the Switch group
members' presence permission by the system administrator.

Log an agent in to a queue

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el
2. On the Agent panel, hover your mouse over the logged-out agent, and change the sta-
tus.

Kristin Hale

(] & Logged % 11/01/2022 225...

& Login

Ko

]
[11]

a. Click the agent status.
b. Click Log In.
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Log an agent out of a queue

Note:

The static agent can not log out of a queue.

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el.
2. On the Agent panel, hover your mouse over the logged-in agent, and change the sta-

tus.

Kristin Hale

& Logged 'n@-m_-‘zczz 22°5.
& Pause

& Log Out

vave nigains

a. Click the agent status.
b. Click Log Out.

Pause an agent's service

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el
2. On the Agent panel, hover your mouse over the logged-in agent, and change the sta-
tus.
Kristin Hale
K
o & Logged in 11/01 -'?ﬁz:z:a..

Lunch B Pause : [k

Break & LogOut

S v s

a. Click the agent status.

b. Click Pause.
c. Optional: In the pause reason list, select a reason.
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The system will not distribute queue calls to the paused agent.
Unpause an agent's service

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el
2. On the Agent panel, hover your mouse over the logged-in agent, and change the sta-
tus.
Kristin Hale
K Bay i
:ij} -FCJEE‘L@
. _0__ _ d& Pause
& Unpause
& LogOut

a. Click the agent status.
b. Click Unpause.

The agent becomes available to receive queue calls.

Manage Queue Calls

Pick up a Call

If a call is ringing and has not been answered for a long time, in order to save the callers'
user's waiting time, you can pick up the ringing call. This topic describes how to pick up a
ringing call.

Requirements

To pick up agents' incoming calls, make sure that you have been granted the Allow for
picking up or hanging up agents' calls permission by the system administrator.
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Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.

3. Right click the incoming call, and select Pick Up.

The PBX system routes the call to your extension.

L. Waiting Calls (1)

Caller Callee Status Time Details
B400:Becky [1000] 1025 1025 [1025] Ringing 00:00:15 ]

< Redirect
Becky [1000] 6400 [6400] 00:00:29

~ Hang Up

“ 3@U:

4. Answer the call.

Redirect a Call

If a call has not been answered for a long time, in order to save the caller's waiting time, you
can redirect the incoming call to another extension, ring group, queue, or extension's voice-
mail. This topic describes how to redirect an incoming call that is in the ringing status.

Requirements

To redirect agents' incoming calls, make sure that you have been granted the Call distrib-
ution management (Redirect, Transfer, Drag and Drop operation) permission by the
system administrator.

Redirect a call to an extension

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.
3. Redirect the call to an extension user in one of the following methods:

» Drag the call and drop it on a desired agent displayed in Agent panel.

The agent will receive an incoming call.
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S Waiting Calls (1) & Agent (3/3) Q
Caller Callee Status Time Details 1025 1025

6400:John Snow [4444] 1025 1025 [1025] Ringing % 00:00:09 Internal Ringing Agent 1
] @ Loggedin

0 4

John Snow [4444] 6400 [6400] 00:00:09 Internal, Waiting in Queue

3 Active Calls (0) l& 30 @ Static Agents

Caller Callee Status Time Details 1

» Right click the call, and click Redirect.

On the pop-up panel, enter an extension number, and click .

The agent will receive an incoming call.

0 Tip:
You can also click the extension user from the matching results to
transfer the call.

Redirect

6401 g
R

6401
[External]

Redirect a call to extension voicemail

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.
2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.

3. Right click the incoming call, and select Redirect.
4. In the pop-up window, enter an extension number to search the extension user.

5. From the matching results, click @& to redirect the call.

The call is redirected to the extension's voicemail and the caller can leave a message
to the extension user.
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Redirect
3 33333333

Redirect a call to another ring group or queue

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.

3. Redirect the call to a ring group or a queue.

a. Right click the call, and click Redirect.
b. In the pop-up window, enter a ring group number or a queue number, and click

The system will route the call the ring group or queue.
Redirect

6401 g
R

6401
[External]

Transfer a Call

This topic describes how to transfer an active call.

Requirements

To transfer members' active calls, make sure that you have been granted the Call distrib-
ution management (Redirect, Transfer, Drag and Drop operation) permission by the
system administrator.
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Transfer a call to an agent

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el.
2. On the Active Calls panel, hover your mouse over an active call.
3. Transfer the call to an extension user in one of the following methods:

« Drag the call and drop it on a desired extension displayed in Agents panel.

The agent will receive an incoming call.

L Waiting Calls (1) & Agent (3/3) Q
Call Call Stat Ti Detaill
aller allee atus ime etails T s
Becky Lai [1001] 6400 [6400) Waiting 00:00:15 Internal Waiting in Queue 1
( ] ® Loggedin

4 39

’ 3333 3333
G Active Calls (2) N [z}iz 3 (] @ Static Agents
Caller Callee Status Time Details 20 .
®  5400:Becky [1000] 33333333 [3333] Talking 00:00:15 Internal
@ 6400Jchn Snow [4444] 1025 1025 [1025] Talking 00:00:28 Interna [} Nicole Liu
(= ® Loggedin

» Right click the call, click Transfer, and select a transferred party.
In the pop-up window, enter a target extension number, and click .

The system routes the call to the agent, the extension user will receive an in-
coming call.

6 Tip:

You can also click the extension user from the matching results to
transfer the call.

Transfer

.J James Blant =
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Transfer a call to an extension's voicemail

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.
. On the Active Calls panel, hover your mouse over an active call.

. Right click the call, and select Transfer.
. In the pop-up window, enter an extension nhumber to search the extension user.

aa b~ WON

. From the matching results, click ®® to transfer the call.

The system routes the call to the extension's voicemail. The caller can leave a mes-
sage to the selected extension user.

Transfer

Voicemail

@ Leo Ba - as
Yo 1y

Park a Call

Call parking is a method of holding a call on a phone, so that anyone can retrieve the call on
another phone. This topic describes how to park a call.

Requirements

To park agents' active calls, make sure that you have been granted the Call parking opera-
tion permission by the system administrator.

Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Active Calls panel, hover your mouse over an answered call.

3. Right click the answered call, and select Parked.

4. Select the parked party.
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The call is parked on an available parking number. The system puts the parked party's
call on hold, and plays a prompt to tell the other party where to retrieve the call.

&L waiting Calls (1)

Caller Callee Status Time Details
> Transfer
~ HangUp
(¥ Pause Recordi...
P Parked g John Snow [4444]
,,, .
S Active Calls (2) £\ Barge In
Caller Callee Status ) ist Details
{3 Listen
6400:Becky [10:00] 3333 3333 [3333] Talking Internz
7 Whisper
6400:)ohn Snow [4444] 1025 1025 [1025] Talking N Interna

Switch Call Recording Status

If administrator has enabled call recording for specific queues, the specified queue calls
would be recorded as soon as they are established. Being granted with specific recording
operation permissions, you can pause the call recording to avoid sensitive information be-
ing recorded. Moreover, you can start recording a queue call when necessary, even if it is
not a call specified to be recorded by administrator.

Requirements

» To switch call recording status for yourself, make sure that the Pause/Resume per-

mission or Start/Pause/Resume permission is assigned to your extension by the
system administrator.

Note:
- Pause/Resume permission allows you to pause or resume the record-
ing during a queue call that is specified to be recorded.
- Start/Pause/Resume permission allows you to start, pause, or re-
sume the recording during any queue calls, be the calls specified to be
recorded or not.
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« To switch call recording status for other agents, make sure that you have been grant-
ed the Switch agent's recording status permission by the system administrator.

Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el

2. On the Active Calls panel, hover your mouse over a call being recorded.

3. To pause recording, right click the call, and click Pause Recording.

ransfer »
~ Hang Up
S Active Calls (2)
() Pause Recordi...
Caller Callee Status Time @
®  5400:Becky [1000] 3333 32332 [3333) Talking 00:02:08 P Parked g
6400:4444 4444 [4444] 1025 1025 [1025] Talking 00:03:41 Internz
The recording icon stops flashing, and changes to 1]
4. To start or resume recording, right click the call, and click Recording.
+ Transfer
L Active Calls (2)
~ Hang Up
Caller Callee Status Details
@® Recording
5400:Becky1 [1000] 1025 1025 [1025] Talking @ Interna
P Parked
0 6400John Snow [4444] James Blant [3333] Talking Interna

The recording icon is changed to ® and flashing.

Monitor a Call

Call monitoring is the process of monitoring conversations between employees and cus-
tomers for improving communication and customer service. This topic describes how to
monitor a call.

Scenario

For sales and support in call center, call monitoring is a way to manage call quality, increase
agent efficiency, improve agent performance, and develop sales or marketing strategies.
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You can monitor agents' conversations in the following ways:

« Call listening: Listen to the active call between the agent and customer to ensure that
quality standards are met, without the agent or customer knowing.

- Call whispering: Talk to the agent, and give assistance to the agent during an active
call, without the customer hearing the discussion.

« Call barging: Join the call to speak with both the agent and customer, provide immedi-
ate assistance, and improve customer satisfaction.

Requirements

« You are queue manager.
- To monitor agents' calls, make sure that you have been granted the Call monitoring
operations (Listen, Whisper, Barge In) permission by the system administrator.

Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el.
2. On the Active Calls panel, hover your mouse over an active call.
3. Right click the call, and select a monitor mode: Barge In, Listen, or Whisper.

The system places a call to your extension.

S Waiting Calls (1)

Caller Callee Status Time Details
Becky3 [1007] 6400 [6400] e01:47 Internal Waiting in Queue
= Transfer
~ Hang Up
@ Pause Recordi..
P Parked
S Active Calls (2)

2% Barge In

Caller Callee Status ) Details
5 Listen J}"‘|

6400:Becky [1000] 3333 3333 [3333] Talking ~ Interna
B Whisper

6400:John Snow [4444] 1025 1025 [1025] Talking i Interna

4. Answer the call.
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Hang up a Call

This topic describes how to hang up a call.

Requirements

To hang up agents' calls, make sure that you have been granted the Allow for picking up
or hanging up agents' calls permission by the system administrator.

Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Waiting Calls or Active Calls panel, hover your mouse over a call.

3. Right click the call, and select Hang Up.

L2 Waiting Calls (1)

Caller Callee Status Time Details

6400:Becky [1000] 4444 4444 [4444] Ringing 00:00:16 Internal Ringing Agent

Becky [1000] 6400 [6400] s Internal Waiting in Queue
~ Hang Up @

4. In the pop-up dialog box, click OK.

The system ends the call.

Place a Call to an Agent

This topic describes how to place a call to an agent quickly on Call Center Console.
Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el

2. On the Agent panel, hover your mouse over the agent's avatar.
3. Double-click the avatar.

A call is placed to the agent, and a call window pops up that allows you to manage the
call.
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Manage Queue Call Logs

This topic describes how queue managers can view and manage the call logs of missed
queue calls on their Linkus Web Client, Desktop Client, and Mobile Client.

Requirements
» The firmware version of PBX serveris 37.18.0.1883.18.0.1884.18.0.18 or later.

« System administrator has granted you the viewing and deleting permission of missed
queue call logs.

Manage missed queue call logs on Linkus Web Client

1. Log in to Linkus Web Client, go to Call Logs > Queue Call Logs.
2. Optional: At the top of the list, filter or search the desired missed call logs.

Personal Call Logs Queue Call Logs

& Missed call v Al

Name Status Source Time Duration Call Notes ProcessingResult  Operations
Testcall
18852232258 (E . Missed call 6400 (6400) 04/18/2025 11:01:58 00:00:00 & Dealt v B oE

TestCall
1 X, Missed call 6400 (6400) 04/18/202510:43:23 00:00:00 Dealt W B e

Testcall
1885 58 (E . Missed call 6400 (6400) 04/18/2025 10:42:52 00:00:00 & Dealt v B oE

QO Total:3 ‘ 1 20/ page

3. Manage the missed queue call logs according to your needs.

Operation Instruction

Delete missed queue  You can delete missed queue call log via the following methods:
call logs ) ) @ )
» To delete a single call log, click beside the call log.
» To bulk delete call logs, select the checkboxes of the desired
missed call logs, then click Delete.
= Missed call v Al Y Q
Name Status Source Time Duration Call Notes Processing Result Operations'
T Twesm," 2258 (External % Missed call 6400 (6400) 04/18/202511:01:58  00:00:00 Dealt L B
Tes:‘ca»"' X Missed call 6400 (6400) 04/18/202510:43:23  00:00:00 Dealt - B
T r‘esmu 2258 (External . Missed call 6400 (6400) 04/18/202510:42:52  00:00:00 Dealt L B
o Toats < [1] 20/ pag
Place a call to the You can directly place a call from a call log via the following methods:
caller » Double click the desired call log.
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Operation Instruction

« Click & beside the call log.

Change the processing If you decide to handle a missed queue call, or you have handled it,
status of a missed you can change the processing status of the missed queue call.
queue call . Figure 1. Linkus Web Client

Name Status Source Time

1002
.]

sl o X, Missed call

Tech Support - USA (6401)  Yesterday 03:53:02 00:00:00

1002
1

oo . Missed call
© 1002 (Extension)

Tech Support - EU (6400) Yesterday 03:31:16 00:00:00

. Figure 2. Linkus Desktop Client

1002
1

1002 (Extension)

Queue:Tech Support - EU(6400) | f6.

&

f5. Not Deal

ort - USA(6401 | @ Dealing

1002 Dealt
1002 (Extension)

Queue:Tech Support - EU(6400)

a. Click the processing status beside the call log.
b. In the drop-down list, select the desired one.
The processing status is changed; All the authorized agents can see
the change, and check the operation record by hovering mouse over
the processing status.
. Figure 3. Linkus Web Client

Name Status Source Time

1002
1

. Missed call
© 1002

e Tech Support - USA (6401)  Yesterday 03:53:02
xtensior

. Figure 4. Linkus Desktop Client

Operator: Leo Ball(3000) ;

1002 Time of Operation: 12/14/2023 21:39:23

1002 (Extension)
Queue:Tech Support - EU(6400) |@

)

Manage missed queue call logs on Linkus Desktop Client

1. Log in to Linkus Desktop Client, go to Call Logs > Queue Call Logs.
2. Optional: At the top of the list, filter or search the desired missed call logs.

Duration  Processing Status

Operator: Leo Ball(3000) ;
Time of Operation: 12/16/2023 01:07:05

Operations

f %

Not Deal @

Dealing

Dealt

Yesterday 03:30:31
00:00:03

Yesterday 03:30:29
00:00:11

dperations

00:00:00 @ D jﬁ %
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Personal Call Logs Queue Call Logs

= Missed call v Al

All

Testcall 04/18/202511:01:58
! 00:00:00

04/18/2025 10:43:23
00:00:00

04/18/2025 10:42:52
00:00:00

3. Manage the missed queue call logs according to your needs.

Operation Instruction

Delete missed queue  You can delete missed queue call logs via the following methods:

call logs . . @ .
» To delete a single call log, click beside the call log.

* To bulk delete call logs, select the checkboxes of the desired
missed call logs, then click Delete.

= Missed call v Al T o
Al

TestCall 04/18/2025 11:G1:58
T

el Nurmber oodhoo

04/18/202510:43:23
00:00:00

04/18/202510:42:52
00:00:00

Check the details of You can conveniently check the source of the queue call logs, as well

queue call logs as the processing status of missed queue calls.
1002 03:31:16
1002 (Extension) 00:00:00

Queue:Tech Support - EU(6400) &

» Source: The queue the call came from.
» Processing Status: The processing status of a missed queue
call.

Place a call You can directly place a call from a call log via the following methods:
» Double click the desired call log.

» Hover your mouse over the call log, then click %.

1002
1002 (Extension)
Queue:Tech Support - EU(6400) @

Change the processing  If you decide to handle a missed queue call, or you have handled it,
status of a missed you can change the processing status of the missed queue call.
queue call

¢
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Operation Instruction

1002

1 1002 (Extension) -
Queue:Tech Support - EU(6400) | f8. &

5 1001 & Not Deal Yesterday 03:30:31
1001 (Extension) I _ 00:00:03
Queue:Tech Support - USA(6401 | @ Dealing
1002 Dealt Yesterday 03:30:29

1 1002 (Extension) 00:00:11

Queue:Tech Support - EU(6400)

a. Click the processing status beside the call log.
b. In the drop-down list, select the desired processing status.

The processing status is changed; All the authorized agents can see
the change, and check the operation record by hovering mouse over
the processing status.

Operator: Leo Ball(3000) ;
1002 Time of Operation: 12/14/2023 21:39:23
1002 (Extension) %
Queue:Tech Support - EU(6400) @ e

Manage missed queue call logs on Linkus Mobile Client

Requirements

Make sure that the version of your Linkus Mobile Client meets the following re-
guirements:

« Linkus iOS Client; Version 5.10.3 or later
« Linkus Android Client: Version 5.10.3 or later

Procedure

1. Log in to Linkus Mobile Client, go to Calls > Call Logs.
2. At the top-left corner, select Queue Missed Calls.
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All
Personal All Calls
" Personal Missed Calls

\
\Queue All Calls
\

N
Queue Missed Calls v

Queue Incoming Calls

3. Manage the missed queue call logs according to your needs.

Operation Instruction
Delete missed You can delete missed queue call logs as follows:
queue call logs * To delete a single call log, swipe left on the

desired call log, then tap Delete.
» To bulk delete call logs, do as follows:

16:12 ¢ 24 56 € 16:12 ¢ ! 56 €2 16:12 ¢ 222! 56 €D
I‘% 2 Calls Q + Cancel Delete Queue Call Logs Cancel Delete Queue Call Logs
Call Logs Voicemal Recordings Kristin Hale . Kristin Hale
° Extension ° i Extension
Queus Missed Calls v Ofaoeec] ° Kristin Hale o Kristin Hale
Extension i Extension
Kristin Hale vesday
Frensen ° Kristin Hale ) . Kristin Hale
Extension i Extension
Kristin Hale Tuesday @)
Extension Ashley Gardner o) . Ashley Gardner
Extension i Extension

Default DOD v
Once confirmed, all agents

Ashley Gardnel
shiey Gardner © | willno longer be able to view

Extension
the deleted missed call logs.
1 Ashley Gardner o | Are you sure you want to
ABC DEF Extension delete the selected data?
GHI KL MNO Extension .
Kristin Hale Kristin Hale
aRs T§v Wgz Extension o i Extension
Kristin Hale Kristin Hale
* 9 # Extension 9 . it Extension
Kristin Hale o) Kristin Hale
Extension i Extension
& Joe Lewis ~ & Joelewis
LN &= =] P Select Al © [pelete: 3| SelectAll Delete: 3

a. At the top-right corner, tap Delete.
b. Select the checkboxes of the desired
missed queue call logs.

c. Tap Delete.
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Operation Instruction

d. In the pop-up window, tap OK to confirm
your operation.

You can directly place a call from a call log by tapping the
call log.

5503301 10:56 M @

i External number |

Place a call to the
caller

Check the details  You can conveniently check the source of the queue call
of queue call logs logs, as well as the processing status of missed queue
calls.
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Instruction ‘

10:56 e
< Call History Details
5503301
iii External number @ 5503301
. - +

Processing

Call Video  Chat Email Add Status

2024-06-17 10:56:06 AM fB.Not Deal
Missed Call
iii Queue : Tech Support - EU (6400)

External number | Recently

a. Tap @ beside the desired queue call log.
b. Check the details of the call log.
» Source: The queue the call came from.
* Processing Status: The processing status
of a missed queue call.

Change the
processing status
of a missed queue
call

If you decide to handle a missed queue call, or you have
handled it, you can change the processing status of the
missed queue call.
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Operation

Instruction

< Call History Details

5503301

ili External number

Processing Result

f.Not Deal °

6 Not Deal

@ Dealing

Dealt

a. Tap @ beside the desired queue call log.
b. Tap the processing status beside the call log
details.
c. Select the desired processing status.
The processing status is changed; All the authorized
agents can see the change and check the operation
record.
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Operation Instruction

Processing Result

Call History Details

Operator: Kristin Hale(1001)
Operation Time: 2024/06/17 11:00:40

i Not Deal

© Dealing

Dealt

Agent Guide

Call Center Agent Guide

This guide provides guidance on how to manage your availability status in queues, and
process queue call interactions using a unified agent portal available on web, desktop, and

mobile devices.

Audience

This guide is intended for customer service representatives (agents) who handle inbound

voice calls from customers.

Agent portal

To enhance communication mobility and improve agent productivity, the Yeastar Call Center
provides a unified agent portal integrated into the Linkus UC Clients that is available on mo-
bile, desktop, and web-based platforms. Agents can efficiently handle queue calls anytime

anywhere through the supported clients.
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Supporte -
d Client Description

Linkus The Linkus Web Client and Desktop Client allow agents to access the call center
Web / functionalities from intuitive Call Center workspaces, Wallboard and Queue

Desktop  Panel, equipped with all the necessary tools for efficient call interaction and queue
Client management.

» For queue-related operational instructions for the agents using the Queue Panel,
see Agent operations on Web Client / Desktop Client.

« For operational instructions for agents with access to the Wallboard, see Call
Center Supervisor Guide.

» For more information about utilizing Linkus Web Client or Desktop Client, see
Linkus Web Client User Guide or Linkus Desktop Client User Guide.

Linkus Available as a mobile application, Linkus Mobile Client provides agents with access

Mobile to essential call features, allowing them to handle queue calls and update their

Client availability status from their mobile devices, ensuring that agents can stay connected and
responsive on the go.

» For queue-related operational instructions on Linkus Mobile Client, see Agent
operations on Mobile Client.

» For more information about utilizing Linkus Mobile Client, see Linkus Mobile Client
User Guide.

Agent Operations on Web Client / Desktop Client

Access and use Queue Panel

This topic describes how a queue agent can access and use Queue Panel on Linkus Web
Client or Desktop Client.

Requirements

» The firmware of PBX server is 37.19.0.70 or later.

« To access and use the Queue Panel on Linkus Web Client or Desktop Client, make
sure the following requirements are met.

Client Requirement

Linkus Web Client Make sure your web browser meet the following requirements.
> Google Chrome (recommended): Chrome 87 or later
> Microsoft Edge: Edge 87 or later
> Opera: Opera 72 or later


https://help.yeastar.com/en/p-series-linkus-appliance-edition/web-client-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/desktop-client-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/mobile-client-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/mobile-client-user-guide/about-this-guide.html
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Requirement

Linkus Desktop Client The version of Linkus Desktop Client is 1.13.1 or later

Procedure

1. Log in to Linkus Web Client or Desktop Client, go to Call Center Console > Queue
Panel.

2. If you belong to more than one queue, set the queue range to view the corresponding
statistics.

Queue Range Instruction

A specific queue Sales-eu [6401] v/

sale@us [6400]

sales-eu [6401]

Custom

a. At the top-left corner of the queue panel, click the current
queue.

b. In the drop-down queue list, select the desired queue.

A group of queues o

sales-eu [6401] v
All

sales-us [6400]
Queue Group Management

sales-eu [6401]

15[ Delete

* SLA Al
* Group Name * Queue Thresholad"(r“’/a) Operations Sort

80

sales-us [6400] X

o Sales sales-eu [6401] X 80 L2}

o + Add

0

a. At the top-left corner of the queue panel, click the current
queue.

b. In the drop-down queue list, select Custom.
c. In the pop-up window, click Add to add a queue group.
d. Configure a queue group.
- Group Name: Enter a name to help you identify the
queue group.
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Queue Range Instruction

« Queue: In the drop-down list, select the desired queues.
+ SLA Alarm Threshold (%): Specify the SLA rate before
an alert is triggered.
- Sort: Optional. Adjust the display order of the queue
group in the queue list.
e. Click Save.
f. In the drop-down queue list, select the queue group.

1 sales-eu [6401] Vv

All

“af  sales
salesﬁg [6400]

sales-eu [6401]

Custom

All queues

|| sales-eu [6401] Vv

All

-

Sales
sales-us [6400]

sales-eu [6401]

Custom

a. At the top-left corner of the queue panel, click the current
queue.
b. In the drop-down queue list, select All.

Note:

If you want to change the threshold of SLA for this
queue range, select Custom, then edit the rate in the
pop-up window.
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Queue Range

sales-eu [6401] v/

All
sales-us [6400]

sales-eu [6401]

Instruction

Queue Group Management

E[ Delete

*SLA Al
* Group Name * Queue arm Operations Sort
Threshold (%)

T C—

~+ Add

<) B

3. Select a time range.
 Today: View statistics of today.
» This Week: View statistics of this week.

 This Month: View statistics of this month.

Today

Today
This Week

This Month

4. Optional: Click ** to display queue panel in a separate browser window.

For example, display the queue panel of Service in a browser window; display the
queue panel of Sales in another browser window.
5. Check queue statistics and handle queue calls in the following panels.
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6400 [6400]v Today
100% 1 0 0 00:00:19 00:00:19 00:00:00
SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Auwerage Waiting Time Awerage Talking Time

&, gent (6/10) o =
RS Waiting Calls (1)
Keira Knightley
Caller Callee Status Time Details
® B Logged in 2024/06/26 142427
6400:Becky Lai [1001] 1024 1024 [1024] Ringing 00:00:03 Internal,Ringing Agent o . 0.0
o Becky Lai [1001] 6400 [6400] Waiting 00:00:03 Internal Waiting in Queue fnawered Hiased Tetal Tk

Audrey Hepburn

A
-- © @ statcagents
Waiting call panel u | UDUU

Answered Missed Total Talks

L3 Active Calls (1) 1003
Caller Callee Status Time Details R Y—
65400:1025 1025 [1025] 3333 3333 [3333] Talking 00:01:34 Internal 0 0 00:00

Answered Missed Total Talks

1006

Active call panel Agent panel

« Check queue data on the call statistics panel
 Check and manage calls on the waiting call panel

» Check and manage calls on the active call panel

» Check and manage agent status on the agent panel

Check queue data on the call statistics panel

You can check the call statistics of the specified range of queue(s).

[

sales-eu [6401] v Today PR
75% 3 1 0 00:00:13 00:00:10 00:00:42
SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Average Waiting Ti... Average Talking Ti...

To understand each metric, you can refer to the table below.

Call statistics Description

SLA Display the percentage of calls answered within the target response time
(SLA) for the queue(s).
Answered calls Display the total calls that queue agents answered over a period of time.
Abandoned Calls Display the total calls that have been abandoned over a period of time.
Tip:

You can click on the widget to view detailed information about related
call logs and manage the processing status.

Missed Calls Display the total calls that queue missed over a period of time.
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Call statistics Description

Tip:
You can click on the widget to view detailed information about related
call logs and manage the processing status.

Max Waiting Time Display the maximum call waiting time for all calls answered over a period of

time.
Average Waiting Display the average waiting time over a period of time for all queue calls.
Time
Average Talking Display the average talking time over a period of time for all queue calls.
Time

Check and manage calls on the waiting call panel

You can check the details of incoming call that is in ringing or waiting state in real time,
including caller, callee, queue, status, time, and details. You can also manage the calls as
needed.

Note:

The QCB indicates that the caller has requested a callback.

.". Yeastar = 8 ® B Ev AgentSttusv @ Availablev ¢ rotou system . (@) Q JoeLevisw
Rz Extensions
Support [6401] v Today
[ Contacts
25% 2 6 0 00:00:12 00:00:09 00:00:38
[= Chat SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Average Waiting Time Average Talking Time
=) Operator Panel Caller Callee Status Time Waiting ﬁ Leo Ball
00 Ringing \&,
€ Call Center Console N Terrell Smith [1002] Ringing 00:00:13 S \\{)O 2 Loggedont
Dave Harris [1003] Ringing 00:00:13 External Ringing Agent
Wallboard 0 0 00:00
Support [6401] Waiting 00:00:14 External Waiting in Queue Answered Missed Total Talks

Queue Panel

B callLogs @
1 Active Calls (0)

“CA® & Logged in 2024/09/12 16:06:45

Terrell Smith

Check and manage calls on the active call panel
You can check the details of answered calls in real time, including caller, callee, queue, sta-
tus, time, and details. You can also manage the calls as needed.

Note:

The QCB indicates that this is a callback.
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-'.. Yeastar = 82 @ B B AgentStatusv @ Availablev  Follow System v ° ? Joe Lewisv

R= Extensions
Support [6401] \/ Today

[ Contacts
35.7% 5 9 0 00:00:12 00:00:05 00:00:19

[= Chat SLA Answered Calls Abandoned Calls Missed Calls Max Waiting Time Average Waiting Time Average Talking Time

& Video Conferencing R Waiting Calls (0) & Agent (3/5) Q =

& Operator Panel Caller Callee Status Time Details Leo Ball

o)

63 Call Center Console A LU0 & Loggedount
Wallboard 0 0 00:00
Answered Missed Total Talks
Queue Panel
Terrell Smith
B callLogs @
S Active Calls (2 .
G Active Calls 2) |:/ ~® & Logged in 2024/09/12 16:06:45
ao Voicemails
Caller Callee Status Time Leo Ball [1000] 2 2 00:18
. Terrell Smith [1002] i
9 Recordings Joe Lewis [1005] Talking 00:00:09 errell Smith [1002] Answered Missed Total Talks
Dave Harris [1003]
_ Terrell Smith [1002] Talking 00:01:26 Dave Harris
Sa Preferences Joe Lewis [1005] @
Phillip Huff [1001] I

& static Agents
) Access Management Portal

Check and manage agent status on the agent panel

You can check the agent details in the queue(s), including the agent's presence, queue sta-
tus, and the agent's queue call statistics.

Agent's presence

To see an agent's presence status, hover your mouse over the presence icon.

&, Agent(2/3) Q

1025 1025
Busy

% @ Logged out

Queue Status

Icon Presence

:é The agent has logged in to the queue, and is available to receive a call.
1.6 The agent logged out of the queue.
‘0&. The agent has paused receiving the queue calls.

View Switch



Contact Center Guide | 2 - Inbound Call Center Guide | 141

By default, Standard View is displayed. You can click the View Switch button
to switch to the Compact View, which allows you to view and manage queue
agents more efficiently.

Standard View Compact View

Today @ || Today [CHRIT
00:00:00 00:00:00 00:00:00 MO:OO:OD
Average Waiting Time Average Talking Time r -------- A-u e;g-e VVaErE‘F veTag-E T-a\zn;‘;m: - -=
D | |
&, Agent Q A, Agent Q
Sales-us [6400] (1/4) ~ Sales-us [6400] (1/4) ~
Sales-eu [6401] (4/5) Sales-eu [6401] (4/5) Expand/Collapse Group
JdekWilson™ — T T el ™ ~ ™ 12k wilson-1000
100 . 0 0 00:00

(] Iﬁ Logged in 2025/04/25 u9:27.52|
Emily Parker-1001

0 0 00:00 & 2[00 o000
Answered Missed Total Talks
[ —————— Call Statistics ¥ S —
Sarah Bennett 1002

. 1
Emily Parker £ 0 0 00:00
1 1
asiatchgemsl I David Miller-1003
& 0 0 00:00
0 0 00:00
Answered Missed Total Talks Kevin Thompson-3001

Sarah Bennett

1002
TR === mmmmm e --

1
1
1
& & 0 0 00:00
:
1
1

0 0 00:00
Answered Missed Total Talks
David Miller
o

Search and Filter

You can search and filter from the list using the following options to find the
desired agents quickly and efficiently.
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Option Description

Search the specific agent.
g) Filter and display only online agents that meet with both of the
1Y

following conditions:

» The extension status is online, meaning it is logged in to a
Linkus client, or registered on an endpoint.
» The agent status is set to Log In, Unpause, or Pause.
Manage Agent Status

Manage Your Status in Queues

As an agent of a queue or multiple queues, you can change your own status in a specific
queue or in all queues on Linkus Web Client or Desktop Client. This topic describes how to
log in to and out of queues, pause and unpause queue calls.

Log in to queues

Note:

This operation is only available for dynamic agents.

Login to all queues
You can log in to all queues by either of the following methods:

Method Instruction

Login to all
queues from g¢ @ [ B v |AgentStatusv| @ Availablev i Default DOD v ° a Kristin Hale v
Toolbar

& Logln Switch All Queues Status To > Q. H =

& Support{6401]

@ Phillip & 6402[6402) ’\r Terrell Smith-1002
Q@ & B 1 /.\ L9 ™ @

1. In the top navigation bar of Linkus Web Client or Desktop
Client, click Agent Status.
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Method Instruction

2. Hover your mouse over Switch All Queue Status To.

3. Click Log In.
Log in to all 1. Obtain the Log In to All Queues feature code from the
queues using system administrator.
feature code 2. Dial the feature code.

For example, if the feature code is * 77, simply dial *77 to
log in to all queues you are assigned to.

Log in to all previously logged-in queues

You can log in to all queues you were previously logged in to by either of the
following methods, without needing to select each queue manually.

Method Instruction

Log in to last
logged-in queues 8% [ B3V |AgentStatusv | @ Availablev g ° e Leo Ballv
from Toolbar

&% Pause > Switch All Queues Status To > Q HS =

% Unpause

& LoglIn &, Customer Sejvice [6400] >

& Login to Last Queues © & Pre-Sales [6401] >

@ 1 & ViPcustomer [6402] > LW K @A
& Log Out

—_

. In the top navigation bar of Linkus Web Client or
Desktop Client, click Agent Status.

2. Hover your mouse over Switch All Queue Status To.

3. Click Log in to Last Queues.

Login to last 1. Obtain the Log in to Last Queues feature code from
logged-in queues the system administrator.
using feature code 2. Dial the feature code.

For example, if the feature code is * 78, simply dial * 78 to
log in to all queues you previously logged in to.

Log in to a specific queue

You can log in to a specific queue by any of the following methods:



Contact Center Guide | 2 - Inbound Call Center Guide | 144

Method Instruction
L

og in to a specific
queue from Toolbar B @ B By |Agenstausy | @ Avalablev “ @ @ neomiv

Switch All Queues Status To > Q HS BN

& 6400 [6400] @ > 13

% Loglin @
@ Available £ 6401 [6401] 5 Jnavailable AV I I

1. In the top navigation bar of Linkus Web Client or
Desktop Client, click Agent Status.
2. Hover your mouse over the desired queue.

3. Click Log In.
Log in to a specific 1. In the Linkus Web Client or Desktop Client, go to Call
queue from Queue Center Console > Queue Panel.
Panel 2. In the top-left corner of the Queue Panel, select a

desired queue.

6400 [6400]% Today
SR 2 1 0 00:00:17 00:00:10 00:00:09
6401 [6401] Answered Calls Abandoned Cal... Missed Calls Max Waiting Ti... Average Waitin... Average Talkin.
L. Waiting Calls (0) & Agent (3/7)
3. On the Agent panel, hover your mouse over your
extension and change the status.
Kristin Hale
K
o & Logged %t'\‘lfﬂ'l.-‘iﬂﬂ 225..
1 & Loglin '
Answered ks
a. Click the agent status.
b. Click Log In.
Log in to a specific 1. Obtain the Log in/Log out feature code from the system
queue using administrator.
feature code 2. Dial the feature code.
For example, if the feature code is *7, to log in to queue
6400, simply dial * 76400.
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Log out of queues

Note:

This operation is only available for dynamic agents.

Log out of all queues

You can log out of all queues by either of the following methods:

Method Instruction

Log out of all ,
queues from B e B v |Agent Statusv | @ Availablev i Default DOD v o a Kristin Hale v
Toolbar
% Pause > Switch All Queues Status To > Q i =
&£ LogOut

@ & Support{6401]

@ Phillip ~ & 6402[6402] 5 Terrell Smith-1002
@ W W A - b 1 LG (| (e

1. In the top navigation bar of Linkus Web Client or
Desktop Client, click Agent Status.

2. Hover your mouse over Switch All Queue Status To.

3. Click Log Out.

Log out of all 1. Obtain the Log Out of All Queues feature code from
queues using the system administrator.
feature code 2. Dial the feature code.

For example, if the feature code is *077, simply dial
*077 to log out of all queues you are assigned.

Log out of a specific queue

You can log out of a specific queue by any of the following methods:
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og out of a specific
queue from Toolbar

Log out of a specific
queue from Queue
Panel

Log out of a specific
queue using feature
code

Method Instruction
L

B @ [ BEv |AgentStatusv| @ Availablev
Switch All Queues Status To
& Pause > & 6400 [6400] @ > -
Jnavailable

& 6401 [6401]

K n Logom{}j

1. In the top navigation bar of Linkus Web Client or

Desktop Client, click Agent Status.
2. Hover your mouse over the desired queue.
3. Click Log Out.

1. In the Linkus Web Client or Desktop Client, go to Call
Center Console > Queue Panel.

2. In the top-left corner of the Queue Panel, select a
desired queue.

6400 [6400]
&b

6400 [6400] 2 1 0

Abandoned Cal... Missed Calls

00:00:17

Answered Calls Max Waiting Ti...

6401 [6401]

L. Waiting Calls (0)

3. On the Agent panel, hover your mouse over your
extension and change the status.

Kristin Hale
K
o & Logged in@'ﬂ'l;‘ﬂ:ﬂ 225..
__1 & Pause : )
Answered ks
& Log Out <

wave riania

a. Click the agent status.
b. Click Log Out.

1. Obtain the Log in/Log out feature code from the
system administrator.
2. Dial the feature code.

For example, if the feature code is * 7, to log out of
queue 6400, simply dial * 76400.

Qa8
L@

Today
00:00:10
Average Waitin...

&. Agent (3/7)

00:00:09

Average Talkin.



Pause queue calls
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As a queue agent (be it static or dynamic), you can pause receiving the queue calls when
you are away from desk. The queue will not distribute calls to you after you pause queue

calls.

Pause service in all queues

O] B v |Agent Statusv| @ Availablev

w  Lunch & Pause >
Break & Log Out
Wrap-up

3 Leo Ball-1000

<

Mo « m m

i Default DOD v ° a Kristin Halev

Switch All Queues Status To > Q Hy =

& Suppor{6401]

-

@ Phillip & 6402 [6402] g/‘ Terrell Smith-1002
® L W @ - "~\.I1lﬂ'"

1. In the top navigation bar of Linkus Web Client or Desktop Client, click

Agent Status.

2. Hover your mouse over Switch All Queue Status To.

3. Click Pause.

4. Optional: In the pause reason list, select a specific reason.

Pause service in a specific queue

You can pause service in a specific queue by any of the following methods:

Method

Pause service in a specific
queue from Toolbar

Lunch

Break

w

Wrap up

. In the top navigation bar of Linkus Web Client or

. Hover your mouse over the desired queue.

. Click Pause.
. Optional: In the pause reason list, select a

Instruction

88 @ [ B v |AgentStatusv | @ Availablev

Switch All Queues Status To

& Pause > & 6400 [6400] 3

M 8 Logout £ 6401 [6401] 5 Jnavailable
1006 1007

x @ - Unavailable LA - Unavailable

Desktop Client, click Agent Status.

specific reason.

O

Lo

@ @rem

H
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Instruction

Pause service in a specific
queue from Queue Panel

Pause service in a specific
queue using feature code

. On the Agent panel, hover your mouse over your

. Obtain the Pause/Unpause feature code and the

. Dial the feature code.

1. In the Linkus Web Client or Desktop Client, go to

Call Center Console > Queue Panel.

. In the top-left corner of the Queue Panel, select a

desired queue.

6400 [6400]
O

6400 [6400] 2 1 0 00:00:17

6401 [6401] Answered Calls Abandoned Cal... Missed Calls Max Waiting Ti...

L Waiting Calls (0)

extension and change the status.

Kristin Hale

K
o & Loggedin11/01/242222:5_.  §

1 )
Lunch & Pause > [‘
¥ ik

Break & LogOut

varc rams

Wrap up
a. Click the agent status.
b. Click Pause.
c. Optional: In the pause reason list, select
a specific reason.

Pause Reason feature codes from the system
administrator.

For example, if the Pause/Unpause feature
code is *07, to pause service in queue 6400, do
as follows:
« To directly pause without reason, dial
*076400.
» To pause with specific reason, dial
*076400 plus the pause reason feature
code, e.g. *076400*03.

Unpause queue calls

As a queue agent (be it static or dynamic), you can resume receiving queue calls when you

are ready to take a call.

Unpause service in all queues

Today

00:00:10

Average Waitin...

& Agent (3/7)

00

Avel



Contact Center Guide | 2 - Inbound Call Center Guide | 149

gt @ [ B v |AgentStatusv] @ Availablev it Default DOD v ° a Kristin Hale v
&% Pause > Switch All Queues Status To > Q Hy =
& Unpause
& Log Out & Support[6401]

Phillip @ Terrell Smith-1002
& 6402[6402] k’/
@ L u | /A L M B

1. In the top navigation bar of Linkus Web Client or Desktop Client, click

Agent Status.
2. Hover your mouse over Switch All Queue Status To.
3. Click Unpause.

Unpause service in a specific queue

You can unpause service in a specific queue by any of the following methods:

Method Instruction

Unpause service in a
specific queue from Toolbar B2 @ [ Bv |Agentstatusv| @ Availablev
Switch All Queues Status To
& Pause > & 6400 [6400] @ b
B & Unpause @ Jnavailable
& Log Out &5~ 6401 [6401] > )7
[ I I Unavailable W @ e & Unavailable
1. In the top navigation bar of Linkus Web Client or
Desktop Client, click Agent Status.
2. Hover your mouse over the desired queue.
3. Click Unpause.
Unpause service in a 1. In the Web Client or Desktop Client, go to Call
specific queue from Queue Center Console > Queue Panel.
Panel 2. In the top-left corner of the Queue Panel, select
a desired queue.
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Method Instruction

6400 [6400]y
&

6400 [6400] 2 1

6401 [6401] Answered Calls Abandoned Cal...

&S Waiting Calls (0)

Kristin Hale

K

@ P Paused @

0 & Pause

& Unpause 4

& Log Out

a. Click the agent status.
b. Click Unpause.

0

Missed Calls

3. On the Agent panel, hover your mouse over
your extension and change the status.

1lKs

Unpause service in a 1. Obtain the Pause/Unpause feature code from
specific queue using the system administrator.
feature code 2. Dial the feature code.

For example, if the feature code is *07, to
unpause service in queue 6400, dial *076400.

Related information
Automatically Switch Agent Status Based on Extension Presence

00:00:17

Max Waiting Ti...

Automatically Switch Agent Status Based on Extension Presence

This topic describes how to set your agent status to automatically change along with your

extension presence on Linkus Web Client or Desktop Client.

Procedure

1. Log in to Linkus Web Client or Desktop Client, go to Preferences > Presence.

2. On the status bar, select a presence status to edit.

Today

00:00:10

Average Waitin...

& Agent (3/7)

0
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User Presence Voicemail Audio & Video Features Function Keys

‘ Available Away Business Trip Do Not Disturb Lunch Break Off Work

Avaiable Now!

3. Scroll down to the Options section, then select an action in the Agent Status Auto
Switch drop-down list.

Option Description

Log In When your extension changes to the presence status, you will automatically log
in to all the queues to which you belong.
» Dynamic agent: Log in to the queues.
- Static agent: Resume receiving calls from the queues.

Login When your extension changes to the presence status, you will automatically log
to Last in to all previously logged-in queues.
Queues » Dynamic agent: Log in to the queues.

- Static agent: Resume receiving calls from the queues.

Log Out When your extension changes to the presence status, you will automatically log
out from all the queues to which you belong.

Note:
The logout operation is only available for dynamic agent.

Pause When your extension changes to the presence status, you will automatically
pause receiving queue calls.

Note:

You can select a specific pause reason in the Pause Reason drop-down
list.

Agent Status Auto Switch

Pause Lunch

Do Nothing When your extension changes to the presence status, your agent status in the
queues remains unaffected.

4. To configure the agent status auto-switch for more presence status, repeat Step 2 - 3.
5. Click Save.
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Handle Queue Calls on Queue Panel

Pick up a Call

If a call is ringing and has not been answered for a long time, in order to save the callers'
user's waiting time, you can pick up the ringing call. This topic describes how to pick up a
ringing call.

Requirements
To pick up agents' incoming calls, make sure that you have been granted the Allow for

picking up or hanging up agents' calls permission by the system administrator.

Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.

3. Right click the incoming call, and select Pick Up.

The PBX system routes the call to your extension.

S Waiting Calls (1)

Caller Callee Status Time Details
6400:Backy [1000] 1025 1025 [1025] Ringing 00:00:15
= Redirect
Becky [1000] 6400 [6400] 00:00:29
~ Hang Up

i 3@U:

4. Answer the call.

Redirect a Call

If a call has not been answered for a long time, in order to save the caller's waiting time, you
can redirect the incoming call to another extension, ring group, queue, or extension's voice-
mail. This topic describes how to redirect an incoming call that is in the ringing status.
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Requirements

To redirect agents' incoming calls, make sure that you have been granted the Call distrib-
ution management (Redirect, Transfer, Drag and Drop operation) permission by the
system administrator.

Redirect a call to an extension

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el

2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.
3. Redirect the call to an extension user in one of the following methods:

» Drag the call and drop it on a desired agent displayed in Agent panel.

The agent will receive an incoming call.

% Waiting Calls (1) & Agent (3/3)
Caller Callee Status Time Details 025 10
6400:John Snow [4444] 1025 1025 [1025] Ringing % 00:00:09 Internal Ringing Agent 1
, _ L ® [ ged
John Snow [4444] 6400 [6400] 00:00:09 Internal, Waiting in Queue
0 4 00:00
Ans otal Tal
|
%3 Active Calls (0) l& (] @ Static Agents

Caller Callee Status Time Details 1

» Right click the call, and click Redirect.

On the pop-up panel, enter an extension number, and click .

The agent will receive an incoming call.

0 Tip:
You can also click the extension user from the matching results to
transfer the call.

Redirect

6401 E
A

6401
[External]
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Redirect a call to extension voicemail

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.
2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.

3. Right click the incoming call, and select Redirect.
4. In the pop-up window, enter an extension number to search the extension user.

5. From the matching results, click @& to redirect the call.

The call is redirected to the extension's voicemail and the caller can leave a message
to the extension user.

Redirect
3 33333333

Redirect a call to another ring group or queue

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el.
2. On the Waiting Calls panel, hover your mouse over a call that is in Ringing status.
3. Redirect the call to a ring group or a queue.
a. Right click the call, and click Redirect.
b. In the pop-up window, enter a ring group number or a queue number, and click

The system will route the call the ring group or queue.

Redirect

6401| g
A

6401
[External]



Transfer a Call

This topic describes how to transfer an active call.

Requirements
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To transfer members' active calls, make sure that you have been granted the Call distrib-
ution management (Redirect, Transfer, Drag and Drop operation) permission by the

system administrator.

Transfer a call to an agent

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-

el.

2. On the Active Calls panel, hover your mouse over an active call.
3. Transfer the call to an extension user in one of the following methods:

« Drag the call and drop it on a desired extension displayed in Agents panel.

The agent will receive an incoming call.

S Waiting Calls (1)
Caller

Becky Lai [1001]

Q Active Calls (2)
Caller
®  6400:Becky [1000]

®  5400J0hn Snow [4444]

Callee

6400 [6400]

Callee
3333 3333 [3333]

1025 1025 [1025]

Status

Status
Talking

Talking

& Agent (3/3)

Time Details 1025 1025

00:00:15 Internal Waiting in Queue 1
[ ] ® Lloggedin
4 39 21:38

’ 3333 3333

Time Details

00:00:15 Interna

[z}iz 3. @ Static Agents

00:00:28 Interna [} Nicole Liu

N

(2] ® Loggedin

« Right click the call, click Transfer, and select a transferred party.

In the pop-up window, enter a target extension number, and click .

The system routes the call to the agent, the extension user will receive an in-

coming call.

6 Tip:

You can also click the extension user from the matching results to
transfer the call.
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Transfer

J James Blant —

Transfer a call to an extension's voicemail

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.
. On the Active Calls panel, hover your mouse over an active call.

. Right click the call, and select Transfer.
. In the pop-up window, enter an extension humber to search the extension user.

a b~ WOWN

. From the matching results, click ®® to transfer the call.

The system routes the call to the extension's voicemail. The caller can leave a mes-
sage to the selected extension user.

Transfer

Voicernail

@ Leo Ba 1000 an
Yo T Y

Park a Call

Call parking is a method of holding a call on a phone, so that anyone can retrieve the call on
another phone. This topic describes how to park a call.

Requirements

To park agents' active calls, make sure that you have been granted the Call parking opera-
tion permission by the system administrator.
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Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Active Calls panel, hover your mouse over an answered call.

3. Right click the answered call, and select Parked.

4. Select the parked party.

The call is parked on an available parking number. The system puts the parked party's
call on hold, and plays a prompt to tell the other party where to retrieve the call.

%S Waiting Calls (1)

Caller Callee Status Time Details

* Transfer
~ HangUp

(® Pause Recordi...

P Parked g John Snow [4444]
- )
L3 Active Calls (2) £ Bargeln

Caller Callee Status ) ) Details
¢y Listen

6400:Becky [10:00] 3333 3333 [3333] Talking Interna
& Whisper

6400:)ohn Snow [4444] 1025 1025 [1025] Talking SR Interna

Hang up a Call

This topic describes how to hang up a call.

Requirements

To hang up agents' calls, make sure that you have been granted the Allow for picking up
or hanging up agents' calls permission by the system administrator.

Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Waiting Calls or Active Calls panel, hover your mouse over a call.

3. Right click the call, and select Hang Up.
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% Waiting Calls (1)

Caller Callee Status Time Details

6400:Becky [1000] 4444 4444 [4444] Ringing 00:00:16 Internal Ringing Agent

Becky [1000] 6400 [6400] cmom e Internal Waiting in Queue
~ Hang Up @

4. In the pop-up dialog box, click OK.

The system ends the call.

Place a Call to an Agent

This topic describes how to place a call to an agent quickly on Call Center Console.

Procedure

1. In the Linkus Web Client or Desktop Client, go to Call Center Console > Queue Pan-
el.

2. On the Agent panel, hover your mouse over the agent's avatar.
3. Double-click the avatar.

A call is placed to the agent, and a call window pops up that allows you to manage the
call.

Add Notes to a Call

This topic describes how to add notes during a queue call or in the wrap-up time to capture
important details for future reference.

Requirements

« The firmware of the PBX server is version 37.18.0.102 or later
- System administrator has configured call disposition codes on server, and granted
you the permission to use call note feature.

Add call notes in-call
During a queue call, you can add call notes to capture essential information or decision
made in the conversation.
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1. During an active call, click Call Notes to open the call note panel.

5503301 | 5503301 | E2 Call Notes |

Call Notes

Select Call Disposition
ENEN

N
\‘~.
S

5503301

00:00:22

5503301 | 5503301 (2 Call Notes

Call Notes %

. Transferred to Another Department X

User encountered xxx issue, needs
resolution from the tech support
depariment.

5503301

00:02:11

a. In the Select Call Disposition drop-down list, select a disposition code.

b. In the Remark field, enter short descriptions to note down essential information
for the call.

c. Click Save.
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An "Edited Successfully" prompt pops up, indicating that call note is saved suc-

cessfully.

Note:

You can modify and save the notes multiple times before the call ends.

Add call notes in wrap-up time
When you finish a queue call and enter the wrap-up time, a call note panel will appear, where

you can add or edit call notes.

Note:

After call, you can check and edit call notes in the corresponding call log. For more
information, see Manage Queue Call Logs.

9,
7¢ Yeastar

Q: Extensions

6400 [6400] V/
[ Contacts

100% 6
[ Chat SLA Answered Calls

Bl Video Conferencing & Waiting Calls (0)

6 Call Center Console N Caller
Wallboard
Queue Panel

B callLogs

Qo Voicemails (12]

@ Recordings

s Preferences & Active Calls (0)

Caller
£ Chrome Extension °

O Access Management Portal

Missed Calls
Time
Time

88 ® [ BV AgentStatusv @ Availablev

o e Madison Cooperv

Today

00:00:13

Average Talking Time

00:00:24

Max Waiting Time

00:00:08

Average Waiting Time

& Agent (2/3) Q =
Detail Carmen Gordon
© g static agents
2 00:12
swered s Total Taks
Madison Cooper
M
Call Notes(5503301) X
Warp-up Time: 00:00:25
Detail

Tech Support Provided

Customer's issue has been resolved.

1. In the Select Call Disposition drop-down list, select a disposition code.
2. In the Remark field, enter short descriptions to note down essential information for

the call.
3. Click Save.
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Manage Queue Call Logs

This topic describes how to check and manage the queue call logs on Linkus Web Client or
Desktop Client.

Requirements

System administrator has granted you the viewing permission of queue call logs.

Procedure

1. Log in to Linkus Web Client or Desktop Client, go to Call Logs > Queue Call Logs.
2. Optional: At the top of the list, filter or search the desired call logs.

. Figure 5. Linkus Web Client
igure 5. Lin ien
= anv Last 7 days
Name Status Source Time Duration Call Notes Processing Result Operations
N N . Missed call 6400 (6400) Yesterday 08:29:25 00:00:00 B Not Deal v B

Ce c“""e”s‘"f’“'ﬂ X, Incoming call 6400 (6400) Tuesday 14:59:35 000046  Callback B @
) Carmen Goréon L ncoming cal 6400 (6400) Tuesdey 133733 000009 Techsupp. v BE
. - -
. Figure 6. Linkus Desktop Client

3. Manage the call logs according to your needs.

Operation Instruction
Check the details of You can conveniently check the source of the queue call logs, as well
queue call logs as the processing status of missed queue calls.
. Figure 7. Linkus Web Client
Name Status Source Time Duration Call Notes
K° 'f{'f""ri‘ N . Missed call (Céfu'g;"e'su"”" Yesterday 13:08:09  00:00:00
. Figure 8. Linkus Desktop Client ‘
1002
1 002 (Extension)
Queue:Tech Support - EU(6400) 6

Processing Result

£ Not Dealt

Operations

S B

03:31:1¢
00:00:0t
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Operation Instruction

Where Source indicates the queue the call came from, and
Processing Status indicates the processing status of a missed
queue call.

Check and edit call You can check or edit the call notes for a call in the corresponding

notes call log.
. Figure 9. Linkus Web Client

Name Status Source Time Duration Gall Notes Processin gResult  Operations

& o . . Incoming call 6400 (6400) Call Notes « Trantor. %

s

e xx
support department

n-2025/03/04 16:47:36

x concel [T

. Figure 10. Linkus Desktop Client

5503301
(External Number) LB E
Transferr. Call Notes X

Transferred to Another Department X
User encountered xxx issue, needs resolution from the

tech support department.

Carmen Gordon - 2025/03/05 13:50:43

X Cancel

a. Click @ beside the desired call log.
b. In the call note panel, edit the information as needed, then

click Save.

Place a call to the You can directly place a call from a call log via the following methods:
caller » Double click the desired call log.

* Click % beside the call log.

Change the processing If you decide to handle a missed queue call, or you have handled it,
status of a missed you can change the processing status of the missed queue call.
queue call . Figure 11. Linkus Web Client

Name Status Source Time Duration  Processing Status  Operations

1002
— issed cal ‘ech Support - ‘esterday 03: K
1 1002 (Extension UM d call Tech Si t- USA (6401) Yesterday 03:53:02 00:00:00 | 'S
@ 1002 (Extension) @
Not Deal

1002 li
1 o 1002 (Extension)  Missedcall  TechSupport-EU(6400)  Yesterday0331:16  00:00:00 | > %
o Dealt
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Operation Instruction
. Figure 12. Linkus Desktop Client
1002
1 1002 (Extension) %
Queue:Tech Support - EU(6400) | f8 &
1 1007 & Not Deal Yesterday 03:30:31
1007 (Extension) I 00:00:03
Queue:Tech Support - USA(6401 | @ Dealing
1002 Dealt Yesterday 03:30:29
2 002 (Extension) - 00:00:11
Queue:Tech Support - EU(6400)
a. Click the processing status beside the call log.
b. In the drop-down list, select the desired one.
The processing status is changed; All the authorized agents can see
the change, and check the operation record by hovering mouse over
the processing status.
. Figure 13. Linkus Web Client
Name Status Source Time Operator: Leo Ball(3000) ; )perations
Time of Operation: 12/16/2023 01:07:05
10 Egi‘ble%w . Missed call Tech Support - USA (6401) Yesterday 03:53:02 00:00:00 @ [T‘rﬂjm %
. Figure 14. Linkus Desktop Client
; Operator: Leo Ball(3000) ;
1002 Time of Operation: 12/14/2023 21:39:23
1 1002 (Extension) %
Queue:Tech Support - EU(6400) |©®
3
Delete incoming queue 5
72 Note:
call logs
Only supports to delete the call logs of queue calls that you
have answered.
You can delete incoming queue call logs via the following methods:
» To delete a single call log, click @ beside the call log.
» To bulk delete call logs, select the checkboxes of the desired
incoming call logs, then click Delete.
° Figure 15. Linkus Web Client
= Missed call v Al Q
Name Status Source Time Duration Call Notes

T . Missed call 6400 (6400) 04/18/2025 11:01:58 00:00:00
T . Missed call 6400 (6400) 04/18/2025 10:43:23 00:00:00
T . Missed call 6400 (6400) 04/18/2025 10:42:52 00:00:00
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Operation Instruction

Figure 16. Linkus Desktop Client

Personal Call Logs Queue Call Logs

= Incoming call v

® Al
_ Ashley Gardner
Jueue: 6404 (6404

Ashley Gard

iner
Q‘ 1009 (Exte
Queue: 6404 (6404,

Agent Operations on Mobile Client
Manage Agent Status

Manage Your Status in Queues

As an agent of a queue or multiple queues, you can change your own status in a specific
gueue or in all queues on Linkus Mobile Client. This topic describes how to log in to and out
of queues, pause and unpause queue calls.

Requirements
Make sure that the version of your Linkus Mobile Client meets the following requirements:

« Linkus iOS Client: Version 5.12.4 or later
« Linkus Android Client: Version 5.12.3 or later

Log in to queues

Note:

This operation is only available for dynamic agents.

Login to all queues

You can log in to all queues by either of the following methods:
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Method Instruction

Log in to all queues
via the mobile R
interface < R (3)
Log In ‘ e
& 6401[6401]
& sales [6403]
. . . [ )]
1. At the top-left corner of Linkus Mobile Client, tap a
beside your account.
You are redirected to the Agent Status page.
2. In the Switch All Queues Status To section, tap
Log In.
3. At the top-right corner, tap Done.
Log in to all queues 1. Obtain the Log In to All Queues feature code from
using feature code the system administrator.
2. Dial the feature code.
For example, if the feature code is * 77, simply dial
*77 to log in to all queues you are assigned to.

Login to all previously logged-in queues

You can log in to all queues you were previously logged in to by either of the
following methods, without needing to select each queue manually.
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Method Instruction

Log in to last logged-in
queues via the mobile
in te rface < | Agent Status e
e e | ©
Log In
Log Out
Pause
& Customer Service [6400]
& Pre-Sales [6401]
& VIP customer [6402]
. . . @)
1. At the top-left corner of Linkus Mobile Client, tap
beside your account.
You are redirected to the Agent Status page.
2. In the Switch All Queues Status To section, tap Log
in to Last Queues.
3. At the top-right corner, tap Done.
Log in to last logged-in 1. Obtain the Log in to Last Queues feature code from
queues using feature the system administrator.
code 2. Dial the feature code.
For example, if the feature code is * 78, simply dial
*78 to log in to all queues you previously logged in to.

Log in to a specific queue

You can log in to a specific queue by any of the following methods:
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Method Instruction

6400 [6400]

Log out of queues

Note:

This operation is only available for dynamic agents.

Log out of all queues

You can log out of all queues by either of the following methods:

Log nt0 a specif YY) (T
queue via the mobile
< Agent Status Done <
interface Switch All Queues Status To Switch Status To
Log In __.| LogIn
Log Out
Resume
Pause
& 6400 [6400] @ ,,,E
& 6401[6401]
& 6404 [6404]
. . . [ )
1. At the top-left corner of Linkus Mobile Client, tap @
beside your account.
You are redirected to the Agent Status page.
2. Tap the desired queue, then tap Log In.
3. At the top-right corner, tap Done.
Log in to a specific 1. Obtain the Log in/Log out feature code from the
queue using feature system administrator.
code 2. Dial the feature code.
For example, if the feature code is *7, to log in to
queue 6400, simply dial *76400.
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Method Instruction

Log out of all
queues via the
mobile interface

< Agent Status e

Switch All Queues Status To
‘ Log Out ‘ 9

Pause

Inbound Queue
& 6401[6401]
Outbound Queue

& sales [6403]

[ )]
1. At the top-left corner of Linkus Mobile Client, tap
beside your account.

You are redirected to the Agent Status page.

2. In the Switch All Queues Status To section, tap Log
Out.

3. At the top-right corner, tap Done.

Log out of all 1. Obtain the Log Out of All Queues feature code from
queues using the system administrator.
feature code 2. Dial the feature code.

For example, if the feature code is *077, simply dial
*077 to log out of all queues you are assigned.

Log out of a specific queue

You can log out of a specific queue by any of the following methods:
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Instruction

Log out of a specific
queue via the mobile
< Agent Status Done < 6400 [6400]
Interface Switch All Queues Status To Switch Status To
Log Out - Log Out
Resume i Pause
Pause
& 6400 [6400] @
&b 6401[6401]
& 6404 [6404]
. . . [ )]
1. At the top-left corner of Linkus Mobile Client, tap a
beside your account.
You are redirected to the Agent Status page.
2. Tap the desired queue, then tap Log out.
3. At the top-right corner, tap Done.
Log out of a specific 1. Obtain the Log in/Log out feature code from the
queue using feature system administrator.
code 2. Dial the feature code.
For example, if the feature code is * 7, to log out of
queue 6400, simply dial * 76400.

Pause queue calls

As a queue agent (be it static or dynamic), you can pause receiving queue calls when you
are unavailable. The queue will not distribute calls to you after you pause queue calls.

Pause service in all queues
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< Agent Status o

Switch All Queues Status To

Log Out

Resume

Pause v e
Pause Reason

Lunch

Break

Wrap up v e

Inbound Queue

& 6401[6401]
Time : 00:03
Pause Reason : Wrap up

Outbound Queue

& Sales [6403]
Time : 00:03
Pause Reason : Wrap up

1. At the top-left corner of Linkus Mobile Client, tap -3 beside your ac-
count.

You are redirected to the Agent Status page.
2. In the Switch Status To section, tap Pause.
3. Optional: In the Pause Reason section, select a specific reason.
4. At the top-right corner, tap Done.

Pause service in a specific queue

You can pause service in a specific queue by any of the following methods:
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Instruction

< Agent Status Done < 6400 [6400]

Switch All Queues Status To Switch Status To

Pause service in a
specific queue via the
mobile interface

Log Out Log Out

Resume Resume

Pause v ‘6

1
Inbound Queue 1 Pause Reason
1

& 6400 [6400] @ Lunch v p

Outbound Queue Break

Pause g
i

& 6401[6401]

Time : 39:10 Wrap up

& 6404 [6404]

1. At the top-left corner of Linkus Mobile Client, tap
[ )]
a\ heside your account.

You are redirected to the Agent Status page.
2. Tap the desired queue, then tap Pause.

3. Optional: In the Pause Reason section, select a
specific reason.

4. At the top-right corner, tap Done.

Pause service in a 1. Obtain the Pause/Unpause feature code and the
specific queue using Pause Reason feature codes from the system
feature code administrator.

2. Dial the feature code.
For example, if the Pause/Unpause feature code
is *07, to pause service in queue 6400, do as
follows:
« To directly pause without reason, dial
*076400.
 To pause with specific reason, dial *076400
plus the pause reason feature code, e.g.
*076400*03.

Unpause queue calls

As a queue agent (be it static or dynamic), you can resume receiving queue calls when you
are ready to take a call.
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Unpause service in all queues

28

Agent Status

Switch All Queues Status To

Log Out

Resume

Pause

Inbound Queue

& 6401[6401]
Time : 02:06
Pause Reason : Wrap up

Outbound Queue

& Sales [6403]
Time : 02:06
Pause Reason : Wrap up

1. At the top-left corner of Linkus Mobile Client, tap 2 beside your ac-
count.

You are redirected to the Agent Status page.
2. In the Switch Status To section, tap Resume.
3. At the top-right corner, tap Done.

Unpause service in a specific queue

You can unpause service in a specific queue by any of the following methods:
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Instruction

Unpause service in a
specific queue via the
mobile interface

< Agent Status Done < 6400 [6400]
Switch All Queues Status To Switch Status To

Log Out Log Out

Resume = Resume
i

Pause % Pause
Inbound Queue
& 6400 [6400] @
ime : 00:24
Outbound Queue
& 6401(6401]

Time : 01:00:29

& 6404 [6404]

1. At the top-left corner of Linkus Mobile Client,
®) )
tap ®\ beside your account.

You are redirected to the Agent Status page.
2. Tap the desired queue, then tap Resume.
3. At the top-right corner, tap Done.

Unpause service in a 1. Obtain the Pause/Unpause feature code from
specific queue using feature the system administrator.
code 2. Dial the feature code.

For example, if the feature code is *07, to
unpause service in queue 6400, dial *076400.

Related information
Automatically Switch Agent Status Based on Extension Presence

Automatically Switch Agent Status Based on Extension Presence

This topic describes how to set your agent status to automatically change along with your
extension presence on Linkus Mobile Client.

Procedure

1. At the top-left corner of Linkus Mobile Client, tap your account.
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2. Go to Current Presence.

3. Inthe Presence list, click * beside the desired presence status.

< Presence Done

O Away :

@ Do Not Disturb

Lunch Break

Q Business Trip

® Off Work

4. Scroll down to the Other Settings section, then tap Agent Status Auto Switch.

Other Settings

Ring Mobile Number Simultaneously

Accept Push Notifications ()

Agent Status Auto Switch Log In

5. Select an action according to your need.

Description

Log In When your extension changes to the presence status, you will automatically log
in to all the queues to which you belong.
* Dynamic agent: Log in to the queues.
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Option Description

- Static agent: Resume receiving calls from the queues.

Login When your extension changes to the presence status, you will automatically log
to Last in to all previously logged-in queues.
Queues » Dynamic agent: Log in to the queues.

- Static agent: Resume receiving calls from the queues.

Log Out When your extension changes to the presence status, you will automatically log
out from all the queues to which you belong.

," Note:
The logout operation is only available for dynamic agent.

Pause When your extension changes to the presence status, you will automatically
pause receiving queue calls.

Note:
You can select a specific pause reason in the Pause Reason drop-down
list.

Do Nothing When your extension changes to the presence status, your agent status in the
queues remains unaffected.

a

6. To configure the agent status auto-switch for more presence status, repeat Step 3 -

Handle Queue Calls on Linkus Mobile Client

This topic describes how to handle queue calls on Linkus Mobile Client.
Prerequisites

* You have logged in to Linkus Mobile Client, and logged in to your call queue.

« Linkus Mobile Client is enabled in Ring Strategy (Path: Account > Presence > S
Ring Strategy).

« The Call Waiting feature is enabled (Path: Account > Settings > Advanced > Call
Waiting).

Answer a call

If an incoming queue call reaches your extension while you are on Linkus Mobile Client, an
incoming call notification appears.

You can answer the call by tapping Accept (for iOS phone) or Answer(for Android phone).
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@ Linkus Audio...

Pre-Sales

Remind Me

X 4

Decline Accept

Record a call

Note:
To implement this operation, make sure that the system administrator has granted
your extension the permission to record calls.

During an active call, tap Il (Record) on the call screen.
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P

Pre-Sales

00:07

9 SRR 25

Mute Speaker End Call

Add Video Dialpad Record
Participant

9 & ©

Attended Call Flip

Hold / resume a call

You can place a queue call on hold temporarily to gather information or consult with col-
leagues, and resume the call when you are ready.

« To put a call on hold, tap | (Hold) on the call screen during an active call.
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Pre-Sales

00:02

il %@

Mute Speaker End Call

The caller can not communication with you, and a pre-recorded audio file is played to
the caller on hold.

» To resume the call, tap | (Hold) again on the call screen.
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Pre-Sales

0: 8

Hold Mute Speaker End Call

You and the caller can communication with each other now.

Transfer a call

You may need to transfer calls to other departments, or colleagues if you cannot handle the
issue yourself.

There are two types of call transfer:

- Blind Transfer: Transfer an ongoing call to a third party immediately without giving
him or her prior notification.

- Attended Transfer: Put the ongoing call on hold and establish a second call with third
party to pass on all relevant information and get his or her consent before transferring
the call.

Perform a blind transfer
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Pre-Sales

00:07

vy N

Speaker

2 v

Add Video DIE][eETe]
Participant

—.‘{:

Attended Blind Call Flip

oo

End Call

Record

11:03 ¢

X Cancel

O=
23

Contacts Call Logs

1. During an active call, tap = (Blind) on the call screen.

The call is put on hold.
2. Select the desired individuals in any of the following ways:

« Contacts: Select a contact from your Linkus directory.
» Dialpad: Enter the desired phone number on the dialpad, then tap

- Call Logs: Select a contact from call logs.
The current call is disconnected; The specified contact will receive the
call. When the call is answered, the other two parties are connected.

Perform an attended transfer
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11:03¢
X Cancel

i
Pre-Sales Dave Haris

00:07 Calling...

w4 10X P09 ¢

Speaker End Call Mute Speaker Attended Cancel

2+ .|||.

Add Dialpad Record

Participant
2| = &
(4 S

Contacts
Attended Blind Call Flip

1. During an active call, tap < (Attended) on the call screen.

The call is put on hold.
2. Select the desired individual using either of the following methods.

« Contacts: Select a contact from your Linkus directory.
« Dialpad: Enter the desired phone number on the dialpad, then tap

- Call Logs: Select a contact from call logs.
The specified extension user or contact will receive a call.
3. If the specified extension user or contact answers the call, you can talk

to the contact to pass on all relevant information first, then tap Attend-
ed.

The current call is disconnected; The other two parties are connected.

Add notes to a call
You can add notes to a queue call during the call or in the wrap-up time.

Add notes in-call

During a queue call, you can add call notes to capture essential information or
decision made in the conversation.
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14:53

s

(m)

ar

5

5503301

00:09

LSUBIY 2
Speaker End Call X Call Notes Save

Call Disposition

2+

Add Dialpad Record
Participant

¢ € | &

Attended Call Flip | Call Notes

Remark

1. During an active call, tap 2 (Call Notes).
2. In the call note panel, do as follows:
a. In the Call Disposition field, select one or more disposition codes

as call tag.
b. In the Remark field, enter short descriptions to note down essen-
tial information for the call.

c. Tap Save.

Add notes in wrap-up time

When you finish a queue call and enter the wrap-up time, a call note panel will
appear, where you can add or edit call notes.

Note:

After call, you can check and edit call notes in the corresponding call
log. For more information, see Manage Queue Call Logs.
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X call Notes(5503301e

H Warp-up Time: 00:25s

Call Disposition

o Tech Support Provided

Remark

Customer'issue resolved

1. In the Call Disposition field, select one or more disposition codes as
call tag.

2. In the Remark field, enter short descriptions to note down essential in-
formation for the call.

3. At the top-right corner of the panel, tap Done.

Hang up a call

You can end the call once you have successfully address the caller's concerns or completed
the necessary actions.

To hang up a call, tap @ in the call screen.
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P

Pre-Sales

A

®: - @

Mute Speaker End Call

Manage Queue Call Logs

This topic describes how to check and manage the queue call logs on Linkus Mobile Client.

Requirements

PBX Server

Contact the system administrator to make sure that the server meets the fol-
lowing requirements:

« The firmware version of PBX server is 37.18.0.18 or later.
- System administrator has granted you the viewing permission of queue
call logs.

Linkus Mobile Client

Make sure that the version of your Linkus Mobile Client meets the following re-
quirements:
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« Linkus iOS Client: Version 5.10.3 or later
« Linkus Android Client: Version 5.10.3 or later

Procedure

1. Log in to Linkus Mobile Client, go to Calls > Call Logs.
2. At the top-left corner, filter the desired queue call logs.

All v

Personal All Calls

Personal Missed Calls

Queue All Calls

o Queue Missed Calls

Queue Incoming Calls

 Queue All Calls: Logs of the queue calls that you have answered and the queue
has missed.

» Queue Missed Calls: Logs of the queue calls that the queue has missed.

» Queue Incoming Calls: Logs of the queue calls that you have answered.
3. Manage the call logs according to your needs.

Operation Instruction

Check and edit call You can check or edit the call notes for a call in the corresponding
notes call log.
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Operation Instruction

~
N
\
N\
\
\
\
\
5503301 “
External number l
|
I
]
1
—— /
/
X Call Notes Save ,/
Call Disposition ,,'
Transferred to Another Department > ‘

Remark
User encountered xxx issue, needs

resolution from the tech support
department.

Registered Extension

Carmen Gordon - 2025-03-05 13:50:43

a. Tap @ beside the desired call log.

b. At the top-right corner, tap 2 .
c. In the call note panel, edit the information as needed, then tap
Save.

Place a call to the You can directly place a call from a call log by tapping the call log.
caller
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Operation Instruction

5503301 1056 M @

ili External number

Check the details of You can conveniently check the source of the queue call logs, as well

queue call logs as the processing status of missed queue calls.
10:56 T @)
< Call History Details
5503301 %
iii External number @ 5503301
L +

Processing

Call Video  Chat  Email Add Status

2024-06-17 10:56:06 AM £Not Deal
Missed Call
ili Queue : Tech Support - EU (6400)

External number | Recently

a. Tap @ beside the desired queue call log.
b. Check the details of the call log.
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Operation

Instruction

» Source: The queue the call came from.
* Processing Status: The processing status of a missed
queue call.

Change the processing
status of a missed
queue call

If you decide to handle a missed queue call, or you have handled i,
you can change the processing status of the missed queue call.

- @)

< Call History Details

5503301

ili External number

a0 | @)

Processing Result

% Not Deal

© Dealing °

Dealt

a. Tap @ beside the desired queue call log.

b. Tap the processing status beside the call log details.

c. Select the desired processing status.
The processing status is changed; All the authorized agents can see
the change and check the operation record.




Delete incoming queue
call logs
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Operation Instruction

- @)

Call History Details

@ Dealing ~o

\,
N

-

Se -

Processing Result

/
Operator: Kristin Hale(1001) 4,’
Operation Time: 2024/06/17 11:00:40

£ Not Deal

(]

Dealing

Dealt

Note:

Only supports to delete the call logs of queue calls that you
have answered.

You can delete incoming queue call logs via the following
methods:

» To delete a single call log, swipe left on the desired call log,
then tap Delete.

» To bulk delete call logs, do as follows:
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Operation Instruction

13:39¢ 2156 € 13:38 ¢ 2156 @ 13:38 ¢ 2! 56 @)
Bé 2 Ccalls Q 4+ Cancel Delete Queue Call Logs Cancel  Delete Queue Call Logs
Ccall Logs Voicemail Recordings [ 9 Ashley Gardner ° Ashley Gardner
= il Extension
Queue Incoming Calls v ©Delete
o Ashley Gardner o Asgl‘ee\:‘ gﬁa:dner
& Ashley Gérdner o @ ) . .
e Ashley Gérdner 6
Default DOD v
Once confirmed, all agents
will no longer be able to view
the deleted missed call logs.
Are you sure you want to
1 AsC n% delete the selected data?
5 6 Cancel OK Q
* Y #
. 2= ] 2 Deselect Al Delete: 2 | Deselect Al Delete: 2
a. At the top-right corner, tap Delete.
b. Select the checkboxes of the desired incoming queue
call logs.
c. Tap Delete.
d. In the pop-up window, tap OK to confirm your
operation.
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Omnichannel Messaging Overview

Yeastar P-Series PBX System provides an omnichannel messaging feature, enabling busi-
ness to integrate multiple digital channels into the system. This allows business agents to
interact seamlessly with customers across multiple channels, including text messages, so-
cial media, and more, on a unified platform. ensuring agent productivity while enhancing the
customer experience.

Highlights
Yeastar omnichannel messaging feature provides the following highlights:

All-in-one Message Inbox

Agents are able to receive and respond to customers' queries from different
messaging channels directly on their Linkus UC Clients, greatly saving their
time by eliminating the need of switching between apps or services to check
for messages. The messages are stored on the PBX server, providing a central
record of all the messaging sessions.

Customer Contact using Business Number

Agents can contact customers using a business number, while keeping their
own personal mobile number private. If necessary, the messaging session can
be easily elevated to a call to reach the customer, so that the agent can re-
solve issues faster via voice call.

Seamless Collaboration across Agents

Agents can hand off customers' issue to another agent by transferring the
conversation, the new agent can quickly review the whole chat history and
take over the conversation without hassle.

Flexible Chat Assignment

Route your business messages from different messaging channels to agents,
who can share the workload across teams to reduce customer service re-
sponse time. Chats can be automatically assigned to the first agent who re-
sponds to a session in the queue, or agents can manually take over sessions
as needed.
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Roles in omnichannel messaging

Users can access the omnichannel messaging feature and perform different tasks based on
their roles and responsibilities, as the following table lists.

Role Description

System System administrators that are responsible for configuring and maintaining the
Administrator omnichannel messaging features, including setting up communication channels,
setting routing rules, assigning agents, and managing conversation histories.

For more information, see Omnichannel Messaging Administrator Guide.

Agent Agents that are responsible for interacting with customers from various messaging
channels, handling inquiries, resolving issues, and providing support and services.

For more information, see Omnichannel Messaging Agent Guide.

Administrator Guide

Omnichannel Messaging Administrator Guide

This guide provides detailed instructions for system administrators to set up and manage
the PBX omnichannel messaging feature, implementing smooth communication on the PBX
system across various channels.

Audience
This guide is intended for system administrators responsible for configuring and maintain-
ing the omnichannel messaging feature.

Requirements

Subscribe to Enterprise Plan or Ultimate Plan to ensure that the Omnichannel Messaging
feature is available.

Steps to set up omnichannel messaging

1. Set up message channels

To enable your contact center to handle digital channels interactions, you need
to add the communication channels in the PBX system, and configure settings
for each channel, such as message sending rate, inbound messaging routing
rule, etc., for smooth operation.
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Refer to the individual channel setup articles for the requirements and detailed

instructions.

Channel Instruction

SMS

Social media

To reach customers directly on their mobile phones using SMS,
you can set up SMS channels on Yeastar PBX with the following
supported SMS service providers:

« Set up an SMS Channel for Apidaze
 Set up an SMS Channel for Bandwidth
 Set up an SMS Channel for Flowroute

* Set up an SMS Channel for SIPTRUNK
 Set up an SMS Channel for Telnyx

» Set up an SMS Channel for Twilio

 Set up an SMS Channel for VoiceMeUp

For SMS Service Providers that are not listed above, they can add
their SMS service to Yeastar P-Series PBX System using SMS API.
After the integration is complete, you can create an SMS channel for
the Service Provider on your PBX.

For more information about the SMS service integration and the
SMS channel setup after the integration, see Integrate SMS Service
with Yeastar P-Series PBX System using SMS API.

To interact with customers through popular social media platforms,
you can set up social media channels on Yeastar PBX with the
following supported social media.

» Set up a Facebook Channel
» Set up a Live Chat Channel
« Set up a WhatsApp Channel

2. Set up message queue

Define a group of agents to receive the inbound messages. When an agent of
the queue picks up a session, he or she is able to respond to the messages in
the session, and the session is automatically assigned to the agent.

For more information, see Create a Message Queue and Manage Message

Queues.

3. Set up message campaign

To send a message to multiple recipients, you can create a message cam-
paign. This allows you to set up and manage bulk messaging tasks, enabling
you to deliver a single message to multiple target numbers at once.
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For more information, see Create an SMS Campaign and Create a WhatsApp
Campaign.

4. Manage message history

Get access to the detailed records of customer message interactions from
various channels, allowing you to have a complete overview of each conversa-
tion journey.

For more information, see Check and Manage External Chat Logs and Down-
load External Chat Logs.

Message Channel Setup
Apidaze

Set up an SMS Channel for Apidaze

This topic describes how to set up a Apidaze SMS channel on Yeastar P-Series PBX System,
so that agents in your business can receive and reply to SMS messages from customers on
their Linkus UC Clients.

Requirements
The Yeastar PBX should meet the following requirements:

« Firmware: Version 37.20.0.124 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
» Domain Name: PBX can be remotely accessed via a domain name.

Note:

o Due to the limitation of the third-party platform, the domain name must
NOT contain underscore character(s), otherwise the messaging chan-
nel will encounter authentication failure, or will fail to receive mes-
sages.

o |f you use a self-managed domain name, make sure you have installed
a valid domain certificate for the domain name, otherwise the messag-
ing channel will encounter authentication failure, or will fail to receive
messages.
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For more information about the domain configuration, see the following topics:
> Configure Network for Remote Access by a Yeastar FQDN
> Configure Network for Remote Access by a Yeastar Domain Name
> Configure Network for Remote Access by a Domain Name

Supported message types and limits

Supported message types

The Apidaze SMS channel supports text messages and multimedia messages
(MMS), where the supported MMS file types are determined by Apidaze.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

* File size: Max. 100 MB
» File retention period: 72 hours

Prerequisites
You have obtained the following information from the Apidaze Service Provider:

» APl key
* Secret
« Phone number used for message sending and receiving

Note:

If business needs to communicate with US-based customers, make sure that
the phone number has been completed with T0DLC registration to avoid dis-
ruption in message delivery.



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Procedure

« Step 1. Create and configure an SMS channel on PBX
« Step 2. Configure webhook in Apidaze

Step 1. Create and configure an SMS channel on PBX

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Apidaze.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

Apidaze SMS Channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/apidaze/a32afa9..

Apidaze

« Name: Enter a name to help you identify the channel.
« ITSP: Select Apidaze.
« API Key: Enter the API key obtained from Apidaze.
« Secret: Enter the Secret obtained from Apidaze.
4. In the Messaging Setting tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.
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b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

* Session Timeout (Days)

1

c. In the Accompanying Text for Chat File field, specify the default text that will
be sent along with chat files.

* Accompanying Text for Chat File
Sent by Yeastar

Apidaze requires that the chat file be accompanied by text content. Please configure the
default accompanying text. For example: Sent by Yeastar.

The message recipient will see the text displayed alongside the chat files.

Sent by Yeastar

Two-factor Authentication

d. In the Number section, click Add to add a message routing rule.
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Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball

4 items Available 2 items Selected

Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext... 1000 Leo Ball

1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris

1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:
The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber]). For example, +14102161183.

- Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.
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Option Description

(Transmitted via

API) "2 Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

e. Click Save.
5. Click Save.

Step 2. Configure webhook in Apidaze

1. On PBX web portal, go to Messaging > Message Channel.

2. Click the SMS channel you created.

3. In the Authentication tab, select a desired URL from the Webhook URL drop-down
list, then copy the URL.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

Apidaze SMS Channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/apidaze/a32afa9... 3')

4. In Apidaze, configure messaging webhook for the phone number using the PBX's web-
hook URL to receive inbound messages.


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing .

Status Name Type Number Total Sent Operations

@ Apidaze SMS SMs

+14102161183 0 0 Z T
Channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add Al

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client
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Bandwidth

Set up an SMS Channel for Bandwidth

This topic describes how to set up a Bandwidth SMS channel on Yeastar P-Series PBX Sys-
tem, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:

« Firmware: Version 37.20.0.124 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
- Domain Name: PBX can be remotely accessed via a domain name.

Note:

> Due to the limitation of the third-party platform, the domain name must
NOT contain underscore character(s), otherwise the messaging chan-
nel will encounter authentication failure, or will fail to receive mes-
sages.

o |f you use a self-managed domain name, make sure you have installed
a valid domain certificate for the domain name, otherwise the messag-
ing channel will encounter authentication failure, or will fail to receive
messages.

For more information about the domain configuration, see the following topics:
> Configure Network for Remote Access by a Yeastar FQDN
> Configure Network for Remote Access by a Yeastar Domain Name
> Configure Network for Remote Access by a Domain Name

Supported message types and limits

Supported message types

The Bandwidth SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by Band-
width. For more information, see Bandwidth supported MMS file types.

Important:


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://support.bandwidth.com/hc/en-us/articles/360014128994-What-MMS-file-types-are-supported-
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When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

s File size: Max. 100 MB
» File retention period: 72 hours

Prerequisites

» You have created a sub-account and associated with your location in Bandwidth.

Note:
Ensure that the Allow user credentials to authenticate API option is en-
abled for the account.

+ User Access Method

(O Allow user to login to the Bandwidth App
I © Allow user credentials to authenticate API I

« You have purchased phone number(s) in Bandwidth.

Procedure

« Step 2. Configure a number for SMS on Bandwidth
« Step 3. Create and configure an SMS channel on PBX
« Step 1. Obtain a Webhook URL on PBX



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://support.bandwidth.com/hc/en-us/articles/360035563254-How-do-I-manage-Sub-accounts-and-Locations-in-the-Bandwidth-Dashboard-
https://support.bandwidth.com/hc/en-us/articles/360011094753-How-do-I-search-and-order-phone-numbers-

Contact Center Guide | 3 - Omnichannel Messaging Guide | 203

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Bandwidth.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the ITSP drop-down list, select Bandwidth, then select and copy the desired Web-

hook URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.
https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/bandwidth/90b4cf3 &

Bandwidth

4. Note down the Webhook URL.

Step 2. Configure a number for SMS on Bandwidth

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone
numbers that are used for A2P (Application-to-Person) messaging MUST be reg-
istered, otherwise SMS messages sent to US numbers from unregistered 10DLC

numbers will be blocked.

If your business needs to communicates with US-based customers, you should
confirm the registration requirements with the SMS service provider and complete
the phone number registration to avoid disruption in message delivery.

Log in to Bandwidth portal, and complete the followings:



https://support.bandwidth.com/hc/en-us/articles/1500003820522-Registering-brands-and-campaigns-for-10DLC
https://support.bandwidth.com/hc/en-us/articles/1500003820522-Registering-brands-and-campaigns-for-10DLC
https://passport.bandwidth.com/login
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1. Create an application using a sub-account and configure the callback with PBX's Web-
hook URL.

(9) ‘ Dashboard  Numbers order
-
/

Applications

PSPPI | £ ARNING LAB & SUPPORT

Test Company (*+#+#4%) Account Log out

Your messaging URI: https://medsaging.bandwidth.com/api/v2/users/**+++**/messages COPY

APICREDENTIALS  DEVELOPER DOCS ]
Applications + creareapucarion | Create Application

« Application name:

+ Application ID:
Yeastar SMS messaging

We create this for you
Application type:

Use multiple callback URLs
CALLBACK

+ Callback URL:

https:/, ast

m/api/vi.

/ddal867t

Use 3 username/password for callbacks

STATUS CALLBACK TYPES

@ Senc message-delivered: callbacks (2
@ senc message-failed callbacks 7

Sendmessage-sending' callbacks (7

X CANCEL CHEATEAPEIJCATION

2. On the details page of the new application, associate the application with your loca-
tion.

ASSOCIATED LOCATIONS @

1 ASSOC\@BE LOCATION | [i] DISASSOCIATE LOCATION

Associate a location
LOCATION

Location

‘- Yeastar Test

- |

3. Enable HTTP SMS and MMS messaging for your location and the associated applica-

+ ASSOCIATE ANOTHER LOCATION

tion.
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Yeastar Test

SETTINGS VOICE MESSAGING uc

@5 MS SETTINGS
( SMS Enabled

% ) Toll Free

X | Short Codes

Geographic reach

CAN ZONE 2 ZONE 3 ZONE 4

Selected countries apply to bath SMS and MMS

SMS Protocol

HTTP
API-based
« V2 Messaging

* Applications
Yeastar SMS messaging ™
+ CREATE APPLICATION

MMS SETTINGS

( MMS Enabled

MMS Protocol

HTTP
API-based

V2 Messaging

) DELETE X CANCEL W

4. Search the number that you want to use for SMS and associate it with your sub-ac-
count.

@‘Dashboard Numbers | Orders Applications Insights

My Numbers | Hosted Messaging External Numbers

My Numbers
MY INVENTORY LINE FEATURES MOVE NUMBERS

. SEARCH FOR NUMBERS ACTIVE ON YOUR ACCOUNT

How do you want to search?

° Show all numbers on your account (sub-account / location)

o Find the sub-account and location information for a telephone number
O Search for a number based on IP address or DNS

Sub-account: Location:

~~ SEARCH RESULT (ACCOUNT: TEST COMPANY |

Move Number

# Sub-Account
(410) 216-1183 Yeastar Test |

* Location

Yeastar Test
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5. Note down the Application ID and Account ID for the integration with PBX.

SRR £ ARNING LAB & SUPPORT
(9) ‘ Dashboard  numbers oOrders Insights

Applications

API CREDENTIALS  DEVELOPER DOCS 3

/—\pplicaﬁons ++ CREATE APPLICATION SMS for Yeastar
S « Application name: + Application ID
Yeastar SMS messaging L

Yeastar SMS messaging
Messaging Application

Application type:

Use multiple callback URLs.

Step 3. Create and configure an SMS channel on PBX

Create an SMS channel on PBX, and configure the channel with the authentication informa-
tion and number obtained from Bandwidth.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Bandwidth.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings

Bandwidth SMS channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/bandwidth/90b &

Bandwidth

« Name: Enter a name to help you identify the channel.

« ITSP: Select Bandwidth.

« Application ID: Paste the Application ID obtained from Bandwidth.

» Account ID: Enter the Account ID of your Bandwidth account.

« Username: Enter the user name of your Bandwidth account.

« Password: Enter the password associated with your Bandwidth account.
4. In the Messaging Settings tab, configure the channel.
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a. In the Message Sending Rate field, specify the number of messages that PBX

can send per second.
Note:

rate.

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add

+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball

4 items Available 2 items

Extension Num... Caller ID Name Extension Num...

Extension Group  Default_All_Ext... 1000
1002 Terrell Smith 1001
1003 Dave Haris
1004 Troy Daniel

Selected

Caller ID Name
Leo Ball

Phillip Huff

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender

ID.
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Note:
The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

« Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) ,‘ Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing .

Status Name Type Number Total Sent Operations

Bandwidth SMS
(O]

SMS +14102161183 0 0 Z T
channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add Al

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client
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Flowroute

Set up an SMS Channel for Flowroute

This topic describes how to set up a Flowroute SMS channel on Yeastar P-Series PBX Sys-
tem, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements

Platform Requirement

Yeastar PBX » Firmware: Version 37.20.0.124 or later
* Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
» Domain Name: PBX can be remotely accessed via a domain name.

Note:

> Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise
the messaging channel will encounter authentication failure,
or will fail to receive messages.

o If you use a self-managed domain name, make sure you
have installed a valid domain certificate for the domain
name, otherwise the messaging channel will encounter
authentication failure, or will fail to receive messages.

For more information about the domain configuration, see the following
topics:
o Configure Network for Remote Access by a Yeastar FQDN
o Configure Network for Remote Access by a Yeastar Domain Name
o Configure Network for Remote Access by a Domain Name

Flowroute API Version: v2.1

Note:
You can check or update the API version on Flowroute (Path:
PREFERENCE > API Control > SMS Webhook Version).

Supported message types and limits

Supported message types


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://manage.flowroute.com
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The Flowroute SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by
Flowroute. For more information, see Flowroute supported MMS file types.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

s File size: Max. 100 MB
» File retention period: 72 hours

Procedure

» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure a number for SMS on Flowroute
« Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Flowroute.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.

3. In the ITSP drop-down list, select Flowroute, then select and copy the desired Web-
hook URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.


https://support.flowroute.com/937402-Supported-MMS-file-types
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/flowroute/90b...

Flowroute

4. Note down the Webhook URL.

Step 2. Configure a number for SMS on Flowroute

Important:
According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone
numbers that are used for A2P (Application-to-Person) messaging MUST be regis-

tered, otherwise SMS messages sent to US numbers from the unregistered 10DLC
numbers will be blocked.

If your business communicates with US-based customers, you should confirm the
registration requirements with the SMS service provider and complete the phone
number registration to avoid disruption in message delivery.

Log in to Flowroute portal, and complete the following settings:

1. Enable the messaging feature for the desired DID number.

ﬂowro Uie Yeastar shirley .

@ DasHBoARD Manage | Purchase  PortOrders E911  CNAM

BILLING

Manage your DIDs

(O]
Ll cors & sTaTs

INTERCONNECTION

Route Options

Set Route
Set Failover Route
Add New Route Failover . cNAM cNaM
‘Alias Options Route e R e
Set Alias

& prerrences

4 BN 4 status 4 Rate Center

] e

Clear Alias
- E911 Options
Assign / Enter E911 Profile
()} 18002786915 Unassign E911 Profile ion Opted-out Yes
Messaging Options
Enable Messaging
Disable Messaging
Set Callback URL
Clear Callback URL
CNAM Options
Set CNAM Storage Preset

Opted-out PURCHASED DC~WSHNGTNZ

PURCHASED DC~WSHNGTNZ

Show 25 v entries

Showing 1to 2 of 2 entries 1 row sel

Clear CNAM Storage Preset
Enable CNAM Lookups

2. Configure messaging webhook according to your needs.


https://support.flowroute.com/265034-Messaging-Guidelines---10DLC-Carrier-Fees-and-Registration
https://support.flowroute.com/265034-Messaging-Guidelines---10DLC-Carrier-Fees-and-Registration
https://manage.flowroute.com
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« If you only need to receive callback notification for inbound messages sent from
a specific number, configure messaging webhook with PBX's Webhook URL for
the number individually.

flowroute  vesstar

Manage your DIDs el

Set Callback URL for your Phone
Numb

aaaaaaaaaa

 Set Callback URL.

Sy

« If you need to receive callback notification for inbound messages sent from all
the numbers in your account, configure global messaging webhook with PBX's
Webhook URL as shown below.

'"owro V) i‘e Yeastar Shirley .

@ pasHEOARD Account 't Information User Profile Features Fraud Control Balance Management API Control 10DLC Registration Toll Free Verification @ support ~

P Messaging Webhooks
28 iNTerconnEcTION ok UR e
# ons
['s QTS webhook/flowroute/b3ee2 (@ Update URL
ar.com/api/v].0/webhook/flowroute/b3ee2 (2 Update URL
SMS DLR ( Enabled
MMS DLR q Enabled
‘docs ras yeastar.com/api/v1.0/webhook/flowroute/b3ee2 @ Update URL

3. Create an API key for the integration with PBX.

Important:
You MUST note down the generated key in the pop-up window, as it is only
displayed ONCE.
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ﬂowroui’e Yeastar Shirley . v

@ oasHBoARD Account 't Information User Profile Features. API Control 10DLC Registration Toll Free Verification © support ~

[@ s

CDRS & STATS.

YS

yo

a
L INTERCONNECTION

# ows

display a any keys which have or w
pdnawARLEy

] e NAME DESCRIPTION EXPIRATION

| veastar Docd tion (Optiona @ datetime (Optiona ﬂ

API Key Created

Please

824 db

ﬂowroui’e Yeastar shirley .~

@ oasHBoaRD Account Information User Profile Features Fraud Control Balance Management API Control 10DLC Registration Toll Free Verification © support ~
TN N

@ s

g API Keys

yo ent API Key Sets to provide and revoke access to your account resources via our APIs. When you create an API Key, you wil be provided with a matching ‘Secret Key' This key is only displayed

¢
L6 INTERCONNECTION

# ows .
Add new API Key
] e NAME DESCRIPTION EXPIRATION
8 st opton =
+ (7 Columns) 2items  FilterBy Al v Q
Account Description  AccessKey  Secret Key Expires Created Actions

Vesstr R ——— 07 2020114374 20000 [ co | e | @0e |
Yeastar Docs 3. 4 TSRS Never Apr 07,2020 11:49 PM +00:00 mm

Step 3. Create and configure an SMS channel on PBX

Create an SMS channel on PBX, and configure the channel with the authentication informa-
tion and number obtained from Flowroute.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Flowroute.
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Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

Flowroute SMS channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/flowroute/90..

Flowroute

« Name: Enter a name to help you identify the channel.
« ITSP: Select Flowroute.
« Access Key: Paste the access key obtained from Flowroute.
« Secret Key: Paste the API key obtained from Flowroute.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.
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Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball

4 items Available 2 items Selected

Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext... 1000 Leo Ball

1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris

1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:
The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber]). For example, +14102161183.

- Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.
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Option Description

(Transmitted via

API) "2 Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.
d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing Q.

Status Name Type Number Total Sent Operations

Fl te SMS
1) owroute SMS +14102161183 0 0 Z ®

channel

« PBX automatically tracks and records the number of messages sent and received on
the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

Note:

o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.



https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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> You can filter the statistics by a time period using the time filter.

Number Total Sent Failed Received Operations

14102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

SIPTRUNK

Set up an SMS Channel for SIPTRUNK

This topic describes how to set up a SIPTRUNK SMS channel on Yeastar P-Series PBX Sys-
tem, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements

Platform Requirement

Yeastar PBX » Firmware: Version 37.20.0.124 or later
+ Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
» Domain Name: PBX can be remotely accessed via a domain name.

Note:

o Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise
the messaging channel will encounter authentication failure,
or will fail to receive messages.

o If you use a self-managed domain name, make sure you
have installed a valid domain certificate for the domain
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Platform Requirement

S name, otherwise the messaging channel will encounter
authentication failure, or will fail to receive messages.

For more information about the domain configuration, see the following
topics:
o Configure Network for Remote Access by a Yeastar FQDN
o Configure Network for Remote Access by a Yeastar Domain Name
o Configure Network for Remote Access by a Domain Name

SIPTRUNK » Telephone number: The DID number(s) should be SMS/MMS compatible
and registered with 10DLC.

Important:

According to US legislation (A2P 10DLC SMS), 10DLC

(10-digit Long Code) phone numbers that are used for A2P
(Application-to-Person) messaging MUST be registered, otherwise
SMS messages sent to US numbers from the unregistered 10DLC
numbers will be blocked.

If your business communicates with US-based customers, you
should complete the 10DLC registration for your phone numbers to
avoid disruption in message delivery.

0 Tip:
Submit a request to your service provider for the required
number(s). For more information, see SMS Process &

Expectations.

Supported message types and limits

Supported message types

The SIPTRUNK SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by SIP-
TRUNK.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://support.siptrunk.com/hc/en-us/articles/20569864729371-SMS-Process-Expectations
https://support.siptrunk.com/hc/en-us/articles/20569864729371-SMS-Process-Expectations
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

s File size: Max. 100 MB
» File retention period: 72 hours

Procedure

» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure messaging feature on SIPTRUNK
« Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on SIPTRUNK.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.

3. In the ITSP drop-down list, select SIPTRUNK, then select and copy the desired Web-
hook URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings

https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/siptrunk/90b4..

SIPTRUNK

4. Note down the Webhook URL.
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Step 2. Configure messaging feature on SIPTRUNK
Log in to SIPTRUNK customer portal, and complete the following settings:

1. Note down the desired DID number to be added to the SMS channel.

&

|

]

siptrunk
CUSTOMER PORTAL
Dashboard
Profile

Payment Center
SIP Trunking
Nurmber Porting
Billing

Fax

TELEPHONE NUMBERS

Create CSV (all 4 numbers)  Bulk Update Recent Orders View by Trunk Search View)/Set CNAM
edit  Number Type  Primary Secondary PSTN Forward ~ PSTN Backup

# [0 14102161183 | SO Trunk 1 not set not set not set

Call Detail Records

SIP Trunks

rnew numbers.

Telephone Numbers

Order Telephone Numbers

International Calling

Vmail to Email  Description: Location Description: General

not set

2. Configure messaging webhook for the DID number.
a. Create a Webhook using the PBX's Webhook URL.

siptrunk

CUSTOMER PORTAL

/&% Dashboard

[ Profile

Eg) Payment Center >
Q, SIPTrunking > Yol

Q¥ Number Porting >

i

[y

@[O0

Billing
Fax
Messaging

7) Support

API Keys [l Webhooks [ll API Docs Jf Package Pricing J§ How to Use Messaging

141C

oy System Status

b. Assign the Webhook to the DID number.

«Me = = =
LC UL Create New Webhook CLOSE|

+10C

*Me Inbound Description Active Delete

Webhooks

Enter the PBX's webhook URL
PRl [ Set a webhook name



https://login.siptrunk.com/
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Sl Pt rp.n k APl Keys [l Webhooks [l API Docs |l Package Pricing Jll How to Use Messaging

CUSTOMER PORTAL
Messaging Resources:
ﬁ Dashboard « Messaging Setup Process & Timeline
= Profle + 10DLC Registration Form Help Sheet

» Messaging Knowledgebase
g21 Payment Center

Y SIPTrunking Your Messaging DIDs:

v
% Number Porting DID Enabled Assign WebHook

14102161183 0 -

Yeastar_PBX_Webhook (| htlps.//yeasiarducs.ras.yeastar.com/apiIvl.OIwebhoq*kfsiptrunk/f4e0‘3b1393b4472c9e445488784db4f5)

=4 Billing

= Fax

() Messaging

(@) Support

oy System Status

3. Create an API key for the integration with PBX, and note down the Access Key and
Secret Key.

Important:
Make sure that you have copied and properly saved the Secret Key before
closing the pop-up window, as it is only displayed ONCE.

S Pt rp .n k m Webhooks |l APl Docs |l Package Pricing il How to Use Messaging
1

CUSTOMER PORTAL
1
1

S — .
P2 B Gl Create New AP Key CLOSE

ﬁ Dashboard

35 Profile

API Keys
E81 Payment Center >
R, SIP Trunking >

Q€ Number Porting >

APl Keys
. API| Key Created.
3 Billing ‘
Please save the secret key. You won't be able to see it again
after you close this screen.
= pyry——; .
Fax Access Key: baa: 2273
E Secrst Key: 9041 17899f
SCXAPI Token
YmFhYTdIYTctOGVMS00Ym YSLWIIN]YtMDI3SMGELMWEyMjczOjkwNGYyMDBILTZmMjktNDBhNCOSYWIwLWM1Z)M5N2I30Dk52g==
{7 Messaging L | Description: test
(7) Support

Ay System Status
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Step 3. Create and configure an SMS channel on PBX

Create an SMS channel on PBX, and configure the channel with the authentication informa-
tion and number obtained from SIPTRUNK.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of SIPTRUNK.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings

SIPTRUNK SMS channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/siptrunk/90b4..

SIPTRUNK

« Name: Enter a name to help you identify the channel.
« ITSP: Select SIPTRUNK.
« Access Key: Paste the access key obtained from SIPTRUNK.
« Secret Key: Paste the secret key obtained from SIPTRUNK.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.
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Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-532-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:

The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

» Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.
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Option Description

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing Q.

Status Name Type Number Total Sent Operations

© SIPTRUNK SMS SMs +14102161183 0 0 4

Channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add All

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Telnyx

Set up an SMS Channel for Telnyx

This topic describes how to set up a Telnyx SMS channel on Yeastar P-Series PBX System,
so that agents in your business can receive and reply to SMS messages from customers on
their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:
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« Firmware: Version 37.20.0.124 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
» Domain Name: PBX can be remotely accessed via a domain name.

Note:

o Due to the limitation of the third-party platform, the domain name must
NOT contain underscore character(s), otherwise the messaging chan-
nel will encounter authentication failure, or will fail to receive mes-
sages.

o If you use a self-managed domain name, make sure you have installed
a valid domain certificate for the domain name, otherwise the messag-
ing channel will encounter authentication failure, or will fail to receive
messages.

For more information about the domain configuration, see the following topics:
> Configure Network for Remote Access by a Yeastar FQDN
> Configure Network for Remote Access by a Yeastar Domain Name
> Configure Network for Remote Access by a Domain Name

Supported message types and limits

Supported message types

The Telnyx SMS channel supports text messages and multimedia messages
(MMS), where the supported MMS file types are determined by Telnyx. For
more information, see Telnyx supported MMS file types.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

* File size: Max. 100 MB
» File retention period: 72 hours


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://support.telnyx.com/en/articles/3102823-mms-sending-and-receiving#mms-file-types-and-sizes
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Procedure

» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure a number for SMS on Telnyx
«» Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Telnyx.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.

3. In the ITSP drop-down list, select Telnyx, then select and copy the desired Webhook
URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/telnyx/90b4cf3bc8a... ©

4. Note down the Webhook URL.

Step 2. Configure a number for SMS on Telnyx

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone

numbers that are used for A2P (Application-to-Person) messaging MUST be regis-
tered, otherwise SMS messages sent to US numbers from the unregistered 10DLC

numbers will be blocked.



Contact Center Guide | 3 - Omnichannel Messaging Guide | 229

If your business communicates with US-based customers, you should confirm the
registration requirements with the SMS service provider and complete the phone
number registration to avoid disruption in message delivery.

Log in to Telnyx portal, and complete the following settings:
1. Search and purchase a DID number with SMS feature.

Asteinux Pro090

Available creditin USD +
Buy Number Number Orders
Real-Time Communications ~
Messaging v
| Buy Numbers
Voice v
Numbers ~
Country Required | Features Type Search By Area Code
Buy Numbers
United States of America +1 v SMS X MMS X v v Area code v v

Manage Numbers

Port Numbers. Advanced Search v

Compliance Search Numbers
S M

Video v
Identity v Number Location/Rate Center Number Type ~ Features UpfrontPrice  Monthly Price
Fax +1555 123 4567 United States of America Toll free (R =N ] US$1.00 US$1.00 Add to Cart
Virtual Networking o
+1415 987 6543 United States of America Toll free (R =N ] US$1.00 US$1.00 Add to Cart
O FE CEND +1212 555 7890 United States of America Toll free (e =N ] US$1.00 US$1.00 Add to Cart

2. Create a message profile and configure messaging webhook with PBX's Webhook
URL.

Note:
For any settings not shown, configure them according to your actual require-
ments.



https://support.telnyx.com/en/articles/6325731-register-for-10dlc-messaging
https://support.telnyx.com/en/articles/6325731-register-for-10dlc-messaging
https://portal.telnyx.com
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&telnyx Proge

Real-Time Communications ~

I Add New Profile I

« Back to Messaging Profiles @

Messaging ~ Create Messaging Profile

Programmable Messaging

1

1

1

= Filters
Compliance

Profile Name Required 2. Allowed destinations
Settings
g Yeastar SMS Messaging 3. Inbound
Debug
API Version 4. Outbound
Reports I A 5. Senders

6. Keywords

Create Messaging Profile B Quickstart

Inbound settings 1. Details

Control how your profile handles incoming messages 2. Allowed destinations

| https://yeastardocs.ras.yeastar.com/api/v1.0/webhc I 4. Outbound

Webhook Failover URL @ 5. Senders

[ e.g. nttpsi//example.com 6. Keywords

If you wish to send and receive using an SMPP bind 7, please email sales@telnyx.com

3. Assign the message profile to the purchased DID number.
Atelnyx Pr oo
Hosted Messaging Numbers Short Code Verified Numbers
Messaging v

Real-Time Communications ~
| My Numbers
Voice v

I Numbers ~ I [ Enter full or partial number (e.g. last 4 digits) Q |

T
* Buy Numbers

. Ny . Ny \ \ [/ \ \ .
| Status v | NumberType v || Source v | Tags~ | Connection v || MessagingProfile v || BillingGroup - || Voice Billing Method v
| TS | N J\ J\ AN VAN J\ J\ J\ J

P N N N N
Port Numbers | Emergency Status ~ | | Bundles ~ || Number(s) on bundle pricing v || Countries v+ | C
N AN AN / N\ S
Compliance & Export
Reports
Video v (O  Number$ Status Ci i ication ¢ jing profile Services
Identity v
O +1-410-216-1183 @ ® Active Yeastar Yeastar SMS Mess.“@ ® < JORS) s w
Fax

4. Create an API key for the integration with PBX.

Important:

Properly copy and save the API key after it is created, as it will only be dis-
played once. You will not be able to view the key again after you close the API
key display window.
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o API Key Created X

(1) Copy the key value now as you will not be able to see it
again. Losing a key requires creating a new one.

APl Key
KEYQ197BFE1F2E68862C5280B+ ++# k%% % [n] |
Copy to clipboard and close
L -

Atelnyx P: 0986

Logged in as:
shirley@yeastar.com
Welcome, Shirley! Organization:
(D Xiamen Yeastar Information Technology Co.. Lid.

What's nev
Al, Storage and Compute v

<> APIkeys

10T and Wireless o Product Highlight: Conversational Al

6/24/2025
Design and deploy Al Assistants with global telephony and dedicated Private PG &  Account settings

infrastructure for agile, scalable and real-time engagement.

Real-Time Communications M
allocation "
Bl Manage biling

Dark mode (@ ]

Virtual Networking

Reporting v

Read more

- 6/23/2025
Ask our Al assistant Telnyxexg  Sign Out

|
1

1

1

1

1

1

1

1

1

1
Read more 2 1
1

1

1

1

1

1

1

1

1

1

1
!

€ Back
Account settings v

Friers . API Keys

APIKe
B Create and manage APl Keys to use with the Telnyx API v2

Organization API Keys

1
Public Key status APIKey Create API Key x  [eated LastUsed
1
Access Control Lists v " " - - b
® Active This API Key is encrypted Once created, you will be able to see and configure key details in Jun 2025 12:47 AM 30 Jun 2025 h:00 PM © 2
Advanced Features v the table view. 1
Integration Secrets ® Active This API Key is encrypted Tags IMay 2025 2:14 PM 18 Jun 2025 II:ZG AM

[ Select an existing option or enter a new one

Optional descriptor(s) to easily identify the APl key

Expiration

Expiration Date (UTC)

[ 07/31/2025 12:00 AM

5. Note down the Public key in Public Key page.

o] %4 0 9 @

Account settings v

APl Keys

Public Key

APl Keys
& Use your public key to validate Telnyx API V2 webhooks

Organization API Keys

Access Control Lists v | wb3e75 . YOWK= [a] |

Advanced Features ~

Integration Secrets
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Step 3. Create and configure an SMS channel on PBX

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Telnyx.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.
Telnyx SMS channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/telnyx/90b4

Telnyx

« Name: Enter a name to help you identify the channel.
« ITSP: Select Telnyx.
* API Key: Paste the API Key obtained from Telnyx.
» Public Key: Paste the Public Key obtained from Telnyx.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:

« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.
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Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-532-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:

The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

» Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.
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Option Description

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing Q.

Status Name Type Number Total Sent Operations

(@) Telnyx SMS channel ~ SMS +14102161183 0 0 Z T

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add All

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Twilio

Set up an SMS Channel for Twilio

This topic describes how to set up a Twilio SMS channel on Yeastar P-Series PBX System,
so that agents in your business can receive and reply to SMS messages from customers on
their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:
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« Firmware: Version 37.20.0.124 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
» Domain Name: PBX can be remotely accessed via a domain name.

Note:

nel will encounter authentication failure, or will fail to receive mes-
sages.

messages.

For more information about the domain configuration, see the following topics:
> Configure Network for Remote Access by a Yeastar FQDN
> Configure Network for Remote Access by a Yeastar Domain Name
> Configure Network for Remote Access by a Domain Name

Supported message types and limits

Supported message types

The Twilio SMS channel supports text messages and multimedia messages
(MMS), where the supported MMS file types are determined by Twilio. For
more information, see Twilio supported MMS file types.

Important:

When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

* File size: Max. 100 MB
» File retention period: 72 hours

o Due to the limitation of the third-party platform, the domain name must
NOT contain underscore character(s), otherwise the messaging chan-

o If you use a self-managed domain name, make sure you have installed
a valid domain certificate for the domain name, otherwise the messag-
ing channel will encounter authentication failure, or will fail to receive


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://www.twilio.com/docs/sms/troubleshooting/accepted-mime-types
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Procedure

» Step 1. Obtain a Webhook URL on PBX
« Step 2. Configure a number for SMS on Twilio
«» Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX
Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on Twilio.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.
3. Inthe ITSP drop-down list, select Twilio, then select and copy the desired Webhook

URL.

Important:
The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's

customer portal.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings

https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/twilio/90b4cf3.. @

Twilio

4. Note down the Webhook URL.

Step 2. Configure a number for SMS on Twilio

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code) phone
numbers that are used for A2P (Application-to-Person) messaging MUST be regis-
tered, otherwise SMS messages sent to US numbers from the unregistered 10DLC

numbers will be blocked.
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If your business communicates with US-based customers, you should confirm the
registration requirements with the SMS service provider and complete the phone
number registration to avoid disruption in message delivery.

Log in to Twilio portal, and complete the followings:

1. Search and purchase a number with SMS feature.

0 Tip:

You can check the SMS service pricing here.

Console

Account v Biling v (@) Test Account v

testaccount@mail.com's Account | ¢

oeveor | wonr  Buy @ Number
Country Capabilities
us (+1) United States - US Q W voice | M svs W wmvs | W Fax
v # Phone Numbers Search criteria Match to

» Advanced Search

aller IDs
i I
TwiML apps Number Type Capabilties Address Requirement Monthly fee

> Ports Voice sMs MMs Fax

+1972996 72524
Richardson, TX US

Local S = = ® None $1.15 Buy

+124831369294
Walled Lake, MI US

Local S =] =] =] None $1.15 Buy

2. Edit the purchased number to configure the messaging webhook with PBX's Webhook
URL.

Active Numbers

@ A2ZP 10DLC registration reqy me ing C
@ Check the A2P 10DLC registration t

prventery lters {(—\ A2P 10DLC registration required for US messaging.
Nomber v

‘/ [ —

11410216 113 &

Us.Us

ion message routing is: Active

URL HTTP
HITP POST
Primary handler fails URL HTTR

Webhook v HTTP POST


https://support.twilio.com/hc/en-us/articles/1260801864489-How-do-I-register-to-use-A2P-10DLC-messaging-
https://support.twilio.com/hc/en-us/articles/1260801864489-How-do-I-register-to-use-A2P-10DLC-messaging-
https://www.twilio.com
https://www.twilio.com/en-us/sms/pricing/us
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3. Enable the geographic permission for the desired region(s) where you want to send
SMS messages, so that messages can be successfully sent to the phone numbers
within the region(s).

Note:

This setting should be completed in the parent account.

Console

©]

Account v Billing v @) Test Account v

testaccount@mail.com's Account | ©

Develop Monitor . . - -
Messaging Geographic Permissions
v [ Messaging Filter by country
Overview &
> Tryitout
Services North America
> Senders
Anguilla (+1264) Antigua and Barbuda (+1268) Aruba (+297)
Content Editor Ascension (+247) Bahamas (+1242) Barbados (+1246)
+"Beta Belize (+501) Bermuda (+1441) %Canada (+1)
v Settings Cayman Islands (+1345) Costa Rica (+506) Cuba (+53)
— Curacao and Caribbean Netherlands (Bonaire, Sint || Dominica (+1767) Dominican Republic (+1829)
Eustatius, Sint Maarten, Saba) (+599)
Log archives Dominican Republic (+1849) Dominican Republic (+1809201) Dominican Republic (+1809)
Geo permissions El Salvador (+503) Greenland (+299) Grenada (+1473)
, Guadeloupe (+590) Guatemala (+502) Haiti (+509)
Add-ons+”Beta
Honduras (+504) Jamaica (+1876) Martinique (+596)
® Docs and Support Mexico (+52) Montserrat (+1664) Nicaragua (+505)
Panama (+507) Puerto Rico (+1787) St Kitts and Nevis (+1869)

«

4. Go to your account's dashboard, note down the Account SID and Auth Token, as
you will need to use it on PBX later.

Note:
The account MUST be the one used for purchasing the number. That is, if the

number is purchased using a sub-account, you need to access the sub-ac-
count's dashboard to obtain the information.

Develop Menitor © Al US. SMS and MMS messages from unregistered 10DLC phone numbers are now blocked. Please register your numbers
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@ Al US.SMS and MM messages from unregistered 10DLC phone numbers are now blocked. Please register your numbers, get approved and resume messaging. Learn more (2

Ahoy , welcome to Twilio!

Connect to 3rd-party applications Invite teammates

You'll need 3 things to use Twilio with most 3rd-party applications Add developers in your team to your account,

+ te teammates >
Talk to Sales
Connect vith 3 Tuilio expert to find out what products and plans best suit your needs
Talk to Sales (2
~ Account Info ~ Helpful links
Account SID
AC0000000000000000XXKXXX 49
Auth Tok
O | sn
@ Docs and Support : = Y e more
«

Step 3. Create and configure an SMS channel on PBX

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of Twilio.

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings

* *
Twilio SMS channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/twilio/90bacf3bcs...
*
Twilio
* *
et St

« Name: Enter a name to help you identify the channel.
« ITSP: Select Twilio.
« Account SID: Paste the Account SID obtained from Twilio.
« Auth Token: Paste the Auth Token obtained from Twilio.
4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

| Note:
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« If the number of messages to send exceeds the set value, PBX
4 will arrange the messages in queue and send them at the sending
rate.

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

| Note:
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The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

« Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) ,’ Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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Result

« A messaging channel for Twilio is created successfully. You can see the channel dis-

played in the Messaging Channel list with Status showing Q.

Status Name Type Number Total Sent Operations

@ Twilio SMS channel SMS +14102161183 0 0 Z ‘E[

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add All

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client




Contact Center Guide | 3 - Omnichannel Messaging Guide | 244

VoiceMeUp

Set up an SMS Channel for VoiceMeUp

This topic describes how to set up a VoiceMeUp SMS channel on Yeastar P-Series PBX
System, so that agents in your business can receive and reply to SMS messages from cus-
tomers on their Linkus UC Clients.

Requirements

The Yeastar PBX should meet the following requirements:

« Firmware: Version 37.20.0.124 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
- Domain Name: PBX can be remotely accessed via a domain name.

Note:

> Due to the limitation of the third-party platform, the domain name must
NOT contain underscore character(s), otherwise the messaging chan-
nel will encounter authentication failure, or will fail to receive mes-
sages.

o |f you use a self-managed domain name, make sure you have installed
a valid domain certificate for the domain name, otherwise the messag-
ing channel will encounter authentication failure, or will fail to receive
messages.

For more information about the domain configuration, see the following topics:
> Configure Network for Remote Access by a Yeastar FQDN
> Configure Network for Remote Access by a Yeastar Domain Name
> Configure Network for Remote Access by a Domain Name

Supported message types and limits

Supported message types

The VoiceMeUp SMS channel supports text messages and multimedia mes-
sages (MMS), where the supported MMS file types are determined by Voice-
MeUp.

Important:


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
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When sending multimedia messages (such as images), the SMS ser-
vice provider downloads the files from a link provided by the PBX.
Therefore, if you have set Allowed Country/Region IP Access Pro-
tection rule, make sure that you have allowed the IP access from the
country where the SMS service provider is located, otherwise the file
transmission would fail.

Limits

* File size: Max. 100 MB
» File retention period: 72 hours

Procedure

» Step 1. Obtain a Webhook URL on PBX
«» Step 2. Configure messaging feature on VoiceMeUp
« Step 3. Create and configure an SMS channel on PBX

Step 1. Obtain a Webhook URL on PBX

Obtain a Webhook URL from PBX web portal first, which is required when you configure a
number for SMS on VoiceMeUp.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select SMS.

3. In the ITSP drop-down list, select VoiceMeUp, then select and copy the desired Web-
hook URL.

Important:

The URL will change once you leave the current page, please make sure you
use the latest Webhook URL for the configuration on the service provider's
customer portal.


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
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Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings.

https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/voicemeup/9

VoiceMeUp

4. Note down the Webhook URL.

Step 2. Configure messaging feature on VoiceMeUp
Log in to VoiceMeUp customer portal, and complete the following settings:

1. Purchase a DID number with SMS feature.

Important:

According to US legislation (A2P 10DLC SMS), 10DLC (10-digit Long Code)
phone numbers that are used for A2P (Application-to-Person) messaging
MUST be registered, otherwise SMS messages sent to US numbers from the
unregistered 10DLC numbers will be blocked.

If your business communicates with US-based customers, you should con-
tact the SMS service provider to complete 10DLC registration for your DID
number to avoid disruption in message delivery.


https://clients.voicemeup.com/v3/login

© DID Numbers

oo omg

Qsearch | YFiters B Export

® DID Numbers
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Port Requests

©  ContestualHelp

Order Details

Quantity

1

Faxing support (38 protocol)
®ves
Ono

This option s not availabe.

& Demande de Commande - Nouveau Numéro

Account ID: 80020676
A

© ~opropriate Funds

ia)

sequence
@ Random numbers

O sequential numbers

Desired messaging features

2. Configure messaging webhook for the DID number.

a. Go to the edition page of the desired DID number.

Q search

Y Filters

® DID Numbers

B Export

©  Contextual Help

CTaTeleTelele e [ e [ P wT e Te [ol e s [ o v w [X] 2]

Search String

search Field(s)

Use new lines o commas for multipie search (CTRL-ENTER to subrmi

Vo / Friendly Name +/ Phone Number
= 15 tems per page
o ID =t Friendly Name !
® DID Numbers [m] © 54213 14102161183
- [m] © s
[m] © 55486

[ orword Number

Showing item 1to 3. Total: 3

Type DID Number !
local B B j@  +1 410-216-1183

local B B 1&

local B B 1&

(=

Account ID: 80020576
Account status - Active
$124.25 US!

Account balance

© #ppropriate Funds

D CR (Postpaid)

[ oniskewrte

peer(s)

SIP / ITest - Yeastar Interop 1

[ comments

Options Action

rm (]

e N - B

e |

Peer(s)

b. Enable SMS/MMS for the DID number, and configure the Callback URL using the

PBX's Webhook URL.
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Available Options

Basic Call Flow

Peer [ SIP Trunk [ call queue [ call forward O call director @
Route call to selected peer(s) Send callto a call queue Forward the call to another number Send call to director service
[ Media playback [ voicemail
Play a media file to the caller send call to a voice mailbox
Applications
Virtual fax Virtual attendant SIP URI Conference @
Send callto fax service Route the call to a virtual attendant profile Route call to another SIP address Multiple party conference system

Additional Options

[ call recording O ritters SMS/MMS options @ [ Advanced options
MS options for this number Additional options for advanced users

Record inbound calls associated to this number Block calls based on sslected criteria Modiify SMS/

<

27 SMS/MMS options

Enable SMS/MMS for this DID SMS/MMS Profile (Optional)

You don't have an AS Profiles

@ /MM Profile

If you are not using an SMS/SMS Profile, please use the options below:

Enable forwarding @ Forwarding number

O

Enable email notifications @ Notification email

O

Enable autoreply @ Autoreply message

O

Enable Callback URL @ Callback URL

https:/ [yeastardocs.ras.yeastar.com/api/v1.0fwebhook/voicemeup,/885c2304e9a04a850749552a56c279b4

Advanced option : Incoming SMS/MMS messages will be transmitted to the Callback URL.

D Enable SMS DNIS Override SMS DNIS override

3. Configure a user account used for the integration with PBX.
a. Create a user account.

po—
= O yeastar_interop ~ I

&8 Users & Access

- [ Y % (5]

Qsearch  YFi

search string

Use new lines o commas for multiple search

search Field(s)
Vo

+/ FullName / Email [ comments

page Showing item 1to 8. Total: 8

] D Type Access  Username First Name Last Name 12 Email Notifications Action




Contact Center Guide | 3 - Omnichannel Messaging Guide | 249

b. Configure the account information, and enable API access for the account.

Note:

Note down the username you set, as you will need it later on PBX.

User Type @
Please remember to adjust the permissions after saving, as new users
standard @ will have access to all applications by default.
Username

yeastar_test

m @ Password A Notifications P Access

First Name Last Name
Example Yeastar

Email Phone Number Extension
example@yeastar.com [T R

Fax Number Preferred Language

O french @ English

Time Zone

AmeticafMontreal [GMT -4]

&User @Password M Notifications

[ Allow login to the client section ~/ Allow access to the API

APl access is a big security risk because it allows anyone with the key to make changes in your account. Make sure not to disclose it anywhere.

Client Account ID Auth Token

50020576
IMPORTANT - Regenerating a token renders the pravious token obsolete.

API URL

https:/[clientsvoicereup.com/api/vil[xmi/get_request_types?username=USERNAME&aUth_token=AUTH _TOKEN

Documentation URL

https://developer.voicemeup.com/guides/xml_engine htm!

B o o | =
5 Copyright 2006-2023, Internet Infinity. All rights reserved. )

An account is created successfully; You are redirected the user account list.
c. Go to the account's details page, and obtain the Auth Token for the integration.
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fuser  @rassword  Anotficarons SN

Allow login to the client section Allow access to the API
API access is a big security risk because it allows anyone with the key to make changes in your account. Make sure not to disclose it
anywhere.
Client Account ID Auth Token
© n

Step 3. Create and configure an SMS channel on PBX

Create an SMS channel on PBX, and configure the channel with the authentication informa-
tion and number obtained from VoiceMeUp.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, enter the authentication information of VoiceMeUp.

Authentication Messaging Settings
VoiceMeUp SMS channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/voicemeup/9--
VoiceMeUp

« Name: Enter a name to help you identify the channel.

+ ITSP: Select VoiceMeUp.

« Username: Paste the username of the VoiceMeUp account.

« Auth Token: Paste the auth token of the VoiceMeUp account.
4. In the Messaging Settings tab, configure the channel.

a. In the Message Sending Rate field, specify the number of messages that PBX
can send per second.

Note:
« If the number of messages to send exceeds the set value, PBX
will arrange the messages in queue and send them at the sending

rate.




Contact Center Guide | 3 - Omnichannel Messaging Guide | 251

« If the sending rate set in PBX exceeds the limit set by the SMS
service provider, it may result in message delivery failures. Con-
tact your SMS service provider to confirm the sending rate limit of
your account and increase the limit as needed.

b. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X
+14102161183
For phone numbers, please enter them in E.164 format. For example, +86-532-5503309 should be entered as +865925503309.
Extension 3000-Leo Ball
4 items Available 2items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext.. 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Alphanumeric Sender
ID.

Note:

The phone number should be in E.164 format ([ +] [ count ry
code] [ phone nunber] ). For example, +14102161183.

- Destination for Inbound Messaging: Specify the destination of inbound
messages from the number.
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Option Description

Extension

Message Queue

Third-Party
Message
Analytics Platform
(Transmitted via
API)

If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from the number.

If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
able to receive and respond to the follow-up inbound
messages in the session.

If selected, inbound messages will be automatically
forwarded to a third-party message analytics platform via
API for advanced processing.

," Note:
To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

- Extensions allowed to create messaging sessions: Select the exten-
sions that are allowed to initiate a messaging session with customers.

d. Click Save.
5. Click Save.

Result

« A messaging channel is created successfully. You can see the channel displayed in

the Messaging Channel list with Status showing Q.


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging

Contact Center Guide | 3 - Omnichannel Messaging Guide | 253

Status Name Type Number Total Sent Operations

VoiceMeUp SMS
©) p

SMS +14102161183 0 0 Z ™
channel

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column indicates the total number of sent messages, in-
cluding both successfully sent messages and failed ones.

"4 Note:

. o For sent messages, PBX only tracks the number of the messages sent
from agents' Linkus UC Clients. If you want to calculate the actual cost
of sent messages, consult with the SMS service provider for the precise
number of messages transmitted, as long text messages (longer than
160 characters) are automatically split into segments and then re-as-
sembled when they are received, increasing the number of sent mes-
sages.

> You can filter the statistics by a time period using the time filter.

@ Add Al

Number Total Sent Failed Received Operations

414102161183 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client
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Custom SMS Channel

Integrate SMS Service with Yeastar P-Series PBX System using
SMS API

Yeastar P-Series PBX System allows Service Providers to integrate their SMS service with
the PBX system using SMS API. This topic describes how Service Provider can achieve the
interaction of SMS service with Yeastar PBX using API, and introduces how PBX administra-
tors can set up an SMS channel for the Service Provider on PBX system.

Requirements

To implement the SMS service integration with Yeastar P-Series PBX System, Yeastar PBX
and Service Provider must meet the following requirements.

Platform Requirement

Yeastar PBX » Firmware: Version 37.20.0.124 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
» Domain Name: PBX can be remotely accessed via a domain name.

Note:

> Due to the limitation of the third-party platform,
the domain name must NOT contain underscore
character(s), otherwise the messaging channel will
encounter authentication failure, or will fail to receive
messages.

o If you use a self-managed domain name, make sure
you have installed a valid domain certificate for the
domain name, otherwise the messaging channel will
encounter authentication failure, or will fail to receive
messages.

For more information about the domain configuration, see the following
topics:
o Configure Network for Remote Access by a Yeastar FQDN
o Configure Network for Remote Access by a Yeastar Domain
Name
o Configure Network for Remote Access by a Domain Name

Service Provider » API: Service Provider should provide the following API interfaces.
o HTTPS REST API for sending messages.



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
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Platform Requirement

o (Optional) If the service provider requires PBX to verify its
identity, an HTTPS REST API for verifying authentication should
also be provided.

» Customer Portal Feature: Service Provider should offer the following
features on its customer portal.

> Provide an API key to authenticate API requests sent from PBX
system.

o (Optional) If the Service Provider requires signature verification
for webhook requests sent to the PBX, a Secret should also be
provided for the PBX to verify the authenticity of the webhook
requests.

o Support for configuring Webhook through the customer portal.

* Number Format: Phone numbers should follow the E.164 format.

Authenticate requests
As the SMS service integration is implemented via API interactions between Service

Provider and PBX, the Service Provider should provide an APl key and a Secret for the re-
quest authentication of APIs and webhooks in the integration.

* API key

The API key is used to authenticate the API requests sent from PBX to Service
Provider.

The PBX will pass the API key in the header of each API request under an Aut hori za-
ti on field, as shown below:

Aut hori zati on: Bearer {api_key}

Upon receiving an API request, Service Provider verifies the API key extracted from the
request header. If the API key is valid, the Service Provider should execute the corre-
sponding actions as specified in the request. Otherwise, the API request fails.
For more information about the API request, see the followings:

o (Optional) Verify SMS channel connectivity

> Send messages through Service Provider

* Secret

The Secret is used to authenticate the webhook requests sent from Service Provider
to PBX.

| Note:
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Whether the Secret is required depends on whether the Service Provider uses
it for signature verification in webhook request.

When sending a message to PBX via webhook, the Service Provider needs to utilize
the Secret along with the SHA256 algorithm to generate a signature based on the
webhook request body, and pass the signature in the header of each webhook request
under an X- Si gnat ur e- 256 field, as shown below:

Important:
The signature included in the request header must be in all lowercase letters.

X- Si gnat ur e- 256: sha256={si gnat ur e}

Upon receiving a webhook request, PBX calculates a signature using the Secret along
with SHA256 algorithm based on the received webhook request body, then compares
the result with the signature extracted from the request header. If the signatures
match, it indicates that the webhook request is valid and PBX will deliver the message
retrieved from the request body to the message recipient. Otherwise, the webhook re-
quest will be rejected.

For more information about the webhook request, see Receive messages from Ser-
vice Provider.

(Optional) Verify SMS channel connectivity

Note:
Whether to perform this operation depends on the Service Provider's requirement
for identity verification. If not required, it can be skipped.

Once an SMS channel has been established on PBX web portal, the system will periodical-
ly send API requests to Service Provider using the API address for verifying authentication
and API key to verify the connectivity of the channel.

Interaction flow

The process of channel connectivity verification is shown below:
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Yeastar P-Series
PBX System

w
@®
3
=,
9]
o
o
=
o
=
a
]
=

Send request to API

GET /verify?challenge_code

Verify
APl key

Return status code 200
and challenge_code

Verify the
challenge_code

1. PBX initiates an API request, containing a randomly generated challenge
code.

2. Upon receiving the API request, Service Provider validates the API key.

3. If the API key is valid, Service Provider should return a status code 200,
and include the challenge code in the response body.

4. Upon receiving the response, PBX checks if the returned challenge code
matches the one it sent.

If the challenge code matches, it indicates that the channel connection
is successful.

APl request sent by PBX

Below is the structure and explanation of the API request sent by PBX for
channel connectivity verification.

Request method
GET

Request URL

{api _address_for_verifying_authentication}
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For example:

https://service-provider.exanpl e.com verify

Headers

Parameter Description

Authorizatio String Pass the API key in the header.

n Format: Bearer { api _key}

Query parameter

Parameter Description

challenge  String Challenge code. A random string that is
generated by PBX.

Request example

GET /

verify?chal | enge=mAWGyeTZgguOPYl Wt GPl RIYI hoLMy
HTTP/ 1. 1

Host: service-provi der. exanpl e.com

Aut hori zati on: Bearer {api_key}

APl response returned by Service Provider
Service Provider should return the API response in JSON format.

Success response

If the request is successful, Service Provider should return the
following information in the response:

« HTTP status code 200
« The challenge code that was sent by PBX in the request

For example:

HTTP/ 1.1 200 K
Body: mAWGhYyeTZgguOPYl Wt GPl RJYI hoLMy

If the challenge code in the response body matches the one sent
by PBX, it indicates that the channel has successfully connected.
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In this case, the channel status on PBX web portal is displayed

as @ (Connected).

Error response

If the request fails, Service Provider should return the error infor-
mation in the response according to the following format.

Parameter Type Description
code String Error code.
title String Error type (Customizable).
detail String Detailed information of the error
(Customizable).

The following example shows a response of a failed channel
connectivity verification.

HTTP/ 1.1 401 Unaut hori zed

{
"errors": |
{
"code": "10004",
"title": "Authentication failed",
"detail": "No key found matching the ID
with the provided secret."
}
]
}

Exceptions and troubleshooting

If channel connectivity verification fails, the channel on PBX web
portal will display an abnormal status. Service Provider can trou-
bleshoot the cause of the anomaly by checking the error code
and response body.

* Error code

The table below lists the error codes defined in the PBX.
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Error

Code

10001

10002

10003

10004
10005
10006

10007

10008

Error Message
channel.ErrinvalidPhon
eNumber

channel.ErrinvalidPara
m

channel.ErrUnsupportM
edia

channel.ErrAuthFail
channel.ErrAuthFail

channel.ErrTooManyRe
quest

channel.ErrServiceUnav
ailable

channel.ErrExceedsSiz
eLimit

Description

Invalid phone number.

Invalid parameter in the
request.

Resource type not
supported (MMS).

Authentication failed.
No permission.

Too many requests.

Service unavailable on
recipient's platform.

File size exceeds the
limit.

« Exceptions

The table below lists the possible abnormal channel sta-
tuses and their trigger conditions.

Channel

Status

Services of

unavailable

Unknown

Unauthorized

the recipient
platform are

Request Failed

Trigger Condition

o Authentication failed, Service

Provider returns HTTP status code

401/403/404.

o The returned challenge code does
not match the one sent by the PBX.

Service Provider returns HTTP status code

500.

Service Provider returns HTTP status code
except for 401/403/404/500, and returns error
information in the response body according
to the format defined by the PBX.

o Service Provider does not return

an HTTP status code, possibly
due to TCP connection issues or
non-existent domain.
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Channel

Status Trigger Condition

o Service Provider returns HTTP status
code except for 401/403/404/500, and
does not return a response body or
the returned response body is not in
JSON format.

Send messages through Service Provider

When a PBX user sends a message, PBX will send an API request to the Service Provider us-
ing the API interface for sending messages and API key, so as to deliver the message to ex-
ternal message recipient through Service Provider.

Interaction flow

The process of sending a message through Service Provider is shown below:

| 1 Yeastar P-Series \
H ! t PBX System ! |
. N \

Send

Send request to API
POST /sendmessage

I
|
|
)
:
i
! Verify
i APIkey
|
|
I
|
Return status code 200 |

and data.id

Deliver the message ——————|

1. A PBX user sends a message.

2. PBX initiates an API request to send a message through the Service
Provider.

3. Upon receiving the API request, the Service Provider validates the API
key.

4. If the API key is valid, the Service Provider should return a status code
200 and a dat a. i d to pass the unique ID of the message.

5. Service Provider delivers the message to the message recipient.

APl request sent by PBX

Below is the structure and explanation of the API request sent by PBX for
sending a message through Service Provider.
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Request method
POST

Request URL

{api _address_for_sendi ng_nessage}
For example:

https://service-provider. exanpl e. conl sendnessage

Headers
Parameter Type Description
Content-Ty  String Define the content type of the request
pe payload.
Valid value: application/json
Authorizatio String Pass the API key in the header.
n Format: Bearer { api _key}
Request body

PBX will pass the outbound message in the request body.

Param
T D ipti
eter ype escription
from String Phone number of the message sender.
73 Note:
This parameter should be in E.164
format. For example, +8618012121222.
to String Phone number of the message recipient.
Note:
This parameter should be in E.164
format. For example, +8618012121222.
text String The textual content of the message.
media_ur Array<Str The URL(s) pointing to the media content of
Is ing> the message.
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Request example

Here are examples of sending SMS/MMS messages to a phone
number through Service Provider.

« Send an SMS message

POST / sendnessage HTTP/ 1.1

Host: servi ce-provider. exanpl e. com
Cont ent - Type: application/json

Aut hori zation: Bearer {api_key}

{
"from': "+8618012121222",
"text": "Hello, World!"
"to": "+8618012121223"

}

« Send an MMS message

POST /sendnessage HTTP/ 1.1

Host: service-provider. exanpl e. com
Cont ent - Type: application/json

Aut hori zation: Bearer {api_key}

“from':"+8618012121222",
"to":"+8618012121223",

"media_url s":["yeastardocs. ras. yeastar. conf
api / chat / 70dee7e2f 95041ca890f 222ace06c2dc" ]

}

APl response returned by Service Provider

Service Provider should return the API response in JSON format.

Success response

If the request is successful, Service Provider should return the
following information in the response:

« HTTP status code 200
« A parameter dat a. i d to pass the unique ID of the mes-

sage
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For example:

HTTP/ 1.1 200 K

{
"data": {
"id":"b301led3f - 1490- 491f - 995f - 6664€69674d4" ,
/'l Message | D (Required, and MUST be different every
tinme)

}

Error response

If the API request fails, Service Provider should return the error
information in the response according to the following format.

Parameter Type Description
code String Error code.
title String Error type (Customizable).
detail String Detailed information of the error
(Customizable).

The following example shows a response of a failed message
sending request.

HTTP/ 1.1 400 Bad Request

{
"errors": |
{
"code": "10001",
"title": "lnvalid '"to' address"”,
"detail": "The 'to' address should be a
single valid nunber."
}
]
}

Exceptions and troubleshooting

If message delivery fails, an error prompt will be displayed on the
PBX user's Linkus client. Service Provider can troubleshoot the
cause of the anomaly by checking the error code and response
body.
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* Error code

The table below lists the error codes defined in the PBX.

Description

Invalid phone number.

Invalid parameter in the
request.

Resource type not
supported (MMS).

Authentication failed.
No permission.

Too many requests.

Service unavailable on
recipient's platform.

File size exceeds the

Error
Code Error Message
10001 channel.ErrinvalidPhon
eNumber
10002 channel.ErrinvalidPara
m
10003 channel.ErrUnsupportM
edia
10004 channel.ErrAuthFail
10005 channel.ErrAuthFail
10006 channel.ErrTooManyRe
quest
10007 channel.ErrServiceUnav
ailable
10008 channel.ErrExceedsSiz
eLimit

limit.

« Exceptions

The table below lists the possible error prompts and their

trigger conditions.

Error Prompt Trigger Condition

Failed to send

Authentication
Failed

o Service Provider does not return a
data.id.

o Service Provider returns HTTP status
code 404, prompting service not
found.

o Message delivery fails, and Service
Provider returns error information
according to the format defined by
the PBX, which will be displayed in
the error prompt.

o Message delivery fails, and Service
Provider does not return error
information or the returned response
body is not in JSON format.

o Service Provider returns HTTP status
code 401.
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Error Prompt Trigger Condition

o Service Provider returns error code
10004 or 10005.

Recipient o Service Provider returns HTTP status
Platform code 403.

Service o Service Provider returns error code
Unavailable 10007.

Invalid Phone Service Provider returns error code 10001.

Number

Invalid Service Provider returns error code 10002.
Parameter

This type of Service Provider returns error code 10003.

message is not
supported due
to the restriction
of the recipient
platform.

Too frequent Service Provider returns error code 10006.
operations.

Please try again

later.

The file size Service Provider returns error code 10008.
exceeds the

limit of the

recipient's

platform.

Receive messages from Service Provider

PBX can receive messages from external message sender via a phone number provided
by the Service Provider. When an external message sender sends a message to the phone
number, Service Provider can send a request to PBX's webhook URL, so as to deliver this
message to PBX.

Interaction flow

The process of receiving a message from Service Provider is shown below:

| Note:
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Whether to perform signature verification depends on the Service
4 Provider's requirement for signature verification. If not required, the
signature-related operations can be skipped.

Yeastar P-Series
PBX System

} POSTrequest to

Webhook URL
|
|
i

Verify :
Webhook signature |
|

|

|

|

i

Return status code 204 ———» |

Deliver the messag

1. An external message sender sends a message.

2. The Service Provider should initiate a request to the PBX's webhook URL,
with the inbound message attached in the request body and a SHA256
signature included in the request header.

3. Upon receiving the webhook request, PBX verifies the signature by using
the secret provided by Service Provider to calculate a SHA256 signature
based on the received webhook request body, then compares the result
with the signature extracted from the request header.

If the signatures match, it indicates that the webhook request is valid,
and PBX will return a status code 204 to the Service Provider.
4. PBX delivers the message to the PBX user.

Webhook request sent by Service Provider

Below is the structure and explanation of the webhook request that Service
Provider should send for message delivery.

Request method
POST

Request URL

{webhook_ur| _provi ded_by_pbx}

For example:
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https://yeastardocs.ras. yeastar.com
api / v1. 0/ webhook/ gener al / 429ced149f f 9437695be795af f 3
8407b

Headers

Parameter | Type Description
Content-Typ String | Define the content type of the request
e payload.
Valid value: application/json
X-Signature- String  Pass the signature for webhook
256 authentication, where { si gnat ur e} is the
lowercase result generated by encrypting

the body content with the Secret using the
SHA256 algorithm.

Format: sha256={si gnat ur e}

Request body

The Service Provider should pass the inbound messages in the
request body.

Note:
Here only lists the mandatory parameters. Service
Provider may extend this message with other data if

needed.

Requ

P t T D ipti
arameter ired ype escription

data.event ty Yes Strin Event type.

pe 9 Valid value: nessage. r ecei ved.

data.payload.i Yes Strin Message ID.

d g
Note:

* The maximum
character length is
255.




Requ

Parameter :
ired

data.payload.f Yes
rom.phone_nu
mber

data.payload.t Yes
o.phone_num
ber

data.payload.t Yes
ext

data.payload. Yes

media

data.payload.r Yes
eceived_at

Type

Strin
g

Strin
g

Strin
g

Array
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Description

 The ID MUST be
different every time.

Phone number of the message
sender.

Note:
This parameter should be in
E.164 format. For example,
+8618012121222.

Phone number of the message
recipient.

Note:
This parameter should be in
E.164 format. For example,
+8618012121222.

Textual content of the message.

Important:

Either dat a. payl oad. t ext or
dat a. payl oad. medi a must be
provided.

The information and URL pointing to

<med the media content of the message.

ia>

Strin
g

Important:

Either dat a. payl oad. t ext or
dat a. payl oad. nedi a must be
provided.

The time when the message was
received (ISO 8601 format).

Format:
YYYY- MM DDTHH: MMt SS. nmm+/ - HH: MM

Example:
2019-12-09T20:16:07.588+08:00.
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Parameter Description

data.payload.r Yes Strin Record type.

ecord_type 9 Valid value: nessage.

media

Param | Requ
eter ired

Type Description

content No Strin  The type of the media file.

_type g
e Tip:

Refer to the Media
Types for the
corresponding
value.

sha256 No Strin The SHA256 value of the

g media file.

size No Integ File size.
er

url Yes Strin  The URL that points to the
g media file.

Request example

The following example shows a webhook request for Service
Provider to send a message to the PBX.

PCST /

api / v1. 0/ webhook/ gener al / 429ced149f f 9437695be795af f 3
8407b HTTP/ 1.1

Host: yeastardocs.ras. yeastar.com

Cont ent - Type: application/json

X- Si gnat ur e- 256: sha256={si gnat ur e}

"data": {
"event _type": "nmessage.received",
"id":
"b301led3f - 1490- 491f - 995f - 6e64€69674d4" ,
/'l Event 1D (Required, and MJST be different every
time)


https://www.iana.org/assignments/media-types/media-types.xhtml
https://www.iana.org/assignments/media-types/media-types.xhtml
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"occurred_at":
"2019-12-09T20: 16: 07. 588+00: 00",

"payl oad": {
"conpleted_at": null,
"direction": "inbound",

"encodi ng": "GSM 7",
"errors": [],
"from': {
/1 Sender information
“carrier": "T-Mbile USA",

"l'ine_type": "long_code",
"phone_nunber": "+8618012121222",
"status": "webhook delivered"

I

"id":

"84ccal75- 9755- 4859- b67f - 4730d7f 58aa3",
// Message | D
"media": [{
// Medi a content of the message
"content type": null,
"sha256": null,
“url™:
"https://pbs.twi ng. com profile_ i mges/ 1142168442042
118144/ AVBF4f FD_400x400. png"
il
"messagi ng_profile_id":
"740572b6- 099c- 44al- 89b9- 6¢c92163bc68d",
"organi zation_id":
"47a530f 8- 4362- 4526- 829b- bceel7f d9f 7a",

"parts": 1,

"received_at":
"2019-12- 09T20: 16: 07. 503+00: 00", /1 The tine
when the nessage is received

"record_type": "nmessage",

/'l Record type
"sent _at": null,
"tags": [],
"text": "Hello from PBX!'",
/l Textual content of the nessage
to": |
/1 Recipient information

{

"carrier": "PBX",
"line_type": "Wreless",
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"phone_nunber":

"+8618012121223",
"status": "webhook delivered"
}
IR
"type": "SMs/ MVB",
"valid until": null,
"webhook failover url": null,
"webhook_url":
"http://webhook. site/ 04bbd2e3- 09b5- 4c9e- 95de- aldebe
b9e675"
I s
"record_type": "event"
I
"meta": {
"attenpt": 1,

"delivered to":
"http://webhook. site/ 04bbd2e3- 09b5- 4c9e- 95de- aldebe

b9e675"
}
}

Webhook response returned by PBX
The PBX system will return an HTTP status code in the response.

Status Code Description
204 Success.
400 Bad request, returned when the signature is incorrect.

Set up an SMS channel for Service Provider

After Service Provider implements the SMS service integration with Yeastar PBX, PBX ad-
ministrator can set up an SMS channel on PBX web portal for the Service Provider.

Limitations

Item Limitation

Supported message The supported message types are determined by the Service
types Provider.

Important:

When sending multimedia messages (such as
images), the SMS service provider downloads the
files from a link provided by the PBX. Therefore, if
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Item Limitation

you have set Allowed Country/Region IP Access
Protection rule, make sure that you have allowed the
IP access from the country where the SMS service
provider is located, otherwise the file transmission
would fail.

File size Max. 100 MB

File retention period 72 hours

Prerequisites

« Obtain the following information from the Service Provider:
> APl address for sending messages
> (Optional) API address for verifying authentication
> Message sending rate limit
« Obtain the following information from the Service Provider's customer
portal:
> APl key
> (Optional) Secret
> Phone number used for message sending and receiving

Note:
If business needs to communicate with US-based cus-
tomers, make sure that the phone number has been com-
pleted with 10DLC registration to avoid disruption in mes-
sage delivery.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select SMS.
3. In the Authentication tab, complete the following settings.

General SMS Channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/general/90b4cf3.

General

https://service-provider.example.com/sendmessage https://service-provider.example.com/verify


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html

Contact Center Guide | 3 - Omnichannel Messaging Guide | 274

« Name: Enter a name to help you identify the channel.

« ITSP: Select General.

* API Key: Enter the API key obtained from the Service Provider's
customer portal.

« Secret: Optional. If Service Provider provides a Secret for verifica-
tion, enter it in this field.

- APl Address for Sending Messages: Enter the correspond-
ing API address provided by the Service Provider. For example,
https://service-provider. exanpl e. com sendnmessage.

- APl Address for Verifying Authentication: Optional. If Service
Provider provides an API address for identity authentication, enter
it in this field. For example, ht t ps: / / ser vi ce- pr ovi der . exanpl e-
.conm verify.

« Webhook URL: Select a desired URL from the drop-down list, then
copy the URL, and configure messaging webhook for the phone
number using the URL in the Service Provider's customer portal.

4. In the Messaging Settings tab, configure the channel.
a. In the Message Sending Rate field, specify the number of mes-
sages that PBX can send per second.

Note:

« If the number of messages to send exceeds the set
value, PBX will arrange the messages in queue and
send them at the sending rate.

« If the sending rate set in PBX exceeds the limit set
by the SMS service provider, it may result in mes-
sage delivery failures. Contact your SMS service
provider to confirm the sending rate limit of your ac-
count and increase the limit as needed.

b. Optional: If you want the system to automatically close the ses-
sions that have been inactive for a specific period of time, select

the checkbox of Close Session Automatically, then set the time-
out in the Session Timeout (Days) field.
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Close Session Automatically

c. In the Number section, click Add to add a message routing rule.

Add X

*
+14102161183

For phone numbers, please enter them in E.164 format. For example, +86-592-5503309 should be entered as +865925503309.

Extension 3000-Leo Ball
4 items Available 2 items Selected
Extension Num... Caller ID Name Extension Num... Caller ID Name
Extension Group  Default_All_Ext 1000 Leo Ball
1002 Terrell Smith 1001 Phillip Huff
1003 Dave Haris
1004 Troy Daniel

X Cancel

« Number: Enter the purchased number or specify an Al-
phanumeric Sender ID.

Note:
The phone number should be in E.164 format ([ +]
[country code] [ phone nunber] ) For example,

+14102161183.

- Destination for Inbound Messaging: Specify the destina-
tion of inbound messages from the number.

Description

Extension If selected, choose an extension from the
Extension drop-down list.

Only the extension user can receive inbound
messages from the number.
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Option Description

Message If selected, choose a queue from the Message
Queue Queue drop-down list.

All the agents in the selected message queue
can receive inbound message(s) of new
sessions in the queue. However, only the
user who picks up a session will be able to
receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be
Message automatically forwarded to a third-party
Analytics message analytics platform via API for
Platform advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of
inbound messages to a third-party
message analytics platform, ensure
that your PBX server has been
integrated with the third-party
message analytics platform via
API. Once this option is selected,
the PBX system will automatically
transmit inbound messages to the
designated platform. You can get
notified by monitoring the API event
(30031) New Message Notification.
Additionally, the PBX provides a
comprehensive Message API suite for
advanced message interaction with
the integrated third-party message
analytics platforms.

- Extensions allowed to create messaging sessions:
Select the extensions that are allowed to initiate a messag-
ing session with customers.

d. Click Save.
5. Click Save.

Result


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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« A messaging channel for the Service Provider is created successfully.

The channel is displayed in the Messaging list with Status showing .

Status Name Type Number Total Sent Operations

o) General SMS SMs pom o 0 0 2 B

Channel

« PBX automatically tracks and records the number of messages sent
and received on the channel, where the Total column indicates the total
number of sent messages, including both successfully sent messages
and failed ones.

Note:

> For sent messages, PBX only tracks the number of the
messages sent from agents' Linkus UC Clients. If you
want to calculate the actual cost of sent messages, con-
sult with the SMS service provider for the precise number
of messages transmitted, as long text messages (longer
than 160 characters) are automatically split into seg-
ments and then re-assembled when they are received, in-
creasing the number of sent messages.

> You can filter the statistics by a time period using the time
filter.

Number Total Sent Failed Received Operations

+14102161183 30 20 10 8 Z W

What to do next

Send text messages to the phone number added in the channel, and see if the
specified PBX user can receive messages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client
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Facebook

Facebook Messenger Integration Guide

By integrating Facebook and Yeastar P-Series PBX System, agents in your business can re-
ceive and reply to Facebook Page messages directly on Linkus UC Clients, without having to
log in to Facebook Messenger.

Requirements

Platform Requirement

Yeastar PBX * Firmware: Version 37.20.0.124 or later

* Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
+ Domain Name: PBX can be remotely accessed via a domain name.

Note:

> Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise
the messaging channel will encounter authentication failure, or
will fail to receive messages.

o If you use a self-managed domain name, make sure you
have installed a valid domain certificate for the domain name,
otherwise the messaging channel will encounter authentication
failure, or will fail to receive messages.

For more information about the domain configuration, see the following topics:
> Configure Network for Remote Access by a Yeastar FQDN
> Configure Network for Remote Access by a Yeastar Domain Name
> Configure Network for Remote Access by a Domain Name

Facebook * Product: Messenger Platform

» Account:
> A Meta Developer account

Note:
You only need one Meta Developer account to create multiple
Meta apps for the Facebook channel integration. There is no
limit to the number of Facebook channels on PBX.

o

A Business Manager account (Business Portfolio)

Note:



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://developers.facebook.com/docs/development/register
https://www.facebook.com/business/help/1710077379203657?id=180505742745347
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Platform Requirement

3 After you set up a Business Manager account, verify your
4 business.

Limitations

Learn about the limitations of Facebook messaging channel.

Item Description

Message type Supports text messages and multimedia messages, where the multimedia
message types are determined by Facebook. For more information, see
Facebook supported media types.

Important:

When sending multimedia messages (such as images), Facebook
downloads the file from a link provided by the PBX. Therefore, if you
have set Allowed Country/Region IP Access Protection rule, make
sure that you have allowed the IP access from the country where the
Facebook server is located, otherwise the file transmission would fail.

Messaging Supports to receive and reply to Inbound messages, but agents can NOT
mechanism initiate a messaging session with a Facebook user.

Message sending  Supports to send up to 40 messages per second.

rate

File size Supports to send a file with a maximum size of 25 MB.
File retention Files can be retained for 72 hours.

period

Set up a Facebook Channel

This topic describes how to set up a Facebook channel on Yeastar P-Series PBX System, so
that agents in your business can receive and reply to your Facebook Page messages.

Step 1. Create a Meta app

On 'Meta for Developers' portal, create a Meta app for the integration.

1. Log in to 'Meta for Developers' portal, then go to My Apps from the top menu.


https://www.facebook.com/business/help/2058515294227817?id=180505742745347
https://www.facebook.com/business/help/2058515294227817?id=180505742745347
https://developers.facebook.com/docs/messenger-platform/reference/send-api#sample-request
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://developers.facebook.com
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00 Meta Developer Products Docs Blog More My Apps Q

Introducing Llama 3.1:
Our most capable
models to date

Llama 3.1 405B is the first openly available model that rivals the
top Al models when it comes to state-of-the-art capabilities in M e et L I a I I I a 3 .1
general knowledge, steerability, math, tool use, and multilingual

translation.

-> ) Learn more

2. At the top-right corner, click Create App.

Docs  Tools  Suppot  Apps Required actions

R Meta

Apps Name or App ID
)

Filter by Admin Apps Select all

(@) All Apps (14)
Archived &R o
u P X
v
Required actions (1)

Business portfolio Clear

No busine ortfolio select v @ Administrator @) Administrator @ Administrator

3. For App details, configure app name and contact email, then click Next.

Create an app

[ ) App details

App name

This is the app name that will show on your My Apps page and associated with your app ID. You can change the name later in Settings.

Yeastar Messaging

App contact email
This is the email address we'll use to contact you about your app. Make sure it is an address you check regularly. We may contact you about policies, app restrictions or recovery if your
app is deleted or compromised

becky@yeastar.com

=1

4. For Use cases, select Other, then click Next.
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Create an app

@ App details (P usecases QO Business QO Finalize

Add use cases

Create & manage ads with Marketing API
Create, manage and optimize ad campaigns across Meta technologies. Programmatically extend, stop or update ad campaigns and more.
Learn more.

Measure ad performance data with Marketing API
Maximize ROl with ad performance data to optimize ad budgets, creatives and create custom audiences, connect customers to product
catalogs and improve reach. Learn more.

Capture & manage ad leads with Marketing API
Give potential customers a quick and safe way to sign up to get info about your business or products. Learn more.

Run ads to promote your app
Get an app ID to promote your app on Meta technologies, like Facebook and Instagram. Learn more.

Access the Threads API
Use the Threads API and choose to authenticate users, retrieve user information, post threads, reply to threads, manage reply settings
and/or gather insights for a Threads profile you own or manage on behalf of others. Learn more.

Embed Threads content in other websites
Use the Threads oEmbed API to embed content of Threads posts, such as photos and videos, in other websites. Learn more.

Launch a game on Facebook
Launch a game that players can find and play directly in their Feed or messages/conversations, on both desktop and mobile devices. Learn
more.

Authenticate and request data from users with Facebook Login
Our most common use case. A secure, fast way for users 1o log into your app or game and for the app to ask for permissions to access their
data to personalize their experience. Learn more.

Looking for something else?
If you need something that isn't shown above, you can see more options by selecting Other.

Other o
Explore other options for app integrations such as Whatsapp messaging, Commerce APl and more. You'll be asked to select an app type, then add
the permissions and products you need.

Cancel Previous m

5. For App type, select Business, then click Next.
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Create an app

(D Type

-") Details

Select an app type
The app type can't be changed after your app is created. Learn more

Business o

1 Create or manage business assets like Pages, Events, Groups, Ads, Messenger, WhatsApp, and
Instagram using the available business permissions, features and products.

Consumer
a'. Connect consumer products and permissions, like Facebook Login to your app.

=

6. For App details, select your Meta business portfolio.

Create an app

Q Type

(D Details

7. Click Create app.

App name

This is the app name that will show on your My Apps page and associated with your app ID. You can change the name later in Settings
Yeastar Messaging 17/30
App contact email

This is the email address we'll use to contact you about your app. Make sure it is an address you check regularly. We may contact you about
policies, app restrictions or recovery if your app is deleted or compromised.

becky@yeastar.com
Business portfolio - Optional
Connecting a business portfolio to your app is only required for certain products and permissions. You'll be asked to connect a business

portfolio when you request access to those products and permissions.

T | TestBusiness hd

Cancel Previous

The Meta app is created; You are redirected to the App Dashboard page.

Step 2. Set up the Meta app

On 'Meta for Developers' portal, add Messenger Platform to your Meta app and set up the
app to gather the required credentials for the integration.

1. On the Add products to your app page, click Set up on Messenger.
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Add products to your app

We've streamlined the app creation process by surfacing the products and permissions needed to build the app type you selected

® G -

Messenger Instagram WhatsApp

Allow creators and businesses to manage
messages and comments, publish content, track Integrate with WhatsApp
nsights, hashtags and mentions.

Customize the way you interact with people on
Messenger.

Read Docs Set up Read Docs Set up Read Docs Set up

You are redirected to the Messenger API configuration page.
2. Connect the Meta app to your Facebook Page to generate an access token, and gath-
er credentials of the Facebook Page.
a. Scroll down to the 2. Generate access tokens section, click Connect to add
your Facebook Page.
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App Dashboard upport  Apps  Required actions

Yeastar Messaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help

(o) pashboard 2. Generate access tokens
v Connect Facebook pages to generate access tokens and set up webhook subscriptions.
Required actions

{G% App settings v
App roles v
£\ Alerts v
@ App Review v
Products Add Product
Messenger -~

No FB pages yet.

Messenger API Settings Connect to your F8 pages.

Instagram settings

Activity log m

1= Activity log
€) Log in With Facebook - Google Chrome - O X ) Log in With Facebook - Google Chrome = m] X
25 facebook.com/dialog/oauth?client id=4901615936574638display=po... % 25 facebook.com/dialog/oauth?client id=490161593657463&display=po... %

xN-B ‘- - B L

Continueas = ww? Choose the Pages you want Yeastar Messaging to
Yeastar Messaging will receive your name and profile picture. access
Later you'll be able to review what Yeastar Messaging will be able to do
with the Pages you select.
Not ? Log into another account.

Opt in to all current and future Pages
This will give Yeastar Messaging access 1o your current Pages, in addition to
any Page you create in the future

@ Optinto current Pages only
This will only give Yeastar Messaging access to the Pages you select

Select all 1Asset Selected

v Yeastar
334079033132769

By continuing, Yeastar Messaging will receive ongoing access to the information you
share and Meta will record when Yeastar Messaging accesses it. Learn more about

this sharing and the settings you have.

€) Log in With Facebook - Google Chrome = o X €) Log in With Facebook - Google Chrome = [m} X

2% facebook.com/dialog/oauth?client i

N~ B ‘-~ N = E e -

id=4901615936574638&display=po... % 25 facebook.com/dialog/oauth?client id=4901615936574638&display=po... %

Review what Yeastar Messaging is requesting # Law has been connected to Yeastar Messaging
permission todo To manage this connection, go to Business Integrations.

Manage and access Page conversations in Messenger
1 Page selected

... oo |
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Refresh the webpage and you will see that the Facebook Page is added.

2. Generate access tokens

A~
Connect Facebook pages to generate access tokens and set up webhook subscriptions.
Page Name Webhook Subscription Token
Yeastar Add Subscriptions
Generate 1]
. 354079033132769 No fields subscribed.
Add Page

b. Generate an access token to authenticate the Meta app and allow it to perform
actions on behalf of the Facebook Page.

Note:
Copy and note down the access token, as you will need to add it on the
PBX later.

Token Generation X

Yeastar
2. Generate access tokens 334079033132769

Connect Facebook pages to generate access tokens and set up webhook subscriptions.

To protect your security, ONLY share this token with app developers you trust.

Page Name Webhook Subscription Token
Yeastar ‘Add Subscriptions This token will ony be shown once, so keep it safe. I it gets lost, you'l need to create a new
334079033132769 Generate | @ one. Anyone could potentially use this token to impersonate this page, depending on the
No fields subscribed.

privacy settings of your app. If you wish to revoke all previously generated tokens for this
app, you can go to Business Integrations settings. Learn More
Add Page

(V) 1Understand

EAAGGXpUMZBMOBOTrXRLTY{YBUWYFaXV1UISFi6jfNvedEoJiavFyopJoe | ([ Copy

c. Copy and note down the name and ID of your Facebook Page, as you will need
to add them on the PBX later.

2. Generate access tokens

Connect Facebook pages to generate access tokens and set up webhook subscriptions. ~
Page Name Webhook Subscription Token
. Veastar Token generated
334(@33132759 No fields subscribed. Generate W
Add Page

3. Obtain secret key for the Meta app.
a. On the left navigation bar, click App settings > Basic.
b. On the right of the App secret field, click Show to show the secret key.
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bs s swpot  apps  equresacors s (IR & &

QN Meta = App Dashboard

[E] veastar Messaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help
m Dashboard
App ID secret
Required actions PP App
2478854338991095  eesssses Show
b App settings ~
Display name Namespace
Basic
Yeastar Messaging
Advance d

c. Copy and note down the secret key, as you will need to add it on the PBX later.
Docs. Tools Support Apps Required actions 4 — A .

OQMeta = App Dashboard

[ vessurmessaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help
@ Dashboard

AppID App secret
Required actions PP PP

468798182717645 56187 Reset

ﬁ App settings A @

Display name Namespace

Basic
Yeastar Messaging

Advanced

Step 3. Create a Facebook channel

On PBX web portal, create and configure a Facebook channel.

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click Add, and select Facebook Messenger.
3. In the Authentication tab, enter the authentication information of Facebook.

Authentication Messaging Settings
Please refer to the User Guide for information on how to configure the following settings

Facebook channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/facebook/cb70e

334079033132769 Yeastar

« Name: Enter a name to help you identify the channel.
« Webhook URL: Select and note down the Webhook URL, as you will need it lat-

er on 'Meta for Developers' portal.
- Verify Token: Note down the verify token, as you will need it later on 'Meta for

Developers' portal.
» Access Token: Paste the Access Token obtained from 'Meta for Developers'

portal.
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» App Secret: Paste the App Secret obtained from 'Meta for Developers' portal.

 Page ID: Paste the Page ID obtained from 'Meta for Developers' portal.

» Page Name: Paste the Page Name obtained from 'Meta for Developers' portal.
4. In the Messaging Settings tab, configure the channel.

Authentication Messaging Settings

* *
Extension 1002-Terrell Smith
Close Session Automatically

*

1

- Destination for Inbound Messaging: Specify the destination of inbound mes-
sages from Facebook Page.

Option Description

Extension If selected, choose an extension from the Extension drop-down list.

Only the extension user can receive inbound messages from the
Facebook Page.

Message If selected, choose a queue from the Message Queue drop-down list.

Queue All the agents in the selected message queue can receive inbound

message(s) of new sessions in the queue. However, only the user
who picks up a session will be able to receive and respond to the
follow-up inbound messages in the session.

Third-Party If selected, inbound messages will be automatically forwarded
Message to a third-party message analytics platform via API for advanced
Analytics processing.

Platform

(Transmitted ,‘. Note:

via API) To enable automatic forwarding of inbound messages

to a third-party message analytics platform, ensure that

your PBX server has been integrated with the third-party
message analytics platform via API. Once this option

is selected, the PBX system will automatically transmit
inbound messages to the designated platform. You can get
notified by monitoring the API event (30031) New Message
Notification. Additionally, the PBX provides a comprehensive
Message API suite for advanced message interaction with the
integrated third-party message analytics platforms.

» Close Session Automatically: Optional. If you want the system to automatical-
ly close the sessions that have been inactive for a specific period of time, select


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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the checkbox of Close Session Automatically, then set the timeout in the Ses-
sion Timeout (Days) field.
5. Click Save.

Step 4. Set up Meta webhook

On 'Meta for Developers' portal, configure webhook for your Meta app and subscribe to the
messages event, so that PBX can get notified upon receiving Facebook Page messages.

1. On 'Meta for Developers' portal, go to the Messenger API configuration page of your
Meta app.

2. In the 1. Configure webhooks section, configure a webhook and subscribe to mes-
sages field for your app.
a. Click Configure to add and configure a webhook.

Edit Callback URL X

Callback URL

| https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/facebook/f4f8f0074a6bafa894ea7ec1 cbed788¢ |

Verify Token

| qm3rprrg52wzk1ah |

- Callback URL: Paste the Webhook URL obtained from PBX.
- Verify Token: Paste the verify token obtained from PBX.
b. Click Manage to subscribe to messages field.
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1. Configure webhooks

~
Configure a custom webhook URL or use services that help you set up an endpoint. Learn more.
Callback URL Verify Token
https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/face Edit
Webhook Fields
Manage
Show Recent Errors
Webhook fields X
message_reactions v20.0 w v20.0 w m
messages v20.0 w v200 ¥ Subscribe
messaging_account_linking v20.0 w v20.0 w Subscribe
mAanaamins Anctamaar infarmmatin L1 N N
Cancel

3. Inthe 2. Generate access tokens section, click Add Subscriptions to subscribe to
messages field for your Facebook Page.



Contact Center Guide | 3 - Omnichannel Messaging Guide | 290

2. Generate access tokens
Connect Facebook pages to generate access tokens and set up webhook subscriptions.

Page Name Webhook Subscription Token

. Yeastar Add Subscriptions Generate @

334079033132769 ;
No fields subscribed.

Add Page
Edit Page Subscriptions X
Yeastar
334079033132769
messages messaging_postbacks
messaging_optins messaging_optouts
message_deliveries message_reads
messaging_payments messaging_pre_checkouts
messaging_checkout_updates messaging_account_linking
messaging_referrals message_echoes
message_edits messaging_game_plays
PRPRF | R RS S ERPR PR e
Learn more Cancel m

Result

« On PBX web portal, the Status of the Facebook channel shows @, which indicates
that you have successfully created a Facebook channel.

Status Name Type Number Total Sent Failed Operations

@ Facebook channel Facebook Messenger ~ 334079033132769 0 0 0 Z B

» PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column displays the total amount of the sent messages,
including both successfully sent messages and failed ones.

e Tip:

You can filter the statistics by a time period using the time filter.
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Status Name Type Number Total Sent Failed Received Operations

@ EE Facebook Messenger  334079033132769 30 30 0 25 Z

What to do next

Submit App for Review.

(Optional) Add a Tester for Meta App

After a Meta app is created, only your Meta Developer account has permission to interact
with the app. To keep your account safe, you can add a user as a Tester to aid with the test-
ing process.

Requirements

The user who you want to add as a Tester must have a Meta developer account.
Step 1. Add a user to business portfolio

1. Go to Business settings in Meta Business Manager, then select the business portfolio
that is connected with your Meta app.

00 Meta —
Settings
| Test Business v
@ Ads Manager
E}J Ads Reporting

O%)D Events Manager

2. Go to Users > People, then click Invite people.


https://business.facebook.com/settings/
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3

. Test Business
Settings .

Business portfolio

A) users N People o Q Search | =5 Filters & Export v
m Name T Business portfolio access @

Partners

Lastactive @ Status @

=)

System Users

b o o B o

3. In the Email address field, enter the email address of the user who you want to add,
then click Next.

Invite people Add people X
‘) Add people YZ: can invite people to join the Test Business business portfolio by entering their email
address.

Email address
Notifications from the business will be sent to these email addresses.

yangym@yeastar.com X

Additional settings
@  Temporary access

@  Meta Spark access

Allow this person to access AR effects in Meta Spark on behalf of this business portfolic. They
won't have access to other business tools. Learn more

4. Set the type of access that you want to assign as needed, then click Next.
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Invite people Assign access x
Q Add people Sele:tl‘Fhe tasks that best fit what all the invitees need to do in the Test Business business
parttolio.

Assign access .
O g Partial access

Basic

can

Apps and integrations
Set up Conversions API. Monitor events, edit applications and create access tokens.

(] Manage

Full control
Everything

This is the most control you can give someone. They can do all of the above, assign other people full
control and delete the business portfolio.

(] Manage

View advanced options *

Learn more about assigning access to a business portfolio. Back Next

5. Leave business asset(s) blank, then click Next.



Contact Center Guide | 3 - Omnichannel Messaging Guide | 294

Invite people Assign business assets X

Assign all invitees access to Facebook Pages, Instagram accounts or other business assets in

Q Add people ’ ) ‘
the Test Business business portfolio.
Q Assign access
Select business asset(s) v
O Assign business a...
Learn more about assigning access to a business asset Back Next

6. Click Send invitation.



Invite people

Q Add people

@ Assign access

Q Assign business a...

(P Review invitation
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Review invitation X
An email will be sent to inviting them to join the Test Business business portfolio.
Add to business portfolio
& yangym@yeastar.com
Access to portfolio and assets

Test Business
Partial access: Basic

No assets assigned
Select Assign business assets or Back 1o assign

Your business name, business portfolio cre.
country, business

Back Send invitation

Y

7. Click Done to close the window.
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Invite people Invitation sent X
o Add people

@ Assign access

o Assign business a...

Q Review invitation

Your invitation to to join the Test Business
business portfolio is on the way! The invitation
will expire in 30 days.

Meta will send an activation email to the user; The user needs to accept the invitation
to join your business portfolio.

Step 2. Assign the Meta app to the user

1. On the right of the desired user, click ***, then select Assign assets.

00 . Test Business
Settings . Business portolio
AU 7 Welcome to the new Settings experience on Meta Business Suite -~
sers IS
. The new Settings is an updated version of Business Settings. It has the same features, but with a fresh new look, improved user experience and added reliability. Please note that
m the legacy Business Settings will be discontinued soon.
® Partners
o e People © Q Search by name, ID, or ema 5 Filters & Export w + Invite people
ystem Users
fol Name 11 Business portfolio access @ Lastactive @ Status @
8 =9 Accounts ~
Gy yangym Partial access .
Pages & Jangymeyeastarcom Basic Aug 15,2024 Active
Ad Accounts X i
View details
Business Asset Groups
& Editinfo
Apps
Edit business portfolio permissions
Instagram accounts
Assign assets
WhatsApp Accounts
) Remove from business portfolio
Q £ DataSources v
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2. Assign the Meta app and test access to the user, then click Assign assets.

Select assets and assign permissions X
Select asset type @ Select assets Assign permissions =
Catalogs Q Search by name or ID Partial access .

Apps Y Develop app

—  Select all - Can change app settings, test the app and view analytics.
WhatsApp accounts ~ . PS View insights
v Yeastar Messaging Can view app analytics.
o Test app
© @ Can test the app.
&R
. Full control
e
He Manage app
. Can manage roles, change app settings, test the app and
..6, view analytics.
&R
&
: hd
&R 4 » -

- | 4 3

1 asset selected Cancel

3. Click Done to close the window.

Select assets and assigh permissions X

Assets assigned
1 asset was assigned to yang ym.
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Result

The user is added as a Tester and can interact with your Meta app.

What to do next

Submit App for Review.

Submit App for Review

After you set up a Facebook channel, you need to test message delivery between Facebook
Page and Yeastar P-Series PBX System, then submit your app for review.

Before you submit

Test message delivery between Facebook Page and Yeastar P-Series PBX System.

1. (Optional) Add a user as a Tester.

By default, only your Meta Developer account has permission to interact with the app.
You can directly use your Meta Developer account to test message delivery, but we
recommend that you add a Tester account with limited access to aid with the testing
process. This helps avoid exposing your Meta Developer account, as Meta requires a
Facebook account to test your app.
2. Test message delivery and record two screencasts.
« A screencast that demonstrates how you send a message to your Facebook
Page and how the message is received and replied on Yeastar P-Series PBX
System within 24 hours.

« A screencast that demonstrates how your app uses a human agent tag to re-
spond to customer messages outside the 24-hour window.

0 Tip:
App Review - Best Practices may help improve the quality of your submission and
reduce the chances of it being rejected.

Step 1. Complete app settings

1. Go to the Basic settings page of your Meta app.
a. Log in to 'Meta for Developers' portal, then go to My Apps from the top menu.



https://developers.facebook.com/docs/resp-plat-initiatives/app-review/before-you-submit?locale=en_US
https://developers.facebook.com

b. On the App list, click your Meta app.

x

(R Meta

Meta

Introducing Llama 3.1:
Our most capable
models to date

Llama 3.1 405B is the first openly available model that rivals the

top Al models when it comes to state-of-the-art capabilities in

general knowledge, steerability, math, tool use, and multilingual

translation.

- ) Learn more
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Developer Products

Docs

Blog More My Apps Q

/

(4058 )

Meet Llama 3.1

c. On the left navigation bar, go to App settings > Basic.

Apps

Filter by

(®) AllApps (16)

Archived

Required actions (1)

No bu

Business portfolio Clear

ess portfolio selected v

Admin Apps

2N |Yeastar Messaging
R el e
6ol Mode: IIK_Jiopment
% Type: Business
Business: Test Business

@ Administrator

Docs Tools

@ Administrator

Support Apps

2. At the top of the page, complete the following settings.

OQOMeta = App Dashboard

[E] Yeastar Messaging

Gﬁ Dashboard
Required actions
O App settings

Basic

Advanced
@J App roles
Q Alerts
@ App Review
Products
Webhooks

Messenger

Activity log

i= Activity log

-

App ID: 477381038391389

v

Add Product

App Mode: Development @

AppID
477381038391389

Display name

Yeastar Messaging

App domains

Privacy Policy URL

https://www.yeastar.com/privacy/

App icon (1024 x 1024)

v
a»
0

Docs  Tools  Suppot  Apps

Live

App type: Business

App secret

Namespace

Contact email @

becky@yeastar.com

Terms of Service URL

Required actions f4

Select all

@ Administrator

ez + (N A %

@ Help

Show

Terms of Service for Login dialog and App Deta

Category @

Messaging

« Privacy Policy URL: Enter your organization's privacy policy URL.
« App icon: Upload your organization's icon.
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« Category: Select Messaging.
3. Scroll down to the bottom of the page, add a website platform to share the PBX URL
with Meta.

Select Platform

Website Android
12 app stores available

Windows App

Page Tab

OQOMeta = App Dashboard Docs Tools Support Apps Required actions 1 a
75 YeastarMessaging ¥ App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help
City/District
@ Dashboard
Required actions
State/Province/Region ZIP/Postal Code Country
ﬂ' App settings ~ United States -
Basic
Advanced
Website Quick Start X
App roles v
Site URL
£ Alerts o v ﬂ https://yeatardocs ras.yeastar.com/
@ App Review v
Provide testing instructions
Products Add Product Meta performs regular reviews of apps on the platform in order to verify that an app's access to permissions follows our terms and policies.
Avoid unexpected restrictions by keeping this required testing information up to date.
Webhooks ) .
& Add or update instructions
Messenger v

+ Add platform
Activity log

1= Activity log oscars [

a. Click Add platform.

b. Select the checkbox of Website, then click Next.

c. In the Site URL field, enter the FQDNof your PBX system.
4. Click Save changes.

Step 2. Select permissions and features

1. On the left navigation bar, go to App Review > Permissions and Features.
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2. Search for the required permissions (pages_messaging, Human Agent, and Busi-
ness Asset User Profile Access) and click the corresponding Request advanced
access button to add them to your submission.

Filter access levels v O pages_messaging

Permissions and features 11 Access level @ 4 APlcalls @ Ti Status T! Action @ T

pages_messaging

e No App Review
essenge Standard access e Active (12) © App Review Request advanced access w
requested
(® Full description @ Requirements
Filter access levels w Q Human Agent
Permissions and features 1. Access level @ | APlcalls @ 1! Status . Action @ 1.
Human Agent
© e A - 7 ~ent No App Review =
uman_ag Standard access © Ready to use (0) Request advanced access il
a e requested
@ Full description  Requirements
Filter access levels w (Q Business Asset User Profile Access
Permissions and features T! Access level @ APlcalls @ 1! Status T/ Action @ Tl

Business Asset User Profile Access

No App Review .
Standard access © Ready to use (0) " Request advanced access il
requeste

@ Full description @ Requirements
3. Click Continue request.

Step 3. Remove unnecessary permissions

1. On the left navigation bar, go to Messenger > Messenger API Settings.
2. In the 3. Complete App Review section, click Request Permission.
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QO Meta = App Dashboard Docs Tools Support Apps Required actions 4 A

7% Yeastar Messaging v App ID: 477381038391389 App Mode: Development @ Live App type: Business @ Help
|
@ Dashboard
. . 1. Configure webhooks -
Required actions Configure a custom webhook URL or use services that help you set up an endpoint. Learn more.
{g} App settings v
2. Generate access tokens o
App roles “ Connect Facebook pages to generate access tokens and set up webhook subscriptions.
Q Alerts v v © 3 Complete App Review
This ission or feature requires ion of the App Review process before your app can access live data.
@ App Review v
Products Add Product You should create a prototype and submit for app review. This helps us review your overall app experience. Learn more

Webhooks To send and receive request pages._! i ission. To access more i [o—
features, please review our documentation. Learn more
Messenger ~ “

Messenger API Settings ¢/> Advanced - Optional

Instagram settings. Optional Advanced Settings
Activity log

i= Activity log

3. Unselect the checkboxes of the following permissions, then click Request Permis-
sion.

Request Permission
Required permissions

V| pages_messaging

Optional

pages_show_list pages_manage_metadata

pages_read_engagement business_management

Learn more Cancel Request P jon

You will be redirected to App Review > Requests.
Step 4. Answer data handling questions

1. On the left navigation bar, go to App Review > Requests.
2. Scroll down to the Data handling questions section, then click Answer questions
about data handling.
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N Meta App Dashboard Docs Tools Support Apps Required actions 1

74 Yeastar Messaging v App ID: 2478854338991095 App Mode: Development @ Live App type: Business @ Help

@ Dashboard

) Business verification
Required actions

{G% App settings v @ submit business verification >

App roles v

£ Alerts v Data handling questions
a App Review ~
| Answer questions about data handling >
Requests To obtain advanced to permissions, an app administrator must answer some questions about your data handling practices.
Learn about our d: ling guidelines.

Permissions and Features 99
Products Add Product
Webhooks

(® Add additional permissions and features

Messenger v
Activity log

You must complete all steps before you can submit for review.

i= Activity log

3. Fill in the following information based on your situation, then click Submit.

Data handling questions X

) Auto-saved on 7:15PM, Aug 13,2024 (@) Pre-fil from another app

A A A A 2 1P A At 0 S SIS AR SRR AR 13 SR, T L B 1A A A ) PR S 1 AR 8 I AR S TSt e

organization for guidance on how to answer these questions. Learn about our data handling guidelines.

“Personal data” is any data you receive from Meta that is related to an identifiable person. For examples, refer to the definitions in the General Data Protection Regulation (GDPR) and
the UK Information Commissioner’s Office.

Do you have a data controller located in the European Economic Area (EEA) or the United Kingdom (UK) that will be responsible for all data Meta shares with you?
A data controller is the entity that exercises overall control over the purposes and means of the processing of personal data. Refer to definitions in the General Data Protection Regulation (GDPR) and the UK GDPR for
detalls and examples

Yes

@ No/lamnot sure

List all data processors, including your own companies, that will have access to the personal data of users that you obtain from Meta.
A data processor is a person or business that provides you with services to help you process personal data you obtain from Meta. This may include Service Providers as defined in Meta's Platform Terms.

Yeastar

Have you provided the personal data of users to public authorities in response to national security requests in the past 12 months?
This does not include requests related to search warrants or court orders associated with criminal investigations

Yes, we have shared the personal data of approximately 10 or fewer users.

Which of the following policies or processes do you have in place regarding requests from public authorities for the personal data of users? Check all that apply.

Required review of the legality of these requests.

Need help? Contact Direct Support Cancel

4. Complete the following tasks to demonstrate why the pages_messaging permission
with advanced access is needed and how the app uses it.
a. Click How will your app use the advanced access pages_messaging per-
mission?.

How will your app use the advanced access pages_messaging permission? >
Review the policies for pages_messaging and tell us how you intend to use it

Describe how your app uses this permission or feature
Upload screencast showing the end-to-end user experience
Agree that you will comply with allowed usage

Please provide instructions for how to reproduce this feature

b. Copy and paste the following text in the detailed description box.
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This app is used to integrate Yeastar Phone System wi th Facebook
Messenger. After obtaining the "pages_nessagi ng" perm ssion,
agents can nmanage Page nessages within Yeastar Phone System

Tell us why you're requesting pages_messaging

Please provide a detailed description of how your app uses the permission or feature requested, how it adds value for a person
using your app, and why it's necessary for app functionality.

This app is used to integrate Yeastar Phone System with Facebook Messenger. After obtaining the "pages_messaging"
permission, agents can manage Page messages within Yeastar Phone System.

c. In the Test and reproduce the functionality of your integration section, se-
lect your Facebook Page, copy and edit the following text based on your situa-
tion, then paste in the text field.

Step 1: Log in to Yeastar Phone Systemwi th the follow ng
credenti al s:

Logi n address: { pbx_f qdn}

User nanme: {extension_nunber or_ emil address}

Passwor d: {password}

Step 2: Log in to Facebook with the foll owing credentials and
send a message to the Facebook Page: {url _for_facebook_ page}
Emai | or phone: {enmil_address_or_phone_nunber}

Passwor d: {password}

Step 3: Receive and reply to the nessage on Yeastar Phone System
In this example, we paste the following text:

Step 1: Log in to Yeastar Phone Systemw th the follow ng
credenti al s:

Logi n address: https://yeastardocs.ras. yeastar.com

User name: smith@eastar.com

Password: rz9nDg3Cr O

Step 2: Log in to Facebook with the follow ng
credentials and send a nessage to the Facebook Page:
https://ww. f acebook. coni profil e. php?i d=61563743597525
Emai | or phone: yangym@eastar.com

Passwor d: YpeS345j oi
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Step 3: Receive and reply to the nessage on Yeastar Phone System

Test and reproduce the functionality of your integration

As part of the review process, we will check that the functionality of the app experience is working as intended. If you provide a
Page management surface to users, provide us with a temporary test account so we can test it.

Yeastar ¥

Step 1: Log in to Yeastar Phone System with the following credentials:
Login address:https://yeastardocs.ras.yeastar.com

Username: smith@yeastar.com

Password: rzdnDg3CrO

Step 2: Log in to Facebook with the following credentials and send a message to the Facebook Page:

Lbbnn Thanrns: fmmnbemale o e enfil o MR ACRATANEATEALD

d. Click Upload file to upload the screencast that demonstrates how you send a
message to your Facebook Page and how the message is received and replied
on Yeastar Phone System.

Upload a screen recording that demonstrates how your app will use this permission or feature so we can confirm it is used
correctly and does not violate our policies. For more information, visit the Screen Recordings guide and Developing for
Success video.

Drag and drop your file

_!_ Upload file

e. Select the checkbox to agree that you will comply with the allowed usage, then
click Save.

If approved, | agree that any data | receive through pages_messaging will be used in accordance with the allowed
usage.

5. Complete the following tasks to demonstrate why the Business Asset User Profile
Access permission with advanced access is needed and how the app uses it.
a. Click How will your app use the advanced access Business asset user
profile access feature?.

How will your app use the advanced access Business asset user profile access feature?
Review the policies for Business asset user profile access and tell us how you intend to use it

Describe how your app uses this permission or feature
Upload screencast showing the end-to-end user experience

Agree that you will comply with allowed usage
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b. Copy and paste the following text in the detailed description box.

This app is used to integrate Yeastar Phone System w th Facebook
Messenger. After obtaining the "Business Asset User Profile
Access" pernission, agents can view the nane of Facebook users
who send nessages to the Page directly within Yeastar Phone
System which enables themto identify different Facebook users
and provide better services.

Tell us why you're requesting Business asset user profile access

Please provide a detailed description of how your app uses the permission or feature requested, how it adds value for a person
using your app, and why it's necessary for app functionality.
This app is used to integrate Yeastar Phone System with Facebook Messenger. After obtaining the "Business Asset User Profile

Access" permission, agents can view the name of Facebook users who send messages to the Page directly within Yeastar -
Phone System, which enables them to identify different Facebook users and provide better services.

c. Click Upload file to upload the screencast that you have uploaded for pages_-
messaging.
Upload a screen recording that demonstrates how your app will use this permission or feature so we can confirm it is used

correctly and does not violate our policies. For more information, visit the Screen Recordings guide and Developing for
Success video.

Drag and drop your file

!_ Upload file

d. Select the checkbox to agree that you will comply with the allowed usage, then
click Save.

If approved, | agree that any data | receive through Business Asset User Profile Access will be used in accordance
with the allowed usage.

Cancel m

6. Complete the following tasks to demonstrate why the Human Agent permission with
advanced access is needed and how the app uses it.
a. Click How will your app use the advanced access Human Agent feature?.
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How will your app use the advanced access Human Agent feature?
Review the policies for Human Agent and tell us how you intend to use it

Describe how your app uses this permission or feature
Upload screencast showing the end-to-end user experience

Agree that you will comply with allowed usage

O Your submission must include instagram_business_manage_messages or instagram_manage_messages to use Human
Agent

b. Copy and paste the following text in the detailed description box.

This app is used to integrate Yeastar Phone System w th Facebook
Messenger. According to Facebook's rul es, user can only use

the Message Tag feature to send nessages to users outside the
24- hour Standard nessagi ng wi ndow.
After obtaining the "Human Agent" perm ssion, when a custoner's

i nqui ry cannot be resolved within the standard nessagi ng w ndow,

the agent can use the hunman_agent tag to continue providing
services to the custoner.

Tell us why you're requesting Human Agent

a human ent he human_a

Please provide a detailed description of how your app uses the permission or feature requested, how it adds value for a person
using your app, and why it's necessary for app functionality. 7

This app is used to integrate Yeastar Phone System with Facebook Messenger. According to Facebook's rules, user can only
use the Message Tag feature to send messages to users outside the 24-hour Standard messaging window. After obtaining the -
"Human Agent" permission, when a customer's inquiry cannot be resolved within the standard messaging window, the agent

i e e i a mmmed fmm b mmet e mems i ime s e ae o e e e

c. Click Upload file to upload the screencast that demonstrates how your app us-
es a human agent tag to respond to customer messages.

Upload a screen recording that demonstrates how your app will use this permission or feature so we can confirm it is used

correctly and does not violate our policies. For more information, visit the Screen Recordings guide and Developing for
Success video.

Drag and drop your file

! Upload file

d. Select the checkbox to agree that you will comply with the allowed usage, then
click Save.
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If approved, | agree that any data | receive through Human Agent will be used in accordance with the allowed
usage.

Cancel

7. At the bottom of the page, click Submit for Review and enter password to confirm
your operation.

Result

Your submission is queued and you will receive the review result in a few days.

What to do next

After you pass App Review, you need to switch your app to Live mode on 'Meta for Develop-
ers' portal, as shown below.

OMeta = App Dashboard Docs

Yeastar Messaging v App ID: 2478854338991095 App Mode: Development . Live

-
"

ﬁ Dashboard

Live Chat

Live Chat Integration Guide

By adding Yeastar Live Chat to a website, your website visitors can call or chat with your
agents in just one click, while agents in your business can centrally handle all customer con-

versations on Linkus UC Clients.
Highlights

Easy website integration
Embed a live chat widget on any website effortlessly, no coding skills required.

Free online consultation (chat & call)
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Website visitors can initiate a chat or a call with agents in your business at no
cost.

Secure resource control

Specify website domain and limit the number of concurrent calls to ensure
that the live widget only works on the trusted website and prevent resource
abuse.

Requirements

Make sure Yeastar P-Series PBX System meets the following requirements:

Item Requirement

Firmware Version 37.20.0.124 or later
Plan Enterprise Plan (EP) or Ultimate Plan (UP)

Domain Name PBX can be remotely accessed via a domain name.

Note:

« Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise the
messaging channel will encounter authentication failure, or will fail
to receive messages.

« If you use a self-managed domain name, make sure you have
installed a valid domain certificate for the domain name, otherwise
the messaging channel will encounter authentication failure, or will
fail to receive messages.

For more information about the configuration, see the following topics:

» Configure Network for Remote Access by a Yeastar FQDN
» Configure Network for Remote Access by a Yeastar Domain Name
» Configure Network for Remote Access by a Domain Name

Limitations

Learn about the limitations of Live Chat widget.

Description

Message type Supports text messages, emojis, and images.

I Note:


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
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Item Description

" For Image: The file format should be . png, . j pg, or . j peg and the
4 maximum file size is 10 MB.
Messaging Supports to receive and reply to Inbound messages, but agents can NOT
mechanism initiate a chat or a call with website visitors through the live chat widget.
File retention Files can be retained for 72 hours.
period
Chat session Supports 20 active sessions.

Set up a Live Chat Channel

To add Yeastar Live Chat to your website, you need to create and configure a live chat chan-
nel on Yeastar P-Series PBX System first.

Before you begin

If you want to allow website visitors to call your agents directly, we recommend that you
create a WebRTC trunk and set up a corresponding inbound route in advance, as they are re-
quired in the follow-up process.

For more information, see Set up WebRTC Click-to-Call.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select Live Chat.
3. In the General tab, configure general settings for the channel.

a. In the Basic section, enter the following basic information.

Basic

LiveChat www.yeastar.com

- Name: Enter a name to help you identify the channel.

» Website Domain: Enter the domain name of the website to which you
want to add the live chat widget.

| Note:


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/set-up-webrtc-click-to-call.html
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For security reasons, the live chat widget will only load on the
4l website domain.

b. In the Interaction Mode section, set how website visitors can interact with
your agent(s) and where to route the visitors.

Interaction Mode Interaction Mode

Chat Only Phone and Chat

Phone calls through live chat is available only when visitors access the website through the HTTPS transport
Extension 1000-Leo Ball protocol. Please ensure that your website supports HTTPS.

Extension 1000-Leo Ball
Enable WebRTC Inbound Call

To achieve this feature please create a WebRTC trunk and an inbound route First.

WebRTC_Trunk WebRTC_Inbound_Calls

« Interaction Mode: Specify the interaction mode supported on the live

chat widget.
Option Description
Chat Only If selected, website visitors can communicate with your
agent(s) via chat message.
Phone and Chat If selected, website visitors can communicate with your

agent(s) via chat message or phone call.

Note:
Phone calls through live chat is available only
when visitors access the website through HTTPS
transport protocol. Therefore, make sure that your
website supports HTTPS.

» Destination: Specify the destination of inbound messages from live chat.

Option Description

Extension If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages
from live chat.

Message Queue If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue.
However, only the user who picks up a session will be
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Option Description

able to receive and respond to the follow-up inbound
messages in the session.

Third-Party If selected, inbound messages will be automatically
Message forwarded to a third-party message analytics platform via
Analytics Platform  API for advanced processing.

(Transmitted via

API) / Note:

To enable automatic forwarding of inbound
messages to a third-party message analytics
platform, ensure that your PBX server has been
integrated with the third-party message analytics
platform via API. Once this option is selected, the
PBX system will automatically transmit inbound
messages to the designated platform. You can
get notified by monitoring the API event (30031)
New Message Notification. Additionally, the PBX
provides a comprehensive Message API suite for
advanced message interaction with the integrated
third-party message analytics platforms.

« Enable WebRTC Inbound Call: If you allow phone calls through live
chat, enable this option and select a WebRTC trunk and its corresponding
inbound route.

c. In the Advanced section, complete the following settings.

Advanced

5 Text Only

Close Session Automatically
*

1 Day(s)

« Maximum Concurrent Calls: Set the maximum number of concurrent
calls supported on live chat.

When the limit is reached, no more calls can be made through live chat.

| Note:


https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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> Phone calls made through live chat, whether by agents or
website visitors, occupy the concurrent calls.

> The default number is 5, you can set up to 10 concurrent
calls.

- Supported Message Types for Visitors: Specify the message type that
website visitors can send.

Option Description

Text Only

Text and Image Website visitors can send text, emojis, and images.

Website visitors can send text and emojis.

,“ Note:
The maximum size for a single image uploaded
in the chat widget is 10 MB.

« Close Session Automatically: If you want the system to automatically
close the sessions that have been inactive for a specific period of time,

select the checkbox of Close Session Automatically, then set the time-
out in the Session Timeout field.

4. In the Display & Appearance tab, customize how the live chat widget on your web-
site will look and what information it will offer.

Note:

When customizing your chat widget, you can preview the changes you made
on the right panel.

a. In the Appearance section, customize the appearance of your chat widget.
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]

[RE—

Appearance

P N I

@ Support v

.
-@: Lightmode € Darkmode et How canwe nelp your

.

EEENE EF

.

@ Bubble = Bar

| I

EUBQQQ

— I

b. In the Display section, customize the information that will be displayed when
website visitors initiate a chat or a call.

]

i
@ Support AV

£ et How canwenelp your

Display

P

Support Name

Hide "Powered by Yeastar"

P ——————————————

&
Note:

For Agent Information Display: If you choose Name or Name and
Profile Photo, the real name and profile photo of the agent who deals
with the chat message or phone call will be displayed when visitors ini-
tiate a chat or a call. Otherwise, the default agent name and agent pro-
file photo will be displayed.

5. In the Message section, configure language preference and message settings for the
chat widget.
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a. In the Language section, select an option from the drop-down list.

This determines the display language of the chat widget.
b. If you want to use a pre-chat form to gather visitor information before a chat

starts, complete the following settings in the Pre-Chat section.

Pre-Chat

Enable Pre-Chat Form

* Hello §

Hello . Please fill in the form below before starting
the chat.

P A—

*

Please fill in the form below before starting the chat.

'

1

First Name and Last Name Required v/ !

1

I

; [ .
Email Address Optional v/
Phone Number Optional v/

Data Privacy and Consent

%

B I U & (o]

We need to store and process your personal data to provide you with the requested content. For detailed informati
on about our privacy practices and our commitment to protecting your privacy, please check our Privacy Policy.

Require explicit consent

c. Optional: In the Message section, edit the following auto-reply text messages
as needed, which will be sent to website visitors based on specific scenarios.

Message

Hello! How can we help you?
We are away, leave us a message!
Hello, thank you for contacting us. We have received your message.

This chat session has ended. Please feel free to contact us if you have any further questions.

| Note:
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The Online and Offline Greeting Messages are triggered based on office
4 hours. Make sure that office hours in the PBX are properly configured.
For more information, see Overview of Business Hours and Holidays.

+ Online Greeting Message: Automatically send the text message to web-
site visitors when they open the chat interface in the following situations:
> PBX is within Business Hours, and the live chat destination is a mes-
sage queue.
> PBX is within Business Hours, and the live chat destination is an ex-
tension that is logged in to Linkus UC Clients with presence status
set to Available.
- Offline Greeting Message: Automatically send the text message to web-
site visitors when they open the chat interface in the following situations:
o PBX is within Outside Business Hours or Holidays.
> PBX is within Business Hours, and the live chat destination is an ex-
tension that logs out of Linkus UC Clients or that is logged in but
has presence status set to Away / Business Trip / Do Not Disturb /
Lunch Break / Off Work.
- Auto-response to the First Message: Automatically reply the text mes-
sage to website visitors when they send their first message in the chat.
» Chat Session Closed Message: Automatically send the text message to
website visitors when the chat session ends, either manually closed by

agent / website visitor or automatically closed when session timeout is
reached.

6. Click Save.

Result

A code snippet for live chat is generated and displayed in the pop-up window.


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/overview-of-business-hours-and-holidays.html
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Embed Code (LiveChat) X

To enable live chat on your website, you'll need to add the embed code. Learn
configuration details in the User Guide.

<script Copy

src="https://yeastardocs.ras.yeastar.com/live chat.v1.8.0
.js?channelNumber=LC@0000" ></script>

Send installation instruction to website admin via email

What to do next

1. Click Copy to copy the code snippet.

Note:

You can also email the code snippet as well as the website domain to a spe-
cific user (e.g. website admin) to help with the process. The system will send
an email with installation instructions using the default template (Path: Sys-
tem > Email > Email Templates > Request to Add Live Chat to Website)
to the specified email address.

Send installation instruction to website admin via email

becky@yeastar.com

2. Enable live chat on your website using the code snippet.
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Enable Yeastar Live Chat on Your Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code snippet be-
fore the closing </ body> tag in the HTML code for your desired website. When done, a live
chat widget appears at the bottom-right corner of the website, enabling website visitors to
have a real-time conversation with your agents.

Procedure

To enable Yeastar Live Chat on your website, paste the code snippet before the closing </

body> tag in the HTML code for your desired website. After you successfully add the code
snippet to your website, a live chat widget is added to the bottom-right corner of your web-
site.

Note:

« Currently, the live chat widget is fixed to the bottom-right corner of a website
and its position can not be changed.

« The live chat widget has been proven to work when visitors access your
website using Google Chrome, Microsoft Edge, or Firefox. For other web
browsers, it may not work as expected.

Example

We take the following Content Management System (CMS) platforms as examples to show
you how to enable Yeastar Live Chat on a website.

 Enable Yeastar Live Chat on WordPress Website
 Enable Yeastar Live Chat on Joomla Website
 Enable Yeastar Live Chat on Drupal Website
 Enable Yeastar Live Chat on Wix Website

 Enable Yeastar Live Chat on Squarespace Website

Enable Yeastar Live Chat on WordPress Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code into the
footer of your WordPress website. When done, a live chat widget appears at the bot-
tom-right corner of the website, enabling website visitors to have a real-time conversation
with your agents.
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Prerequisites

You have obtained the code snippet for Yeastar Live Chat.

Enable Yeastar Live Chat on WordPress website using theme editor

1. Log in to your WordPress admin panel.
2. On the left navigation bar, go to Appearance > Themes, then click Customize on the
desired theme.

@ @ wordpressdemosite © 9 B 0 4 New WrCode

@ Dashboard Themes e [ Add New Theme

A Posts Search installed themes

0] Media
B Pages
% Comments

D SeedProd

® Elementor

& Templates

3. On the left navigation bar, click Pages, then edit your desired page.
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@ wordpress demo site

¢ Design YeastarTest

& wordpress demo site

wordpress demo site Privacy Policy YeastarTest

< Pages

YeastarTest

Privacy Policy
admin Published

4. At the top-right corner, click ¢ , then click Code editor.
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= 8 veosartes cutex ccvBoo
YeastarTest

Distraction free

Write with calmness Ctbe shift\
Spotlight mode

Focus on one block at a time

EDITOR

Visual editor v
Code editor Ctrl+Shift+Alt+M
PLUGINS

Styles o0
TooLs

Keyboard shortcuts Shift-Alt+H
Copy all blocks

Help (4

Export

5. Scroll down to the bottom, paste the code snippet, then click Save.

g - 8 v ccElo o

Editing code Exit code editor
<!-- wp:paragraph -->
<p>...or something like this:</p>

<1-- /wp:paragraph -->

<!-- wp:quote -->

<blockquote class="wp-block-quote"><p>The XYZ Doohickey Company was founded in 1971, and has been providing quality
doohickeys to the public ever since. Located in Gotham City, XYZ employs over 2,000 people and does all kinds of
awesome things for the Gotham community.</p></blockquote>

<!-- /wp:quote -->

<!-- wp:paragraph -->

<p>As a new WordPress user, you should go to <a href="http://wordpress-demo.com/wp-admin/">your dashboard</a> to delete
this page and create new pages for your content. Have fun!</p>

<l-- /wp:paragraph -->

<script src="https://yeastardocs.ras.yeastar.com/live_chat.v1.0.0.js?channelNumber=LC00000" ></script>

Access the page, then you will find the Live Chat widget is added to your website.
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@ @ wordpressdemosite W Editsite <8 ® 0 4+ New 2 EditPage WPCode Howdy, admin [ll Q |

YeastarTest

o

Enable Yeastar Live Chat on WordPress website using WPCode plugin

1. Log in to your WordPress admin panel.
2. On the left navigation bar, go to Plugins > Add New Plugin.
3. Add and activate WPCode plugin.

a. At the top-right corner, search for WPCode plugin, then click Install Now to in-
stall the plugin.

@ @ wordpress demo site

@ Dashboard Add Plugins Upload Plugin

A Posts

= Search Results ~ Featured ~ Popular ~ Recommended  Favorites  For Elementor (2 SearctrPlagims= wpcode Keyword v
3] Media
B Pages 16 items
% Comments
Q) Seedrod WPCode - Insert Headers and Footers Install Now Search & Replace Everything by

SeedProd N . .

> + Custom Code Snippets — WordPress ) WPCode - Find and Replace Media,
More Details .
© Eementor Code Manager ) p) Text, Links, and More
e
Easily add code snippets in WordPress. Insert header & Search and Replace everything in WordPress. Easily find

[ =

eress WPCode s, a ith condi ore with a

» Appearance

£ Plugins

Installed Plugins (1.392) Last Updated: 5 days ago &) Last Updated: 3 weeks ago

Add New Plugin 2+ Million Active Installations ¥ Compatible with your version of WordPress 1,000+ Active Installations ¥ Compatible with your version of WordPress

b. Click Activate to activate the plugin.
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WPCode - Insert Headers and Footers
/> + Custom Code Snippets — WordPress

Mo ils
Code Manager )
WPC d Easily add code snippets in WordPress. Insert header &
oce footer scripts, add PHP code snippets with conditional
logic, insert ads pixel code, and more.
By WPCode
(1,392) Last Updated: 5 days ago
2+ Million Active Installations v Compatible with your version of WordPress

4. Add the code snippet to the footer.

@ @A wordpressdemosite <3 P 4 New WPCode Howdy, admin [l

© Elementor Global Header and Footer

& Templates
Footer

A Appearance
% Plugins v 1|<script src="https://yeastardocs. ras. yeastar. com/live_chat. v1. 0. 0. js?channe1Number=LC00000"></script.
& Users

& Tools

Settings

Code Snippets
Co

Header & Footer
Conver: ixels

a. On the left navigation bar, go to Code Snippets > Header & Footer.
b. In the Footer section, paste the code snippet.
c. At the top-right corner, click Save Changes.

Access the page, then you will find the Live Chat widget is added to your website.
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@ @ wordpressdemosite A Editsite <& 8 B 4 New £ EditPage WPCode

YeastarTest

Q o

Enable Yeastar Live Chat on Joomla Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code to your
Jommla website's source code before the / body tag. When done, a live chat widget appears
at the bottom-right corner of the website, enabling website visitors to have a real-time con-
versation with your agents.

Prerequisites

You have obtained the code snippet for Yeastar Live Chat.

Procedure

1. Log in to your Joomla's administrator panel.
2. On the left navigation bar, click System, then click Site Templates.
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m_]oomlo! # System Dashboard 443 | 3 TakeaTow v M 2 PostinstallationMessages  [£ joomladdemo @ UserMenu v

@ Toggle Menu

4 Home Dashboard & Setup / Maintenance © Information
B Content Global Configuration Clear Cache Warnings 1
Menus
Database v Installation Messages 2
c X, Install
omponents
Global Check-in v System Information
Users Extensions
Do v e & e
Languages Extensions Joomla 446
Languages Extensions v

& Templates

. Content Languages Update Sites
Site Templates

. Language Overrides
Site Template Styles

A User Permissions

|E

ugins
Administrator Templates Groups

3. Click the template to which you want to add the code.

m_]oomlol“ <[> Templates: Templates (Site) Ma43 |3 TekeaTouwr v | M 2  Postinstallation Messages [  joomladdemo | €@ UserMenu v

@ Toggle Menu

& Styles £ Options ? Help
4 Home Dashboard
A Content Site v Search n Template ascending v 20 v
= Menus
Components
u Image Template ~ Version Date Author Override Files
sers
System Cassiopeia Details and Files 10 2017-02 Joomla! Project Upto
No preview ble. You can enable admin@joomla.org
Help
. . .
4. Click index.php, then paste the code snippet before / body tag.
B save B save&Close & Rename File X Delete File X Close File ? Help
Editor Create Overrides Updated Files Template Description
Editing file '/templates/cassiopeia/index.php" in template "cassiopeia”
B8 /templates/cassiopeia i class=grid-child container-bottomb’s -
™ himl <jdoc:include type="modules” name="bottom-b” style="card” />
<Jdiv>
1 <7php endif; 7>
B component.php .
B error.php
= <Iphp it (this->countllodules( footer’, true)) : 7>
B index.php v Cfooter class="container-footer footer full-width”>
N <div class="grid-child’>
Bijoomla.asset json <jdoc:include type="modules” name="footer” style="none” />
N <fdiv>
Bi offline.php </fmgr:h

| <Iphp endif; 7
B templateDetails.xml php endif;

<Tphp if (this-dpara

et (' backTop’ ) VR

m /media/templates/site/cassiopeia 36 v <a href="#top” i ack-top” class="back-to-top-1ink” aria-label="<7php echo Text::_(’ TPL_CASSIOPEIA BACKTOTOP'), 75>
’ 3 <span clas con-arrow-up icon-fw” aria-hidden="true’></span>
M css <fa>
o <Iphp endif; 7
m images 4
<jdoc:include type="modules” name="debug” style="none” />

s {script_src= https://yeastardocs. ras. yeastar. com/1ive_chat. v1. 0. 0. jo7channel Number=LC00006 ></Scxipty]

oody>
B scss 2 </l >

Press F10 to toggle Full Screen editing.

5. At the top-left corner, click Save.
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Result

Access your Joomla website, you will find the live chat widget is added to the bottom-right
corner of your website.

CASSIOPEIA

You are here: Home Main Menu

Home Home

Login Form

Hi admin,

Log out

Enable Yeastar Live Chat on Drupal Website

After you obtain the code snippet for Yeastar Live Chat, you can add the code to your Drupal
website. When done, a live chat widget appears at the bottom-right corner of the website,
enabling website visitors to have a real-time conversation with your agents.

Procedure

1. Log in to your Drupal admin panel.
2. On the top navigation bar, go to Structure > Block layout.

@ Backtosite = Manage Y Shortcuts _§ admin

B content | gk Structure | X Appearance | Pe Extend 9\ Configuration g People  4lI Reports @ Help

Home > Administration

Structure

> Block layout

Configure what block content appears in your site's sidebars and other regions

3. Scroll down to the bottom, click Place block beside Footer Top.
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@ Backtosite = Manage Y Shortcuts _§ admin @ Tour

I Content gk Structure 4 Appearance | Pe Extend S\ Configuration g People ]I Reports @ Help

Content Below  Place block
No blocks in this region
Footer Top Place block

No blocks in this region
Footer Bottom Place block

No blocks in this region

4. Add a custom block.

Place block

| + Add custom block

‘ Filter by block name

B Content ¢k Structure | 4 Appearance e Extend |, Configuration g People ol Reports | @ Help

Home

Add custom block

Block description

Yeastar Live Chat
—

A brief description of your block.
Body

B I X x L@z izv e @|y— s . 55 Sourcs
N,

<soript sre="https://yeastardocs. ras. yeastar. con/live_chat. v1. 0.0. js?channelunber=LCO0000"></ seript>

Text format | Full HTML ~ About text formats
4

Revision information
No revision

Revision log message

\_/E

a. Click Add custom block.
b. In the Block description field, enter a short description of the block.
c. In the Body field, click Source, then paste the code snippet.
d. In the Text format drop-down list, select Full HTML.
e. Click Save.
5. Scroll down to the bottom, then select Footer Top from the Region drop-down list.
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Region*
Footer Top A

Select the region where this block should be displayed.
6. Click Save block.

Result
Access your Drupal website, you will find the live chat widget is added to the bottom-right
corner of your website.

= Manage Y Shortcuts  § admin

B Content gk Structure  4X Appearance Mo Extend W Configuration  Jg People Il Reports = @ Help

YeastarTest

©

©

Enable Yeastar Live Chat on Wix Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code to your Wix
website's source code before the / body tag. When done, a live chat widget appears at the
bottom-right corner of the website, enabling website visitors to have a real-time conversa-

tion with your agents.

Note:

You can also add the chat widget using Wix Editor. For more information, see Wix
Editor: Embedding a Site or a Widget.



https://support.wix.com/en/article/wix-editor-embedding-a-site-or-a-widget
https://support.wix.com/en/article/wix-editor-embedding-a-site-or-a-widget
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Prerequisites

You have obtained the code snippet for Yeastar Live Chat.

Procedure

1. Log in to your Wix account, then go to Settings.
2. On Settings page, scroll down to the ADVANCED section, then click Custom code.

</> Custom code %% Headless settings 59 Marketing Integrations
Add custom code snippets Use QAuth apps to Connect marketing tools to
to the head or body of your authenticate with Wix and understand how people
site. make API calls from any interact with your site.

external platform.

3. At the top-right corner, click Add Custom Code.
4. In the pop-up window, complete the following settings, then click Apply.
- Paste the code snippet here: Paste the code snippet for the live chat widget.
« Name: Enter a name to help you identify the code.
- Add Code to Pages: Set the page(s) to which you want to add the code snippet.
» Place Code in: Select Body - end.

Result

Access your Wix website, you will find the live chat widget is added to the bottom-right cor-
ner of your website.

Enable Yeastar Live Chat on Squarespace Website

After you obtain the code snippet for Yeastar Live Chat, you can paste the code into the
footer of your Squarespace website. When done, a live chat widget appears at the bot-
tom-right corner of the website, enabling website visitors to have a real-time conversation
with your agents.

Prerequisites

You have obtained the code snippet for Yeastar Live Chat.
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Procedure

1. Log in to your Squarespace account.

2. On the Dashboard, click the website to which you want to add the live chat widget.

1) Dashboard Domains

Dashboard

Test
marlin-cube-tgha.squarespace.com

Website trial expires on Aug 31, 2024

WEBSITE SELLING

Help Account Settings

CREATE WEBSITE

3. On the left navigation bar, go to Pages > Website Tools > Code Injection.

% Q ¢ Home
Pages Q
Setup Guide ¢
Website Main Navigation + <«
Pages
Styles Member Sites () o+ <
Assets
Selling Not Linked (@ + <
Invoicing
Content &
Memberships
Utilities
Donations
System Pages
Scheduling
Website Tools
Marketing
Trash
Contacts
Analytics Version 71

4. In the Footer section, paste the code snippet.

€ WEBSITE

Website Tools

CUSTOM CODE
Custom CSS

Code Injection

MESSAGING
Announcement Bar
Promotional Pop-Up

Mobile Information Bar

&


https://login.squarespace.com/
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FOOTER

Enter code that will be injected into the template-defined footer on every page of your site.

1} <script src="https://yeastardocs.ras.yeastar.com/live_chat.v1.0.0.js?channelNumber=LC00000 >

</script>

5. At the top-left corner, click Save.

Result

The live chat widget is added to the bottom-right corner of your website.

Home
EDIT Page - Published I;I B & A
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WhatsApp

Set up a WhatsApp Channel

This topic describes how to set up a WhatsApp channel on Yeastar P-Series PBX System, so
that agents in your business can receive and reply to WhatsApp messages from customers
on their Linkus UC Clients.

Requirements
Make sure the following resources are ready.

Platform Requirement

Yeastar PBX « Firmware: Version 37.20.0.124 or later
* Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
+ Domain Name: PBX can be remotely accessed via a domain name.

Note:

> Due to the limitation of the third-party platform, the domain
name must NOT contain underscore character(s), otherwise
the messaging channel will encounter authentication failure, or
will fail to receive messages.

o If you use a self-managed domain name, make sure you
have installed a valid domain certificate for the domain name,
otherwise the messaging channel will encounter authentication
failure, or will fail to receive messages.

For more information about the domain configuration, see the following topics:
> Configure Network for Remote Access by a Yeastar FQDN
> Configure Network for Remote Access by a Yeastar Domain Name
> Configure Network for Remote Access by a Domain Name

WhatsApp » Product: WhatsApp Business Platform

» Account:
o A Meta Developer account

Note:
You only need ONE Meta Developer account to create
MULTIPLE Meta apps for the WhatsApp channel integration.
There is no limit to the number of WhatsApp channels on PBX.

o

A Business Manager account (Business Portfolio)

Note:



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-fqdn.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-yeastar-domain-name.html
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/configure-network-for-remote-access-by-a-domain-name.html
https://developers.facebook.com/docs/development/register
https://www.facebook.com/business/help/1710077379203657?id=180505742745347
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Platform Requirement

* Phone number: Ensure that your phone number is valid and available for

S After you set up a Business Manager account, verify your

4 business.

messaging.

oo @y

> o e

Note:
You can check the status of your phone number on 'Meta Business
Suite' portal (Path: Account > WhatsApp accounts > WhatsApp

Manager > Account tools > Phone numbers).

Settings . Test Business

Business portfolio

© Busi ol h

PP

) users ~ Name 11
People
Partners

System users

5 Accounts ~
Pages
Ad accounts
Business asset groups

Apps

[ x

WhatsApp accounts

&3 DataSources v
& Requests v

© Brandsafetyand... v

0o B

° O @& 0O

Troubleshooting:

© Yeastar Messaging

Veastar Messaging
10:97 144
Owmed by Test Business.

& Assign people
Summary People Partners

Business information
Address
No address

WhatsApp Manager > Phone numbers

2%, Partner overview

@ Partner solutions
View guidelines

&) overview

Q search by phone number or name

() Messagetemplat... A

Phone number
Manage templates

Template library o 15559871234

=3 Account tools ~

Insights

Flows

Catalog

Activity log

@ Paymentconfigu... A

by name or ID = Fiters | [IRENEEY

Assign people

Edit business information

Payment settings [
WhatsApp Manager [}
Remove i Jsiness portiolio

Filter by country -

Name Status Quality rating

Leo Ball Connected @ High

What should | do if my WhatsApp phone number status is "Pending"?

Limitations

Learn about the limitations of WhatsApp messaging channel.

¥ Filter by status -

Messaging Limit

1K Customers/24hr


https://www.facebook.com/business/help/2058515294227817?id=180505742745347
https://www.facebook.com/business/help/2058515294227817?id=180505742745347
https://business.facebook.com/
https://business.facebook.com/
https://help.yeastar.com/en/p-series-appliance-edition/faq/omnichannel-messaging-faq.html#omnichannel-messaging-faq__pending-number
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Item Description

Message type Supports text messages and multimedia messages, where the multimedia
message types are determined by WhatsApp. For more information, see
WhatsApp supported media types.

Important:

When sending multimedia messages (such as images), WhatsApp
downloads the file from a link provided by the PBX. Therefore, if you
have set Allowed Country/Region IP Access Protection rule, make
sure that you have allowed the IP access from the country where the
WhatsApp server is located, otherwise the file transmission would fail.

Messaging You can receive and reply to customers' inbound messages, or proactively
mechanism initiate a messaging session using a WhatsApp message template.

Message sending  Supports to send up to 80 messages per second.

rate
File size Supports to send a file with a maximum size of 100 MB.
File retention Files can be retained for 72 hours.
period
Procedure

« Step 1. Create a Meta app on 'Meta for Developers' portal

« Step 2. Obtain essential credentials on 'Meta Business Suite' portal
« Step 3. Create and configure a WhatsApp channel on PBX

« Step 4. Configure webhook in the Meta app

Step 1. Create a Meta app on 'Meta for Developers' portal

On 'Meta for Developers' portal, create a Meta app on the Meta for Developers portal, add
phone number to the app, and obtain a phone number ID as well as the app secret, which is
required later when configuring the WhatsApp channel on the PBX.

1. Log in to 'Meta for Developers' portal with your Meta Developer account, then go to
My Apps from the top menu.


https://developers.facebook.com/docs/whatsapp/cloud-api/reference/media#supported-media-types
https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/restrict-specific-countries-or-regions-from-accessing-yeastar-pbx.html
https://developers.facebook.com
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2. Create an app of the Business type.
a. Click Create App.

b. Complete the app settings.

Note:
In the Business Portfolio field, select your Business Account to con-
nect the app with your business, as apps that need advanced access

for permissions must be connected to a verified business entity.



https://developers.facebook.com/docs/graph-api/overview/access-levels/
https://developers.facebook.com/docs/graph-api/overview/access-levels/
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Create an app

(D App details

°|
. Cammerce AP1 and more. Youll be askec o seec an 3pp ype then 300

3. In the Add products to your app page, scroll down to find WhatsApp and click Set
up.

o S =

Webhooks WhatsApp Facebook Login for Business

Subscribe to changes and recewe updates in real Integrate with WhatsApp A secure way for businesses to give your app
time without calling the API. permissions to access data.

Read Docs

Setup Read Docs Set up Read Docs Setup

You are redirected to the Quickstart page of the WhatsApp product.

4. On the left navigation bar, go to WhatsApp > APl Setup > Send and receive mes-
sages, and complete the followings:

a. In the From drop-down list, click Add phone number to add your WhatsApp
phone number for messaging.

Send and receive messages
Step 1: Select phone numbers

From

Test phone numbers allow you to send free messages for 90 days. You can use your own phone number, which is subject to limits and pricing. About

pricing
[ Test number: +1 555 019 3510 - ] Add phone number Add a phone number for WhatsApp X
This is the number people will see when they chat with you. Learn how to use a
Test Number Business| @) WA Business Profile number that's already on WhatsApp.
° @ +1555 0193510
O Add number Phone number
+ Add phone number us+1 v | (555)987-1234 I ‘

a code to verify this numbe!

Choose how you would like to verify your number:
If you are using a landline number, choose phone call

@ Text message Phone call

-

b. Select the added phone number from the list, then note down the corresponding
Phone number ID as you will need to add them on the PBX later.
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Send and receive messages

Step 1: Select phone numbers

From
Test phone numbers allow you to send free messages for 90 days. You can use your own phone number, which is subject to limits and pricing. About
pricing
+1 5559871234 -
Phone number ID: 39 05 % WhatsApp Business Account ID: 44 02 O
To
US+1 w  Phone number

Important:

If you are using the test number provided by WhatsApp for demo or
testing purposes, you need to specify the recipients' phone number in
the To drop-down list, otherwise message sending may FAIL.

Step 1: Select phone numbers

From
Send free messages with the provided test phone number. You can usgauenwmmshansmumbsmuhinksissnbissttadimitsandmnrininmsamemnrms

Test number: +1 555019 3510 v Add a recipient phone number X
You can have up to 5 phone numbers to receive free test messages.

Phone number

Ph ber ID: 1 7 WhatsApp Business A
one number © 1SAPP BUSINESSAR s +1 - | (800)278-6915 o]

To . : : .
By continuing, you are giving consent to receive messages at this phone number.

Gancel m
:

{ Select a recipient phone number v J

Manage phone number list

s s s S s snsmmsmsness PIINAL AN NrRSS Anter Tn create vour own messane temfhlate click here

5. On the left navigation bar, go to App settings > Basic, note down the App secret of
the app, as you will need it later on PBX.

@ Dashboard

Required actions App ID App secret

ﬁ' App settings ~ g i 744 2 Reset
Basic Display name Namespace
Advanced Yeastar Messaging

Step 2. Obtain essential credentials on 'Meta Business Suite' portal

On 'Meta Business Suite' portal, create a system user and grant permissions to the user,
then generate an access token for the user to grant access the Meta App you created in the
previous step, which is required when configuring WhatsApp channel on the PBX. Addition-
ally, obtain the WhatsApp Business Account ID, which is needed to retrieve message tem-
plates associated with the account.
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Important:

It is recommended to use the access token from Meta Business Suite instead of
the one from Meta for Developer portal, as the latter is a temporary token that may
cause missed messages once it expires.

1. At the top-left corner of the 'Meta for Developers' portal, go to App Dashboard >

Business settings.
00 Metafor Developers | = App Dashboard |
¥ Docs
. Shortcuts ¢
I
© ich © i
ﬂ WhatsApp Business settings| Business Support
Manager Home
& \s] (@) ®: t
Apps Brand Safety and Ad account
Suitabilit settings

You are redirected to the Business settings page of ‘Meta Business Suite' portal.

2. Go to Users > System users, create a system user and grant app permission to the
user.

a. Click Add to create a system user with Admin role.

. Test Business
Settings T Business portfolio
@ Businesspoltoiiolin i System users © Q Search by name or ID + Add
® (&) users ~ Name 7 Role ©
8 People
- Partners
Q Create system user x
.
Enter a name for the system user you want to create below
S Qe - System user name
Admin
Pages
Ad accounts
Business asset groups -
Apps
WhatsApp accounts
Q
a &3 DataSources v
) I

b. Select the created user, click Add assets and grant the full control permission
of the app to the created user.


https://developers.facebook.com
https://business.facebook.com/

System users @

Name 7
& Admin &
D: 106 185

Assigned assets

Select assets and assign permissions

Select asset type @ Select assets
Catal

atalegs Q Search by name or ID
Apps 1

—  Selectall
WhatsApp accounts slecta

v ‘,'. Yeastar Messaging

1 asset selected

Test Business

Settings Business portfolio
. 59 Business portfolio info WhatsApp accounts @
] users N Name 14
®
& People (© Yeastar Messaging
Partners
& System users
7 Accounts -~
Pages
Ad accounts
Business asset groups Add people and set permissions
WhatsApp account: Yeastar Messaging
Apps
Add people
Instagram accounts
Q — | Selectall
&3 DataSources v
u v @ Admin (System user)
I~ ~
?

1 person selected
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Q Search by name or ID

Admin
1D: 100
Admin access

185

Installed apps

Assign permissions

Partial access

Full control

Manage app

Generate token Revoke tokens X

Edit info

Assign assets

. Ny

Can manage roles, change app settings, test the app and

view analytics.

3. Go to Accounts > WhatsApp Accounts, add the created user to your WhatsApp Busi-
ness account and grant the user full control permission.

Q Search by name or ID

Yeastar Messaging
1D: 9751025558261144
Owned by: Test Business

& Assign people

Summary  People Partners

Business information

Assign permissions
Partial access

Full control

Manage WhatsApp business accounts
@ ou can do all o the above, and also assign users and view

= Filters + Add

Edit
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4. Go back to Users > System users, generate an access token with the what sapp_-
busi ness_nessagi ng and what sapp_busi ness_management permissions enabled.

Note:
By default, the token expires after 60 days. You can set it to Never if you
don't want the token to expire.

Test Business

Settings [T ;s porfolio
E] E=] Business portfolio info System users © Q Search by name or ID + Add
® B users > Name 1 Admin
85
People ¢ Admin & ID:10 185 Generate token Revoke tokens X
) 1D: 100 "85 Admin access
Partners
Assigned assets  Installed apps
& System users
Accounts ~ Py .
= Generate token What permissions will be granted to the app? x
Pages
@ selectapp @ Ifyou are unable to find the necessary permissions, consider
Ad accounts granting an app role to the system user.
@ setexpiration
Business asset groups Select permissions
(O Assign permissions
Apps 2 options selected - ) o Mancge
Instagram accounts Q
2
WhatsApp accounts pages_read_user_content @ Mfanage
pages_show_list
Q a b W Manage
v
u foJDRta SrcEs private_computation_access
publish_video 3 w Manage
o ~
& @ read_insights
0] Manage
read_page_mailboxes
v whatsapp_business_management -
v whatsapp_business_messaging .

The pop-up window shows the generated access token.

Important:
Make sure that you have copied and properly saved the access token before
closing the pop-up window, as it is only displayed ONCE.
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Generate token Token created X

Q Select app Your token has been created and can now be used.

Token

@ setexpiration :
RtjGFQ74en1FSfGgT97xaHbWfaWz 7T Copy

0 Assign permissions

O Done

5. Go to Accounts > WhatsApp accounts, click your WhatsApp Business Account, then
copy the account ID.

Test Business
Business portfolio

Settings T

£ Businessinfo WhatsApp accounts @

Q search by name or ID

= Filters + Add

a

B o

@ Users -~ Name 11
@ Test WhatsApp Business Account
- 1D: 10 35 X
g EoDS (© Test WhatsApp Business Account Gwned{": Test Business
Partners &
B & Assigi people & Assign partner

System users

B Accounts ~ Summary People Partners
Pages
Business information Edit
Ad accounts
Address
Business asset gro... No address
Currency
Apps
PPp! e
Instagram accounts .
Time Zone

> R n /:)

America/Los_Angeles

Business name
Test Business

Business verification

Step 3. Create and configure a WhatsApp channel on PBX

On the PBX, create a WhatsApp channel and configure it using the information obtained in
the previous steps. This ensures that the PBX can connect to the WhatsApp for messaging.

1. Log in to PBX web portal, go to Messaging > Message Channel.
2. Click Add, and select WhatsApp.
3. In the Authentication tab, enter the authentication information of WhatsApp.



Contact Center Guide | 3 - Omnichannel Messaging Guide | 342

Authentication Messaging Settings

Please refer to the User Guide for information on how to configure the following settings

WhatApp channel https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/whatsapp/5d

« Name: Enter a name to help you identify the channel.

« Webhook URL: Select and note down the Webhook URL, as you will need it lat-
er on WhatsApp.

» Verify Token: Note down the verify token, as you will need it later on Whats-
App.

 Access Token: Paste the Access Token obtained from 'Meta Business Suite'
portal.

» App Secret: Paste the App Secret obtained from ‘Meta for Developers' portal.

4. In the Messaging Settings tab, configure the channel.
a. Enter WhatsApp phone number information.

+15559871234 12 7

« Phone Number: Enter the WhatsApp phone number in E.164 format ([ +]
[country code] [ phone nunber] ) For example, +15559871234.
+ Phone Number ID: Paste the phone number ID.

b. In the WhatsApp Business Account ID field, paste the account ID obtained
from 'Meta Business Suite' portal.

PBX will automatically synchronize the message templates associated with the
WhatsApp account to the channel.

c. In the Destination for Inbound Messaging drop-down list, specify the desti-
nation of inbound messages from the number.
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5000-Leo Ball

Extension @

Message Queue

Option Description

Extension

Message Queue

Third-Party Message
Analytics Platform
(Transmitted via API)

If selected, choose an extension from the Extension
drop-down list.

Only the extension user can receive inbound messages from
the number.

If selected, choose a queue from the Message Queue
drop-down list.

All the agents in the selected message queue can receive
inbound message(s) of new sessions in the queue. However,
only the user who picks up a session will be able to receive and
respond to the follow-up inbound messages in the session.

If selected, inbound messages will be automatically forwarded
to a third-party message analytics platform via API for
advanced processing.

Note:
To enable automatic forwarding of inbound messages
to a third-party message analytics platform, ensure
that your PBX server has been integrated with
the third-party message analytics platform via
API. Once this option is selected, the PBX system
will automatically transmit inbound messages to
the designated platform. You can get notified by
monitoring the API event (30031) New Message
Notification. Additionally, the PBX provides a
comprehensive Message API suite for advanced
message interaction with the integrated third-party
message analytics platforms.

d. In the Extensions Allowed to Create Messaging Sessions section, select the
extensions that are allowed to initiate a messaging session with customers.



https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/enable-yeastar-p-series-pbx-api.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/event-new-message-notification.html
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
https://help.yeastar.com/en/p-series-appliance-edition/developer-guide/api-interfaces-and-events-summary.html#api-interface-and-event-overview__section_messaging
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| 2/9items Available 2items Selected

®  Extension Number Caller ID Name Extension Number Caller ID Name

Extension Group Training Group 5000 Leo Ball

5002 Sarah Bennet % 5001 Kristin Hale
3@ 5003 Dave Miller
5004

Micheal Harris

a

5005 Lucy Anderson

5006 Rachel Morgan

e. Optional: If you want the system to automatically close the sessions that have
been inactive for a specific period of time, select the checkbox of Close Ses-
sion Automatically, then set the timeout in the Session Timeout (Days) field.

Close Session Automatically

5. Click Save.

Step 4. Configure webhook in the Meta app

On the 'Meta for Developers' portal, set up a webhook for your Meta app to receive real-time
message events. This allows the PBX to process incoming messages from WhatsApp.

1. Log in to 'Meta for Developers' portal with your Meta Developer account, then go to
My Apps from the top menu.


https://developers.facebook.com
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2. Click the created app to enter the details page.

OQ Meta for Developers Docs Tools Support [WIYCBl Q. Search developer documentation _

Apps Q search by App Name or App ID Create App
Filter by Recently Used v
(®) AllApps (2)

Archived
‘App ID: 12 6
. . Mode: In development
Required actions Type: Business

Business: Test Business

® Administrator

3. Go to WhatsApp > Configuration to configure the messaging webhook and sub-
scribe to webhook field, so that PBX can get notified upon receiving WhatsApp mes-
sages.

a. Paste the Webhook URL and verify token obtained from the PBX.

Webhook
To get alerted when you receive a message or when a message's status has changed, you need to set up a Webhooks endpoint for your app. Learn
how to configure Webhooks.

Callback URL @
https://yeastardocs.ras.yeastar.com/api/v1.0/webhook/whatsapp/4f9664096f524cc79d7b8fed69ec9b17
Verify token @

38owndego8ugcinx

@  Attach a client certificate to Webhook requests. Learn more.

Remove subscription

b. In the Webhook fields section, subscribe to messages webhook field.
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messages v21.0 - Test . Subscribed

Result

« The Status of the WhatsApp channel shows @, which indicates that you have suc-
cessfully created a WhatsApp channel.

Status Name Type Number Total Sent Operations

@ WhatsApp channel WhatsApp +15559871234 0 0 Z ™

« PBX automatically tracks and records the number of messages sent and received on

the channel, where the Total column displays the total amount of the sent messages,
including both successfully sent messages and failed ones.

6 Tip:

You can filter the statistics by a time period using the time filter.

Number Total Sent Failed Received Operations

+15550193510 30 20 10 8 Z

What to do next

Send text messages to the phone number and see if the specified agent can receive mes-
sages on his or her Linkus UC Client.

Related information
Check and Manage External Chat Logs
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

View WhatsApp Message Templates

Yeastar P-Series PBX System supports WhatsApp message templates, allowing extension
users to send pre-approved, structured messages to their customers.
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Introduction

PBX automatically synchronizes approved message templates based on the WhatsApp
Business Account ID associated with the WhatsApp channel. By default, extension users
can reply to inbound messages within the WhatsApp channel during the WhatsApp 24-hour
customer service window. To proactively send messages, such as initiating a new Whats-
App session or launching a WhatsApp campaign for bulk messaging, outside this 24-hour
time window, users must use these synchronized template messages.

« For more information about how to view message templates for a WhatsApp channel
in PBX, refer to the instructions below.

« For more information about how to use template messages in a WhatsApp campaign,
see Create a WhatsApp Campaign.

 For more information about how users can use the message templates, see Agent
Guide - Start a Message Session via a WhatsApp Channel.

Prerequisites

» Ensure that the firmware of PBX server is 37.20.0.21 or later.
» Message templates have been created and approved in your WhatsApp Business Ac-

count.

Note:

> Only templates with Active status will be synchronized to the PBX; mar-
keting templates of the Catalog type will be excluded.

> The PBX supports synchronizing up to 250 message templates for each
WhatsApp channel.

o Variable names in the template support only lowercase letters and
numbers. Do not use underscores or special characters, as this may af-
fect usage.



https://www.facebook.com/business/help/2055875911147364?id=2129163877102343
https://www.facebook.com/business/help/2055875911147364?id=2129163877102343
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Test Business
Business portfolio

Settings

& Businessinfo

WhatsApp accounts @

@ users ~ Name T4

People (O Yeastar Messaging

Partners

a8
®
g
&

System users

B Accounts ~
Pages
Ad accounts
Business asset gro...
Apps

Instagram accounts

WhatsApp accou...

O, Messaget... ~

Template library

Sy B

& Accountt.. A
Insights
Flows
Phone numbers
Catalog

Activity log

Manage templates

Q search by name or ID

Yeastar Messaging

1D:
Ovned by: Test Business

& Assign people & Assign partner

Summary  People Partners

Business information
Address
No address

Currency

Templates  Template groups

Q search Categ.. ¥ Langu.

Template
name

Language 11

English (US)

hello_world
- Welcome and congrat.

Utility

1 message template shown (total active templates: 1 of 6000)

Status 11

Active - Qualit

9 |
Assign people
Edit business information
Payment settings &)
WhatsApp Manager ]

Remove fron] business portfolio

last7.. ¥ % Namespa:

Mess:
T
delive °

Mess.
rea...

0

ce

Compare Create template

Last
edited

Oct 16, 2023

« A WhatsApp channel has been set up with your WhatsApp Business Account.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Channel.

2. Click [ beside a WhatsApp channel.

Status Name Type

©

WhatsApp Message Template

O Refresh

Template Name
PromoOffer
AccountVerification
Eventlnvitation
FeedbackRequest
AppointmentReminder
PaymentSuccess
ShippingUpdate

OTPCode

Template Type O

Number

Template Language O

Marketing English (US)
Authentication English (US)
Marketing English
Marketing English
Utility English (US)
Utility English
Utility English
Utility English

Q Total: 85

20/ page

Total Sent
X 189
Q
Preview
©
©®
©
©
©®
©
©
©®
Goto
v OK

Operations

2| B |

A window pops up, displaying all synchronized message templates associated with
your WhatsApp Business Account.

3. To preview a message template, click O}
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4. To update the list and content of message templates to the latest version, click Re-
fresh.

Note:
The system automatically refreshes the templates once a day by default. If
needed, you can also refresh the list manually.

Message Queue Setup

Create a Message Queue

Yeastar P-Series PBX System allows to route messages from different message channels to
message queues, so as to share workload between agents and reduce customer service re-
sponse time. This topic describes how to create a message queue.

Limitation

Message Queue

Agents per Message 20 25 60 120
Queue

Requirements

« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)
» Firmware: 37.20.0.21 or later

Procedure

1. Log in to PBX web portal, go to Messaging > Message Queue.
2. Click Add.
3. In the Name field, specify a name to help you identify it.

4. In the Chat Assignment Mode section, configure the assignment mode according to
your needs.
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(@ Manual Pickup: Agents can take over the session by clicking the 'Pick Up' button.
Auto-Pickup: The first agent to respond will automatically pick up the session.

Disable Pickup: Agents cannot pick up sessions.

Mode Description

Manual Pickup All agents can view and reply to messages until an agent manually click the
Pick Up button to pick up the session.

Auto-Pickup All agents can view the messages, and the first agent to reply automatically
picks up the session.

Tip:
If you select this mode, make sure to inform all agents in the queue
in advance to avoid incorrect operations.

Disable Pickup All agents can view and reply to messages, and sessions cannot be picked
up.
5. In the Agents section, select the desired extension users from the Available box to
the Selected box.

W 1/6items Available 6 items Selected
- Extension Number Caller ID Name Extension Number Caller ID Name
2006 Naomi Nichols 2000 Leo Ball
2007 Ashley Gardner % 2001 Phillip Huff
2008 Jaime Hart 2002 Terrell Smith
2009 Carmen Gordon test 2003 Dave Haris
2010 Joe Lewis 2004 Troy Daniel
3000 Leo Ball 2005 Kristin Hale

6. Click Save.
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Result

All the selected extension users are assigned as agents of the message queue.

What to do next

Set the message queue as the inbound message destination of a channel number (Path:

Messaging > Message Channel > Z Messaging Settings).

+18723428005

Message Queue Tech Support

Related information
Manage Message Queues
User Guide - Manage customer queries from SMS channel on Linkus Web Client /
Desktop Client
User Guide - Manage customer queries from SMS channel on Linkus Mobile Client

Manage Message Queues

This topic describes how to edit a message queue, and delete message queue(s).

Edit a message queue

1. Log in to PBX web portal, go to Messaging > Message Queue.

2. Click Z beside the queue that you want to edit.
3. Change the settings according to your needs.
4. Click Save.

Delete message queues

Important:
Before you delete a message queue, make sure that the queue is not set as the in-
bound messaging destination of a message channel.
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1. Log in to PBX web portal, go to Messaging > Message Queue.
2. To delete a queue, do as follows:

a. Click [T beside the queue that you want to delete.

b. In the pop-up window, click OK.
3. To delete queues in bulk, do as follows:
a. Select the checkboxes of the queues that you want to delete.

b. At the top of the list, click Delete.
c. In the pop-up window, click OK.

Message Campaign

Message Campaign Overview

Yeastar P-Series PBX System supports a message campaign feature that allows you to
send bulk messages to a group of contacts through specified messaging channel. This fea-
ture is commonly used for marketing promotions, notifications, reminders, and customer
engagement.

Requirements

« Firmware: Version 37.20.0.21 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

Limitations

* You can create up to 1,000 message campaigns.
« Each campaign can include up to 1,000 contacts.

Supported channels

You can create message campaigns for SMS and WhatsApp channels, allowing you to
reach your contacts through their preferred communication method.

For more information about the campaign configuration, see the following topics:

» Create an SMS Campaign
» Create a WhatsApp Campaign
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Campaign Status

The following table describes different statuses of the message campaign.

Status Description

Draft The campaign is saved as a draft. Messages will not be sent.

Scheduled The campaign is scheduled to be sent at the specified time.

Pending The campaign is waiting to send messages because another campaign is in
progress.

Executing The campaign is currently sending messages.

Completed The campaign has completed sending all messages.

Stop The campaign was unexpectedly stopped due to a system issue, such as system
restart, subscription issue, etc.

Retrying The campaign is retrying to send messages.

Create an SMS Campaign

SMS campaigns allow you to send targeted messages directly to your contacts' mobile
phones, making it easy to reach customers quickly and efficiently. This topic describes how
to create a message campaign for an SMS channel.

Requirements

« Firmware: Version 37.20.0.21 or later
« Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

Prerequisites

Before you begin, make sure that the following resources are ready for a message cam-
paign:

Item Description

Message Channel  Set up and configure an SMS channel.

Note:
Ensure your account with the selected service provider has sufficient
credits or quota to support your planned bulk messaging volume.

Contact List Prepare a list of contacts with phone numbers for the campaign.
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Item Description

Note:
Each campaign supports up to 1,000 contacts.

You can associate a contact list with a campaign using one of the following
methods:

« Manually add contact numbers.
+ Import a CSV file containing contacts' phone numbers.

73 Note:
To use this method, ensure your file meets the following
requirements:
o Format: UTF-8 . csv
- Size: Less than 50 MB
> File name: Less than 127 characters
o Import parameters: Use a Nunber field to provide
phone numbers in E.164 format (e.g. +1xxxxxxxxxx), as
shown in the figure below.

4 A B C D
1 |Number |
2 +12025550101
8 +12025550102
4 +12025550103
5 +12025550104
(6] +12025550105
7 +12025550106
8 +12025550107
9 +12025530108
10 +120255320109
11 +12025550110
12

Directly use the existing contacts stored in a PBX phonebook.

) Note:
To use this method, ensure that the contact's phone number are
stored in E.164 format, as shown in the figure below.

* Number Type * Number Operations
Business +12025550101 o

+ Add



https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/manage-company-phonebooks.html
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Description

Message Routing  Optional. If you want the message campaign to automatically create sessions,
Target configure the desired routing target (either an extension or a message queue) in
advance.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Campaign, then click Add.
2. In the Basic section, complete the basic settings.
« Name: Enter a name for the campaign to help you identify it.
- Message Channel: Select the desired SMS channel.
« Sender: Select the number associated with the selected SMS channel for mes-
sage sending.
« Recipient: Specify recipients using one of the following methods.

Instruction
Manual entry Manually add contact numbers in E.164 format (e.g.,
FIXXXXXXXXXX ).
Recipient
@ Input & Import Phonebooks

* Number Operations

+12025550101 o)

Total: 1 [ 1 20/ page

a. Select Input & Import.
b. Click Add to manually add phone numbers.

Import from CSV file Import a CSV file containing the contacts’ phone numbers.

Recipient

(® Input & Import Phonebooks

.
o0&
Import Message Campaign X
* Number
Please choose a UTF-8.csv file to import.
Click Here to view the format requirement for the imported file.

a. Select Input & Import.
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Method Instruction

b. Click Import.

c. In the pop-up window, click Browse to select the
desired file.

d. Click Import.

Use existing PBX Directly use existing contacts stored in your PBX phonebook.
phonebook

Recipient

Input & Impor: (® Phonebooks

The recipient number must start with "+Country Code" and only numbers and character + are allowed.

VIP_Contacts_Phonebook Business

a. Select Phonebooks.

b. In the Phonebooks drop-down list, select the existing
phonebook.

c. In the Number Type drop-down list, select the number
type.

The system will retrieve phone numbers from the
specified number types.

3. In the Message Content section, customize your message content.

You can send either a text message (SMS) or a multimedia message (MMS) that in-

cludes a file.
Type Instruction
File To send an MMS message that include a file, do as follows:

Note:

« Supported file types are determined by the ITSP of the SMS
channel.
» The file size can NOT exceed 100 MB.

Message Content
(® File Text

Choose a File

a. Select File.
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Type Instruction

b. Click Choose a File, then select a file to upload.

Text To send an SMS message, do as follows:

Note:

» The message length is up to 1600 characters.
» Emojis are supported.

Message Content

Fild (® Text

©

Dear VIP Member,
Thank you for your continued loyalty! This month, we have prepared exclusive rewards and surprises just for you. Feel free to contact
our team for more details. We look forward to serving you! &

“

a. Select Text.
b. In the text field, enter the message content and add emojis as needed.

4. In the Sending Rules section, configure the message send time and the mode.
a. In the Send Time section, specify when to send the message.

Option Description

Send Now The campaign will be sent immediately after saving.
Schedule Sending The campaign will be sent at a specified date and time.

(®) Schedule Sending

* Time

2025/07/24 08:50:00 AM

Do NOT Send, The campaign will be saved as a draft. You can edit or send it
Save as Draft later.

b. In the Send Mode section, set whether to create sessions accordingly.

Option Description

Create session The system automatically create a session for each contact

and send message number when sending the campaign messages, and the sessions
will be assigned to a selected target (either an extension or a
message queue).

) Note:
If an active session already exists for a contact number,
the campaign message will be sent to the existing
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Description

S session instead of creating and assigning a new session
A tothe specified target.

(®) Create session and send message.
A session will be automatically created when sending a message. And this session will be assigned to your selected target.

*

*

VIP_Service

Extension

Message Queue

No session will be created when sending a message. And the

Send messages
message will not be displayed in External Chat Logs.

directly without
creating session

5. Click Save.

Result

A campaign is created successfully and displayed in the campaign list.
o |f you choose to send messages immediately, the campaign status will display

as Executing, and messages will be sent to the specified phone numbers right

away.
Status Name Message Channel Sender Recipient Operations Y
Executing Promotion Ca.. @ SMS channel +14102161183 VIP_Contacts_Phon.. Z

o If you scheduled the campaign, the campaign status will display as Scheduled,
and messages will be sent automatically at the specified time.

Status Name Message Channel Sender Recipient Operations Y
VIP_Contacts_Phon.. 2 [P o)

Scheduled Promotion Ca.. @ SMS channel +14102161183

« When a campaign is marked as Completed, you can check its results from the cam-
paign list.

Note:

o |f there are any failed messages, you can click 1o retry sending.

o To create a similar campaign, click =F to duplicate the campaign.

o For a quick overview, check the Result and Response Rate columns.
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Send Time Send Mode Result (Failed/Total)  Response Rate Details Operations Y

's_Phon.. 2025/07/2314:04:10 Send messages dir.. |0/5 40% E Z @ 9O 1w

> To see detailed sending information, click El.

Send Time Send Mode Result (Failed/Total) ~ Response Rate Details Operations Y
Va o W
Details(Promotion Campaign) X @

Send Time: 2025/07/23 14:04:10  Failed:0  Succeeded:0  Total: 5

Contact Name Number Result Failed Reason
VIP_Customer_E +12025550105 Succeeded
VIP_Customer_D +12025550104 Succeeded
VIP_Customer_C +12025550103 Succeeded
VIP_Customer_B +12025550102 Succeeded
VIP_Customer_A +12025550101 Succeeded

Total: 5 10/ page

v OK

Create a WhatsApp Campaign

WhatsApp campaigns allows you to send marketing, utility, and authentication messages di-
rectly to your contacts' mobile devices via WhatsApp using message templates, making it
easy to reach customers quickly and effectively. This topic describes how to create a mes-
sage campaign for a WhatsApp channel.

Requirements

« Firmware: Version 37.20.0.21 or later
» Plan: Enterprise Plan (EP) or Ultimate Plan (UP)

Prerequisites

Before you begin, make sure that the following resources are ready for a message cam-
paign:

Description

Message Channel Set up a WhatsApp Channel with your WhatsApp Business Account.

I Note:
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Description
S Ensure your account’s messaging limit can support your planned
4 bulk messaging volume.
WhatsApp Manager > Phone numbers  Test WhatsApp Business Account ¥
S Rbat = ovEiicn Q search by phone number or name Filter by country v ||V Filter by status hd
& Partner solutions
Phone number Name Status Quality rating Messaging Limit
(©) Cxi L 15550193510 1“:' N“’v\‘b;c'“w)‘m Connected ® High 1K Customers/24hr o &
Message Template » Create message templates for your WhatsApp Business Account in
advance, as message templates must be approved by WhatsApp
before use.
724 Note:

Variable names in the template support only lowercase letters
and numbers. Do not use underscores or special characters,
as this may affect usage.

» Refresh the template list in PBX to ensure all approved templates from
your WhatsApp account are synchronized to PBX and available for
your campaign. For more information, see View WhatsApp Message

Templates.

Contact List Prepare a list of contacts with phone numbers for the campaign.

Note:
Each campaign supports up to 1,000 contacts.

You can associate a contact list with a campaign using one of the following
methods:

» Manually add contact numbers.
« Import a CSV file containing contacts' phone numbers.

Note:
To use this method, ensure your file meets the following
requirements:
o Format: UTF-8 . csv
o Size: Less than 50 MB
> File name: Less than 127 characters
o Import parameters: Use a Nunber field to provide
phone numbers in E.164 format (e.g. +1xxxxxxxxxx),
as shown in the figure below.



https://www.facebook.com/business/help/2055875911147364?id=2129163877102343
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Item Description

. A B C D
1 |Number |
2 +12025550101
3 +12025550102
4 +12025550103
5 +12025550104
6 +12025550103
7 +12025550106
8 +12025550107
9 +12025550108
10 +12025550109
11 +12025550110
12

.

Directly use the existing contacts stored in a PBX phonebook.

,'* Note:
To use this method, ensure that the contact's phone number
are stored in E.164 format, as shown in the figure below.

* Number Type * Number Operations
Business +12025550101 Tar
+ Add
Message Routing Optional. If you want the message campaign to automatically create
Target sessions, configure the desired routing target (either an extension or a
message queue) in advance.

Procedure

1. Log in to PBX web portal, go to Messaging > Message Campaign, then click Add.
2. In the Basic section, complete the following settings.
- Name: Enter a name for the campaign to help you identify it.
- Message Channel: Select the desired WhatsApp channel.
« Sender: Select the associated WhatsApp phone number for message sending.
« Recipient: Specify recipients using one of the following methods.

Instruction

Manual entry Manually add contact numbers in E.164 format (e.g.,
FIXXXXXXXXXX ).


https://help.yeastar.com/en/p-series-appliance-edition/administrator-guide/manage-company-phonebooks.html
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Method Instruction

Recipient
@® Input & Import Phonebooks
* Number Operations
+12025550101 o}

Total: 1 1 20/ page

a. Select Input & Import.
b. Click Add to manually add phone numbers.

Import from CSV file  Import a CSV file containing the contacts’ phone numbers.

Recipient

(® Input & Import Phonebooks

:
(X0 [

* Number

Import Message Campaign X

Please choose a UTF-8.csv file to import.
Click Here to view the format requirement for the imported file.

VIP_Customers_Push.csv

a. Select Input & Import.
b. Click Import.

c. In the pop-up window, click Browse to select the
desired file.

d. Click Import.

Use existing PBX Directly use existing contacts stored in your PBX phonebook.
phonebook

Recipient

Input & Impor: (® Phonebooks

The recipient number must start with "+Country Code" and only numbers and character + are allowed.

* Phonebooks * Number Type

VIP_Contacts_Phonebook Business

a. Select Phonebooks.

b. In the Phonebooks drop-down list, select the existing
phonebook.

c. In the Number Type drop-down list, select the number
type.
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Instruction

The system will retrieve phone numbers from the
specified number types.

3. In the Message Content section, configure the message template to be sent.

a. Click WhatsApp Message Template, then search and select the desired mes-
sage template.

Message Content

WhatsApp Message Template v Marketing X English x

O tier_discount_announcement
4

Hello! £ As a valued {{customer tier}} member, were excited to share a
special {{offer type}} with you! T Enjoy {{offer details}}—available until...

b. If the template includes media or variable placeholders, upload the required me-
dia files and fill in specific values for all variables.

Edit tier_discount_announcement Message Preview

Hello!

As a valued VIP member, we're excited to share a
special discount with you! T

Enjoy 20% off for all products —available until July
31,2025

Hello!

Asavalued VIP member, we're excited to share a special ~ discount  with you! If you have any questions or want to redeem your

ffe l ly to th tact
Enjoy  20% off forall products  —available until ~ July 31,2025 offer, simply reply to this message or contact our

team,

Thank you for chocsing SmartMalt @
If you have any questions or want to redeem your offer, simply reply to this message or contact our team

Redeem Offe
Thank you for choosing SmartMal | @

Visit website

Contact us

Note:
* You can preview the final message contents on the right panel.
« For location information, you can simply paste the Google Maps
URL, the system will auto-fill the name and coordinates based on
the URL. However, you need to manually enter the detailed ad-
dress for the { { Addr ess} } variable.



https://www.google.com/maps
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Messaging / Message Campaign / Edit (Sales Campaign)

Message Content

Message Preview

Madison Square Garden

ion ==
Hall at Penn Station ' o e Macy's
i
&
A

2y D34 St-Herald Sq
v S Madison Square Garden

7505045,73 9934387,172/data=1am 2141 550x89c25¢

elimit to enjoy

ny questions, fel free to contact us,

* ({Address))

* 407505045

*73.9934387

4. In the Sending Rules section, configure the message send time and the mode.
a. In the Send Time section, specify when to send the message.

Option Description

Send Now The campaign will be sent immediately after saving.

Schedule Sending The campaign will be sent at a specified date and time.

(®) Schedule Sending
* Time

2025/07/24 08:50:00 AM

Do NOT Send, The campaign will be saved as a draft. You can edit or send it
Save as Draft later.

b. In the Send Mode section, set whether to create sessions accordingly.

Option Description

Create session The system automatically create a session for each contact

and send message number when sending the campaignh messages, and the sessions
will be assigned to a selected target (either an extension or a
message queue).

," Note:
If an active session already exists for a contact number,
the campaign message will be sent to the existing
session instead of creating and assigning a new session
to the specified target.
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Option Description
(®) Create session and send message.

A session will be automatically created when sending a message. And this session will be assigned to your selected target.

*

‘ VIP_Service

Extension

Message Queue

No session will be created when sending a message. And the

Send messages
message will not be displayed in External Chat Logs.

directly without
creating session

5. Click Save.

Result

A campaign is created successfully and displayed in the campaign list.
o If you choose to send messages immediately, the campaign status will display

as Executing, and messages will be sent to the specified phone numbers right

away.
Status Name Message Channel Sender Recipient Operations Y
Executing Promotion Ca... » WhatsApp Chan... +15550193510 VIP_Contacts_Phon... 2

o If you scheduled the campaign, the campaign status will display as Scheduled,
and messages will be sent automatically at the specified time.

Status Name Message Channel Sender Recipient Operations Y
VIP_Contacts_Phon... Z B m)

Scheduled Promotion Ca... ® WhatsApp Chan... +15550193510

« When a campaign is marked as Completed, you can check its results from the cam-
paign list.

Note:

o |If there are any failed messages, you can click 1o retry sending.

o To create a similar campaign, click =F to duplicate the campaign.

> For a quick overview, check the Result and Response Rate columns.
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Send Time Send Mode Result (Failed/Total)  Response Rate Details Operations Y

's_Phon.. 2025/07/2314:04:10 ~ Send messages dir.. |0/5 40% E Z @ 9O 1w

> To see detailed sending information, click El.

Send Time Send Mode Result (Failed/Total)  Response Rate Details Operations Y
2 o W
Details(Promotion Campaign) X @

Send Time: 2025/07/23 14:04:10  Failed: 0 Succeeded:0  Total: 5

Contact Name Number Result Failed Reason
VIP_Customer_E +12025550105 Succeeded
VIP_Customer_D +12025550104 Succeeded
VIP_Customer_C +12025550103 Succeeded
VIP_Customer_B +12025550102 Succeeded
VIP_Customer_A +12025550101 Succeeded
Total: 5 ‘T‘ 10/ page

v 0K

External Chat Log Management

Check and Manage External Chat Logs

External chat logs are comprehensive records of sessions and messages coming from var-
ious messaging channels. This topic describes how to check the external chat logs (includ-
ing session information, session operation records, and detailed chat histories) and how to
delete the session or chat histories on Yeastar P-Series PBX System.

Requirements

The firmware version of Yeastar P-Series PBX System is 37.13.0.25 or later.

Procedure

1. Log in to PBX web portal, go to Reports and Recordings > External Chat Logs.
2. Optional: Set criteria (time, channel type, or other objects) to filter the desired records.

The relevant records of external chat sessions are displayed on the page.



Reports and Recordings / External Chat Logs

2024/09/01 00:00:00 - 2024/10/10 23:59:59
O Refresh
Session ID Created At
a1 2024/09/20 15:18:38
30 2024/09/20 15:09:42
29 2024/09/20 15:01:51
1 2024/08/16 09:27:15

Last Active At

2024/09/20 15:24:03

2024/09/2015:10:10

2024/09/20 15:09:24

2024/09/08 11:29:54
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Sender Recipient Channel Type Channel Number Session Status Details Operations
Website Visitor QueueA Live Chat LC00000 Closed ) o
Website Visitor Leo Ball<1000> Live Chat Lco0000 Closed B o
Website Visitor Leo Ball<1000~ Live Chat Lc00000 Closed ) &
Jim Terrell Smith<1002>  Facebook Messenger  334079033132760 Not Closed B o]

Lee<86153282118153...

Q Total4 E 20/ page

3. Check and manage the records according to your need.

Operation

of an external chat
session

External Chat Session

Check operation records

Instruction

a. Click F@ beside the desired session.

Channel
Session ID Time Sender Recipient Channel Number
Type
2 12/12/2023 customer<+12 TechS N sMs +12 407
2331112 283> ech suppor

A window pops up, displaying the operation records of the
session in a timeline view.

73 Note:
Only the following operations will be recorded:
« Create a session
« Transfer a session
« Pick up a session from a message queue
* Close a session

Session Timeline X

@ Received an inbound message and created session
12/12/2023 23:31:12

Received a message from +12, 283, and the session has been routed to
Tech Support.

&, Session has been picked up from message queue
12/12/2023 23:33:51

Leo Ball<3000> picked up the session from message queue Tech Support

® Session closed by extension
12/18/2023 04:47:29

Leo Ball<3000> closed the session.

Details

Operations
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Operation

Instruction

Delete external chat » To delete a session, do as follows:

session(s)
Session ID Time Sender Recipient Channel Type Channel Number
2 12/12/2023 +12 283 Tech S rt SMS +12 407
2331112 e Suppo

If deleted, extensions will not be able to view the
session, and the message record of the session
will also be deleted. Are you sure you want to
proceed?

X Cancel

a. Click EI beside the session that you want to delete.

b. In the pop-up window, click OK.
» To delete multiple sessions, do as follows:

&> Download v [l O Refresh

Details Operations

B M %

m  SessionID Time Sender Recipient Channel Type Channel Number Details Operations
12/19/2023
K
7 Sy +120: 28005 B [ o)
If deleted, extensions will not be able to view the
6 12419/2023 +120 session, and the message record of the session 28005 B &
05748 will also be deleted. Are you sure you want to
proceed?
12/19/2023
G
5 00:32:58 +120; 28005 R [© T
X Cancel
12/18/2023
K
3 35742 1001 61283 B M &
a. Select the desired sessions, then click Delete.
b. In the pop-up window, click OK.
External Chat History
Check the detailed chat ) ) ) ]
. . . a. Click beside the desired session.
histories of a session
. . - Channel ’ X
Session ID Time Sender Recipient Type Channel Number Details Operations
12/12/2023 customer<+12
2 933112 oy Tech Support SMS +12 407 ) i o
The detailed messages in the session are displayed.
Time Sender Recipient Message Type Message Content Operations
12/18/2023 04:47:29  PBX System The session has been closed.
12/18/2023 00:03:06  Leo Ball<3000> +12 283 Outbound Test Session Completed ]i[
12/12/2023 23:34:13  Leo Ball<3000> +12 283 Outbound Hi! How can | help you? a1
Leo Ball picked up the session from message
12/12/2023 23:33:51 PBX System
queue Tech Support.
12/12/202323:31:12 +12 283 Tech Support Inbound Hi | need help B
Q Total:5 20/ page

Delete chat histories of a
session

I Note:
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Operation Instruction

I Messages sent by the PBX system can NOT be deleted.
,5

a. Click beside the desired session.

Channel
Session ID Time Sender Recipient Type Channel Number Details Operations
12/12/2023 customer<+12
2 233112 283 Tech Support SMs +12 407 @ -{'J o)
The detailed messages in the session are displayed.
b. To delete a single message, do as follows:
Time Sender Recipient Message Type Message Content Operations
12/18/2023 04:47:29  PBX System The session has been closed.
12/18/2023 00:03:06  Leo Ball<3000> +12 283 Outbound Test Session Completed Ty
12/12/2023 23:34:13  Leo Ball<3 w can | help you? B
If deleted, extensions will not be able to see these | picked up the session from message
12/12/2023 23:33:51  PBX Syste|
message(s) when viewing the session on the Yech Support.
client side. Are you sure you want to proceed?
12/12/2023 23:31:12  +12 d help a7

T ~Towl5 1 20/ page

i. Click EI beside the desired message.
i. In the pop-up window, click OK.
c. To delete multiple messages, do as follows:

| 15] Delete
] Time Sender Recipient Message Type Message Content Operations
12/18/2023 04:47:29  PBX System closed.
12/18/2023 00:03:06  Leo Ball<3000> eted B
If deleted, extensions will not be able to see these
12/12/2023 23:34:13  Leo Ball<3000> u? a7

message(s) when viewing the session on the

client side. Are you sure you want to proceed?

e session from message
12/12/202323:33:51  PBX System

X Cancel
12/12/2023 23:31:12 +12 283 o)

Q Total:s 20/ page

i. Select the desired messages, then click Delete.
ii. In the pop-up window, click OK.

Download External Chat Logs

This topic describes how to download external chat logs for legal compliance, dispute reso-
lution, training, or other purposes.



Contact Center Guide | 3 - Omnichannel Messaging Guide | 370

Requirements

The firmware version of Yeastar P-Series PBX System is 37.13.0.25 or later.
Procedure

1. Log in to PBX web portal, go to Reports and Recordings > External Chat Logs.
2. To download all chat logs, click Download at the top of the list, then click Download
All Chat Logs.

¢ Download v [ & Refresh

Download Filtered Chat Logs Sender Recipient Channel Type Channel Number Details Operations

Download All Chat Logs 23

7
UUI3258 12 283 Tech Support SMs +18 005 e [ o}

12/18/9092

3. To download specific chat logs, do as follows:

12/01/2023 00:00:00 12/31/2023 23:59:59 = SMS Y Filter

G\J Download v D Refresh

Download Filtered Chat Logs Sender Recipient Channel Type Channel Number Details Operations

Download All Chat Logs 23
. +12 283 Tech Support SMS +12 407 @ &
N 2
12/12/2023
1 Leo Ball<3000> +12( 407 SMS +12! 283 @ o]
23:31:.07
Q  Total :2 ‘ 1 ‘ 20/ page

a. Set criteria to filter the desired records.

The relevant records of external chat sessions are displayed on the page.
b. At the top of the list, click Download, then click Download Filtered Chat
Logs.

Result
The external chat logs are downloaded to your computer, and each downloaded chat log
has two CSV files:

» Session_Record: This file includes basic information about all the chat sessions in the
download list.
» Chat_Data_Record: This file contains detailed chat histories of the entire chat session.
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Agent Guide

Omnichannel Messaging Agent Guide

This guide provides guidance on how to manage incoming customer inquiries on a unified
agent portal available on web, desktop, and mobile devices.

Audience

This guide is intended for customer service representatives (agents) who handles chat in-
teraction with customers through multiple digital messaging channels.

Agent portal

To enhance communication mobility and improve agent productivity, Yeastar provides a uni-
fied agent portal integrated into the Linkus UC Clients that is available on mobile, desktop,
and web-based platforms. Agents can efficiently handle message-based interactions come
from multiple digital channels through the supported clients.

Supported
Client

Description

Linkus Web The Linkus Web Client and Desktop Cleint allows agents to manage customers'
Client / Desktop | chat interactions directly from a web browser or a Desktop application.
Client
« For instructions on handling message-based interactions with customers
on Linkus Web Client and Desktop Client, see Agent operations on Web
Client / Desktop Client.
» For more information about utilizing Linkus Web Client and Desktop Client,
see Linkus Web Client User Guide and Linkus Desktop Client User Guide.

Linkus Mobile The Linkus Mobile Client is suitable for agents who need the flexibility to handle
Client customers' chat interactions on the go.

« For instructions on handling message-based interactions with customers
on Linkus Mobile Client, see Agent operations on Mobile Client.

» For more information about utilizing Linkus Mobile Client, see Linkus
Mobile Client User Guide.



https://help.yeastar.com/en/p-series-linkus-appliance-edition/web-client-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/desktop-client-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/mobile-client-user-guide/about-this-guide.html
https://help.yeastar.com/en/p-series-linkus-appliance-edition/mobile-client-user-guide/about-this-guide.html
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Agent Operations on Web Client / Desktop Client

Start a Messaging Session with a Customer on Web Client /
Desktop Client

If you need to send customers messages for notifications, marketing campaigns or other
purposes, you can proactively start a messaging session.

Note:
You can proactively start a messaging session via SMS or WhatsApp messaging
channel.

Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

« PBX Version: 37.20.0.21 or later.
« Plan: Enterprise Plan or Ultimate Plan
» Messaging:
o At least one SMS or WhatsApp messaging channel is set up on
PBX.
> You have been granted with the permission to create message
sessions in the channel.
o To initiate a session via the WhatsApp channel, only WhatsApp-ap-
proved message templates can be used. Ensure that the desired
templates have been synchronized to the PBX.

Linkus Desktop Client

Make sure that the version of your Linkus Desktop Client meets the following
requirement:

« Windows Desktop: 1.7.3 or later
« macOS Desktop: 1.7.3 or later



Supported methods

Contact Center Guide | 3 - Omnichannel Messaging Guide | 373

« Start a session via an SMS channel

« Start a session via a WhatsApp channel

Start a session via an SMS channel

1. On Linkus Web Client or Desktop Client, go to Chat > External Chat.
2. Click + to add a session.

.I

7¢ Yeastar

Q: Extensions

[Ek Contacts

[= Chat

Bl Video Conferencing
E Operator Panel

69 Call Center Console
[& CallLogs

ao Voicemails

O Recordings

= Preferences

£ Chrome Extension

B ® Bl AgentStatusv @& Availablev Fu\lowsyﬂem\,o %

Internal Chat External Chat

T
&

Recent

3. In the pop-up window, complete the following settings.
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Create Session X

@ SMS

+141516170000/SMS Channel

+1 United State... 2025550101

« Session Type: Select SMS.

« Sender: Select the desired channel number for sending messages.

» Recipient: Select a country/region code, then enter the recipient number.
4. Click Create.

The SMS messaging session is created, you can send massages and chat with your

customer.
+12025550101 .
Internal Chat External Chat
+
Recent v
Campaign Group
+12025550101 et
D
© B B

Dear Mr. Smith, this is a reminder for your car maintenance appointment at
AutoCare Center on July 26th at 9:00 AM. Please reply “1” to confirm or “2” to 17
reschedule. For assistance, call (123) 456-7890) @
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Start a session via a WhatsApp channel

1. On Linkus Web Client or Desktop Client, go to Chat > External Chat.
2. Click 1 to add a session.

_l

7¢ Yeastar

Q: Extensions

[E; Contacts

[=1 Chat

B Video Conferencing

E Operator Panel

69 Call Center Console v
B CallLogs 2]
ao Voicemails

O Recordings

S Preferences

1
a

%> Chrome Extension L]

B ® B3+~ AgentStatusv @& Availablev & Fu\lowsyﬂemvo %

Internal Chat External Chat

T
&

Recent

3. In the pop-up window, do as follows:

Create Session

® WhatsApp

+15550193510/WhatsApp Channel

+1 United State...

2225550101

+ Session Type: Select WhatsApp.
« Sender: Select the associated phone number for sending messages.
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« Recipient: Select a country/region code, then enter the recipient number.
4. Click Create.

The WhatsApp messaging session is created.
5. In the session, send the desired message template to your customer.
a. Click WhatsApp Message Template, then search and select the desired tem-

.
Internal Chat External Chat +12025550101
+
All v
Campaign Group
+12025550101 .
]
WhatsApp Message Template X
Marketing » English X a

WhatsApp Message Template

tier_discount_announcement

Hello! As a valued {{customer_tier}} member, we're excited to share a special {{offer_type}}
with you! T Enjoy {{offer_details}}—available until {{expiry_date}}. If you have any questions or...

X Cancel

b. If the template includes media or variable placeholders, upload the required me-
dia files and fill in specific values for all variables.
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WhatsApp Message Template X

Message Preview

Hello! .2
Hello! .
As avalued VIP member, we're excited
to share a special discount with you!
Asavalued VIP  member, we're excited to T

Enjoy 20% off for all products —

share a special  discount  with you! T available until July 30, 2025

Enjoy 20% off for all product —available until
If you have any questions or want to

July 30,2025 redeem your offer, simply reply to this
message or contact our team.
If you have any questions or want to redeem your Thank you for choosing SmartMal! @

offer, simply reply to this message or contact our Redeem Offer

Note:
* You can preview the final message contents on the right panel.
« For location information, you can simply paste the Google Maps
URL, the system will auto-fill the name and coordinates based on
the URL. However, you need to manually enter the detailed ad-
dress for the {{ Addr ess}} variable.

7505045,-73.0934387,

WhatsApp Message Template

----------- ttps://www google.com/maps/place/Madisor

Google Maps

* Madison Square Garden:

* {{Address)}

* 40.7505045

*73.9934387

c. Click Send.


https://www.google.com/maps

Contact Center Guide | 3 - Omnichannel Messaging Guide | 378

Related information
Manage Customer Queries from External Messaging Channels on Web Client / Desk-

top Client

Manage Customer Queries from External Messaging Channels
on Web Client / Desktop Client

This topic describes how to manage the messaging sessions of customer queries on
Linkus Web Client and Desktop Client.

Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

« PBX Version: 37.20.0.128 or later.
« Plan: Enterprise Plan or Ultimate Plan
» Messaging: At least one messaging channel is set up on PBX.

Linkus Desktop Client

Make sure that the version of your Linkus Desktop Client meets the following
requirement:

» Windows Desktop: 1.2.14 or later
» macOS Desktop: 1.2.14 or later

Pick up a messaging session
If you are an agent of a message queue, when the queue receives inbound message(s) in a
new session, you can see the message(s) and pick up the session from the queue.

Note:
The pickup operation is only available when the chat assignment mode of your
message queue is set to Manual Pickup or Auto-Pickup.

« If the mode set to Manual Pickup, you need to manually pick up the session.
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« If the mode is set to Auto-Pickup, the session will be automatically assigned
to you if you are the first agent to reply. You can also manually pick up the
session in this mode if needed.

Internal Chat External Chat ) ? 283

+
Click the button to pick up the session from the message queue.
Recent

283 *
@ 283

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
2. To manually pick up a session, click Pick Up at the top of the messaging session.

There is a prompt indicating that you have picked up the session from the message
queue; Only you can see the session and respond to messages in the session.

Transfer a messaging session

During a session, you can transfer a customer's conversation to another colleague or a mes-
sage queue for further handling. Alternatively, if advanced message processing or automa-
tion is required, you can transfer the session to a third-party message analytics platform.

Note:

The option to transfer sessions to a third-party message analytics platform will only
appear if the system administrator has integrated the PBX server with a third-party
platform via API.
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121) +1 121 S s 2 a
Internal Chat External Chat &y

Recent Transfer

121 * Do you want to transfer this messaging session? Once transferred,
- you will no longer be able to ork on the session. The person who

receives the session will see all your previous chat history. mple.pdf

Extension

1003-Kristin Hale

X Cancel

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of the messaging session, click e
3. In the pop-up window, select the desired destination and click OK.

The messaging session is removed from your external chat list, and transferred to the
colleague / message queue / Third-party message analytics platform with whole chat
history.

Initiate a voice call from a messaging session

You can initiate a voice call right from the messaging session to resolve a customer's issue
if necessary.

Note:
This operation requires the permission to make outbound calls. Contact the system
administrator to check if you have the permission.
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sample.pdf

121

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of the messaging session, click .

Linkus Web Client quickly dials out the customer's number, and the call is sent
through the PBX.

Add a customer to Contacts

You can add a customer to Contacts right from the messaging session.

121 +1 121 . "Q) 5 a

@ Add New Contact

2. Add to Existing Contact

+ o
o
° sample.pdf

121

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of the messaging session, click 2 .
3. Add the customer to Contacts according to your needs.
« To add the customer as a new contact, click Add New Contact and enter the
customer's information.
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» To add the customer to an existing contact, click Add to Existing Contact and
edit the contact's information as needed.

View messaging session details

You can check the detailed information of a messaging session, including the message
source channel, channel number, etc.

(R - | 8 | Details X

2

There: 2
D
° sample.pdf v Session Details

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the bottom of the messaging session, click El

The details of the messaging session is display at the right panel.

Archive a messaging session

You can archive a messaging session if there is no response from the customer or you wish
to refer back to the session later.

+
o
PS B sample.pdf

3}

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
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2. At the top-right corner of the messaging session, click ]
The messaging session is moved from Recent list to the Archived list.

Note:

To start the conversation again, you can directly send a message in the

archived messaging session, or click B at the top-right corner to unarchive
the messaging session. The unarchived session will be moved back to the
Recent list.

End a messaging session

When you're done helping a customer, you can end the messaging session.

Do you want to close this messaging
+1 121 session? Once closed, you will not be able
[:~:] to send new messages on this session.

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.

2. At the top-right corner of a messaging session, click =
3. In the pop-up window, click OK.

The messaging session is closed and moved to the Archived list; You can NOT send
messages on this session any more. Next time the customer sends messages, a new
messaging session will be created.

Remove a messaging session

To remove a messaging session, do as follows:
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121) +1 121 .8 a

A Mutenotifications This will remove the conversation from this P sample.pdf
chat list. Are you sure to remove it?

X Cancel [EVAVS

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
2. In the external chat list, right click the messaging session that you want to remove.
3. Click Remove.

4. In the pop-up window, click OK.

The messaging session is removed from all your Linkus clients.

Handle campaign sessions

If system administrator sets message campaigns to send messages in bulk, and assigns
the campaign sessions to your extension or the message queue you belong to, you can view
and manage these campaign sessions.

[
o

909) +12025550909 .~

102 +12025550102 . 2 @ a a

Recent o l
N

+12025550909 < Campaign Group test3op

909

12025550101
101

412025550102
102

4120255500
-

qga +12005850104
-]

{gp +12025550105
@

1. On Linkus Web Client or Desktop Client, click Chat, then click the External Chat tab.
2. In the external chat list, click Campaign Group.

All sessions created by message campaigns will be listed.
3. Click a session to view and respond to customer replies as needed.
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Agent Operations on Mobile Client

Start a Messaging Session with a Customer on Mobile Client

If you need to send customers messages for notifications, marketing campaigns or other
purposes, you can proactively start a messaging session.

Note:

You can only proactively start a messaging session via SMS messaging channel.

Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

« Version: 37.12.0.57 or later.
« Plan: Enterprise Plan or Ultimate Plan
« Messaging: At least one messaging channel is set up on PBX.

Linkus Mobile Client

Make sure that the version of your Linkus Mobile Client meets the following re-
quirements:

* Linkus iOS Client: Version 5.7.3 or later
+ Linkus Android Client: Version 5.7.4 or later
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1. On Linkus Mobile Client, go to Chat > External Chat.

2. At the top-right corner, tap +.

3. In the drop-down menu, select Create SMS Session.
4. Select sender and recipient.

a. In the Sender drop-down list, select the channel number for sending messages.

b. In the Recipient drop-down list, select a country/region code, then enter the re-
cipient number.

5. At the top-right corner, tap Create.

Result
The messaging session will appear in the external chat list after you send a message.

Related information
Manage Customer Queries from External Messaging Channels on Mobile Client

Manage Customer Queries from External Messaging Channels
on Mobile Client

This topic describes how to manage the messaging sessions of customer queries on
Linkus Mobile Client.
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Requirements

PBX Server

Contact system administrator to make sure that PBX server meets the follow-
ing requirements:

* Version: 37.20.0.128 or later.
« Plan: Enterprise Plan or Ultimate Plan
« Messaging: At least one messaging channel is set up on PBX.

Linkus Mobile Client

Make sure that the version of your Linkus Mobile Client is 5.19.7 or later.

Pick up a messaging session
If you are an agent of a message queue, when the queue receives inbound message(s) in a
new session, you can see the message(s) and pick up the session from the queue.

Note:

The pickup operation is only available when the chat assignment mode of your
message queue is set to Manual Pickup or Auto-Pickup.

« If the mode set to Manual Pickup, you need to manually pick up the session.

- If the mode is set to Auto-Pickup, the session will be automatically assigned
to you if you are the first agent to reply. You can also manually pick up the
session in this mode if needed.
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Gl he buton pick up the sess
from the message queue.

1. On Linkus Mobile Client, go to Chat > External Chat.
2. To manually pick up a message session, tap Pick Up at the top of the session.

There is a prompt indicating that you have picked up the session from the message
queue; Only you can see the session and respond to messages in the session.

Transfer a messaging session

During a session, you can transfer a customer's conversation to another colleague or a mes-
sage queue for further handling. Alternatively, if advanced message processing or automa-
tion is required, you can transfer the session to a third-party message analytics platform
(API).

Note:
The option to transfer sessions to a third-party message analytics platform will only
appear if the system administrator has integrated the PBX server with a third-party

platform via API.
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1. On Linkus Mobile Client, go to Chat > External Chat.

2. In an active messaging session, tap ~ at the top-right corner.
3. On the Chat Information page, tap Transfer.
4. Search and select the colleague, then tap Confirm in the pop-up window.

The messaging session is removed from your external chat list, and transferred to the
colleague / message queue / Third-party message analytics platform with whole chat
history.

Initiate a voice call from a messaging session

You can initiate a voice call right from the messaging session to resolve a customer's issue
if necessary.

Note:
This operation requires the permission to make outbound calls. Contact the system
administrator to check if you have the permission.
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407

1. On Linkus Mobile Client, go to Chat > External Chat.
2. In a messaging session, tap % atthe top-right corner.

Linkus Mobile Client quickly dials out the customer's number, and the call is sent
through the PBX.

Add a customer to Contacts

You can add a customer to Contacts right from the messaging session.

Add to Contacts
New Contact

Add to Existing Contact

Cancel
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1. On Linkus Mobile Client, go to Chat > External Chat.

2. In a messaging session, tap ~ at the top-right corner.
3. At the bottom of the Chat Information page, tap Add to Contacts.
4. Add the customer to Contacts according to your needs.

« To add the customer as a new contact, click New Contact in the pop-up win-
dow, and enter the customer's information.

« To add the customer to an existing contact, click Add to Existing Contact in
the pop-up window, select the contact and edit the information as needed.

View messaging session details

You can check the detailed information of a messaging session, including the message
source channel, channel number, etc.

Session Details

Channel Type

Channel Number

Recipient Number

1. On Linkus Mobile Client, go to Chat > External Chat.

2. In a messaging session, tap ~ at the top-right corner.

The details of the messaging session is displayed in the Session Details section.

Note:
If the customer is an existing contact, you can also tap the customer to quick-
ly access the contact's information.
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Archive a messaging session

You can archive a messaging session if there is no response from the customer or you wish
to refer back to the session later.

1. On Linkus Mobile Client, go to Chat > External Chat.
2. In the external chat list, touch and hold an active messaging session, then tap

Archive.

The messaging session is moved from Recent list to the Archived list.

Note:

To start the conversation again, you can directly send a message in the
archived messaging session, the messaging session will be automatically

unarchived and moved back to the Recent list.
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End a messaging session
When you're done helping a customer, you can end the messaging session.

2:17 e T @

< Chat Information

External Chat

0 +12027886407

Session Details

Channel Type [i:]
Channel Number +12026461283
Recipient Number +12027886407
Mute Notifications ()
Close >
Transfer >
Archive ()
Do you want to close this messaging session? Once
closed, you will not be able to send new messages on

this session.

o Confirm

Cancel

1. On Linkus Mobile Client, go to Chat > External Chat.

2. In an active messaging session, tap ~ at the top-right corner.
3. On the Chat Information page, tap Close.
4. In the pop-up window, click Confirm.

The messaging session is closed and moved to the Archived list; You can NOT send
messages on this session any more. Next time the customer sends messages, a new
messaging session will be created.

Remove a messaging session

To remove a messaging session from the chat list, do as follows:
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External Chat

Archive  Delete

w_

1. On Linkus Mobile Client, go to Chat > External Chat.
2. In the external chat list, touch and hold a messaging session, then tap Delete.

The messaging session is removed from the chat list on all your Linkus clients.

Handle campaign sessions

If system administrator sets message campaigns to send messages in bulk, and assigns
the campaign sessions to your extension or the message queue you belong to, you can view
and manage these campaign sessions.
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[Document t]
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1. On Linkus Mobile Client, go to Chat > External Chat.
2. In the external chat list, tap Campaign Group.

All sessions created by message campaigns will be listed.
3. Tap a session to view and respond to customer replies as needed.
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